Cisco Customer Response Solutions
Administration Guide, Release 5.0(1)

Cisco Unified Contact Center Express, Cisco Unified IP IVR, and Cisco Unified Queue Manager
May 2007

Americas Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706
USA
http://www.cisco.com
Tel: 408 526-4000
800 553-NETS (6387)
Fax: 408 527-0883
THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB’s public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and coincidental.

Cisco Customer Response Solutions Administration Guide, Release 5.0(1)
Copyright © 2007 Cisco Systems, Inc. All rights reserved.
##Preface

- Audience
- Organization
- Related Documentation
- Conventions
- Obtaining Documentation
  - Cisco.com
  - Product Documentation DVD
  - Ordering Documentation
- Documentation Feedback
- Cisco Product Security Overview
  - Reporting Security Problems in Cisco Products
- Product Alerts and Field Notices
- Obtaining Technical Assistance
  - Cisco Support Website
- Submitting a Service Request
- Definitions of Service Request Severity
- Obtaining Additional Publications and Information

##PART 1

###Cisco Customer Response Solutions: Overview

####CHAPTER 1

- Introducing Cisco Customer Response Solutions
  - About the Cisco CRS Components
  - The Cisco CRS Product Family
Cisco Customer Response Solutions Administration Guide, Release 5.0(1)

PART 2 Cisco Customer Response Solutions: Configuration

CHAPTER 3 The Cisco CRS Provisioning Checklist 3-1
   About Unified CCX 3-2
   Unified CCX Provisioning Checklist 3-4

CHAPTER 4 Provisioning Unified CM for Unified CCX 4-1
   Configuring Unified CM Information 4-2
   Modifying Cluster Information from Cisco CRS 4-3
      Displaying Unified CM Cluster Nodes in Unified CCX 4-4
   Modifying AXL Information 4-5
   Modifying Unified CM Telephony Information 4-8
   Modifying RmCm Provider Information 4-10
   Modifying NTP Configuration 4-12
   Configuring Unified CM for Unified CCX 4-14
      Invoking Unified CM Administration 4-14
      Defining Unified CM Users as Agents 4-15
         Guidelines for Configuring Agent Phones 4-16
      Assigning Unified CM Users as Cisco TelePresence Virtual Agents 4-17
      Assigning Unified CM Users as Unified CCX Agents 4-19

CHAPTER 5 Provisioning Unified CCX for Unified CME 5-1
   Introducing Unified CME for Cisco CRS 5-2
      Guidelines 5-2
      Supported Features 5-3
      Interoperability between Cisco CRS and Unified CME 5-4
   Verifying Licenses 5-5
   Modifying Unified CME Information from Cisco CRS 5-5
Configuring the AXL User in Cisco CRS  5-5
Provisioning the Unified CME Telephony Subsystem  5-6
  Validating Unified CME and Cisco CRS Data  5-8
  Configuring a Unified CME Telephony Provider  5-9
  Modifying the Unified CME Telephony Call Control Group  5-10
  Modifying a Unified CME Telephony Trigger  5-10
Managing Unified CME Users  5-16
  Assigning Capability Views to Unified CME Users  5-16
  Creating New Unified CME Users  5-17
  Changing Passwords and Pins  5-19
Identifying Agent Directory Numbers  5-19

CHAPTER  6
Provisioning Telephony and Media  6-1
  About CRS Telephony and Media  6-2
    Media Termination Groups  6-3
    Provisioning Channels to Handle Calls  6-3
    Telephony and Media Resources Provisioning Checklist  6-5
  Provisioning the Unified CM Telephony Subsystem  6-5
    Resynchronizing the Unified CM Telephony Data  6-6
    Resynchronizing the Cisco JTAPI Client  6-7
    Configuring a Unified CM Telephony Provider  6-8
    Adding a New Unified CM Telephony Call Control Group  6-9
    Adding a Unified CM Telephony Trigger  6-14
  Additional Unified CM Telephony Information  6-21
    Provisioning Unified CM Telephony Triggers for Unified CCX Queuing  6-21
    Resynchronizing Unified CM Telephony Information  6-21
    Unified CM Telephony Provider Migration  6-23
  Provisioning the Cisco Media Subsystem  6-23
    Adding a CMT Dialog Control Group  6-24
**Provisioning ASR and TTS in Cisco CRS** 6-26

Before You Provision ASR/TTS 6-26

Provisioning the MRCP ASR Subsystem 6-27

Provisioning MRCP ASR Providers 6-28

Provisioning MRCP ASR Servers 6-29

Provisioning MRCP ASR Dialog Groups 6-31

Provisioning the MRCP TTS Subsystem 6-34

Provisioning MRCP TTS Providers 6-35

Provisioning MRCP TTS Servers 6-37

Provisioning MRCP TTS Default Genders 6-38

**CHAPTER 7**

**Provisioning Unified CCX** 7-1

Configuring the RmCm Provider 7-2

Provisioning the RmCm Provider 7-2

Associating Agent Extensions with the RmCm Provider 7-3

Configuring Resource Groups 7-4

Creating a Resource Group 7-4

Modifying an Existing Resource Group Name 7-5

Deleting a Resource Group 7-6

Configuring Skills 7-7

Creating a Skill 7-7

Modifying an Existing Skill Name 7-8

Deleting a Skill 7-9

Configuring Agents 7-10

Implications of Deleting Agents in Unified CM 7-11

Assigning Resource Groups and Skills to One Agent 7-12

Assigning Resource Groups and Skills to Multiple Agents 7-14

Removing Skills from Agents 7-16

Configuring Contact Service Queues 7-17
Creating a CSQ  7-18
Modifying an Existing CSQ  7-24
Deleting a CSQ  7-25
Resource Pool Selection Criteria: Skills and Groups  7-26
Resource Skill Selection Criteria Within a CSQ  7-27
Configuring and Using Remote Monitoring  7-29
Creating a Remote Monitoring Supervisor  7-30
Assigning Resources and CSQs to a Supervisor  7-31
Configuring Agent-Based Routing  7-33
Wrap-Up Data Usage 7-34
Configuring Teams  7-34
Creating a Team Supervisor  7-35
Creating Teams  7-36
Modifying Agents on Teams  7-38
Deleting a Team  7-39
Unified Gateway Auto-Configuration Details  7-40

CHAPTER 8
Provisioning Additional Subsystems  8-1
About Additional Subsystems  8-2
Provisioning the Unified ICME Subsystem  8-3
Configuring General Unified ICME Information  8-4
Configuring Unified ICME VRU Scripts  8-6
Provisioning the HTTP Subsystem  8-8
Configuring HTTP Triggers  8-9
Changing Port Numbers  8-11
Provisioning the Database Subsystem  8-12
Defining an ODBC Data Source  8-13
Adding a New Data Source  8-16
Polling Database Connectivity  8-17
Contents

Provisioning the eMail Subsystem 8-19

CHAPTER 9
Configuring Cisco Applications 9-1

About CRS Applications 9-2
Configuring Cisco Script Applications 9-3
Configuring the Busy Application 9-7
Configuring the Ring-No-Answer Application 9-8
Configuring the Unified ICME Post-Routing Application 9-10
Configuring the Unified ICME Translation-Routing Application 9-14
Configuring the Remote Monitoring Application 9-16

Adding Application Triggers 9-18
Adding a Unified CM/Unified CME Telephony Trigger 9-19
Adding Unified CM/Unified CME Telephony Triggers from an Application Web Page 9-20
Adding Unified CM/Unified CME Telephony Triggers from Cisco CRS 9-21
Adding an HTTP Trigger 9-21
Adding HTTP Triggers from an Application Web Page 9-22
Adding HTTP Triggers from the HTTP Subsystem 9-24

Managing Scripts 9-25
Uploading New Scripts 9-26
Viewing or Downloading a Script File 9-29
Refreshing Scripts 9-30
Individual Script Refresh 9-31
Bulk Script Refresh 9-31
Renaming a Script or Folder 9-33
Deleting a Script or Folder 9-34
Sample Scripts 9-35
CHAPTER 10

Managing Prompts,Grammars, Documents, and Custom Files 10-1

Managing Prompt Files 10-2
Managing Grammar Files 10-4
Managing Document Files 10-6
Managing Languages 10-8
  Creating a New Language 10-8
  Renaming a Language 10-9
  Deleting a Language 10-9
  Upload Zip files to a Language Folder 10-10
  Unzipping a Document File After Uploading 10-11
Recording and Uploading Prompt Files 10-11
  Recording a Prompt 10-13
  Add Spoken Name Prompts 10-14
Managing Custom Files 10-15
  Specify Custom Classpath Entries 10-16
  Specify the Custom Steps Startup Order 10-18
  Specify the Custom Subsystems Start Up Order 10-18
Managing AAR Files 10-19
  Creating AAR Files 10-22
  Uploading AAR Files 10-22
  The META-INF Directory 10-23
  The Prompts, Grammars, Documents, and Scripts Directories 10-23
    The Prompts Directory 10-23
    The Grammars Directory 10-24
    The Documents Directory 10-24
    The Scripts Directory 10-24
  AAR Manifest 10-24
  Attribute Types 10-26
    Main Attributes 10-27
CHAPTER 11

Managing the Cisco CRS System 11-1
  Control Center Terminology 11-2
  About Control Center Management 11-3
  High Availability and Automatic Failover 11-7
    Network Partitions 11-8
  Managing the Control Center 11-9
    Activating a Component 11-12
    Removing a Server 11-13
    Disabling a Server 11-14
    Starting, Stopping, and Restarting CRS Services 11-15
    Reelect Master 11-16
    Server Traces 11-18
    Server Details 11-19
  Managing the CRS Engine 11-20
    Monitoring Service Status 11-20
    Controlling the Auto Refresh Interval 11-21
  Managing Cisco CRS CDS Information 11-22
  Managing System Parameters 11-23
  Exiting Cisco CRS Administration 11-28
  Tracing Configuration 11-28
    CRS Log Collection Tool 11-29
  Cisco CRS Utilities 11-29
    CRS Admin Utility 11-29
      Guidelines and Requirements for the CRS Admin Utility 11-30
      Logging on to the Cisco CRS Admin Utility 11-31
      Changing the CRS Administrator Password 11-31
Contents

Changing the CRSAdministrator Password for Multiple-Node Deployments 11-32
Synchronizing the CRSAdministrator Password for Multiple-Node Deployments 11-33
Synchronizing the Cisco Historical Reports User Password 11-34
Refreshing Account Sync Status 11-35
LogLevel Entry in Registry 11-35
Timeout Seconds Entry in Registry 11-35
ExtRetries Entry in Registry 11-36
CRS Serviceability Utility 11-36
Launching the Cisco CRS Serviceability Utility 11-37
Updating Property File information 11-37
Updating CRS IP Address Information 11-38
Updating Unified CM Information 11-39
Examples: Updating CM Information 11-40
Using the CRS Log Collection Tool 11-44

CHAPTER 12
Managing the Cisco CRS Datastores 12-1
About the CRS Datastore 12-2
Inactive Retention Period 12-3
Publisher Goes Down 12-4
Subscriber Goes Down 12-4
The CRS Datastore Control Center 12-4
Datastore Control Center 12-6
The Publisher Activation Page 12-8
Changing Publisher to Subscriber 12-9
Configuring Trace Settings 12-9
Updating Trace File Information 12-10
Activating/Deactivating Logging 12-11
Trace Settings and Unified CM Telephony Performance 12-12

Cisco Customer Response Solutions Administration Guide, Release 5.0(1)
Chapter 13
Managing Cisco CRS Historical Reporting

13-1

About the CRS Historical Datastore
13-2

Historical Reporting Configuration
13-2

Configuring Database Server Limits
13-3

Specifying Users for Historical Reporting
13-4

Purging Historical Data
13-4

Configuring Automatic Purging
13-5

Setting the Daily Purge Schedule
13-6

Configuring Purge Schedule Configuration Parameters
13-7

Purging Manually
13-9

Verifying the Migration Status
13-10

Database Details for Multichannel Reports
13-11

Multichannel License Requirements
13-12

Configuring the Database Access Details
13-12

Truncating db_cra Database Transaction Log Files
13-13

Importing Historical Data from Data Files
13-15

Chapter 14
Configuring Cisco Unified CCX Outbound Preview Dialer

14-1

About the Outbound Feature for Unified CCX
14-2

Outbound Characteristics
14-2

Unified CCX Requirements
14-3

Outbound Components
14-5

Direct Preview Dialing Mode
14-6

The Outbound Feature License
14-7

How Is a Contact’s Local Time Determined?
14-7
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Outbound Configuration Checklist</td>
<td>14-9</td>
</tr>
<tr>
<td>Verifying the RmCm and Outbound Subsystems</td>
<td>14-10</td>
</tr>
<tr>
<td>Configuring General Outbound Properties</td>
<td>14-11</td>
</tr>
<tr>
<td>Customer Dialing Lists</td>
<td>14-14</td>
</tr>
<tr>
<td>Handling Callbacks</td>
<td>14-19</td>
</tr>
<tr>
<td>How the Outbound Option Works with Area Codes</td>
<td>14-20</td>
</tr>
<tr>
<td>Handling Configuration Updates</td>
<td>14-21</td>
</tr>
<tr>
<td>Allocating CSQ Agent Pool Percentages</td>
<td>14-22</td>
</tr>
<tr>
<td>Adding a New Campaign</td>
<td>14-23</td>
</tr>
<tr>
<td>Importing Contacts for a Campaign</td>
<td>14-25</td>
</tr>
<tr>
<td>Enabling Campaigns</td>
<td>14-27</td>
</tr>
<tr>
<td>Adding Area Codes</td>
<td>14-29</td>
</tr>
<tr>
<td>Setting-up Communications with the Agent’s Desktop</td>
<td>14-31</td>
</tr>
<tr>
<td>Agents Receive Outbound Calls</td>
<td>14-31</td>
</tr>
<tr>
<td>Agent Allocation and Queuing</td>
<td>14-32</td>
</tr>
<tr>
<td>Previewing Customer Information</td>
<td>14-34</td>
</tr>
<tr>
<td>Exchanging Data with CAD</td>
<td>14-35</td>
</tr>
<tr>
<td>Call Status Values</td>
<td>14-37</td>
</tr>
<tr>
<td>Resetting Contact States at Midnight</td>
<td>14-37</td>
</tr>
<tr>
<td>Call Result Values</td>
<td>14-39</td>
</tr>
<tr>
<td>Reclassification Status Behavior</td>
<td>14-40</td>
</tr>
<tr>
<td>Handling Skip-Next Behavior</td>
<td>14-42</td>
</tr>
<tr>
<td>Handling Skip/Reject Behavior</td>
<td>14-42</td>
</tr>
<tr>
<td>Call Retrieval Priority</td>
<td>14-44</td>
</tr>
<tr>
<td>Handling Failover and System Restarts</td>
<td>14-44</td>
</tr>
<tr>
<td>Removing Contacts from the Do Not Call List</td>
<td>14-45</td>
</tr>
</tbody>
</table>

**CHAPTER 15**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backing-up and Restoring Data</td>
<td>15-1</td>
</tr>
<tr>
<td>About the Backup and Restore Application</td>
<td>15-2</td>
</tr>
</tbody>
</table>
Applications 16-17
Sessions 16-18
Datasource Usage 16-19
Overall Unified CCX Stats 16-20
CSQ Unified CCX Stats 16-23
Outbound Campaign Unified CCX Stats 16-24
Resource Unified CCX Stats 16-27
Failover Behavior for Unified CCX Stats 16-29

The Tools Menu 16-29
The Reset All Statistics Menu Option 16-29
The Refresh Connections Menu Option 16-30

The Views Menu 16-30
Application Tasks 16-31
Contacts 16-31
Applications 16-31
Sessions 16-32

The Settings Menu 16-32
The Options Menu Option 16-33

CHAPTER 17 Using the Cisco CRS Supervisor and Cisco CRS User Options Plug-Ins 17-1

About User Management 17-2
About Cisco CRS User Capabilities 17-2
Administrator Privileges 17-3
Supervisor Privileges 17-3
Historical Report User Privileges 17-4
Agent Privileges 17-5

Using the CRS Supervisor Web Interface 17-6
Accessing the Cisco CRS Supervisor Web Page 17-6
Monitoring Agents 17-7
Monitoring CSQs 17-8
Viewing CSQ IDs for Remote Monitoring 17-8
Installing Client-Side Historical Reporting 17-9
Using the CRS User Options Web Interface 17-9
Accessing the Cisco CRS User Options Web page 17-9
Downloading the Agent Desktop 17-10
Adding Alternative Pronunciations 17-10
Accessing the Unified CM User Options page 17-12

PART 3
Cisco Customer Response Solutions: Reference

CHAPTER 18
The System Menu 18-1
The Unified CM Configuration Menu Option 18-2
The Unified CME Configuration Menu Option 18-3
The Control Center Menu Option 18-3
  Control Center/Servers 18-4
  Control Center/Servers/Server Traces 18-4
  Control Center/Features 18-4
  Control Center/Features/Component Activation 18-5
The Datastore Control Center Menu Option 18-5
The System Parameters Menu Option 18-6
The Custom File Configuration Menu Option 18-6
  List of Custom Start Up Order 18-7
The Alarm Configuration Menu Option 18-7
The Tracing Menu Option 18-8
  Trace File Configuration 18-8
  Trace Configuration 18-9
  Agent/Historical/Repository Trace Configuration 18-9
The License Information Menu Option 18-10
  Display Licenses 18-10
Add License(s)  18-11
The Language Information Menu Option  18-11
The Logout Menu Option  18-11

CHAPTER 19

The Applications Menu  19-1
The Application Management Menu Option  19-2
Script Management  19-3
Prompt Management  19-4
Grammar Management  19-5
Document Management  19-6
AAR Management  19-7

CHAPTER 20

The Subsystems Menu  20-1
The Unified CM Telephony Menu Option  20-2
Unified CM Telephony Provider Configuration  20-3
Unified CM Telephony Call Control Group Configuration  20-3
Unified CM Telephony Triggers Configuration  20-4
Unified CM Telephony > Data Resync  20-4
Unified CM Telephony > Cisco JTAPI Resync  20-5
The Unified CME Telephony Menu Option  20-5
Unified CME Telephony Provider Configuration  20-6
Unified CME Telephony Call Control Group Configuration  20-6
Unified CME Telephony Triggers Configuration  20-7
Validate Unified CME in CRS Data  20-7
The RmCm Menu Option  20-7
Skills Configuration  20-8
Adding a New Skill  20-9
Modifying Skills  20-9
Resources Configuration  20-9
Modifying a Resource 20-10
Resource Group Configuration 20-10
  Adding a New Resource Group 20-10
  Modifying Existing Resource Groups 20-11
Contact Service Queues Configuration 20-11
  Adding a CSQ 20-11
RmCm Provider Configuration 20-12
Assign Skills Configuration 20-12
  Adding Skills 20-13
  Removing Skills 20-13
Remote Monitor Configuration 20-13
  Assigning Resources and CSQs to a Remote Supervisor 20-14
Agent Based Routing Settings Configuration 20-14
Teams Configuration 20-15
  Adding a New Team 20-15
The Outbound Menu Option 20-15
General Configuration 20-16
Campaign Configuration 20-16
  Add New Campaigns 20-17
  Import Contacts 20-17
  Delete Do Not Call Contacts 20-17
Area Code Management 20-18
  Add New Area Code 20-18
The Unified ICM Menu Option 20-19
Unified ICME Configuration 20-19
Unified ICME VRU Scripts 20-20
  Add a New VRU Script 20-20
The Database Menu Option 20-21
DataSource Configuration 20-21
  Adding a New Data Source 20-22
Contents

Adding a New Database Parameter 20-22
The HTTP Menu Option 20-22
   HTTP Configuration 20-23
   Add a New HTTP Trigger 20-23
The eMail Menu Option 20-24
The Cisco Media Menu Option 20-24
The MRCP ASR Menu Option 20-25
   MRCP ASR Provider 20-25
   MRCP ASR Servers 20-26
   MRCP ASR Dialog Groups 20-26
The MRCP TTS Menu Option 20-27
   MRCP TTS Providers 20-27
   MRCP TTS Servers 20-28
   MRCP TTS Default Genders 20-28

Chapter 21
The Wizards Menu 21-1
   The Application Wizard 21-2
   The RmCm Wizard 21-3

Chapter 22
The Tools Menu 22-1
   Alarm Definition Menu Option 22-2
   The Plug-ins Menu Option 22-2
   The Real-Time Reporting Menu Option 22-3
   The Real-time Snapshot Config Menu Option 22-4
   The Historical Reporting Menu Option 22-7
      Database Server Configuration Hyperlink 22-8
      The Purge Schedule Configuration Hyperlink 22-8
      The Purge Schedule Hyperlink 22-9
Contents

The Purge Schedule Configuration Hyperlink 22-9
The Purge Now Hyperlink 22-9
The Migration Status Hyperlink 22-10
The Unified WIM /Unified EIM Database Hyperlink 22-10

The User Management Menu Option 22-10
The User View Menu Option 22-11
The Name Grammar Generation Configuration 22-12
The Spoken Name Upload Menu Option 22-13
The Capability View Menu Option 22-14

The Administrator Capability View 22-14
The Supervisor Capability View 22-14
The Reporting Capability View 22-15
The Agent Capability View 22-15

The Troubleshooting Tips Menu Option 22-16
The Backup and Restore Menu Option 22-16

Status 22-17
Backup Storage Location 22-17
Backup Scheduler 22-18
Backup Now 22-18
Restore Now 22-18

CHAPTER 23

The Help Menu 23-1

The Contents and Index Option 23-2
The For This Page Menu Option 23-3
The CRS Documentation Link Option 23-3
The About Menu Option 23-3

APPENDIX A

Cisco CRS Licensing Packages A-1

Application Availability by License Package A-2
Preface

The *Cisco Customer Response Solutions Administration Guide* provides instructions for using the Cisco Customer Response Solutions (CRS) Administration web interface to provision the subsystems of the Cisco CRS package and to configure Cisco CRS applications.

This guide shows you how to implement three systems that integrate with the Cisco CRS Platform:

- Cisco Unified Contact Center Express (Unified CCX)
- Cisco Unified Interactive Voice Response (Unified IP IVR)
- Cisco Unified Queue Manager (Unified QM)

This guide also includes a reference section that describes all the menus and menu options of the CRS Administration web interface.

This guide will help you to:

- Perform initial configuration tasks.
- Administer applications, the CRS Engine, and other components of the Cisco Unified Communication family of products.
- Familiarize yourself with the menus and menu options of the CRS Administration web interface.
Audience

The Cisco Customer Response Solutions Administrator Guide is written for business analysts and application designers who have the domain-specific knowledge required to create multimedia and telephony customer response applications. Experience or training with Java is not required but is useful for making best use of the capabilities of the Cisco Unified Communications family of products.

Organization

This guide is divided into three parts.

- **Part 2**, “Cisco Customer Response Solutions: Configuration,” describes the tasks necessary for configuring Cisco CRS.

Part 1 contains the following chapters:

<table>
<thead>
<tr>
<th>Chapter Number and Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1, “Introducing Cisco Customer Response Solutions”</td>
<td>Describes key features of the Cisco CRS system. Provides an overview of the configuration tasks necessary to configure and administer Cisco CRS.</td>
</tr>
<tr>
<td>Chapter 2, “Introducing the CRS Administration Web Interface”</td>
<td>Provides an overview of the CRS Administration web interface.</td>
</tr>
</tbody>
</table>
Part 2 contains the following chapters:

<table>
<thead>
<tr>
<th>Chapter Number and Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 3, “The Cisco CRS Provisioning Checklist”</td>
<td>Introduces the Cisco Unified Contact Center Express (Unified CCX) subsystem and provides a configuration checklist for the available products.</td>
</tr>
<tr>
<td>Chapter 4, “Provisioning Unified CM for Unified CCX”</td>
<td>Explains how to modify the Cisco Unified Communications Manager (Unified CM) information from Cisco CRS.</td>
</tr>
<tr>
<td>Chapter 5, “Provisioning Unified CCX for Unified CME”</td>
<td>Explains how to modify the Cisco Unified Communications Manager Express (Unified CME) information from Cisco CRS.</td>
</tr>
<tr>
<td>Chapter 6, “Provisioning Telephony and Media”</td>
<td>Introduces the CRS telephony and media subsystems and describes how to provision the Unified CM telephony, CMT (Cisco Media Termination), MRCP ASR (Automated Speech Recognition), and MRCP TTS (Text-To-Speech) subsystems.</td>
</tr>
<tr>
<td>Chapter 7, “Provisioning Unified CCX”</td>
<td>Describes how to provision Unified CM and the Unified CCX subsystem.</td>
</tr>
<tr>
<td>Chapter 8, “Provisioning Additional Subsystems”</td>
<td>Describes how to provision the Cisco Unified Intelligent Contact Management Enterprise (Unified ICME), HTTP, Database, and eMail subsystems.</td>
</tr>
<tr>
<td>Chapter 9, “Configuring Cisco Applications”</td>
<td>Describes how to configure Cisco Busy applications, Cisco Ring-No-Answer applications, Unified ICME post-routing applications, and Unified ICME translation-routing applications and how to manage script files.</td>
</tr>
<tr>
<td>Chapter 10, “Managing Prompts, Grammars, Documents, and Custom Files”</td>
<td>Describes how to manage prompt, grammar, and document files.</td>
</tr>
<tr>
<td>Chapter 11, “Managing the Cisco CRS System”</td>
<td>Describes how to configure, control, and monitor CRS component activities and information in a CRS Cluster.</td>
</tr>
</tbody>
</table>
**Preface**

**Organization**

**Part 3** contains the following chapters:

<table>
<thead>
<tr>
<th>Chapter Number and Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 12, “Managing the Cisco CRS Datastores”</td>
<td>Describes how to manage and monitor agent, historical, repository, and configuration data in a CRS Cluster.</td>
</tr>
<tr>
<td>Chapter 13, “Managing Cisco CRS Historical Reporting”</td>
<td>Describes how to configure the database server, schedule data synchronization, configure historical report users, and set up automatic and manual purging of the Cisco CRS historical reports databases.</td>
</tr>
<tr>
<td>Chapter 14, “Configuring Cisco Unified CCX Outbound Preview Dialer”</td>
<td>Describes how to configure the Cisco Unified Outbound Dialer (Unified OUTD) feature for automated outbound activities for the Unified CM deployment of Unified CCX.</td>
</tr>
<tr>
<td>Chapter 15, “Backing-up and Restoring Data”</td>
<td>Provides details on the backup and restore application for Cisco CRS which is embedded in the Cisco CRS Administrator.</td>
</tr>
<tr>
<td>Chapter 16, “Reporting on Real-Time CRS Data”</td>
<td>Describes how to run real-time reports on CRS data. Provides directions for launching sub-reports, printing reports, refreshing reports, and setting report options.</td>
</tr>
<tr>
<td>Chapter 17, “Using the Cisco CRS Supervisor and Cisco CRS User Options Plug-Ins”</td>
<td>Provides detailed information on the additional plug-in options provided by the Cisco CRS platform.</td>
</tr>
</tbody>
</table>

---

**Part 3** contains the following chapters:

<table>
<thead>
<tr>
<th>Chapter Number and Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 18, “The System Menu”</td>
<td>Describes the options under the System menu of the CRS Administration menu bar.</td>
</tr>
<tr>
<td>Chapter 19, “The Applications Menu”</td>
<td>Describes the options under the Applications menu of the CRS Administration menu bar.</td>
</tr>
<tr>
<td>Chapter 20, “The Subsystems Menu”</td>
<td>Describes the options under the Subsystems menu of the CRS Administration menu bar.</td>
</tr>
</tbody>
</table>
Related Documentation

See the following documents for further information about Cisco CRS applications and products:

- *Cisco Customer Response Solutions Installation Guide*
- *Cisco Customer Response Solutions Servicing and Troubleshooting Guide*
- *Cisco Customer Response Solutions Historical Reports User Guide*
- *Cisco CRS Scripting and Development Series: Volume 1, Getting Started with Scripts*
- *Cisco CRS Scripting and Development Series: Volume 2, Editor Step Reference*
- *Cisco CRS Scripting and Development Series: Volume 3, Expression Language Reference*
- *Cisco Unified Gateway Deployment Guide*
- *Cisco Unified Communications Manager Administration Guide*
- *Cisco Unified Communications Manager System Guide*
- *Cisco Unified Communications Manager Express 4.2 New Features*

These documents are available on Cisco.com at http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_series_home.html. The CRS Administration GUI also provides a direct link to this web site. See “The CRS Documentation Link Option” section on page 23-3.
This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td><strong>Boldface</strong> font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:</td>
</tr>
<tr>
<td></td>
<td>• Choose <strong>Edit &gt; Find</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Finish</strong>.</td>
</tr>
<tr>
<td><strong>italic</strong></td>
<td><strong>Italic</strong> font is used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• To introduce a new term. Example: A <em>skill group</em> is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td></td>
<td>• For emphasis. Example: <em>Do not</em> use the numerical naming convention.</td>
</tr>
<tr>
<td></td>
<td>• A syntax value that the user must replace. Example:</td>
</tr>
<tr>
<td></td>
<td>IF (<em>condition, true-value, false-value</em>)</td>
</tr>
<tr>
<td></td>
<td>• A book title. Example: See the <em>Cisco CRS Installation Guide</em>.</td>
</tr>
<tr>
<td><strong>window</strong></td>
<td><strong>Window</strong> font, such as Courier, is used for the following:</td>
</tr>
<tr>
<td></td>
<td>• Text as it appears in code or that the window displays. Example:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;html&gt;&lt;title&gt;Cisco Systems,Inc.&lt;/title&gt;&lt;/html&gt;</code></td>
</tr>
<tr>
<td><code>&lt; &gt;</code></td>
<td>Angle brackets are used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• For arguments where the context does not allow italic, such as ASCII output.</td>
</tr>
<tr>
<td></td>
<td>• A character string that the user enters but that does not appear on the window such as a password.</td>
</tr>
</tbody>
</table>
Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. This section explains the product documentation resources that Cisco offers.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/techsupport
You can access the Cisco website at this URL:
http://www.cisco.com
You can access international Cisco websites at this URL:

Product Documentation DVD

The Product Documentation DVD is a library of technical product documentation on a portable medium. The DVD enables you to access installation, configuration, and command guides for Cisco hardware and software products. With the DVD, you have access to the HTML documentation and some of the PDF files found on the Cisco website at this URL:
http://www.cisco.com/univercd/home/home.htm
The Product Documentation DVD is created and released regularly. DVDs are available singly or by subscription. Registered Cisco.com users can order a Product Documentation DVD (product number DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at the Product Documentation Store at this URL:
http://www.cisco.com/go/marketplace/docstore
Ordering Documentation

You must be a registered Cisco.com user to access Cisco Marketplace. Registered users may order Cisco documentation at the Product Documentation Store at this URL:

http://www.cisco.com/go/marketplace/docstore

If you do not have a user ID or password, you can register at this URL:


Documentation Feedback

You can provide feedback about Cisco technical documentation on the Cisco Support site area by entering your comments in the feedback form available in every online document.

Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:


From this site, you will find information about how to do the following:

- Report security vulnerabilities in Cisco products
- Obtain assistance with security incidents that involve Cisco products
- Register to receive security information from Cisco

A current list of security advisories, security notices, and security responses for Cisco products is available at this URL:

http://www.cisco.com/go/psirt
To see security advisories, security notices, and security responses as they are updated in real time, you can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

**Reporting Security Problems in Cisco Products**

Cisco is committed to delivering secure products. We test our products internally before we release them, and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability in a Cisco product, contact PSIRT:

- For emergencies only—security-alert@cisco.com
  
  An emergency is either a condition in which a system is under active attack or a condition for which a severe and urgent security vulnerability should be reported. All other conditions are considered nonemergencies.

- For nonemergencies—psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

- 1 877 228-7302
- 1 408 525-6532

**Tip**

We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has been encrypted with PGP versions 2.x through 9.x.

Never use a revoked encryption key or an expired encryption key. The correct public key to use in your correspondence with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page at this URL:


The link on this page has the current PGP key ID in use.
If you do not have or use PGP, contact PSIRT to find other means of encrypting the data before sending any sensitive material.

**Product Alerts and Field Notices**

Modifications to or updates about Cisco products are announced in Cisco Product Alerts and Cisco Field Notices. You can receive these announcements by using the Product Alert Tool on Cisco.com. This tool enables you to create a profile and choose those products for which you want to receive information.

To access the Product Alert Tool, you must be a registered Cisco.com user. Registered users can access the tool at this URL:


To register as a Cisco.com user, go to this URL:


**Obtaining Technical Assistance**

Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco Support website on Cisco.com features extensive online support resources. In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) engineers provide telephone support. If you do not have a valid Cisco service contract, contact your reseller.

**Cisco Support Website**

The Cisco Support website provides online documents and tools for troubleshooting and resolving technical issues with Cisco products and technologies. The website is available 24 hours a day at this URL:

Access to all tools on the Cisco Support website requires a Cisco.com user ID and password. If you have a valid service contract but do not have a user ID or password, you can register at this URL:


Before you submit a request for service online or by phone, use the Cisco Product Identification Tool to locate your product serial number. You can access this tool from the Cisco Support website by clicking the Get Tools & Resources link, clicking the All Tools (A-Z) tab, and then choosing Cisco Product Identification Tool from the alphabetical list. This tool offers three search options: by product ID or model name; by tree view; or, for certain products, by copying and pasting show command output. Search results show an illustration of your product with the serial number label location highlighted. Locate the serial number label on your product and record the information before placing a service call.

Displaying and Searching on Cisco.com

If you suspect that the browser is not refreshing a web page, force the browser to update the web page by holding down the Ctrl key while pressing F5.

To find technical information, narrow your search to look in technical documentation, not the entire Cisco.com website. After using the Search box on the Cisco.com home page, click the Advanced Search link next to the Search box on the resulting page and then click the Technical Support & Documentation radio button.

To provide feedback about the Cisco.com website or a particular technical document, click Contacts & Feedback at the top of any Cisco.com web page.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 and S4 service requests are those in which your network is minimally impaired or for which you require product information.) After you describe your situation, the TAC Service Request Tool provides recommended
solutions. If your issue is not resolved using the recommended resources, your service request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone. (S1 or S2 service requests are those in which your production network is down or severely degraded.) Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411
Australia: 1 800 805 227
EMEA: +32 2 704 55 55
USA: 1 800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has established severity definitions.

Severity 1 (S1)—An existing network is “down” or there is a critical impact to your business operations. You and Cisco will commit all necessary resources around the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your business operations are negatively affected by inadequate performance of Cisco products. You and Cisco will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired while most business operations remain functional. You and Cisco will commit resources during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or configuration. There is little or no effect on your business operations.
Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is available from various online and printed sources.

- The Cisco Online Subscription Center is the website where you can sign up for a variety of Cisco e-mail newsletters and other communications. Create a profile and then select the subscriptions that you would like to receive. To visit the Cisco Online Subscription Center, go to this URL:
  http://www.cisco.com/offer/subscribe

- The *Cisco Product Quick Reference Guide* is a handy, compact reference tool that includes brief product overviews, key features, sample part numbers, and abbreviated technical specifications for many Cisco products that are sold through channel partners. It is updated twice a year and includes the latest Cisco channel product offerings. To order and find out more about the *Cisco Product Quick Reference Guide*, go to this URL:
  http://www.cisco.com/go/guide

- Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo merchandise. Visit Cisco Marketplace, the company store, at this URL:
  http://www.cisco.com/go/marketplace/

- Cisco Press publishes a wide range of general networking, training, and certification titles. Both new and experienced users will benefit from these publications. For current Cisco Press titles and other information, go to Cisco Press at this URL:
  http://www.ciscopress.com

- *Internet Protocol Journal* is a quarterly journal published by Cisco for engineering professionals involved in designing, developing, and operating public and private internets and intranets. You can access the *Internet Protocol Journal* at this URL:
  http://www.cisco.com/ipj

- Networking products offered by Cisco, as well as customer support services, can be obtained at this URL:
- Networking Professionals Connection is an interactive website where networking professionals share questions, suggestions, and information about networking products and technologies with Cisco experts and other networking professionals. Join a discussion at this URL:
  http://www.cisco.com/discuss/networking

- “What’s New in Cisco Documentation” is an online publication that provides information about the latest documentation releases for Cisco products. Updated monthly, this online publication is organized by product category to direct you quickly to the documentation for your products. You can view the latest release of “What’s New in Cisco Documentation” at this URL:
  http://www.cisco.com/univercd/cc/td/doc/abtunicd/136957.htm

- World-class networking training is available from Cisco. You can view current offerings at this URL:
P A R T  1

Cisco Customer Response Solutions: Overview
Introducing Cisco Customer Response Solutions

The Cisco Customer Response Solutions (CRS) platform provides a multimedia (voice, data, and web) IP enabled customer-care application environment that enhances the efficiency of contact centers by simplifying business integration, easing agent administration, increasing agent flexibility, and enhancing network hosting.

The following sections provide an overview of the configuration and management components of the Cisco CRS product family:

- About the Cisco CRS Components, page 1-2
- The Cisco CRS Product Family, page 1-4
- About CRS Cluster Architecture, page 1-7
- Setting Up Cisco CRS, page 1-11
- Running and Managing Cisco CRS, page 1-18
- Where To Go From Here?, page 1-18
About the Cisco CRS Components

A Cisco CRS system contains the following components:

- **Unified Gateway**—Connects the Cisco Unified Communications family of products to the Public Switched Telephone Network (PSTN) and to other private telephone systems such as PBX.

- **Unified CM Server**—The Cisco Unified Communications Manager (Unified CM) provides the features required to implement IP phones, manage gateways, provide failover and redundancy service for the telephony system, and direct Voice over IP (VoIP) traffic to the Cisco CRS system.

  **Note** Cisco Unified Communications Manager was previously known as Cisco Unified CallManager. This guide uses Cisco Unified Communications Manager at the first occurrence and Unified CM for later occurrences.

- **Unified CME interoperability**—The Cisco Unified Communications Manager Express (Unified CME) provides interoperability between Unified CCX and Unified CME, call routing using SIP-based route point, keep alive session management, Support of Cisco Agent Desktop for use with Unified CME, and the ability to store the users locally in the CRS database.

  **Note** Cisco Unified Communications Manager Express was previously known as Cisco Unified CallManager Express. This guide uses Cisco Unified Communications Manager Express at the first occurrence and Unified CME for later occurrences.

- **Cisco CRS Configuration Datastore (CDS)**—Manages configuration, component, and application information within the Cisco CRS cluster and communicates with Unified CM (see About the CRS Datastore, page 12-2).

- **CRS Server**—Contains the CRS Engine that runs applications, including Cisco script applications, Unified CM user integration, Unified CME interoperability, Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) translation-routing and post-routing applications, Busy applications, Ring No Answer applications, and VXML 2.0 applications. You can position your Cisco CRS application server anywhere on the IP network and administer your applications from a web browser on any computer on the...
IP network. Because Cisco CRS uses an open architecture that supports industry standards, you can integrate your applications with a wide variety of technologies and products such as Enterprise databases and Cisco Unified Contact Center (Unified CCX) Agent Desktop.

**Note** If you are using Microsoft Internet Explorer Version 7.0, verify that the popup blocker is disabled.

- Cisco CRS Editor—Allows application developers to use a simple graphical user interface (GUI) to create, modify, and debug Cisco CRS scripts for automating customer interactions. Each script consists of a series of steps, implemented as Java Beans.
- Cisco CRS Administration web interface—Provides access through a web browser for administrators to configure and manage Cisco CRS Datastores, Servers, and Applications.
- Cisco IP Agent and Supervisor Desktops—Desktop programs that allow Unified CCX agents and supervisors to log into the system, change agent states, and monitor status.
- MRCP Text-to-Speech (TTS) server—(Optional.) Dedicated server that converts text into speech and plays it back to the caller.
- Unified CCX Call Monitoring Servers—Additional dedicated servers that provide for call monitoring.
- Historical Reports Database Server—Dedicated server that stores Cisco CRS database for the following datastores: Configuration Datastore (CDS), Historical Datastore (HDS), Repository Datastore (RDS), and Agent Datastore (ADS).

**Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.
Historical Reporting Client—The Unified CCX and Cisco Unified IP IVR (Unified IP IVR) applications can generate a variety of historical reports that provide detailed CDR records, application performance, and traffic analysis information.

The Cisco CRS Product Family

The Cisco CRS product family provides contact-processing functions for your Cisco Unified Communications solution.

The software package you choose determines which steps, components, and subsystems you receive. (Each CRS product includes the CRS Engine and the CRS Editor.)

The Cisco CRS product family includes the following packages:

- Cisco Unified IP IVR, page 1-4
- Cisco Unified Contact Center Express, page 1-5
- Cisco Unified IP Queue Manager, page 1-6

Cisco Unified IP IVR

Cisco Unified IP IVR (Unified IP IVR) is a multimedia (voice, data, web) IP enabled interactive voice response solution that offers an open and feature-rich foundation for the creation and delivery of Unified IP IVR applications via Internet technology.

Unified IP IVR automates call handling by autonomously interacting with contacts. Using Unified IP IVR, you can create applications that answer calls, provide menu choices for callers, obtain caller data such as passwords or account identification, and transfer calls to caller-selected extensions. You can also create Unified IP IVR applications that respond to HTTP requests, outbound calling, sending e-mail, and processing VXML 2.0 commands.

The Unified IP IVR package provides the following features:

- Unified CCE integration—Unified IP IVR can be integrated with the Cisco Unified Queue Manager (Unified QM) functionality to participate in the Unified CCE solution. This option is only available for the Unified CM integration with Unified CCE. It is not available for Unified CME integration with Unified CCE.
Open Database Connectivity (ODBC) support—Unified IP IVR applications can access Microsoft Structured Query Language (SQL) servers and Oracle, Sybase, and IBM DB2 databases.

Real-time reporting client—Unified IP IVR applications can generate a variety of reports that provide detailed information about the real-time status of your system.

Historical reporting client—Unified IP IVR applications can generate a variety of historical reports that provide detailed information about the performance of your system.

ASR—Unified IP IVR applications can take advantage of ASR to provide callers with the option to use speech to navigate through menu options.

TTS—Unified IP IVR applications can use TTS to read back documents and pre-scripted prompts to callers.

Cisco Unified Contact Center Express

Cisco Unified Contact Center Express (Unified CCX) is an IP-based Automated Call Distribution (ACD) system that queues and distributes incoming calls to Unified CCX agents, who can be either groups of Unified CM users for Unified CM integration or Cisco CRS users for Unified CME integration.

You can use Unified CCX applications to route calls to specific agents. You can also integrate Unified CCX with Unified IP IVR to gather caller data and classify incoming calls.

Unified CCX includes a web-based real-time and historical reporting system that you can use to monitor system, Contact Service Queue (CSQ), and resource performance.

The Unified CCX system consists of the following major components:

- Resource Manager—Application program that monitors Unified CCX agent phones and allows you to organize agents into resource groups or skills-based partitions according to the types of calls each group can handle.
- CSQ—Application program that places incoming calls in a queue and distributes them to the appropriate set of agents as the agents become available.
Unified CCX Agent Desktop—Application program that Unified CCX agents run on their desktop computers to log in to the system, change Unified CCX state, and monitor status.

The following licensing options are available for the Unified CCX system:

- Unified CCX Standard (designed for entry-level users)—Includes the steps necessary for creating basic Unified CCX applications.
- Unified CCX Enhanced (designed for enterprise-level users)—Includes all functions of Unified CCX Standard, plus steps that allow for assigning call priority.

**Note**
If you are using Unified CCX with the Cisco Unified Gateway solution, please see the Cisco Unified Gateway Deployment Guide. The instructions for configuring Unified CCX with that solution differs from what is described in this guide. The Unified Gateway provides for the integration of the Unified ICME system with Unified CCX by way of Unified Gateway. The Unified Gateway is a Peripheral Gateway (PG) which you configure on the Unified ICME software.

**Cisco Unified IP Queue Manager**

Cisco Unified QM (Unified QM) is an IP-based call treatment and routing solution that provides powerful call-treatment options as part of the Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) solution, which is a high-end contact center solution capable of distributing calls to multiple sites and performing powerful pre- and post-routing functions.

This product is only supported with Unified CM. It is not available with Unified CME.

You can use Unified QM to allow callers to select routing options, and to provide callers with easy access to multiple agent skill groups, extensions, or announcements, either before or after routing.
Unified QM call-treatment messages can be static, prerecorded announcements or dynamic announcements tailored to specific caller interests. Unified QM can provide dynamic content to queued callers, delivering unique messages tailored to each caller’s needs, the route selected, the caller’s place in the queue, or other associated values.

Unified CCX uses Unified ICME software to direct calls to other systems such as interactive Voice Response Units (VRUs) and ACD systems.

You use the VRU interface included with Unified QM to configure the CRS server to work with Unified CCE. Unified ICME scripts can use the VRU interface to invoke Cisco CRS Editor steps and logic from the CRS Engine to handle calls centrally and direct them to your Cisco Unified Communication family of products based on caller-entered data, information stored in a database, or other parameters.

**Note**
Only customers who use both Unified CCX and Unified ICME can use the VRU interface.

---

### About CRS Cluster Architecture

**Note**
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The Cisco CRS cluster consists of one or more servers (nodes) that are running Cisco CRS components in your Cisco CRS deployment.

If you deploy Cisco CRS components on a single server, the Cisco CRS cluster (often referred to as cluster in this manual) consists of that server. If you deploy Cisco CRS on multiple servers, the cluster includes the Cisco CRS server, expansion servers, and standby servers on which you installed Cisco CRS. The CRS cluster can support up to two CRS Servers, one designated as the **active CRS Server** and the other designated as the **standby CRS Server** for high availability purposes.

When you install or upgrade Cisco CRS on a server, you designate the cluster to which the server will belong by designating the cluster profile for that cluster.
Cluster architecture accommodates high availability and failover since, in case of the failure of a component, a secondary server will take over the functionality lost by that failed component.

All CRS servers within the cluster are configured identically and installed with the same features. One server is designated the active server.

### About the CRS Active Server

- **Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The CRS active server makes global decisions for the cluster and keeps track of calls in the CSQs, agent states (if Unified CCX is installed) and generating historical detail records.

- **Note** Only one server in the cluster can be the active server at any given time.

If the active server fails, the Cisco CRS platform provides automatic failover to the standby server. If the active server fails (for example, in the event a hardware failure occurs or the CRS Engine process terminates), some calls being handled by the server are lost. The lost calls are restricted to those being handled by the system (those in the IVR stage or in queue). Calls answered by agents continue to remain live even though related data on the agent desktop is lost. When the standby server takes over as the new active server, call processing continues (see High Availability and Automatic Failover, page 11-7).

A Cisco CRS cluster consists of the one or more servers (nodes) that run Cisco CRS components in your Cisco CRS deployment (see Control Center Terminology, page 11-2).

Cluster management consists of two main elements:

- Cluster Manager—Receives updates about cluster status and subsystem states.
• Cluster View Daemon (CVD)—Java code that interacts with NodeManager and implements inter-node communication on behalf of the cluster. It detects availability of the other nodes, components and services, provides consistent cluster view and dynamically elects a master service. The following figure shows the components of the CVD interaction with nodes.

The CVD has two interfaces:
• One that monitors *inside* the node, using:
  – Node Manager to monitor and control local processes.
  – Cluster Manager publisher/subscriber to communicate with local applications, such as Step Editor and Application Administration.
• Another that monitors *outside* the node and communicates with other nodes in the cluster.

**Note**
For detailed information about CRS clusters, see Chapter 11, “Managing the Cisco CRS System.”

---

**About the Cisco CRS Engine**

The Cisco CRS Engine (CRS Engine) enables you to run multiple applications to handle Unified CM Telephony calls, Unified CME Telephone calls, or HTTP requests.

While you can deploy the CRS Engine and Unified CM on the same server, deploying them on separate servers allows you to handle greater call volume.

The CRS Engine uses the Unified CM Telephony subsystem to request and receive services from the Computer Telephony Interface (CTI) manager that controls Unified CM clusters. The CRS Engine is implemented as a Windows service that supports multiple applications.

The CRS Engine uses the Unified CME Subsystem to interact with the Unified CME application that run on Integrated Service Routers (ISRs) using open standard Session Initiation Protocol (SIP).
You can use a web browser to administer the CRS Engine and your CRS applications from any computer on the network. You can use the CRS Administration web interface to start and stop the CRS Engine, configure system parameters, monitor CRS Engine activity, and view real-time and historical reports that include total system activity and application statistics.

**Note**  
If you are using Microsoft Internet Explorer Version 7.0, verify that the popup blocker is disabled.

Depending on the Cisco CRS products that you are using, the CRS server may employ as many as 14 subsystems for communicating with other services:

- **Applications**—Manages the applications in the CRS Engine and other features such as session management.
- **Cisco Media**—Configures Cisco Media Termination (CMT) dialog control groups, which can be used to handle simple Dual Tone Multifrequency (DTMF) based dialog interactions with customers.
- **Core Reporting**—Provides information for Unified IP IVR real-time reports.
- **Database**—Handles the connections between the CRS server and the enterprise database.
- **eMail**—Adds components to the CRS Engine that allows it to send e-mail messages.
- **Enterprise Server**—Communicates data for screen pops to the Unified CCX Agent Desktop.
- **HTTP**—Adds components to the CRS Engine that allow it to respond to HTTP requests.
- **Unified ICME**—Manages the connection between the CRS server and the Unified ICME software.
- **Unified CM Telephony**—Manages the connection between Unified CM CTI Manager and the CRS Engine.
- **Unified CME Telephony**—Manages the SIP connection between Unified CME and the CRS Engine.
- **MRCP ASR**—Allows a script to respond to voice input in addition to DTMF using the MRCP protocol.
Chapter 1  Introducing Cisco Customer Response Solutions

Setting Up Cisco CRS

After you install the Cisco CRS system and perform the initial set-up, you can start provisioning and configuring the system:

- **Provisioning** is the process of allocating resources and devising strategies for drawing on them to support the needs of your business.
- **Configuring** is the process of making applications available to the CRS system.

The sections that follow describe these tasks:

- [Provisioning the Telephony and Media Subsystems](#), page 1-11
- [Provisioning the Cisco CRS Subsystems](#), page 1-12
- [Viewing License Information](#), page 1-14
- [Configuring Cisco CRS Applications](#), page 1-16
- [Configuring Cisco CRS Historical Reporting](#), page 1-17

**Provisioning the Telephony and Media Subsystems**

The Cisco CRS telephony and media subsystems manage telephony and media resources and communicate with supporting telephony and media systems.

Depending on the CRS applications you plan to use, you need to provision some or all of the following subsystems:

- **Unified CM Telephony**. The Unified CM Telephony subsystem controls the Unified CM telephony resources for the CRS system.

  - **MRCP TTS**—Composes voice prompts that are generated in real time from text, such as speaking the words in the text of an e-mail message using the MRCP protocol.
  - **Resource Manager-Contact Manager (RmCm)**—Allows Unified CCX to monitor agent phones, control agent states, route and queue calls, and manage the historical reporting feature.
  - **Voice Browser**—Manages Voice Browser functionality.
  - **CRS Voice over Internet Protocol (VoIP)**—Enables remote recording and monitoring.
Caution

While Unified CM supports Unicode characters in first and last names, those characters become corrupted in Cisco CRS Administration web pages for RmCm configuration, Real Time Reporting, Cisco Agent/Supervisor Desktop, and Historical Reports.

- **Unified CME Telephony.** The Unified CME Telephony subsystem controls the Unified CME telephony resources for the CRS system.
- **Cisco Media.** The Cisco Media subsystem controls the CMT media resources for the CRS system.
- **MRCP ASR.** The MRCP ASR subsystem controls the ASR media resources for the CRS system.
- **MRCP TTS.** The MRCP TTS subsystem controls the TTS media resources for the CRS system.

Note

For detailed instructions on provisioning the Cisco CRS telephony subsystems, see Chapter 6, “Provisioning Telephony and Media.”

**Provisioning the Cisco CRS Subsystems**

You need to provision your CRS subsystems to enable the CRS Engine to run multiple applications to handle Unified Communications calls or HTTP requests.

Note

You need to configure a particular subsystem only if you are using CRS applications that require it and which are installed and activated using the appropriate license.

To continue the Cisco CRS system configuration process, you will connect to the Cisco CRS Administration web interface and perform the following tasks:

- **Provisioning the Cisco CRS Subsystems, page 1-12**
- **Provision the Additional CRS Subsystems, page 1-14**
- **The Wizards Menu, page 21-1**
Provision the Unified CCX Subsystem

If you have purchased any of the three versions of Unified CCX, you will need to provision the Unified CCX subsystem.

Note
If your CRS system does not include Unified CCX, proceed directly to the “Provision the Additional CRS Subsystems” section on page 1-14.

Provision the following settings on the Unified CCX subsystem:

- **RmCm Provider.** The Resource Manager (RM) of the Unified CCX system uses a Unified CM user (called a Unified CM Telephony provider) for monitoring agent phones, controlling agent states, and routing and queueing calls.

- **Resources.** Agents that answer calls are also called *resources*. After you create a resource group, you must assign agents (resources) to that group. You can also assign skills to agents if you have purchased either of the Unified CCX Enhanced packages.

- **Resource Groups.** Collections of agents that your CSQ uses to handle incoming calls. To use resource group-based CSQs, you must specify a resource group.

- **Skills.** (Unified CCX Enhanced packages only.) *Skills* are customer-definable labels assigned to agents. The two Unified CCX Enhanced packages can route incoming calls to agents who have the necessary skill or sets of skill to handle the call.

- **CSQs.** After you assign an agent to a resource group, or assign skills to an agent (the Unified CCX Enhanced packages only), you need to configure the agent for the CSQ to which the agent will be assigned.

- **Agent-Based Routing Settings.** You can configure Automatic Work and Wrapup Time settings for the agent-based routing feature from the Agent-Based Routing Settings page (see Configuring Agent-Based Routing, page 7-33).

- **Remote Monitoring.** If you want to associate agents and CSQs that will be monitored by remote supervisors, you need to configure remote monitoring settings. This feature is not available when interoperating with Unified CME.

- **Teams.** If you want to create or associate teams with various agents, CSQs, and supervisors, you need to configure team settings.
Setting Up Cisco CRS

For detailed instructions on provisioning the Unified CCX subsystem, see Chapter 7, “Provisioning Unified CCX” and Chapter 21, “The Wizards Menu.”

Provision the Additional CRS Subsystems

The additional CRS subsystems provide Unified ICME, HTTP, Database, and eMail features.

Provision the following subsystems:

- **Unified ICME.** The ICM subsystem communicates with Unified ICME software.
- **HTTP.** The HTTP subsystem enables CRS applications to respond to requests from a variety of web clients.
- **Database.** The Database subsystem enables CRS applications to communicate with enterprise database servers.
- **eMail.** The eMail subsystem enables CRS applications to create and send e-mail.

For detailed instructions on provisioning these four subsystems, see Chapter 8, “Provisioning Additional Subsystems.”

Viewing License Information

Effective CRS Release 5.0, the **License Information** menu option is available from the main menu under the **System** menu option (see The License Information Menu Option, page 18-10).

The initial license configuration is part of the Setup Wizard procedure (during installation). The uploaded licenses define the feature set for a CRS system. See the Cisco Customer Response Solutions Installation Guide for details on the Setup Wizard.

You can add additional licenses using the **Add Licenses** hyperlink (see “Uploading Licenses” section on page 1-15). See Cisco CRS Licensing Packages, page A-1 for details on license options.
Uploading Licenses

Software for all the Cisco CRS feature components are loaded on the system during installation. However, no feature is available for use:

- Unless a license for that feature is added (see Uploading Licenses, page 1-15).
- Until the feature is activated (see Activating a Component, page 11-12).

Note

A component can be activated even if it is not licensed. However, CRS Node Manager cannot start services related to a component until the license related to the component is uploaded. In other words, in order for a service to run, its component needs to be licensed and activated.

You upload and display licenses using the License Information page.

To upload a license, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose **System > License Information**.

The License Information web page opens.

Step 2  Click the Add License hyperlink on the navigation bar.

The License Information Configuration web page opens.

Step 3  Specify a License file or click Browse to locate a file.

You can either specify a single file with a .lic extension or a .zip file containing multiple .lic files.

Note

If specifying a .zip file, ensure that all .lic files that need to be added are in the root of the .zip file and are not in subfolders in the zip file.

Step 4  Click **Update**.
Configuring Cisco CRS Applications

After you provision the CRS subsystems and view your license information, you need to configure CRS applications to interact with contacts and perform a wide variety of functions.

To continue the CRS system configuration process, connect to the Cisco CRS Administration web interface and manage the following tasks:

- Available Applications, page 1-16
- Managing Scripts, Prompts, Grammars, and Documents, page 1-17
- The Wizards Menu, page 21-1

Available Applications

There are several types of applications you can configure for Cisco CRS:

- **Script** applications perform such functions as receiving calls, playing back prompts, receiving caller input, transferring calls, and queueing calls.
- The **Busy** application simulates a busy signal.
- The **Ring-No-Answer** application simulates a ring tone.

In addition, if your CRS system is to be configured to interface with Unified IP IVR for Unified ICME (not with Unified CCX by way of the Unified Gateway) two extra applications are available: ICME post-routing applications and ICME translation-routing applications (see “About CRS Applications” section on page 9-2).

After adding a Cisco CRS application, you need to define a *trigger* so that this application can respond to telephone calls and/or HTTP requests. Triggers are specified signals that invoke application scripts in response to incoming contacts.

For detailed instructions on configuring CRS applications and defining triggers, see Chapter 9, “Configuring Cisco Applications.”
Managing Scripts, Prompts, Grammars, and Documents

The process of configuring Cisco script applications includes uploading CRS scripts and pre-recorded prompts, installing grammars and customized languages, and adding triggers to applications.

Depending on your particular CRS implementation, you may need to perform most or all of the following tasks to configure a Cisco script application:

- Manage scripts. Cisco script applications are based on scripts that you must upload to the repository and make available to the CRS system.

- Manage prompts. Many applications make use of pre-recorded prompts, stored as .wav files, which are played back to callers in order to provide information and elicit caller response. You must upload these .wav files to the repository and make them available to the CRS system.

- Install grammars. A grammar is a specific set of all possible spoken phrases and/or Dual Tone Multi-Frequency (DTMF) digits to be recognized by CRS applications and acted upon during run time. The CRS system uses specific grammars when recognizing and responding to caller response to prompts. You must store these grammars in a directory to make them available to the CRS system.

- Install customized CRS languages. Language packs, such as American English, Canadian French, and so on, are installed with Cisco CRS. You install language packs in a directory accessible by the CRS system.

Note: For detailed instructions on managing these files, see Chapter 10, “Managing Prompts, Grammars, Documents, and Custom Files.”

Configuring Cisco CRS Historical Reporting

When you install the Cisco CRS system, the installation process creates a database named db_cra. This database contains:

- Information for historical reports, including Unified CCX configuration information, stored procedures, and some call statistics.

- The ContactCallDetail table, which is the main table for call statistics.
To conclude the CRS system configuration process, connect to the Cisco CRS Administration web interface and perform the following Historical Reporting Configuration tasks:

1. Define the maximum number of database connections for report client sessions.
2. Specify users for historical reports.
3. Configure the Daily Purge Schedule and specify notification parameters.

**Note**
For detailed instructions on how to configure the CRS historical reporting database, see Chapter 13, “Managing Cisco CRS Historical Reporting.”

### Running and Managing Cisco CRS

To manage your Cisco CRS platform, you must first provision and configure it. The day-to-day administration of the CRS system and datastores consist of many tasks, such as:

- Starting and stopping the CRS Engine and processes.
- Managing and monitoring the status of CRS servers and components across the cluster.
- Managing and monitoring datastores across the cluster (see Chapter 11, “Managing the Cisco CRS System” and Managing the Cisco CRS Datastores).

**Note**
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

### Where To Go From Here?

- Introduction and overview of the Cisco CRS system
  - See Chapter 2, “Introducing the CRS Administration Web Interface.”
- Provisioning and management tasks.
Where To Go From Here?

– See Chapter 3, “The Cisco CRS Provisioning Checklist”
– See Chapter 4, “Provisioning Unified CM for Unified CCX.”
– See Chapter 5, “Provisioning Unified CCX for Unified CME”
– See Chapter 6, “Provisioning Telephony and Media.”
– See Chapter 7, “Provisioning Unified CCX.”
– See Chapter 8, “Provisioning Additional Subsystems.”
– See Chapter 9, “Configuring Cisco Applications.”
– See Chapter 10, “Managing Prompts, Grammars, Documents, and Custom Files.”
– See Chapter 11, “Managing the Cisco CRS System.”
– See Chapter 12, “Managing the Cisco CRS Datastores.”
– See Chapter 13, “Managing Cisco CRS Historical Reporting.”
– See Chapter 14, “Configuring Cisco Unified CCX Outbound Preview Dialer”
– See Chapter 15, “Backing-up and Restoring Data”
– See Chapter 16, “Reporting on Real-Time CRS Data.”
– See Chapter 17, “Using the Cisco CRS Supervisor and Cisco CRS User Options Plug-Ins.”

• Reference information for each CRS Administration menu option.
  – See Chapter 18, “The System Menu.”
  – See Chapter 20, “The Subsystems Menu.”
  – See Chapter 21, “The Wizards Menu”
Introducing the CRS Administration Web Interface

The Cisco CRS platform provides a multimedia (voice, data, and web) IP-enabled customer-care application environment, using VoIP technology that allows your Cisco Unified Communications network to share resources with your data network.

You can load your Cisco CRS platform on any server in the cluster on which you have installed Cisco CRS. You can then use a web browser located on any computer on the IP network to configure and administer your applications with the CRS Administration web interface.

**Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The CRS Administration web interface allows you to configure and monitor overall system functions, applications, and subsystems; access a wide variety of system tools; and perform many other administrative tasks.

The following sections provide more information about the CRS Administration web interface:

- Accessing the CRS Administration Web Interface, page 2-2
- The CRS Administration Menu Bar and Menus, page 2-3
- CRS Configuration Web Pages, page 2-4
Accessing the CRS Administration Web Interface

The web pages of the CRS Administration web interface allow you to configure and manage the CRS system and its subsystems.

To connect to the CRS Administration web interface, complete the following steps.

**Procedure**

**Step 1** Open the CRS Administration Authentication page by performing one of the following actions:

- From any server on which you have installed Cisco CRS, choose Start > Programs > Cisco CRS Administrator > Application Administrator.
- From a web browser on any computer on your network, enter the following URL:
  
  `http://<servername>/AppAdmin`

  In this example, replace `<servername>` with the host name or IP address of the required CRS server.

  The Authentication page appears.

  **Note** If you are using Microsoft Internet Explorer Version 7.0, verify that the popup blocker is disabled.

**Step 2** On the Authentication page, specify your Cisco CRS User Identification and Password.

  **Note** If you are accessing Cisco CRS for the first time, enter `Administrator` in the User Identification field, enter `ciscocisco` in the Password field; see the Cisco CRS Installation Guide for further instructions.

**Step 3** Click Log On.
A web page opens listing information about Cisco Application Administration and the installed Unified CCX package and the CRS Administration menu bar appears at the top of the page.

Related Topics

- Using the CRS Supervisor Web Interface, page 17-6
- Using the CRS User Options Web Interface, page 17-9

The CRS Administration Menu Bar and Menus

The CRS Administration menu bar, which appears at the top of every web page of the CRS Administration web interface. You begin every CRS configuration and administration task by choosing a menu and submenu option from the menu bar.

The CRS Administration menu bar contains the following menu options:

- **System**—Contains options for activating components, configuring Unified CM or Unified CME information, viewing the status of the CRS Engine and controlling CRS Engine activities, changing system parameters, custom file configuration, changing alarm and tracing configuration, and logging out of the CRS Administration web interface. For a description of all System menu options, see Chapter 18, “The System Menu.”

- **Applications**—Contains options for managing applications, scripts, prompts, grammars, and documents. For a description of all Applications menu options, see Chapter 19, “The Applications Menu.”

- **Subsystems**—Contains options for configuring parameters for the subsystems that are licensed for your CRS server. Your menu may include submenu options for one or more of the following subsystems: Unified CM Telephony, Unified CME Telephony, Unified CCX, Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) software, Database, HTTP, eMail, Cisco Media, MRCP Automatic Speech Recognition (ASR), and MRCP Text-To-Speech (TTS). For a description of all Subsystem menu options, see Chapter 20, “The Subsystems Menu.”
Tools—Contains options that allow you to access the following system tools: alarm definition, Plug-ins, Real-time Reporting, Real-time Snapshot Config, Historical Reporting, User Maintenance, and Troubleshooting Tips. For a description of all Tools menu options, see Chapter 22, “The Tools Menu.”

Help—Provides access to online help for Cisco CRS. For a description of all Help menu options, see Chapter 23, “The Help Menu.”

CRS Configuration Web Pages

When you choose any menu and submenu option from the CRS Administration menu bar, a configuration or administration web page opens. Use this web page to continue your configuration or administration task.

In some cases you will perform your configuration or administration task on this one web page. For example, you configure alarm information on the Alarm Configuration web page.

In other cases, the web page that first opens when you choose a submenu item leads to a series of web pages and areas of web pages. For example, the Unified CM Telephony Call Control Group Configuration web page contains both a navigation bar with hyperlinks that link to other web pages and a configuration area with hyperlinks that link to other web pages.

In some cases, each web page has a unique name. In other cases, configuration web pages retain the same title, but new areas appear when you click a hyperlink.

The table below describes the Refresh All button and the Copy, Delete, and Refresh icons that are found in several Cisco CRS web pages.

<table>
<thead>
<tr>
<th>Icon/Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy        | Click the icon to copy the information in that specific row.  
**Note** When you click the Copy icon, the web page, displays the copied configuration so you can make changes, if desired. |
| Delete      | Click the icon to delete the information in that specific row. |
| Refresh     | Click the icon to refresh the information in that specific row. |
| Refresh All | Click this button to refresh the information listed on this page. |
Cisco CRS Release 5.0 introduces the concept of advanced configuration with the Show More and Show Less options.

On the applicable pages, all configuration details can be displayed or reduced based on user preferences and requirements.

A page by default displays fewer parameters. Parameters configured with default values and not requiring modification or user input are now available in the advanced configuration section. You can access this advanced configuration section by clicking the Show More button at the bottom of the page. When you click this button, the extra parameters become visible and the button changes to Show Less. When you click the Show Less button, the page reverts to its original list of parameters.

Using the Navigation Bar

On the left side of many web pages, you will find a navigation bar, which contains hyperlinks to other web pages. For example, the navigation bar of the Unified CM Telephony Call Control Group Configuration web page contains hyperlinks for the Unified CM Telephony Provider, Unified CM Telephony Call Control Groups, and Unified CM Telephony Triggers, and Resynchronize configuration web pages.
Using Other Hyperlinks and Buttons

Besides displaying current configuration information, many web pages contain an Add a New ... hyperlink that provides access to a web page that you can use to add new information. For example, the Unified CM Telephony Call Control Group Configuration web page contains an Add a New Unified CM Telephony Call Control Group hyperlink. When you click this hyperlink, another area of the Unified CM Telephony Call Control Group Configuration web page opens. Use this area to add a new Unified CM Telephony Call Control Group.

In addition to the Add a New ... hyperlink, many web pages contain other hyperlinks. For example, you can click the information under the column headings of the Unified CM Telephony Call Control Group Configuration web page to access and modify the configuration web page for that information.

Many web pages contain buttons that perform a variety of functions. For example, the Refresh All button on the Unified CM Telephony Call Control Group Configuration web page refreshes all the Unified CM Telephony call control group configurations in the CRS server.

Effective Cisco CRS release 5.0, a few web pages (for example, the Trace Configuration page) contain a Restore Default button. This button allows you to revert to the software set defaults for each parameter on this page.

Related Topics
- CRS Configuration Web Pages, page 2-4
- Displaying Details for Advanced Configuration, page 2-5
- Using Other Hyperlinks and Buttons, page 2-6
- Using Configuration Wizards, page 2-7
Using Configuration Wizards

Effective Cisco CRS Release 5.0, two wizards are available in the main menu: the Application Wizard and the RmCm Wizard.

To improve the usability and configuration process, these wizards walk you through the configuration pages in the required order and help ease the configuration process for these two features. You can access these wizards from a new main menu option called Wizards.

In each Wizard webpage, you are provided with a list of procedures in the left pane and a description of each procedure in the main pane. At the top of the page, you have the option to exit the wizard at any time, go to the next step as required, or click the Skip button to go to any other step.

Related Topics
- The Wizards Menu, page 21-1
- CRS Configuration Web Pages, page 2-4
- Displaying Details for Advanced Configuration, page 2-5
- Using the Navigation Bar, page 2-5
- Using Other Hyperlinks and Buttons, page 2-6
PART 2

Cisco Customer Response Solutions: Configuration
The Cisco CRS Provisioning Checklist

Effective Cisco CRS Release 5.0(1) two product deployments are available for the Cisco CRS platform:

- The Unified CM product supports both single-node and two-node (high availability) deployments.
- The Unified CME product only supports a single-node deployments.

The deployment model is transparent to the CRS installer as the clustering for Unified CM is performed through the CRS Administration using the Cisco CRS setup wizard.

Note

This guide is applicable for both product deployments and identifies the configuration differences between the products where applicable.

The following topics introduce the Cisco Unified Contact Center Express (Unified CCX) subsystem and explain how to modify the Unified CM/Unified CME information from Cisco CRS.

- About Unified CCX, page 3-2
- Unified CCX Provisioning Checklist, page 3-4
About Unified CCX

The Cisco CRS system uses the Unified CCX subsystem as part of an ACD system to provide resource distribution and queueing to call centers.

The following licensing options are available for the Unified CCX system:

- **Unified CCX Standard** (designed for entry-level users)—Includes the steps necessary for creating basic Unified CCX applications. Does not include a Java license.
- **Unified CCX Enhanced** (designed for enterprise-level users)—Includes all functions of Unified CCX Standard, plus support for skills-based routing and priority queuing. Includes a license to enable custom Java extensions.
- **Unified CCX Premium**—Adds full Unified IP IVR support, including database integration, Voice eXtensible Markup Language (VoiceXML), HTML web integration, custom Java extensions, and e-Notification services. Includes a license to enable custom Java extensions.

**Note**
The Unified CCX Enhanced package and the Unified CCX Premium package are provisioned in the same way.

Two types of routing are available:

- **Contact Service Queue (CSQ)-based routing**: CSQs are entities that route calls to your resources (agents). Each CSQ controls incoming calls and determines where an incoming call is placed in the queue and to which agent the call is sent.

  Each CSQ selects resources from an associated resource pool that you define or from resource skills for Unified CCX Enhanced or Premium license packages. When an agent becomes available to take a call, the system chooses a queued call from one of the CSQs whose resource pool includes the agent, and routes that call to that agent.

- **Agent-based routing**: Agent-based routing provides the ability to send a call to a *specific* agent, rather than any agent available in a CSQ.

An Unified CCX agent can participate in both CSQ- and agent-based routing.

**Note**
Unified CCX 4.0 agent-based routing does not support queuing.
An Unified CCX agent can be any one of the following:

- Unified CCX Agent Desktop (CAD)
- IP Phone Agent
- Extension Mobility (EM) Agent

**Note**

EM agents are not supported with Unified CME deployments.

- Supervisor (if the supervisor is taking calls): If the supervisor is not taking calls, it is not considered as an agent. Calls are queued in the CRS server and sent to agents by the CRS server.

The machine you install your CRS system on determines how many agents and IVR ports Unified CCX can accommodate. However, there are several general configuration rules that you should be aware of:

- Each agent cannot be associated with more than:
  - 25 CSQs. (This is a configuration design guideline; CRS Administration does not enforce the rule.)
  - 50 skills. (CRS Administration enforces this rule.)
- Each CSQ cannot be associated with more than 50 skills. (CRS Administration enforces this rule.)
- A call should not queue for more than 25 CSQs. (This is a configuration design guideline; CRS Administration does not enforce the rule.)

**Related Topic**

Unified CCX Provisioning Checklist, page 3-4
## Unified CCX Provisioning Checklist

To provision Unified CCX, complete the following tasks:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>For Unified CM, See...</th>
<th>For Unified CME, See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Configure Unified CME to enable interoperability with Cisco Unified CCX.</td>
<td>Not applicable</td>
<td>See the <em>Cisco Unified Communications Manager Express 4.2 New Features.</em></td>
</tr>
<tr>
<td>Step 2</td>
<td>Configuring Unified CM users who will be agents in your Unified CCX system. Create users and assign the agent capability to these users in Cisco CRS.</td>
<td>“Provisioning Unified CM for Unified CCX” section on page 4-1</td>
<td>“Managing Unified CME Users” section on page 5-16</td>
</tr>
<tr>
<td>Step 2</td>
<td>Provisioning the resources information for the Cisco CRS telephony and media</td>
<td>“Provisioning the Unified CM Telephony Subsystem” section on page 6-5</td>
<td>“Provisioning the Unified CME Telephony Subsystem” section on page 5-6</td>
</tr>
<tr>
<td>Step 3</td>
<td>Provisioning the RmCm Provider to allow the RmCm Subsystem to be in service.</td>
<td>“Configuring the RmCm Provider” section on page 7-2</td>
<td></td>
</tr>
<tr>
<td>Step 4</td>
<td>Creating resource groups.</td>
<td>“Configuring Resource Groups” section on page 7-4</td>
<td></td>
</tr>
<tr>
<td>Step 5</td>
<td>Creating skills—if you are using Unified CCX Enhanced or Premium.</td>
<td>“Configuring Skills” section on page 7-7</td>
<td></td>
</tr>
<tr>
<td>Step 6</td>
<td>Assigning agents to resource groups and assigning skills to agents.</td>
<td>“Configuring Agents” section on page 7-10</td>
<td></td>
</tr>
<tr>
<td>Step 7</td>
<td>Creating Contact Service Queues.</td>
<td>“Configuring Contact Service Queues” section on page 7-17</td>
<td></td>
</tr>
<tr>
<td>Step 8</td>
<td>Provisioning Remote Monitoring—if you are using Unified CCX Premium.</td>
<td>“Configuring and Using Remote Monitoring” section on page 7-29</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>
### Unified CCX Provisioning Checklist

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>For Unified CM, See...</th>
<th>For Unified CME, See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 9</td>
<td>Provisioning agent-based routing—if you are using Unified CCX Enhanced or Premium.</td>
<td>“Configuring Agent-Based Routing” section on page 7-33</td>
<td></td>
</tr>
<tr>
<td>Step 10</td>
<td>Creating teams and assigning agents to teams.</td>
<td>“Configuring Teams” section on page 7-34</td>
<td></td>
</tr>
</tbody>
</table>

**Related Topic**

About Unified CCX, page 3-2
Provisioning Unified CM for Unified CCX

When you access Cisco CRS Administration for the first time in a cluster the system automatically initiates the cluster setup procedure once for each cluster to identify Cisco CRS license files, enter information about Cisco Unified Communications Manager (Unified CM) AXL, and Unified CM Telephony and RmCm providers (see Cisco Customer Response Solutions Installation Guide). You can modify this Cisco Unified Unified CM information from Cisco CRS.

The following topics explain how to modify the Unified CM information from Cisco CRS.

- Configuring Unified CM Information, page 4-2
- Modifying Cluster Information from Cisco CRS, page 4-3
- Modifying AXL Information, page 4-5
- Modifying Unified CM Telephony Information, page 4-8
- Modifying RmCm Provider Information, page 4-10
- Modifying NTP Configuration, page 4-12
- Configuring Unified CM for Unified CCX, page 4-14
Configuring Unified CM Information

**Warning**

Do not configure Unified CM users using administrator/ciscocisco as the user name/password combination when logging into the CRS Administrator. Doing so may restrict the Unified CM when shared across multiple Cisco CRS servers.

**Caution**

The Cisco CRS configuration fails if you perform the Microsoft Windows operating system hardening procedure on Unified CM servers. You will need to restart the services (for example, Tomcat and IIS) used by Unified CM servers that are selected to be AXL providers in Unified CCX.

During the Cisco CRS installation process, the administrator who installed Cisco CRS should have already provided the Unified CM IP address and hostname(s). As of Cisco CRS Release 4.5, the administrator must also provide the Administrative XML Layer (AXL) authentication (user ID and password) information.

The Unified CM Configuration web page allows you to both configure and update the Unified CM cluster information, AXL authentication information, Unified CM Telephony subsystem information, and RmCm Provider configuration information at anytime from within Cisco CRS.

This page has four blocks of information: Unified CM cluster details, AXL service details, Unified CM Telephony Provider details, and RmCm Provider details.

**Related Topics**

- Modifying Cluster Information from Cisco CRS, page 4-3
- Modifying AXL Information, page 4-5
- Modifying Unified CM Telephony Information, page 4-8
- Modifying RmCm Provider Information, page 4-10
- Modifying NTP Configuration, page 4-12
- Configuring the RmCm Provider, page 7-2
- Provisioning the Unified CM Telephony Subsystem, page 6-5
Modifying Cluster Information from Cisco CRS

⚠️ **Caution**
If you change the cluster information, you must reconfigure the Unified CM Telephony/RmCm setup. After reconfiguring this information, you must restart the node manager.

🔍 **Tip**
To log back into CRS Administration, you must associate a user with Administrator capabilities.

The cluster setup is derived from the information provided during the CRS installation process—if configured. You can change this information at any time as required from Cisco CRS. If you do change the cluster, you must provide the IP address of the AXL server to which you will move this server.

For the cluster setup change to take effect, the Administrative XML Layer (AXL) service must be enabled on the required server. If the AXL service is enabled on that server, the Cisco CRS Administration attempts to access that server and updates the Unified CM cluster setup information.

To change previously-configured cluster setup information from Cisco CRS, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **System > Unified CM Configuration**.

The Unified CM Configuration web page opens. The Unified CM cluster name is displayed next to the Unified CM Cluster field. If a cluster name was not assigned during the Unified CM setup process, then the default name (*default*) is assigned by Unified CM to this cluster. Cisco CRS displays the cluster name based on the Unified CM database.

**Step 2**
Click the Change Unified CM Cluster button to change the existing cluster setup for this server.

The Change Unified CM Cluster web page dialog window appears.
Step 3  Use this web page dialog to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXL Service Provider</td>
<td>Provide the IP address or host name of the AXL server providing access to Unified CM.</td>
</tr>
<tr>
<td>User Name</td>
<td>Enter the user name for the AXL server providing access to Unified CM.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the corresponding password for the user account providing access to Unified CM.</td>
</tr>
</tbody>
</table>

Step 4  Click OK.

CRS Administration enables that service and then tries to access the Unified CM Cluster information and update the Unified CM Configuration page.

**Related Topics**

- Displaying Unified CM Cluster Nodes in Unified CCX, page 4-4
- Modifying AXL Information, page 4-5
- Modifying Unified CM Telephony Information, page 4-8
- Modifying RmCm Provider Information, page 4-10
- Modifying NTP Configuration, page 4-12
- Configuring the RmCm Provider, page 7-2
- Provisioning the Unified CM Telephony Subsystem, page 6-5

**Displaying Unified CM Cluster Nodes in Unified CCX**

When connected to a Unified CM cluster, the Unified CM Configuration page in the Cisco CRS Administration GUI only displays the IP address of one node. However, in a two-node cluster, it should show the IP addresses of both the publisher and subscriber nodes. To display both IP addresses, you must configure the DNS suffix information (for the required nodes in the cluster) in the server in which Cisco CRS is installed.

To configure the DNS suffix information and display the IP Addresses of all the nodes in a cluster, complete the following steps.
Modifying AXL Information

To change previously-configured AXL information, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose System > Unified CM Configuration.

The Unified CM Configuration web page opens. The table below describes the contents of the summary page.
Step 2  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CM Cluster</td>
<td>See Modifying Cluster Information from Cisco CRS, page 4-3</td>
</tr>
<tr>
<td>AXL Service Provider Configuration</td>
<td></td>
</tr>
<tr>
<td>Selected AXL Service Providers</td>
<td>Lists the AXL service providers selected by the Cisco CRS user. Select the required entry and move to the opposite list box using the right and left arrows. Arrange the order of the selected entries using the up and down arrows. <strong>Note</strong> If you deselect the AXL service provider from the Selected list box, a Microsoft IE window pops up informing you about the (list of) deselected service(s). For security reasons (in case the service is being used by another AXL service provider), manually disable the AXL service only from the Unified CM.</td>
</tr>
<tr>
<td>Available AXL Service Providers</td>
<td>Lists the Unified CM entries in the cluster. Select the required entry and move to the opposite list box using the right and left arrows.</td>
</tr>
<tr>
<td>User Name</td>
<td>The Unified CM User ID. This information is provided during cluster setup in the CRS installation process. When you select an AXL Service Provider, the corresponding user name is automatically displayed in this field.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the Unified CM User ID. This information is provided during cluster setup in the CRS installation process. When you select an AXL Service Provider, the corresponding user’s password is automatically displayed in this field.</td>
</tr>
<tr>
<td>Unified CM Telephony Subsystem—Unified CM Telephony Subsystem Configuration</td>
<td>See Modifying Unified CM Telephony Information, page 4-8</td>
</tr>
<tr>
<td>RmCm Subsystems—RmCm Provider Configuration</td>
<td>See Modifying RmCm Provider Information, page 4-10</td>
</tr>
<tr>
<td>NTP</td>
<td>See Modifying NTP Configuration, page 4-12</td>
</tr>
</tbody>
</table>

Step 3  Click OK in the Unified CM Configuration web page.
The Unified CM Configuration web page refreshes to display the new settings. A Microsoft IE window pops up to confirm the new AXL service.

**Step 4**

Click OK in the Microsoft IE window.

The selected AXL services are now enabled.

If the selected AXL services cannot be enabled, an error message instructs you to reselect AXL service providers.

---

**Related Topics**

- Modifying Cluster Information from Cisco CRS, page 4-3
- Modifying Unified CM Telephony Information, page 4-8
- Modifying RmCm Provider Information, page 4-10
- Modifying NTP Configuration, page 4-12
- Configuring the RmCm Provider, page 7-2
- Provisioning the Unified CM Telephony Subsystem, page 6-5
Modifying Unified CM Telephony Information

Note Effective Cisco CRS Release 5.0, the Unified CM Telephony client is installed in the background after you configure the Unified CM Telephony user. The Unified CM Telephony client runs silently and verifies that the right version and the right client are installed.

Configuring the Unified CM Telephony user does not automatically install the Unified CM Telephony client. You must activate the Cisco CRS engine in component activation (see Activating a Component, page 11-12) or use the synchronize option in Unified CM Telephony (see Resynchronizing the Cisco JTAPI Client, page 6-7) to install the Unified Telephony client.

The latest list of CTI Managers within a cluster are listed in this section. If the Unified CM is not functioning or if the Cisco CRS is not able to connect to the Unified CM for any reason, information obtained from the most recent connection is saved as a part of the bootstrap information.

To change previously-configured Unified CM Telephony information, complete the following steps.

Procedure

Step 1 From the CRS Administration menu bar, choose System > Unified CM Configuration.

The Unified CM Configuration web page opens. The table below describes the contents of the summary page.

Step 2 Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CM Cluster</td>
<td>See Modifying Cluster Information from Cisco CRS, page 4-3.</td>
</tr>
<tr>
<td>AXL Service Provider Configuration</td>
<td>See Modifying AXL Information, page 4-5</td>
</tr>
<tr>
<td>Unified CM Telephony Subsystem—Unified CM Telephony Subsystem Configuration</td>
<td></td>
</tr>
</tbody>
</table>
### Modifying Unified CM Telephony Information

#### Step 3
Click **OK** in the Unified CM Configuration web page.

The Unified CM Configuration web page refreshes to display the new settings.

A Microsoft IE window pops up to confirm the newly selected CTI Manager.

---

#### Step 4
Click **OK** in the Microsoft IE window.

The newly selected CTI Manager is now enabled.

If the selected CTI Manager cannot be enabled, an error message instructs you to reselect CTI Managers.

---

### Related Topics
- Modifying Cluster Information from Cisco CRS, page 4-3
- Modifying AXL Information, page 4-5

### Field | Description
--- | ---
**Selected CTI Managers** | Lists the CTI Managers selected by the Cisco CRS user. Select the required entry and move to the opposite list box using the right and left arrows. Arrange the order of the selected entries using the up and down arrows.

**Note** If you deselect CTI Managers from the Selected list box, a Microsoft IE window pops up informing you about the (list of) deselected CTI Manager(s).

**Available CTI Managers** | Lists the CTI Managers in the cluster. Move to the opposite list box using the right and left arrows.

**User Prefix** | The syntax of the User ID is: `<userprefix>_<nodeid>`

For example, if you set this field to **cti_user**, then the User ID for Node 1 will be **cti_user_1**.

**Password** | Password you defined for the User ID in Unified CM.

If a CTI Manager is already selected, then the corresponding password is displayed in this field.

**RmCm Subsystems—RmCm Provider Configuration** | See Modifying RmCm Provider Information, page 4-10.

**NTP** | See Modifying NTP Configuration, page 4-12
Modifying RmCm Provider Information

The list of all CTI Managers available in a cluster are saved as a part of the bootstrap information. You can change to any available CTI Managers listed in the Available CTI Managers list box in this page.

**Note**
The RmCm Provider specified through the Cisco CRS Administration is automatically created in Unified CM. You do not need to use the Unified CM web interface to create the user.

To change previously-configured RmCm provider information or to configure a new RmCm Provider, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **System > Unified CM Configuration**.

The Unified CM Configuration web page opens. The table below describes the contents of the summary page.

**Step 2**
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CM Cluster</td>
<td>See Modifying Cluster Information from Cisco CRS, page 4-3.</td>
</tr>
<tr>
<td>AXL Service Provider Configuration</td>
<td>See Modifying AXL Information, page 4-5.</td>
</tr>
<tr>
<td>Unified CM Telephony Subsystem—Unified CM Telephony Subsystem Configuration</td>
<td>See Modifying Unified CM Telephony Information, page 4-8.</td>
</tr>
</tbody>
</table>
Step 3  Click OK in the Unified CM Configuration web page.
The Unified CM Configuration web page refreshes to display the new settings.
A Microsoft IE window pops up to confirm to the newly selected CTI Manager.

Step 4  Click OK in the Microsoft IE window.
The newly selected CTI Manager is now enabled.
If the selected CTI Manager cannot be enabled, an error message instructs you to reselect CTI Managers.
Modifying NTP Configuration

Effective Cisco CRS Release 5.0, Network Time Protocol (NTP) configuration is available in the Unified CM Configuration web page.

The NTP host name or IP address is typically derived from the Unified CM, but can be pointed to another NTP Server if desired. If this information is not provided during the installation setup, be sure to provide it when configuring the CRS Administration.

If you provide a valid host name or IP address of the NTP server, the NTP service synchronizes the client time to that of the NTP server.

Caution

The NTP service synchronization does not take place if the difference between the client time and server time is greater than 1000 seconds.

To change previously-configured NTP information or to configure a new NTP host name or IP address, complete the following steps.

Procedure

1. From the CRS Administration menu bar, choose **System > Unified CM Configuration**.

   The Unified CM Configuration web page opens. The table below describes the contents of the summary page.
Step 2  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CM Cluster</td>
<td>See Modifying Cluster Information from Cisco CRS, page 4-3.</td>
</tr>
<tr>
<td>AXL Service Provider Configuration</td>
<td>See Modifying AXL Information, page 4-5.</td>
</tr>
<tr>
<td>Unified CM Telephony Subsystem—Unified CM Telephony Subsystem Configuration</td>
<td>See Modifying Unified CM Telephony Information, page 4-8.</td>
</tr>
<tr>
<td>RmCm Subsystems—RmCm Provider Configuration</td>
<td>See Modifying RmCm Provider Information, page 4-10</td>
</tr>
<tr>
<td>NTP Host Name or IP Address</td>
<td>The host name or the IP address of the NTP server used for authentication.</td>
</tr>
</tbody>
</table>

Step 3  Click OK in the Unified CM Configuration web page.
- The Unified CM Configuration web page refreshes to display the new settings.
- A Microsoft IE window pops up to confirm to the newly selected NTP details.

Step 4  Click OK in the Microsoft IE window.
- The newly Unified CM is now enabled.
- If the selected CTI Manager cannot be enabled, an error message instructs you to reselect another NTP server.

Caution  If you manually change the Microsoft Windows system time, the Cisco CRS Node Manager Service on all nodes must be restarted after the change.

Related Topics
- Modifying Cluster Information from Cisco CRS, page 4-3
- Modifying AXL Information, page 4-5
- Modifying Unified CM Telephony Information, page 4-8
Configuring Unified CM for Unified CCX

To enable Unified CCX to communicate with Unified CM, you also need to assign extensions for the users who will be agents in your Unified CCX system.

**Note**
If you delete a Cisco CRS user with Administrative rights from Unified CM he user will not be able to log into the Cisco CRS Administration web interface.

**Caution**
When logging into Cisco Agent Desktop, agents use the Unified CM user ID and password. While the Unified CM limits agent IDs to 128 alphanumeric characters, the Cisco CRS platform limits agent IDs to 31 alphanumeric characters. Be sure to abide by the 31 character-limit when configuring agents in Unified CM.

This section contains the following procedures:
- Invoking Unified CM Administration, page 4-14
- Defining Unified CM Users as Agents, page 4-15

Invoking Unified CM Administration

Begin the process of configuring Unified CM by connecting to the Unified CM Administration web interface.

To connect to the Unified CM Administration web interface, complete the following steps.

**Procedure**

**Step 1**
From a web browser on any computer on your network, enter the following URL:  
In this example, *servername* is the host name or IP address of your Unified CM server. The Unified CM Login web page appears.

**Step 2**
Enter the Unified CM user name and password at the prompt, and then click **Log On**.

The Unified CM Administration web page appears.

You are now ready to use the Unified CM Administration web interface to configure users for Unified CCX.

---

**Related Topic**

Defining Unified CM Users as Agents, page 4-15

---

### Defining Unified CM Users as Agents

**Warning**

Do not configure Unified CM users using administrator/ciscocisco as the user name/password combination when logging into the CRS Administrator. Doing so may restrict the Unified CM when shared across multiple Cisco CRS servers.

To use any version of Unified CM, you must first ensure that you define Unified CM users as Unified CCX agents in Unified CM. Once you perform this task, these Unified CCX agents can be combined into Resource Groups, assigned Skills, and placed in CSQs.

**Note**

In Unified CCX, this operation is called “associating a device.”

This section contains the following topics:

- Guidelines for Configuring Agent Phones, page 4-16
- Assigning Unified CM Users as Cisco TelePresence Virtual Agents, page 4-17
- Assigning Unified CM Users as Unified CCX Agents, page 4-19

**Related Topic**

Invoking Unified CM Administration, page 4-14
Guidelines for Configuring Agent Phones

Follow these guidelines when configuring agent phones for Unified CCX agents:

- Choose Device > Phone in the Unified CM Administration. The Find and List Phones window displays. Enter search criteria to locate a specific phone and click Find. A list of phones that match the search criteria displays. Click the device name of the phone to which you want to add a directory number. The Phone Configuration window displays. In the Unified CM Administration Phone Configuration web page, select the required Association Information (on the left) to get to the Directory Number Configuration web page. In this page, make the following changes:
  - In the Multiple Call/Call Waiting Settings section, set the Maximum Number of Calls to 2 (default is 4).
  - In the Multiple Call/Call Waiting Settings section, set the Busy Trigger value to 1 (default is 2).
  - In the Call Forward and Call Pickup Settings section, verify that you do not forward any Unified CM device to the Unified CCX extension of an agent.
  - In the Call Forward and Call Pickup Settings section, verify that you do not configure the Unified CCX extension of an agent to forward to a Cisco CRS route point.

- Always disable (off) Secure Real-Time Transport Protocol (SRTP) when configuring a Cisco Unified Communications product. You can disable SRTP for a specified device or for the entire Unified CM:
  - For a specified device: Choose Device > Phone. In the Find and List Phone page, select the required phone device. In the Phone Configuration page for the selected phone, scroll down to the Protocol Specific Information section. To turn off SRTP on the phone device, select any one of the Non Secure SCCP Profile auth by choices from the SCCP Phone Security Profile field’s drop-down list.
  - For the entire Unified CM cluster: Choose System > Enterprise Parameters. In the Enterprise Parameters Configuration page, scroll down to the Securities Parameters section, to verify that the corresponding value for the Cluster Security Mode field is 0. This parameter indicates the security mode of the cluster. A value of 0 indicates that phones will register in non-secure mode (no security).
Chapter 4  Provisioning Unified CM for Unified CCX

Configuring Unified CM for Unified CCX

- Do not forward any Unified CM device to the Unified CCX extension of an agent.
- Do not configure the Unified CCX extension of an agent to forward to a Cisco CRS route point.
- Do not use characters other than the numerals 0 - 9 in the Unified CCX extension of an agent.
- Do not configure two lines on an agent’s phone with the same extension when both lines exist in different partitions.
- Do not assign an Unified CCX extension to multiple devices.
- Do not configure the same Unified CCX extension in more than one device or device profile. (Configuring an Unified CCX extension in one device or device profile is supported.)

To determine a list of Unified CCX agent devices supported by the Cisco Agent Desktop, see the Cisco CRS Software and Hardware Compatibility Guide: http://www.cisco.com/univercd/cc/td/doc/product/voice/sw_ap_to/crscomtx.pdf.

Related Topics
- Invoking Unified CM Administration, page 4-14
- Assigning Unified CM Users as Unified CCX Agents, page 4-19

Assigning Unified CM Users as Cisco TelePresence Virtual Agents

The Cisco TelePresence application enables enterprises to create a live, face-to-face interaction with customers over the network. This solution allows rapid deployment of a virtual contact center infrastructure. Agents using Cisco TelePresence are referred to as virtual agents in this guide. Virtual agents connect to callers using Unified CCX thus incorporating ACD, CAD, CTI, and Unified IP IVR with Cisco Unified CM and providing the entire solution on one server.

Note

The following guidelines apply for the Cisco TelePresence integration with Unified CCX:
The only commonly-supported CODEC for Unified CCX and Cisco TelePresence is G711.

The following supervisor features are not supported:

- Monitoring and recording is not supported for Cisco TelePresence integration with Unified CCX.
- Due to the unavailability of third-party call control, Cisco Supervisor Desktop (CSD) features, barge-in, and intercept are not supported.
- You will not be able to use the call control Cisco Agent Desktop (CAD) features (hold, unhold, answer, transfer, conference, Make Call, and touch tone). Be sure to remove or disable these features from CAD as specified in Step 4 in the following procedure.

To assign Unified CM users as virtual agents, follow this procedure.

**Step 1**
Identify the required Cisco TelePresence system that should participate as a virtual agent in the Unified CCX application.

a. Note the Unified CM extension of the Cisco TelePresence deployment.

   **Note**
   The Cisco Unified IP Phone 7970G phone and Cisco TelePresence system must be assigned the same extension in Unified CM as they both share the same line.

b. Note the MAC address or the Directory Number of the Cisco Unified IP Phone 7970G phone connected to the identified Cisco TelePresence system.

   **Tip**
   From the Cisco CRS perspective, this is another SIP end point.

**Step 2**
Associate the Cisco Unified IP Phone 7970G phone with the Unified CM user to configure this user as a virtual agent (see Defining Unified CM Users as Agents, page 4-15).

**Step 3**
Associate the Cisco Unified IP Phone 7970G phone with the RmCm provider (see Configuring the RmCm Provider, page 7-2).

**Step 4**
Customize the Cisco Agent Desktop workflow groups (see Cisco Desktop Administrator User's Guide).
Chapter 4      Provisioning Unified CM for Unified CCX

Configuring Unified CM for Unified CCX

Tip
All the Cisco Agent Desktop call control buttons must be disabled as third-party call control will not be available for the Cisco TelePresence integration with Unified CCX.

Assigning Unified CM Users as Unified CCX Agents

Warning
Do not configure Unified CM users using administrator/ciscocisco as the user name/password combination when logging into the CRS Administrator. Doing so may restrict the Unified CM when shared across multiple Cisco CRS servers.

RmCm uses the Unified CM database to determine which devices it can control and provides an interface method for getting the Media Access Control (MAC) address of the calling party.

After you install RmCm, you have access to the Unified CM database. The database stores parameters that initialize Unified CM Telephony, user profiles, application logic, network-specific configuration information, and Directory Number Associations such as Primary Extension and Unified CCX Extension.

The Primary Extension field represents the primary directory number for the end user. End users can have multiple lines on their phones. From the drop-down list box, choose a primary extension when associating devices for this end user.

Unified CCX Extension allows you to define Unified CM users as Unified CCX agents in Unified CM.

To assign Unified CCX devices to end users and application users in the Unified CM web interface, these users must first exist in Unified CM. If these users do not exist, you must first add the users. See the Cisco Unified Communications Manager Administration guide to obtain detailed information about the Unified CCX web interface and configuration procedures. After adding the end user and the application user, be sure to modify their Unified CCX settings (see Modifying Existing Unified CM Users)
Modifying Existing Unified CM Users

**Note**
Be sure to assign Unified CCX devices to both end users and application users in the Unified CM web interface.

To assign devices to an end user, you must access the End User Configuration window for that user. The End User Configuration window in Unified CM Administration allows the administrator to add, search, display, and maintain information about Unified CM end users.

To assign devices to an application user, you must access the Application User Configuration window for that user. The Application User Configuration window in Unified CM Administration allows the administrator to add, search, display, and maintain information about Unified CM application users.

To modify the Unified CCX Extension settings for existing Unified CM users who are Unified CCX agents, complete the following steps.

**Procedure**

**Step 1**
Connect to the Unified CM Administration web interface.

For information about connecting to the Unified CM Administration web interface (see Invoking Unified CM Administration, page 4-14).

The Unified CM Administration web page appears.

**Step 2**
From the Unified CM Administration menu bar, choose **User Management > End User**.

The Find and List End Users window displays. Use the two drop-down list boxes to search for an end user.

**Tip**
To find all end users registered in the database, click **Find** without entering any search text. A list of discovered end users displays. If you choose to do this step, skip to **Step 6**.

**Step 3**
From the first Find end user where drop-down box, choose one of the listed criteria.
From the second Find end user where drop-down list box, choose one of the listed criteria.

Specify the appropriate search text, if applicable, and click **Find**.

A list of discovered end users displays.

From the list of records, click the end user name that matches your search criteria.

The window displays the end user that you choose.

On the End User Information page, scroll down to the **Directory Number Association** section.

In the **Primary Extension** field drop-down list and the **Unified CCX Extension** field drop-down list, choose the required agent extension for this device.

These fields represent the primary directory number for the end user. End users can have multiple lines on their phones. If you have a single line, be sure to select the same extension for both fields.

In the Available Devices list box, select the device and click the Down arrow below this list box. If the device that you want to associate with this end user does not display in this pane, click one of these buttons to search for other devices:

- **Find more Phones**-Click this button to find more phones to associate with this end user. The Find and List Phones window displays to enable a phone search.

- **Find more Route Points**-Click this button to find more phones to associate with this end user. The Find and List CTI Route Points window displays to enable a CTI route point search.

The Available Devices list box displays the devices that are available for association with this end user.

Select the required device and save your changes to associate that device with this end user.

After the device is associated, the Controlled Devices field displays the description information (for example, the MAC address) that the end user controls.

Click **Update** to apply the changes.

The specific End User Information page for this user appears, with the message that the update was successful.
Step 12  From the Unified CM Administration menu bar, choose User Management > Application User. RmCm Providers are referred to as application users in Unified CM.

**Note**  When you associate one device with the Unified CCX agent (end user), you must also be sure to associate the same device with the Unified CCX RmCm Provider (application user).

The Find and List Application Users window displays. Use the two drop-down list boxes to search for the application users in Unified CM.

**Tip**  To find all application users registered in the database, click Find without entering any search text. A list of discovered end users displays. If you choose to do this step, skip to Step 16.

Step 13  From the first Find application user where drop-down list box, choose one of the listed criteria.

Step 14  From the second Find application user where drop-down list box, choose one of the listed criteria.

Step 15  Specify the appropriate search text, if applicable, and click Find.

A list of discovered application users displays.

Step 16  From the list of records, click the application user name that matches your search criteria.

The window displays the application user that you choose.

Step 17  Repeat Step 9 and Step 10 for the selected Application User.

These steps ensure that the Unified CM application users are also defined as Unified CCX agents in Unified CM.

Step 18  Click Update to apply the changes.

The specific Application Information page for this user appears, with the message that the update was successful.
Now that you have defined the agent in Unified CM, you can configure agents in Cisco CRS (see Configuring Agents, page 7-10). Subsequent to that, you will also need to configure resource groups (see Configuring Resource Groups, page 7-4) and CSQs (see Creating a CSQ, page 7-18).

Related Topics
- Guidelines for Configuring Agent Phones, page 4-16
- Invoking Unified CM Administration, page 4-14
- Configuring Agents, page 7-10
Provisioning Unified CCX for Unified CME

After you complete the initial setup of Cisco CRS (see *Cisco Customer Response Solutions Installation Guide*), you will have identified the information that Cisco CRS requires to provision Unified CME for Unified CCX (see Interoperability between Cisco CRS and Unified CME, page 5-4). You can modify the Unified CME information from Cisco CRS.

The following topics explain how to modify the Unified CME information from Cisco CRS.

- Introducing Unified CME for Cisco CRS, page 5-2
- Verifying Licenses, page 5-5
- Modifying Unified CME Information from Cisco CRS, page 5-5
- Configuring the AXL User in Cisco CRS, page 5-5
- Provisioning the Unified CME Telephony Subsystem, page 5-6
- Managing Unified CME Users, page 5-16
- Identifying Agent Directory Numbers, page 5-19
Introducing Unified CME for Cisco CRS

Effective Cisco CRS Release 5.0, Unified CCX enables interoperability with Unified CME, Release 4.2 between Cisco CRS and Unified CME. This interoperability allows for the following functions:

- Configuration query and update between Unified CCX and Unified CME.
- SIP-based simple and supplementary call control services including call routing between Unified CME and Unified CCX using SIP-based route point.
- Unified CCX keep alive session management of Unified CME.
- Unified CCX device and call monitoring of agent lines and call activities in Unified CME.
- Support of Unified CCX5.0 Cisco Agent Desktop for use with Unified CME.

This section includes the following topics:

- Guidelines, page 5-2
- Supported Features, page 5-3
- Interoperability between Cisco CRS and Unified CME, page 5-4
- Unified CCX Provisioning Checklist, page 3-4

Guidelines

The following guidelines apply when using the Unified CME product for Cisco CRS:

- In the Unified CME Telephony subsystem the concept of CTI Ports does not exist. When a call is offered at a CME Telephony Route Point, the route point accepts the call. The call is not transferred to a CTI Port.
- The Unified CME Telephony subsystem only supports G711 codec prompts.
- Unified CME Telephony users are stored locally in the CRS Database
- Unified IP Phone Agents are limited to one Cisco CRS platform for each Unified CME product
- The Unified CME Telephony subsystem only SCCP Phones as agent devices.
Supported Features

The following Cisco CRS features are supported by the Unified CME product for Unified CCX:

- Unified CCX as a whole and as a child to Unified CCE (as a parent)
- Unified IP IVR
- Unified EIM and the Unified WIM
- Limited CAD Functionality
- Limited CSD Functionality

The following Cisco CRS features are not supported by the Unified CME offering:

- Unified QM
- High Availability (only single node support)
- Outbound preview dialer
- Remote monitoring

Related Topics

- Guidelines, page 5-2
- Interoperability between Cisco CRS and Unified CME, page 5-4
- Unified CCX Provisioning Checklist, page 3-4
Interoperability between Cisco CRS and Unified CME

Table 5-1 identifies the tasks to configure interoperability between Cisco CRS and Unified CME.

Table 5-1   Tasks to Configure Interoperability between Cisco CRS and Unified CME

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Name of Document</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify that the appropriate version of Unified CME is installed on the router.</td>
<td>See the Configuring Interoperability with External Services chapter in the Cisco Unified Communications Manager Express, Release 4.2 System Administrator Guide.</td>
</tr>
<tr>
<td>2</td>
<td>Configure the Unified CME router. <strong>Tip</strong> Note the AXL user ID, password, and the router’s IP address.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Configure Unified CME to enable interoperability with Cisco Unified CCX.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Install Unified CCX for Unified CME.</td>
<td>See the Cisco CRS Installation Guide.</td>
</tr>
<tr>
<td>5</td>
<td>Launch the setup wizard on CRS and go through the setup for the Unified CME. <strong>Tip</strong> When setup launches, you are asked for the AXL user ID and password that you created in Unified CME. You also need to enter the router IP address.</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Configure Unified CME Telephony Subsystem to enable interoperability with Unified CCX.</td>
<td>Provided in this chapter of the Cisco CRS Administration Guide.</td>
</tr>
<tr>
<td>7</td>
<td>Create users and assign the agent capability to these users in Cisco CRS (see ).</td>
<td></td>
</tr>
</tbody>
</table>

Related Topics
- Guidelines, page 5-2
- Supported Features, page 5-3
- Unified CCX Provisioning Checklist, page 3-4
Verifying Licenses

Licenses are installed for the first time in the Cisco CRS setup wizard. Once you have uploaded the licenses, the Unified CME Telephony Call Control Group is automatically created.

Related Topics
- Viewing License Information, page 1-14
- Display Licenses, page 18-10
- Add License(s), page 18-11

Modifying Unified CME Information from Cisco CRS

During the Cisco CRS setup process, the administrator provides the Unified CME IP address and hostname(s) and the Administrative XML Layer (AXL) authentication (user ID and password) information. You can change this information at any time as required from Cisco CRS. If you do change the information, you must provide the IP address of the AXL server to which you will move this server.

Related Topics
- Introducing Unified CME for Cisco CRS, page 5-2
- Verifying Licenses, page 5-5
- Configuring the AXL User in Cisco CRS, page 5-5
- Provisioning the Unified CME Telephony Subsystem, page 5-6
- Managing Unified CME Users, page 5-16
- Identifying Agent Directory Numbers, page 5-19

Configuring the AXL User in Cisco CRS

To change previously-configured Unified CME setup information from Cisco CRS, complete the following steps.
Procedure

Step 1
From the CRS Administration menu bar, choose **System > Unified CME Configuration**.

The Unified CME Configuration web page opens. This page facilitates configuration of Unified CME server information, which is required to authenticate to the AXL Service of the Unified CME server.

Step 2
Use this web page dialog to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CME server host name or IP address</td>
<td>Provide the IP address of the server providing access to Unified CME.</td>
</tr>
<tr>
<td>AXL User ID</td>
<td>Enter the user name for the AXL server providing access to Unified CME. The user name is created on the Unified CME router.</td>
</tr>
<tr>
<td>AXL Password</td>
<td>Enter the corresponding password for the user account providing access to Unified CME. The user name is created on the Unified CME router.</td>
</tr>
</tbody>
</table>

Step 3
Click **OK**.

CRS Administration enables that service and then tries to access the Unified CME information and update the page.

---

Provisioning the Unified CME Telephony Subsystem

**Note**
The Unified CME Telephony subsystem is available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR, Unified CCX Standard, Unified CCX Enhanced, or Unified CCX Premium.
The Unified CME Telephony subsystem is the subsystem of the CRS Engine that sends and receives call-related messages from the Unified CME CTI Manager through the Unified CME Telephony client. To enable your CRS server to handle Cisco Unified Communications requests, you will need to provision the Unified CME Telephony subsystem.

From the Cisco CRS Administration GUI, you configure and update the Unified CME Telephony subsystem information at anytime.

To provision the Unified CME Telephony subsystem, complete the following tasks:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>For instructions, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Validate Unified CME and Cisco CRS versions.</td>
<td>Validating Unified CME and Cisco CRS Data, page 5-8</td>
</tr>
<tr>
<td>2</td>
<td>Configure a Unified CME Telephony Provider, if not already configured. Specify the server on which Unified CME is running, and provide a Unified CME user ID and password.</td>
<td>Configuring a Unified CME Telephony Provider, page 5-9</td>
</tr>
<tr>
<td>3</td>
<td>Provision Unified CME Telephony call control groups.</td>
<td>Modifying the Unified CME Telephony Call Control Group, page 5-10</td>
</tr>
</tbody>
</table>

**Related Topics**
- Provisioning the Unified CME Telephony Subsystem, page 5-6
- Managing Unified CME Users, page 5-16
- Introducing Unified CME for Cisco CRS, page 5-2
- Verifying Licenses, page 5-5
- Modifying Unified CME Information from Cisco CRS, page 5-5
- Configuring the AXL User in Cisco CRS, page 5-5
- Managing Unified CME Users, page 5-16
- Identifying Agent Directory Numbers, page 5-19
Validating Unified CME and Cisco CRS Data

Use the validate tool when the configuration in Cisco CRS and Unified CME are not synchronized. You can also use this tool to perform a comparison between the Cisco CRS and Unified CME configurations. For example, if the router configuration does not match the configuration stored in the Cisco CRS database, you can run the validate tool to verify the missing information.

Tip
You can only run this tool when Unified CME is accessible from Cisco CRS.

Caution
This tool does not perform the resynchronization, it only points out the problems.

To validate the Unified CME and Cisco CRS data, complete the following steps.

Procedure

Step 1 From the CRS Administration menu bar, choose Subsystems > Unified CME Telephony.

The Unified CME Telephony Configuration web page opens, displaying the Unified CME Telephony Provider web page.

Step 2 Click the Validate Unified CME in CRS Data hyperlink in the left pane.

A message prompts you to wait while the data is validated. The web page then refreshes itself to provide a summary and status of the validation.

Related Topics
- Configuring a Unified CME Telephony Provider, page 5-9
- Modifying the Unified CME Telephony Call Control Group, page 5-10
- Modifying a Unified CME Telephony Trigger, page 5-10
Configuring a Unified CME Telephony Provider

The Unified CME Telephony provider opens a logical session with Unified CME to detect the state of the connection. This session verifies provider authentication, periodically exchanges heartbeats, and continues to monitor Unified CME availability after successful authentication.

Absence of the heartbeats might be caused by various issues. See the Cisco CRS Servicing and Troubleshooting Guide for more details.

The Unified CME Telephony Providers area of the Unified CME Telephony Configuration web page is a configurable page that displays the latest configured information.

To modify the Unified CME Telephony subsystem, complete the following steps.

Procedure

**Step 1**
From the CRS Administration menu bar, choose **Subsystems > Unified CME Telephony**.

The Unified CME Telephony Configuration web page opens, displaying the Unified CME Telephone Provider pane.

The table below describes the read-only fields displayed in the Unified CME Telephony Provider Configuration web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Unified CME Telephony Port</td>
<td>Enter the SIP port number used by Unified CME to communicate with Cisco CRS (default is 5060).</td>
</tr>
<tr>
<td>Local Unified CME Telephony Port</td>
<td>Enter the port number of any available port in Cisco CRS.</td>
</tr>
<tr>
<td>User Agent</td>
<td>This read only field provides a description of the owner for this connection.</td>
</tr>
<tr>
<td>Keep Alive Interval</td>
<td>If a keep alive message is not received for more than the time period specified in this field, then the connection between Cisco CRS and Unified CME is considered broken.</td>
</tr>
<tr>
<td>Session Server ID</td>
<td>This read only field provides the auto-generated unique ID for the Cisco CRS server.</td>
</tr>
</tbody>
</table>
Provisioning the Unified CME Telephony Subsystem

Field | Description
---|---
Transport | Specify the required protocol to send the keep alive messages. Only the TCP Protocol is accepted.
Outbound Trigger DN | This user-specified trigger must be created before the Unified CME Telephony triggers are created. Cisco CRS uses this trigger to place calls outside of the Cisco CRS.

Related Topics
- Validating Unified CME and Cisco CRS Data, page 5-8
- Modifying the Unified CME Telephony Call Control Group, page 5-10
- Modifying a Unified CME Telephony Trigger, page 5-10

Modifying the Unified CME Telephony Call Control Group

The Unified CME Telephony call control group is automatically added based on license. It is created when you upload the license. The number of channel equals the licensed IVR ports.

The Unified CME Telephony Call Control Group Information web page is read-only and cannot be modified.

Related Topics
- Validating Unified CME and Cisco CRS Data, page 5-8
- Configuring a Unified CME Telephony Provider, page 5-9
- Modifying a Unified CME Telephony Trigger, page 5-10

Modifying a Unified CME Telephony Trigger

**Note**

Unified CME Telephony triggers are only available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR, Unified CCX Standard, Unified CCX Enhanced, or Unified CCX Premium.
Unified CME Telephony triggers define the route point to which a directory number is associated. During the Cisco CRS installation, the Unified CME Telephony trigger is configured with the default Unified CME Telephony Call Control Group, Route Pattern, and Media Termination Dialog group. You must modify these default Unified CME Telephony triggers to invoke application scripts in response to incoming contacts. A Unified CME Telephony trigger responds to calls that arrive on a specific route point by selecting telephony and media resources to serve the call and invoking an application script to handle the call.

Unified CME Telephony trigger settings include:

- **Directory Number** information, such as the Voice Mail Profile and Calling Search Space.
- **Application** information, such as the application name to associate with the trigger.
- **Session** information, such as the application to associate with the trigger, Maximum Number of sessions allowed, and the Idle Timeout value.

To modify a Unified CME Telephony trigger, complete the following steps.

**Procedure**

**Step 1**

From the CRS Administration menu bar, choose **Subsystems > Unified CME Telephony**.

The Unified CME Telephony Configuration web page opens, displaying the Unified CME Telephony Call Control Group summary web page.

**Note**

You can access the Unified CME Telephony Configuration web page only when the CRS Engine is running.
Step 2  On the Unified CME Telephony Configuration navigation bar, click the **Unified CME Telephony Triggers** hyperlink.

The Unified CME Telephony Trigger Configuration summary web page opens. The table below describes the contents of the summary page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory Number</td>
<td>A unique phone number.</td>
</tr>
<tr>
<td>Application</td>
<td>Application name to associate with the trigger.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Maximum number of simultaneous calls that the trigger can handle.</td>
</tr>
<tr>
<td>Enabled</td>
<td>True if the trigger is enabled; False if the trigger is disabled.</td>
</tr>
</tbody>
</table>

Step 3  Click the **Add a New Unified CME Telephony Trigger** hyperlink.

The Unified CME Telephony Trigger Configuration web page opens.

Step 4  Use this web page to specify the following fields:

<table>
<thead>
<tr>
<th>Page Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Directory Number| Directory Number | A unique phone number. The value includes numeric characters, preceded or appended by the following special characters:  
# * [ ] X -  
Examples of **valid** Directory Numbers:  
*#12#* or 12*23  
Examples of **invalid** Directory Numbers:  
91X+, 91X?, 91!, 813510[^0-5] as it contains a character other than numerical and allowed special characters or  
8]90[-, as it doesn't conform with the rule that the square bracket ([ ]) characters enclose a range of values.  
**Note**  
See the *Wild cards and Special Characters in Route Patterns and Hunt Pilots* section in the *Cisco Unified Communications Manager System Guide* for more information.  

### Provisioning the Unified CME Telephony Subsystem

#### Chapter 5  Provisioning Unified CCX for Unified CME

**Trigger Information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Drop-down menu, choose the default language to associate with the incoming call when the application is started.</td>
</tr>
</tbody>
</table>

**Note**  
To add a Language option, click the **Edit** button. The User Prompt dialog box opens. Enter a locale string value and click **OK**. The User Prompt dialog box closes, and the name of the language opens in the Language field in the Unified CME Telephony Configuration web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>Drop-down menu, choose the application to associate with the trigger.</td>
</tr>
</tbody>
</table>
Provisioning Unified CCX for Unified CME

Provisioning the Unified CME Telephony Subsystem

<table>
<thead>
<tr>
<th>Page Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Information</td>
<td>Language</td>
<td>Drop-down menu, choose the default language to associate with the incoming call when the application is started.</td>
</tr>
</tbody>
</table>

**Note** To add a Language option, click the **Edit** button. The User Prompt dialog box opens. Enter a locale string value and click **OK**. The User Prompt dialog box closes, and the name of the language opens in the Language field in the Unified CME Telephony Configuration web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>Drop-down menu, choose the application to associate with the trigger.</td>
</tr>
</tbody>
</table>
### Provisioning the Unified CME Telephony Subsystem

#### Chapter 5  Provisioning Unified CCX for Unified CME

<table>
<thead>
<tr>
<th>Page Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Trigger Information</td>
<td>Enabled</td>
<td>Default = Enabled (Yes) Radio buttons, choose the required option: Yes - enable the trigger. No - disable the trigger.</td>
</tr>
<tr>
<td></td>
<td>Maximum Number of sessions</td>
<td>The maximum number of simultaneous calls that this trigger can handle. The number is actually governed by the Unified CM (10,000 for each separate line). However in the CRS platform, this number is restricted to the maximum number of sessions. Any call exceeding this number gets the busy tone (see the “Modifying a Unified CME Telephony Trigger” section on page 5-10).</td>
</tr>
<tr>
<td></td>
<td>Idle Timeout (in ms)</td>
<td>Default = 5000ms. The number of milliseconds (ms) the system should wait before rejecting the Unified CME Telephony request for this trigger.</td>
</tr>
<tr>
<td></td>
<td>Call Control Group</td>
<td>Default = Media Termination. A read-only field displaying the call control group to associate with the trigger. To override this default, select Yes in the Override Media Termination field. By default, only one Unified CME Telephony Call Control Group is (Default Call Control Group) is created during the setup process.</td>
</tr>
<tr>
<td></td>
<td>Override Media Termination</td>
<td>Default = Media Termination) Radio buttons, choose the required option: Yes - Override media termination. No - Enable media termination. If you select Yes, two panes open:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Selected Dialog Groups displays the default or selected group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Available Dialog Groups lists the configured dialog groups. Use the left and right arrow to move the required dialog group to the Selected Dialog Group pane.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can add dialog groups when adding a new dialog group via ASR/TTS. Only two dialog groups are allowed to be added to Unified CME deployment.</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>A read-only field providing the description of the trigger.</td>
</tr>
</tbody>
</table>
Managing Unified CME Users

Unlike Unified CM users, Unified CME users are configured and managed by Cisco CRS.

A Unified CME user can be assigned one of the following Cisco CRS capabilities in Cisco CRS: Administrator, Supervisor, Reporting, or Agent.

This section includes the following topics:
- Assigning Capability Views to Unified CME Users, page 5-16
- Creating New Unified CME Users, page 5-17

Related Topics
- The User Management Menu Option, page 22-10
- About Cisco CRS User Capabilities, page 17-2

Assigning Capability Views to Unified CME Users

You can assign a capability after you create the Unified CME user or when you are creating the Unified CME user. To assign a capability when creating a Unified CME user, see Creating New Unified CME Users, page 5-17.

To assign a capability to a pre-existing Unified CME user in Cisco CRS, complete the following steps.

Step 5  Click Add (located at the top of the page).

The Unified CME Telephony Trigger Configuration summary web page opens, and displays the new Unified CME Telephony trigger.
Managing Unified CME Users

Procedure

Step 1

From the CRS Administration menu bar, Tools > User Management.

The User Configuration web page opens to display the following fields.

Step 2

In the left pane, click the required view under the Capability View title.

The corresponding view displays with two panes. The pane on the right always displays the list of Available Users and the left pane changes to display the users assigned to the selected view.

Step 3

Change the users as required for each view using the arrow in either direction.

Your changes are displayed in this page and must be saved to the database.

Step 4

Click Update to save the changes to the database.

Step 5

Repeat this process as needed to assign the required capability for each user.

Creating New Unified CME Users

You can create new Unified CME users from Cisco CRS at any time. When creating these users, you can simultaneously assign the capability level.

To create a new Unified CME user and to assign a capability in Cisco CRS, complete the following steps.

Field | Description
--- | ---
User Id | Unique identifier of the user for which the spoken name is to be uploaded.
First Name | The first name for each Unified CME user. You can sort this field alphabetically.
Last Name | The last name for each Unified CME user. You can sort this field alphabetically.
Capability | The capability assigned for each Unified CME user. You can sort this field alphabetically.
Managing Unified CME Users

Chapter 5      Provisioning Unified CCX for Unified CME

Procedure

Step 1  From the CRS Administration menu bar, Tools > User Management. The User Configuration web page opens.

Step 2  Click the Create New User hyperlink in the right pane of this page. The User Configuration page refreshes to display the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>Unique identifier for this new Unified CME user.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name for this new Unified CME user.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name for this new Unified CME user.</td>
</tr>
<tr>
<td>Name Dialing</td>
<td>An automatically generated field that concatenates the first and last name into a unique field to dial a name by function.</td>
</tr>
<tr>
<td>Password</td>
<td>This field cannot be empty. The password requires at least five alphanumeric characters.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Retype the password assigned in the previous field. Do not copy and paste the password.</td>
</tr>
<tr>
<td>PIN</td>
<td>This field cannot be empty. The pin is limited to five numbers and cannot be greater than 20 numbers.</td>
</tr>
<tr>
<td>Confirm PIN</td>
<td>Retype the pin assigned in the previous field. Do not copy and paste the pin.</td>
</tr>
</tbody>
</table>

Capabilities

Selected Capabilities  The capability assigned for each Unified CME user is identified in this box. Use the arrow to assign the required capability for this new Unified CME user. If you wish to change the assigned capability at a later time, follow the procedure provided in the “Assigning Capability Views to Unified CME Users” section on page 5-16.

Available Capabilities The list of capabilities that can be assigned for this new Unified CME user. Use the arrow in either direction to assign the required capability.

Step 3 After entering the information in the fields/boxes, click the Update button at the top of this web page.
The User Configuration page refreshes to dynamically display the newly-added Unified CME user. The capabilities for the newly-added user are effective immediately.

**Step 4** Repeat this process as needed to assign other new users.

### Changing Passwords and Pins

Unified CME users are configured and management by Cisco CRS. Therefore, in addition to the general privileges, a CRS Application User ([http://<CRS IP address>/Appuser](http://<CRS IP address>/Appuser)) has the following additional privileges:

- Change password
- Change the pin
- Upload the spoken name

To access the Cisco CRS Supervisor web page, see *Accessing the Cisco CRS User Options Web page, page 17-9*.

### Identifying Agent Directory Numbers

Directory numbers associated with Unified CCX agent phones must be configured in Unified CME. Identifying agent directory numbers in Unified CME is an ongoing task. See the *Cisco Unified Communications Manager Express 4.2 New Features* document for more information.
Provisioning Telephony and Media

Resource provisioning information for the Cisco CRS telephony and media subsystems are provided in the following sections:

- About CRS Telephony and Media, page 6-2
- Provisioning the Unified CM Telephony Subsystem, page 6-5
- Additional Unified CM Telephony Information, page 6-21
- Provisioning the Cisco Media Subsystem, page 6-23
- Provisioning ASR and TTS in Cisco CRS, page 6-26
About CRS Telephony and Media

The CRS system uses a telephony resource called Computer Telephony Interface (CTI) ports to accept incoming calls and to place outbound calls. The CRS system uses the following media resources to provide interactive services for calls:

- **Unified CM Telephony**—The Cisco CRS Engine uses the Unified CM Telephony subsystem to send and receive calls from the Unified CM by interfacing with the CTI Manager through the Unified CM Telephony client.

- **Unified CME Telephony**—The Cisco CRS Engine uses the Unified CME Telephony subsystem to open a logical session with Unified CME. This session verifies provider authentication, periodically exchanges heartbeats, and monitors Unified CME availability after successful authentication.

- **Cisco Media Termination (CMT)**—The CMT channels provide media terminations in the Cisco CRS for Unified CM/CME Telephony Call Contacts. These channels enable the Cisco CRS to play media to the connected party. DTMF digits are received out of band by the Unified CM/CME Telephony subsystem.

- **MRCP Automated Speech Recognition (MRCP ASR)**—The ASR media resource allows callers to use speech to navigate menus and to provide other information to CRS applications.

- **MRCP Text-To-Speech (MRCP TTS)**—The TTS media resource enables CRS applications to play back documents to callers as speech.

---

**Note**

Media resources are licensed and sold as Cisco Unified IP IVR (Unified IP IVR) ports. Although you can provision more channels than you are licensed for, licensing is enforced at run-time. If more channels are provisioned than licensed, the system will not accept the extra calls, as doing so would violate your licensing agreements.

The CRS system uses the concept of **groups** to share telephony and media resources among different applications:

- **Call control groups** allow you to control how the system uses CTI ports. For example, you can reserve more ports for higher-priority applications or provide access to fewer ports for applications with less traffic.
• *Media resource groups* allow you to share media resources among different applications. For example, you can share ASR media resource groups with applications that collect caller information and applications that transfer calls to specific extensions.

The CRS system also uses the concept of *triggers*, which are specified signals that invoke application scripts in response to incoming contacts.

### Media Termination Groups

Media termination groups are associated with CTI port Groups.

During initial Cisco CRS Setup, based on the licensed number of CTI ports, a default CTI port group and its associated media termination group is created. By default, every trigger is associated with this CTI Port Group and the corresponding media termination group.

---

**Note**

For Unified CME deployments, this will be the only available CTI Port Group. But in the Unified CM deployments, you can create and use additional CTI Port Groups as required.

Effective Cisco CRS Release 5.0, if a CTI port group is selected to support media termination and if the number of channels are identical to both groups, then the CTI port group is automatically created in the background. This auto creation feature eliminates the manual CTI port group creation process.

If you elect to override media termination, then the call control channel chooses the media termination automatically. If you wish to select a new dialog group then you can have more than one media termination options. The options are used in the order displayed in the drop-down list (see Adding a New Unified CM Telephony Call Control Group, page 6-9).

### Provisioning Channels to Handle Calls

CRS needs two types of channels to process calls:

- A *call control channel*, which is provisioned through the Unified CM Telephony subsystem and corresponds to CTI port resources in Unified CM.
About CRS Telephony and Media

A media channel, which is provisioned through either the CMT subsystem or the MRCP subsystem and corresponds to the kernel resources for handling the media voice path with the caller.

Note
MRCP channels also correspond to additional resources on the MRCP server for performing speech recognition.

Cisco CRS needs access to a channel of each type in order to successfully process a call. However, the capabilities of the two channel types are not identical.

For example, consider a Cisco CRS system provisioned with a single Unified CM Telephony call control channel (that is, a CTI port) and a single CMT channel. The system can handle one call at a time; when that call terminates, the system must reinitialize the channel resources before it can accept another call.

However, the time each channel takes to reinitialize is not equal—CMT channels take more time to reinitialize than CTI ports. For example:

- The Unified CM Telephony call control channel may take approximately 1 millisecond to reinitialize
- The CMT channel may take approximately 200 milliseconds to reinitialize.

This example implies that the system will not be able to accept a new incoming call for 200 milliseconds after the first call terminates; although the Unified CM Telephony channel is available after one millisecond, the CMT channel is not and CRS needs both channels to process a call.

Such a delay can become an issue when a CRS system is experiencing a high load condition or needs to handle a burst of incoming calls. Consequently, CMT channels require a higher channel count provisioning.

Tip
To provision CRS systems to handle burst calls equally among all required resources, you must configure approximately 10% more CMT channels than CTI ports, and approximately 10% more MRCP channels than ASR licenses.
Telephony and Media Resources Provisioning Checklist

To provision telephony and media resources, complete the following tasks:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>For instructions, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Provision the Unified CM Telephony subsystem, which controls the telephony resources for the CRS system.</td>
<td>Provisioning the Unified CM Telephony Subsystem, page 6-5</td>
</tr>
<tr>
<td>Step 2</td>
<td>Provision the Cisco Media subsystem, which controls the CMT media resources for the CRS system.</td>
<td>Provisioning the Cisco Media Subsystem, page 6-23</td>
</tr>
<tr>
<td>Step 3</td>
<td>Provision the MRCP ASR subsystem, which controls the ASR media resources for the CRS system.</td>
<td>Provisioning the MRCP ASR Subsystem, page 6-27</td>
</tr>
<tr>
<td>Step 4</td>
<td>Provision the MRCP TTS subsystem, which controls the TTS media resources for the CRS system.</td>
<td>Provisioning the MRCP TTS Subsystem, page 6-34</td>
</tr>
</tbody>
</table>

Provisioning the Unified CM Telephony Subsystem

Note: The Unified CM Telephony subsystem is available if your system has a license installed for one of the following Cisco product packages: Cisco Unified QM, Unified IP IVR, Unified CCX Standard, Unified CCX Enhanced, or Unified CCX Premium.

The Unified CM Telephony subsystem is the subsystem of the CRS Engine that sends and receives call-related messages from the Unified CM CTI Manager through the Unified CM Telephony client. To enable your CRS server to handle Cisco Unified Communications requests, you will need to provision the Unified CM Telephony subsystem.

Note: In previous versions of Cisco CRS, it was necessary to configure Unified CM Telephony information using Unified CM. In Cisco CRS Release 4.0 and later, Unified CM Telephony configuration tasks are performed directly through CRS Administration web pages.
To provision the Unified CM Telephony subsystem, complete the following tasks:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>For instructions, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Resynchronize Unified CM Telephony versions.</td>
<td>Provisioning the Unified CM Telephony Subsystem, page 6-5</td>
</tr>
<tr>
<td></td>
<td>• Resynchronizing the Unified CM Telephony Data, page 6-6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Resynchronizing the Cisco JTAPI Client, page 6-7</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Configure a Unified CM Telephony Provider, if not already configured.</td>
<td>Configuring a Unified CM Telephony Provider, page 6-8 and</td>
</tr>
<tr>
<td></td>
<td>Configuring a Unified CM Telephony Provider, page 6-8 and</td>
<td>Modifying Unified CM Telephony Information, page 4-8</td>
</tr>
<tr>
<td></td>
<td>Specify the server on which the Cisco Media Convergence Server (Cisco MCS) is running Unified CM CTI Manager, and provide a Unified CM user ID and password.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Provision Unified CM Telephony call control groups. Unified CM</td>
<td>Adding a New Unified CM Telephony Call Control Group, page 6-9</td>
</tr>
<tr>
<td></td>
<td>Telephony call control groups pool together a series of CTI ports,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>which the system then uses to serve calls as they arrive at the CRS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>server.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Provision a Unified CM Telephony trigger. Unified CM Telephony</td>
<td>Adding a Unified CM Telephony Trigger, page 6-14</td>
</tr>
<tr>
<td></td>
<td>triggers invoke application scripts in response to incoming contacts.</td>
<td></td>
</tr>
</tbody>
</table>

**Related Topics**

Additional Unified CM Telephony Information, page 6-21

**Resynchronizing the Unified CM Telephony Data**

This resynchronizing process ensures that the Unified CM Telephony user, the call control groups, and the triggers matches the version of Unified CM being used.

To resynchronize the Unified CM Telephony data, complete the following steps.

**Procedure**

**Step 1** From the CRS Administration menu bar, choose Subsystems > Unified CM Telephony.
Provisioning the Unified CM Telephony Subsystem

The Unified CM Telephony Call Control Group Configuration web page opens, displaying the summary web page.

**Step 2**  
Click the **Data Resync** hyperlink in the left pane.  
A new window opens with two options: **Check** and **Synchronize**.

**Step 3**  
Click on **Check** to verify if data inconsistencies exist between Cisco CRS and Unified CM.  
If inconsistencies exist, you will receive a report with the inconsistencies highlighted in red.

**Step 4**  
Review the inconsistencies and click **Synchronize** to correct these inconsistencies.  
You are now ready to provision a Unified CM Telephony trigger.

**Related Topics**
- Configuring a Unified CM Telephony Provider, page 6-8
- Adding a Unified CM Telephony Trigger, page 6-14
- Additional Unified CM Telephony Information, page 6-21

**Resynchronizing the Cisco JTAPI Client**

During the resynchronizing process, an additional check (effective Cisco CRS Release 5.0) ensures that the Unified CM Telephony Client (also known as the Cisco JTAPI Client) are the same between the clients installed on the CRS node and the Cisco JTAPI Client installer. If the CRS platform detects a mismatch, the system downloads and installs the compatible/required installer version.

To resynchronize the Cisco JTAPI Client, complete the following steps.

**Procedure**

**Step 1**  
From the CRS Administration menu bar, choose **Subsystems > Unified CM Telephony**.  
The Unified CM Telephony Call Control Group Configuration web page opens, displaying the summary web page.
Provisioning the Unified CM Telephony Subsystem

Step 2  Click the Cisco JTAPI Resync hyperlink in the left pane.
The window refreshes to display the incompatible installer information.
At this point, it automatically downloads the new installer, if required.
You are now ready to provision a Unified CM Telephony trigger.

Related Topics
- Configuring a Unified CM Telephony Provider, page 6-8
- Adding a Unified CM Telephony Trigger, page 6-14
- Additional Unified CM Telephony Information, page 6-21

Configuring a Unified CM Telephony Provider

The Unified CM Telephony Providers area of the Unified CM Telephony
Configuration web page is a read-only page that displays the latest configured
information.

⚠️ Caution

Some setups may prevent the Unified CM directory administrator from creating
new Unified CM Telephony providers in a multi-server configuration. If this setup
applies to you, be sure to delete preexisting Unified CM Telephony providers
before creating new Unified CM Telephony providers. For example, if the Unified
CM Telephony provider prefix is cmtelephony and you have a two-server
configuration (node_id1 and node_id2), then you must delete both
cmtelephony_<node_id1> and cmtelephony_<node_id2>. If you do not verify
and delete preexisting Unified CM Telephony providers, the Unified CM
Telephony subsystem issues an error and will not allow you to create Unified CM
Telephony providers from the Unified CM Telephony Provider Configuration web
page.

To modify the Unified CM Telephony subsystem, click the Modify Unified CM
Telephony Provider Information hyperlink (see Modifying Unified CM
Telephony Information, page 4-8).
The table below describes the read-only fields displayed in the Unified CM Telephony Provider Configuration web page.

<table>
<thead>
<tr>
<th>Field Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Unified CM Telephony</td>
<td>Read-only field displaying the IP address of the first (of two) Cisco Media Convergence Server (Cisco MCS) running Unified CM CTI Manager in the cluster.</td>
</tr>
<tr>
<td>Provider</td>
<td></td>
</tr>
<tr>
<td>Secondary Unified CM Telephony</td>
<td>Read-only field displaying the IP address of the second (of two) Cisco Media Convergence Server (Cisco MCS) running Unified CM CTI Manager in the cluster.</td>
</tr>
<tr>
<td>Provider</td>
<td></td>
</tr>
<tr>
<td>User Prefix</td>
<td>Read-only field displaying the user prefix for the Unified CM user IDs created in Unified CM.</td>
</tr>
</tbody>
</table>

Related Topics

- Resynchronizing the Cisco JTAPI Client, page 6-7
- Adding a New Unified CM Telephony Call Control Group, page 6-9
- Additional Unified CM Telephony Information, page 6-21
- Modifying Unified CM Telephony Information, page 4-8

## Adding a New Unified CM Telephony Call Control Group

The CRS system uses Unified CM Telephony call control groups to pool together a series of CTI ports, which the system uses to serve calls as they arrive at the CRS server. You can create multiple Unified CM Telephony call control groups in order to share and limit the resources to be used by specific applications.

Note

The Unified CM Telephony Call Control Group area automatically opens in the Unified CM Telephony Configuration web page when you first choose the Unified CM Telephony menu option from the Subsystems menu when the Unified CM Telephony Provider is configured. If the Unified CM Telephony Provider is not configured, the Unified CM Telephony Provider configuration page displays.

To configure a new Unified CM Telephony call control group, complete the following steps.
Chapter 6  Provisioning Telephony and Media

Provisioning the Unified CM Telephony Subsystem

Procedure

Step 1  From the CRS Administration menu bar, choose Subsystems > Unified CM Telephony.

The Unified CM Telephony Configuration web page opens, displaying the Unified CM Telephony Call Control Group summary web page.

Step 2  Click the Add a New Unified CM Telephony Call Control Groups hyperlink.

The Unified CM Telephony Call Control Group Configuration web page opens.

Step 3  Use this web page to specify the following information:

<table>
<thead>
<tr>
<th>Page Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group Information | Group ID               | Corresponds to the trunk group number reported to Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) when the CRS server is part of the Unified ICME solution. Accept the automatic Group ID or enter a unique value.  
  **Note**  If a Stop icon displays beside the Group ID (on the Unified CM Call Control Group Configuration list page), it indicates that the data is invalid or out of sync with Unified CM data; if a Head icon displays, then the Group is valid. |
| Number of CTI Ports | Number of CTI Ports assigned to the group.  
  **Note**  If this field is set to <n>, the system creates <n> ports for each CRS Engine node (node in which CRS Engine component is enabled). |
| Media Termination Support | Enables the auto-creation of media termination groups.  
  Yes = provides automatic media termination if the CTI port group is successful (see Media Termination Groups, page 6-3).  
  No = Media termination port group is not created (default). |
### Directory Number

**Starting Directory Number**

A unique phone number. The value can include numeric characters and special characters (#) and (*).

The specified number of ports will be created starting from the value specified in this field.

The Directory Number that you enter can appear in more than one partition.

**Note** When a pattern is used as a Directory Number, the phone display and the caller ID display on the dialed phone will contain characters other than digits. To avoid this, provide a value for Display (Internal Caller ID), Line Text Label, and External Phone Number Mask.

### Advanced Configuration (only available if you click **Show More**).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group Configuration</strong></td>
<td><strong>Description</strong> Description of the Group ID. Press the Tab key to automatically populate the Description field.</td>
</tr>
<tr>
<td><strong>Device Pool</strong></td>
<td>The device pool - sets of common characteristics for devices, such as region, date/time group, softkey template, and MLPP information - to which you want to assign this phone.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Directory Number (continued)</td>
<td></td>
</tr>
<tr>
<td>DN Calling Search Space</td>
<td>A collection of partitions that are searched to determine how a dialed number should be routed. The calling search space for the device and the calling search space for the directory number get used together. The directory number calling search space takes precedence over the device calling search space. Note For more information, see the Cisco Unified Communications Manager System Guide.</td>
</tr>
<tr>
<td>Redirect Calling Search Space</td>
<td>A collection of partitions that are searched to determine how a redirected call should be routed.</td>
</tr>
<tr>
<td>Media Resource Group List</td>
<td>A prioritized grouping of media resource groups. An application chooses the required media resource, such as a Music On Hold server, from the available media resources according to the priority order that is defined in a Media Resource Group List. If you choose &lt;none&gt;, Unified CM uses the Media Resource Group that is defined in the device pool.</td>
</tr>
<tr>
<td>Location</td>
<td>The Cisco Unified Communications phone location setting specifies the total bandwidth that is available for calls to and from this location. A location setting of HUB_NONE means that the location feature does not keep track of the bandwidth that this Cisco Unified Communications phone consumes.</td>
</tr>
<tr>
<td>Partition</td>
<td>The partition the Directory Number belongs to. The Directory Number field value must be unique within the partition that you choose. If you do not want to restrict access to the Directory Number, select &lt;None&gt; as the partition setting.</td>
</tr>
<tr>
<td>Voice Mail Profile</td>
<td>A list of profiles defined in the Voice Mail Profile Configuration. The first option is &lt;None&gt;, which is the current default Voice Mail Profile that is configured in the Voice Mail Profile Configuration.</td>
</tr>
<tr>
<td>Presence Group</td>
<td>A list of groups to integrate the device with the iPass server (a component running on Unified CM, provides information on the presence of various devices). The device or line information is provided to integrating applications.</td>
</tr>
</tbody>
</table>
### Provisioning the Unified CM Telephony Subsystem

#### Setting (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Require DTMF Reception</td>
<td>A Unified CM radio button to determine if DTMF reception is required. Yes is selected by default. If you select No, a warning message is displayed.</td>
</tr>
<tr>
<td>AAR Group</td>
<td>Automated Alternate Routing (AAR) group for this device. The AAR group provides the prefix digits that are used to route calls that are otherwise blocked due to insufficient bandwidth. An AAR group setting of &lt;None&gt; specifies that no rerouting of blocked calls will be attempted.</td>
</tr>
<tr>
<td>User Hold Audio Source</td>
<td>Audio source heard by the caller when the CRS Script places the caller on hold via the Hold Step (when the user presses the hold key).</td>
</tr>
<tr>
<td>Network Hold Audio Source</td>
<td>Audio source heard by the caller will when CRS performs a Consult Transfer (when Unified CCX calls an agent). Use this entry for the .wav file (for example, .wav file playing a ring back tone) to be played to the caller during this Consult Transfer.</td>
</tr>
</tbody>
</table>

#### Call Forward and Pickup Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Pickup Group</td>
<td>The number that can be dialed to answer calls to this directory number in the specified partition.</td>
</tr>
<tr>
<td>Display</td>
<td>Use a maximum of 30 alphanumeric characters. Typically, use the user name or the directory number (if using the directory number, the person receiving the call may not see the proper identity of the caller). Leave this field blank to have the system display the extension.</td>
</tr>
<tr>
<td>External Phone Number Mask</td>
<td>Phone number (or mask) that is used to send Caller ID information when a call is placed from this line. You can enter a maximum of 30 number and X characters. The X characters represent the directory number and must appear at the end of the pattern. For example, if you specify a mask of 972813XXXX, an external call from extension 1234 displays a caller ID number of 9728131234.</td>
</tr>
</tbody>
</table>

**Step 4** Click **Update** to create the specified number of CTI ports starting with `<Starting Directory Number>`. After creating the CTI ports, the respective CTI ports will be associated to the Unified CM Telephony user configured in the Unified CM Telephony Provider page.
Note
For example, if the starting Directory Number is 2000 and the number of CTI ports is 5, then it will try to create a CTI port with Line Numbers from 2000. If Line Number 2000 is used by any device, then it will try to create a CTI port with Line Number 2001 and so on. The process is complete when five CTI ports are created. The list of configured CTI ports are displayed in the Number of CTI Ports field.

Step 5  
Click Add.

The Unified CM Telephony Call Control Group Configuration summary web page opens. The call control group you have just added appears in the Group ID column.

You are now ready to provision a Unified CM Telephony trigger.

Related Topics
- Resynchronizing the Cisco JTAPI Client, page 6-7
- Configuring a Unified CM Telephony Provider, page 6-8
- Adding a Unified CM Telephony Trigger, page 6-14
- Additional Unified CM Telephony Information, page 6-21

Adding a Unified CM Telephony Trigger

Note
Unified CM Telephony triggers are only available if your system has a license installed for one of the following Cisco product packages: Unified QM, Unified IP IVR, Unified CCX Standard, Unified CCX Enhanced, or Unified CCX Premium.

You must configure Unified CM Telephony triggers to invoke application scripts in response to incoming contacts. A Unified CM Telephony trigger responds to calls that arrive on a specific route point by selecting telephony and media resources to serve the call and invoking an application script to handle the call.
Unified CM Telephony trigger settings include:

- **Session** information, such as the application to associate with the trigger, Maximum Number of sessions allowed (see Media Termination Groups, page 6-3), and the Idle Timeout value.
- **CTI** information, such as a CTI port device and CTI route points for each call CRS simultaneously places or accepts.
- **Directory Number** information, such as the Voice Mail Profile and Calling Search Space.
- **Call Forward and Pickup** instructions.

To add and configure a Unified CM Telephony trigger, complete the following steps.

**Procedure**

**Step 1**

From the CRS Administration menu bar, choose **Subsystems > Unified CM Telephony**.

The Unified CM Telephony Configuration web page opens, displaying the Unified CM Telephony Call Control Group summary web page.

---

**Note**
You can access the Unified CM Telephony Configuration web page only when the CRS Engine is running.
Step 2  On the Unified CM Telephony Configuration navigation bar, click the **Unified CM Telephony Triggers** hyperlink.

The Unified CM Telephony Trigger Configuration summary web page opens.

The table below describes the contents of the summary page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route Point</td>
<td>Available CTI route point, which is the directory number associated with the trigger. <strong>Note</strong> If a Stop icon displays beside the Route Point in the Unified CM Telephony Configuration list page, it indicates that the data is invalid or out of sync with Unified CM data. This also occurs if the Enabled column displays false; to enable the trigger and edit the Unified CM Telephony trigger configuration. The Head icon indicates that this group is valid.</td>
</tr>
<tr>
<td>Application</td>
<td>Application name to associate with the trigger.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Maximum number of simultaneous calls that the trigger can handle.</td>
</tr>
<tr>
<td>Enabled</td>
<td>True if the trigger is enabled; False if the trigger is disabled.</td>
</tr>
</tbody>
</table>

Step 3  Click the **Add a New Unified CM Telephony Trigger** hyperlink.

The Unified CM Telephony Trigger Configuration web page opens.
Step 4 Use this web page to specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Directory Number</strong></td>
<td></td>
</tr>
<tr>
<td>Directory Number</td>
<td>A unique phone number. The value includes numeric characters, preceded or appended by the following special characters: # * [ ] X -</td>
</tr>
<tr>
<td>Examples of <strong>valid</strong> Directory Numbers:</td>
<td><em>#12#</em> or 12*23</td>
</tr>
<tr>
<td>Examples of <strong>invalid</strong> Directory Numbers:</td>
<td>91X+, 91X?, 91!, 813510[^0-5] as it contains a character other than numerical and allowed special characters or 8]90[-, as it doesn't conform with the rule that the square bracket ([ ]) characters enclose a range of values.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>See the Wildcards and Special Characters in Route Patterns and Hunt Pilots section in the Cisco Unified Communications Manager System Guide for more information.</td>
</tr>
</tbody>
</table>

**Trigger Information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Drop-down menu, choose the default language to associate with the incoming call when the application is started.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>To add a Language option, click the Edit button. The User Prompt dialog box opens. Enter a locale string value and click OK. The User Prompt dialog box closes, and the name of the language opens in the Language field in the Unified CM Telephony Configuration web page.</td>
</tr>
<tr>
<td>Application Name</td>
<td>Drop-down menu, choose the application to associate with the trigger.</td>
</tr>
<tr>
<td>Device Name</td>
<td>A unique identifier for this device, consisting of alphanumeric characters, dots, dashes, or underscores.</td>
</tr>
<tr>
<td>Description</td>
<td>A descriptive name for the CTI route point.</td>
</tr>
<tr>
<td>Call Control Group</td>
<td>Drop-down menu, choose the call control group to associate with the trigger.</td>
</tr>
</tbody>
</table>

**Advanced Configuration** (only available if you click Show More).

**Advanced Trigger Information**
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Radio buttons, choose the required option:</td>
</tr>
<tr>
<td></td>
<td>Yes - enable the trigger.</td>
</tr>
<tr>
<td></td>
<td>No - disable the trigger.</td>
</tr>
<tr>
<td>Maximum Number of sessions</td>
<td>The maximum number of simultaneous calls that this trigger can handle. The</td>
</tr>
<tr>
<td></td>
<td>number is actually governed by the Unified CM (10,000 for each separate line).</td>
</tr>
<tr>
<td></td>
<td>However in the CRS platform, this number is restricted to the maximum</td>
</tr>
<tr>
<td></td>
<td>number of sessions. Any call exceeding this number gets the busy tone (see</td>
</tr>
<tr>
<td></td>
<td>the “Adding a Unified CM Telephony Trigger” section on page 6-14).</td>
</tr>
<tr>
<td>Idle Timeout (in ms)</td>
<td>The number of milliseconds (ms) the system should wait before rejecting the</td>
</tr>
<tr>
<td></td>
<td>Unified CM Telephony request for this trigger.</td>
</tr>
<tr>
<td>Override Media Termination</td>
<td>Radio buttons to choose the required options:</td>
</tr>
<tr>
<td></td>
<td>Yes - Override media termination.</td>
</tr>
<tr>
<td></td>
<td>No - Enable media termination (default).</td>
</tr>
<tr>
<td></td>
<td>If you select Yes, two panes open:</td>
</tr>
<tr>
<td></td>
<td>• Selected Dialog Groups displays the default or selected group.</td>
</tr>
<tr>
<td></td>
<td>• Available Dialog Groups lists the configured dialog.</td>
</tr>
</tbody>
</table>

### CTI Route Point Information

| Alerting Name ASCII                        | This information is automatically populated based on the configuration in the  |
|                                            | Unified CM setup and displays the ASCII name filed used in one of the        |
|                                            | following situations:                                                       |
|                                            | • if the device is not capable of handling the Unicode strings               |
|                                            | • if the locals on end point devices do not match                            |
|                                            | • if the Unicode string is not specified                                    |
| Device Pool                                | The device pool to which you want to assign this route point. A device pool   |
|                                            | defines sets of common characteristics for devices, such as region, date/time |
|                                            | group, softkey template, and MLPP information.                             |
| Location                                   | The total bandwidth that is available for calls to/from this location. A     |
|                                            | location setting of HUB_NONE indicates that the locations feature does not    |
|                                            | keep track of the bandwidth used by this route point.                      |

### Directory Number Settings
Chapter 6      Provisioning Telephony and Media

Provisioning the Unified CM Telephony Subsystem

Field | Description
--- | ---
Partition | The partition to which the Directory Number belongs. The Directory Number field value must be unique within the partition that you choose. If you do not want to restrict access to the Directory Number, select <None> as the partition setting.

Voice Mail Profile | A list of profiles defined in the Voice Mail Profile Configuration. The first option is <None>, which is the current default Voice Mail Profile that is configured in the Voice Mail Profile Configuration.

Calling Search Space | A collection of partitions that are searched for numbers that are called from this directory number. The specified value applies to all devices that use this directory number.

**Note** | Changes to this field result in an update of the numbers listed in the Call Pickup Group field.

You can configure calling search space for Forward All, Forward Busy, Forward No Answer, and Forward on Failure directory numbers. The value you choose applies to all devices that are using this directory number.

If you set the Forward All Calling Search Space field to <None>, Unified CM uses the calling search spaces of the line and the phone when the user forwards calls by using the Cisco IP Phone User Options window or the CFwdAll softkey on the phone.

To restrict users from forwarding calls on their phones, choose a restrictive calling search space from the Forward All Calling Search Space field.

For example, assume you have two calling search spaces: Building and PSTN. Building only allows users to call within the building, while PSTN allows users to call both in and outside the building. You could assign the phone to the Building calling search space and the line on your phone to the PSTN calling search space. If you set the Call Forward All calling search space to <None>, Unified CM can forward calls to any number within the PSTN or building calling search spaces. To prevent a user from forwarding calls to numbers outside the building, set the Call Forward All calling search space to Building. For more information, see the *Cisco Unified Communications Manager System Guide*.

Presence Group | A list of groups to integrate the device with the iPass server. The device/line information is provided to integrating applications.

**Call Forward and Pickup Settings**
Step 5  Click Add.

The Unified CM Telephony Trigger Configuration summary web page opens, and displays the new Unified CM Telephony trigger.

Related Topics
- Resynchronizing the Cisco JTAPI Client, page 6-7
- Configuring a Unified CM Telephony Provider, page 6-8
- Adding a New Unified CM Telephony Call Control Group, page 6-9
- Additional Unified CM Telephony Information, page 6-21
Additional Unified CM Telephony Information

This section includes the following topics:

- Provisioning Unified CM Telephony Triggers for Unified CCX Queuing, page 6-21
- Resynchronizing Unified CM Telephony Information, page 6-21
- Unified CM Telephony Provider Migration, page 6-23

Provisioning Unified CM Telephony Triggers for Unified CCX Queuing

When limiting the number of calls per application in Unified CCX applications, you need to take care to coordinate the Unified CM Telephony trigger Maximum Number of Sessions limit with the Media Group session limit.

For example, say you are using Unified CCX for queuing calls and set the Unified CM Telephony trigger Maximum Number of Sessions limit on Unified CCX to 4 and set the Call Forward and Pickup Settings to send the fifth call to voice mail. To make this happen, you must configure the Media Group Session Limit to the identical setting (4). This will cause Unified CM to forward the next incoming call to voice mail (once the CTI New Call Accept timer setting expires).

The drawback of this approach is that you need to define more media groups for each application and you cannot share the same set of media groups across multiple applications.

Related Topics
Provisioning the Unified CM Telephony Subsystem, page 6-5

Resynchronizing Unified CM Telephony Information

If the Unified CM Telephony information (Unified CM Telephony users, CTI ports, triggers) in the Unified CM is missing or not in sync with CRS data, click the Resynchronize hyperlink on the Unified CM Telephony Configuration pages. CRS then:

- Checks whether:
- The Unified CM Telephony users exist in Unified CM.
- All the ports belonging to the Port Group exist in Unified CM.
- The Port Group’s data is in sync with Ports data in Unified CM.
- The Ports’ association to users are correct.
- The Route Point exist in Unified CM.
- The Triggers data is in sync with the Route Point data in the Unified CM.
- The Route Points have been associated with all the Unified CM Telephony users in Unified CM.

- Synchronizes the data by:
  - Creating any missing users.
  - Creating any missing ports.
  - Modifying out-of-sync ports.
  - Associating CTI Ports to Unified CM Telephony users. (For example, associating CTI Ports created for Node 1 to the Unified CM Telephony User for Node 1, and so forth.)
  - Creating any missing route points.
  - Modifying out-of-sync route points.
  - Associating route points to all the Unified CM Telephony users.
  - Automatically detects the Unified CM Telephony client used by the specified Unified CM server and installs this client on the Cisco CRS server.

**Related Topics**

Provisioning the Unified CM Telephony Subsystem, page 6-5
Unified CM Telephony Provider Migration

If you need to migrate to a new Unified CM (or Unified CM cluster), enter the new Unified CM host name/IP address, user prefix and password. If CRS is able to contact the new Unified CM, it will present three options:

- Remove all the Unified CM Telephony Information (Unified CM Telephony Users, Unified CM Telephony Port Groups, Unified CM Telephony Triggers) from the current Unified CM and create all new Unified CM Telephony Information in the new Unified CM.

  If you choose this option and any of the Unified CM Telephony users or triggers already exist on the new Unified CM, the migration process stops and a message displays indicating the reason. However, if any of the CTI Ports in a PG already exist in the new Unified CM, the migration will proceed, as it will not use the existing CTI Port and will try to use the next available CTI Port number.

- Update only the Unified CM Telephony Provider information. If you choose this option, the provider information is only stored in the CRS configuration datastore and not in Cisco Unified CM. You will need to recreate all Port Groups and triggers.

- Cancel the entire operation.

Related Topics
Provisioning the Unified CM Telephony Subsystem, page 6-5

Provisioning the Cisco Media Subsystem

The Cisco Media subsystem is a subsystem of the CRS Engine. The Cisco Media subsystem manages the CMT media resource. CMT channels are required for CRS to be able to play or record media.

The Cisco Media subsystem uses dialog groups to organize and share resources among applications. A dialog group is a pool of dialog channels in which each channel is used to perform dialog interactions with a caller, during which the caller responds to automated prompts by pressing buttons on a touch-tone phone.
Note

The built-in grammars and grammar options that are supported by Cisco CRS when using an MRCP dialog channel is determined by the MRCP speech software you purchase. Refer to the software vendor for information about what built-in grammars and features are supported.

To enable your CRS applications to handle simple DTMF-based dialog interactions with customers, you will need to provision the Cisco Media subsystem to configure CMT dialog groups.

Caution

All media termination strings begin with auto and contain the same ID as the call control group—not the CMT dialog group. If the default media termination is configured and the ID differs, follow the procedure provided in the “Adding a CMT Dialog Control Group” section on page 6-24.

Related Topics

- Adding a New Unified CM Telephony Call Control Group, page 6-9
- The Cisco Media Menu Option, page 20-24

## Adding a CMT Dialog Control Group

To add a CMT dialog control group, complete the following steps.

**Procedure**

1. From the CRS Administration menu bar, choose **Subsystems > Cisco Media**.

   The CMT Dialog Group Configuration summary web page opens. Any preconfigured entry is listed on this page along with the Group ID, Description and Channel information.
Provisioning the Cisco Media Subsystem

Step 2  Click the Add a New CMT Dialog Control Group hyperlink.

The CMT Dialog Group Configuration web page opens.

Step 3  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupID</td>
<td>The unique Group ID associated with the media.</td>
</tr>
<tr>
<td>Description</td>
<td>CMT group description.</td>
</tr>
<tr>
<td>Number Of Licensed IVR ports</td>
<td>Display only. Number of licensed IVR ports.</td>
</tr>
<tr>
<td>Maximum Number Of Channels</td>
<td>Maximum number of channels associated with this group.</td>
</tr>
</tbody>
</table>

Note: The ID in this field need not necessarily match the CMT group ID.

You are now ready to provision MRCP ASR and MRCP TTS subsystems.

Related Topics

- Provisioning the Cisco Media Subsystem, page 6-23
Provisioning ASR and TTS in Cisco CRS

Cisco CRS supports ASR and TTS through two subsystems:

- MRCP ASR—This subsystem allows users to navigate through a menu of options by speaking instead of pressing keys on a touch-tone telephone.
- MRCP TTS—This subsystem converts plain text (UNICODE) into spoken words in order to provide a user with information or prompt a user to respond to an action.

Related Topics
- Before You Provision ASR/TTS, page 6-26
- Provisioning the MRCP ASR Subsystem, page 6-27
- Provisioning the MRCP TTS Subsystem, page 6-34

Before You Provision ASR/TTS

It is the responsibility of the customer to perform the following tasks:

- Order ASR/TTS speech servers from Cisco-supported vendors.

Note

See the Cisco Customer Response Solutions (CRS) Software and Hardware Compatibility Guide at the following web site:

- Work with the ASR/TTS vendor to size the solutions.
- Provision, install, and configure the ASR/TTS vendor software.
- Before uploading an ASR/TTS script to CRS Administration, validate the script against the capabilities and specifications supported by the ASR/TTS vendor.

In addition, please note the following guidelines regarding Cisco CRS deployment with ASR/TTS speech servers:
• Do not install ASR/TTS applications on a server that is running a Cisco CRS component.
• Do not install ASR/TTS applications on a server that is running Cisco Unified CM.
• Do not install ASR/TTS software from different vendors on the same server.

Provisioning the MRCP ASR Subsystem

The MRCP ASR subsystem allows users to navigate through a menu of options by speaking instead of pressing keys on a touch-tone telephone. When a user calls local directory assistance, for example, ASR can prompt the user to say the city and state in which to locate the information, then connect the user to an appropriate operator.

To provision the MRCP ASR subsystem, define the following information:

• MRCP ASR Providers—Information about the vendor of your speech server, including the number of licenses and the grammar type (see Provisioning MRCP ASR Providers, page 6-28).

Note
If you delete an ASR/TTS provider and all of its associated servers and then create a new ASR/TTS provider, its status might become IN_SERVICE immediately, even before you create any servers for it. In this situation, click Refresh for that ASR/TTS provider, or click Refresh All. These actions change the status of the ASR/TTS provider to OUT_OF_SERVICE.

• MRCP ASR Servers—Information about the ASR server’s name, port location, and available languages (see Provisioning MRCP ASR Servers, page 6-29).

• MRCP ASR Groups—Information about the MRCP ASR dialog control groups and associated locales, which enable CRS applications to use speech recognition (see Provisioning MRCP ASR Dialog Groups, page 6-31).

Related Topics
• Before You Provision ASR/TTS, page 6-26
• Provisioning the MRCP TTS Subsystem, page 6-34
 Provisioning MRCP ASR Providers

Use the MRCP ASR Provider Configuration web page to specify information about the vendor of your speech server.

**Note**
After you update MRCP ASR/TTS Providers, Servers, and Groups, the corresponding Provider needs to be Refreshed for changes to take effect. The CRS Engine does not need to be restarted. However, during a Refresh, Unified CM Telephony triggers using affected groups will fall back to the dialog group that is configured and the MRCP Provider being refreshed will go OUT_OF_SERVICE until the reload is complete.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Subsystem > MRCP ASR**.
The MRCP ASR Providers list web page opens, displaying the list of currently configured MRCP Providers, licenses, and the corresponding status.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider</td>
<td>MRCP ASR Providers configured by the Cisco CRS Administrator.</td>
</tr>
<tr>
<td>License</td>
<td>The number of ASR port licenses purchased from the ASR vendor.</td>
</tr>
<tr>
<td>Status</td>
<td>Status or state of the subsystem.</td>
</tr>
</tbody>
</table>

**Step 2**
Click the **Add MRCP ASR Provider** hyperlink.
The MRCP ASR Provider Configuration web page opens.

**Step 3**
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Name</td>
<td>Enter the name of the MRCP ASR provider supported by Cisco CRS.</td>
</tr>
</tbody>
</table>
Provisioning ASR and TTS in Cisco CRS

Chapter 6      Provisioning Telephony and Media

Provisioning ASR and TTS in Cisco CRS

Step 4
Click Add to apply changes.
Your changes appear in the MRCP ASR Providers List page. You are now ready to provision MRCP ASR Servers.

Related Topics
- Provisioning MRCP ASR Servers, page 6-29
- Provisioning MRCP ASR Dialog Groups, page 6-31

Provisioning MRCP ASR Servers

Use the MRCP ASR Server Configuration web page to specify information about the speech server’s name, port location, and available language.

Note
You must have a MRCP ASR Provider defined before you can provision a MRCP ASR Server.

Procedure

Step 1
From the CRS Administration menu bar, choose Subsystem > MRCP ASR.
The MRCP ASR Configuration summary web page opens, displaying the MRCP Providers area.

Step 2
Click the MRCP ASR Servers hyperlink.
The MRCP ASR Server List web page opens to display a list of previously configured servers, if applicable.
Provisioning ASR and TTS in Cisco CRS

Chapter 6      Provisioning Telephony and Media

Provisioning ASR and TTS in Cisco CRS

Step 3
Click the **Add MRCP ASR Server** hyperlink.

The MRCP ASR Server Configuration web page opens.

Step 4
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Host name or IP address of the server in which the ASR server software is installed.</td>
</tr>
<tr>
<td>Port Name</td>
<td>TCP port numbers used to connect to a MRCP server:</td>
</tr>
<tr>
<td></td>
<td>- Nuance SWMS Server - 4900</td>
</tr>
<tr>
<td></td>
<td>- Nuance MRCP Server - 554</td>
</tr>
<tr>
<td></td>
<td>- IBM WVS - 554</td>
</tr>
<tr>
<td>Provider Name</td>
<td>The MRCP ASR Provider to which this server is associated.</td>
</tr>
<tr>
<td>Status</td>
<td>Status or state of the subsystem.</td>
</tr>
</tbody>
</table>

**Field**

**Description**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Name</td>
<td>Drop-down list. Select the name of the MRCP ASR Provider to which this server is associated.</td>
</tr>
<tr>
<td>Server Name</td>
<td>Host name or IP address of the server the MRCP ASR server software is installed on.</td>
</tr>
<tr>
<td>Port Number</td>
<td>TCP port numbers used to connect to a MRCP server:</td>
</tr>
<tr>
<td></td>
<td>- Nuance SWMS Server - 4900</td>
</tr>
<tr>
<td></td>
<td>- Nuance MRCP Server - 554</td>
</tr>
<tr>
<td></td>
<td>- IBM WVS - 554</td>
</tr>
<tr>
<td>Provider Name</td>
<td>Select the name of the MRCP ASR Provider this server is associated with from the drop down list.</td>
</tr>
<tr>
<td>Locales</td>
<td>Languages supported by the ASR Provider. Select a language (or multiple languages) from the drop-down list and click <strong>Add</strong> Language; the selected language appears in the Enabled Language list.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Use the check box to disable/enable a language.</td>
</tr>
</tbody>
</table>

Step 5
Click **Add** to apply changes.
Your changes appear in the MRCP ASR Server list web page. You are now ready to provision MRCP ASR Groups.

Related Topics
- Provisioning MRCP ASR Providers, page 6-28
- Provisioning MRCP ASR Dialog Groups, page 6-31

Provisioning MRCP ASR Dialog Groups

Use the MRCP Groups Configuration web page to specify information about MRCP ASR dialog control groups, which enable CRS applications to use speech recognition.

Note
You must have a MRCP ASR Provider defined before you can provision a MRCP ASR Group. Also, you should configure MRCP ASR Servers for the specific MRCP Provider before configuring the MRCP ASR Groups. This allows users to configure languages for the groups based on the languages supported by the configured servers.

Procedure

Step 1
From the CRS Administration menu bar, choose Subsystem > MRCP ASR. The MRCP ASR Providers list web page opens, displaying the MRCP Providers area.

Step 2
Click the MRCP ASR Dialog Groups hyperlink. The MRCP ASR Dialog Group Configuration web page opens to display a list of preconfigured entries, if applicable.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Of Licensed IVR Ports</td>
<td>Display only.</td>
</tr>
<tr>
<td>Group ID</td>
<td>Identifier for the group.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this dialog group.</td>
</tr>
</tbody>
</table>
Step 3  Click the Add MRCP ASR Dialog Control Group hyperlink.

The MRCP ASR Dialog Group Configuration web page opens.

Step 4  Use this web page to specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider</td>
<td>Name of the MRCP ASR provider</td>
</tr>
<tr>
<td>Channels</td>
<td>Maximum number of sessions.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>Associated group ID.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this dialog group.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>Include languages that will be used by this Group to the description. Doing so will provide insight to the languages this Group uses when you set up the dialog group in the Unified CM Telephony trigger configuration. This also ensures that the locales used by the application configured in the Unified CM Telephony trigger match the locales supported by the MRCP ASR dialog group being selected.</td>
</tr>
<tr>
<td>Number Of Provider Licenses</td>
<td>Display only.</td>
</tr>
<tr>
<td>Number Of Licensed IVR Ports</td>
<td>Display only.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Number Of sessions</td>
<td>Maximum number of sessions associated with this dialog group.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>You can assign any value for Maximum Number Of Channels, but restrictions are placed on the system when a call is made. This restriction is imposed by the number of licensed IVR ports on your system.</td>
</tr>
<tr>
<td>Provider Name</td>
<td>Select a MRCP Provider name from the drop-down list that contains a list of all previously defined provider names.</td>
</tr>
<tr>
<td>Enabled Languages</td>
<td>Select the language(s) that you wish to configure for this group from the list displayed. The displayed languages represent the locales configured for all MRCP ASR servers for the specified provider. If there are no MRCP ASR servers configured, no languages are displayed. In this case, you will need to update the group configuration once MRCP ASR servers have been configured for the specified provider.</td>
</tr>
</tbody>
</table>

### Step 5

Click **Add** to apply changes.

Your changes appear in the MRCP ASR Groups list web page.

### Related Topics
- Provisioning MRCP ASR Providers, page 6-28
- Provisioning MRCP ASR Servers, page 6-29
Provisioning the MRCP TTS Subsystem

The MRCP TTS subsystem converts plain text (UNICODE) into spoken words in order to provide a user with information or prompt a user to respond to an action.

For example, a company might use TTS to read back a customer’s name, address, and telephone number for verification before the company ships a requested product to the customer’s location. Or a customer might dial into a pre-designated phone number, access a voice portal, and listen to the latest weather report or stock quotes. TTS can also convert e-mail text to speech and play it back to the customer over telephone.

To provision the MRCP TTS subsystem, define the following information:

- **MRCP TTS Providers**—Information about the vendor of your TTS system (see Provisioning MRCP TTS Providers, page 6-35).

  Note
  
  If you delete an ASR/TTS provider and all of its associated servers and then create a new ASR/TTS provider, its status might become IN_SERVICE immediately, even before you create any servers for it. In this situation, click Refresh for that ASR/TTS provider, or click Refresh All. These actions change the status of the ASR/TTS provider to OUT_OF_SERVICE.

- **MRCP TTS Servers**—Information about the TTS server’s name, port location, and available languages (see Provisioning MRCP TTS Servers, page 6-37).

- **MRCP TTS Default Genders**—Information about the default gender setting for the Locales specified during TTS Server provisioning (Provisioning MRCP TTS Default Genders, page 6-38).

Note

You will need at least one MRCP TTS Provider for each vendor requiring TTS server installation.

Related Topics

- Before You Provision ASR/TTS, page 6-26
- Provisioning the MRCP ASR Subsystem, page 6-27
Provisioning MRCP TTS Providers

Use the MRCP TTS Providers Configuration web page to specify information about the vendor of your TTS server.

**Note**

After you update MRCP ASR/TTS Providers, Servers, and Groups, the corresponding Provider needs to be Refreshed for changes to take effect. The CRS Engine does not need to be restarted. However, during a Refresh, Unified CM Telephony triggers using affected groups will fall back to the dialog group that is configured and the MRCP Provider being refreshed will go OUT_OF_SERVICE until the reload is complete.

**Procedure**

**Step 1**

From the CRS Administration menu bar, choose **Subsystems > MRCP TTS**. The MRCP TTS Providers List web page opens. If providers are already configured, this page lists the provider name and corresponding status.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Name</td>
<td>MRCP TTS Providers supported by Cisco CRS.</td>
</tr>
<tr>
<td>Status</td>
<td>Status or state of the subsystem.</td>
</tr>
</tbody>
</table>

**Step 2**

Click the **Add MRCP TTS Provider** hyperlink. The MRCP TTS Provider Configuration web page opens. Use this web page to specify the choose the MRCP TTS Provider supported by Cisco CRS.

To change the Provider Name, click **Edit** and modify the name of the provider. When you edit a Provider Name, the new name is added to the drop-down list.

The information in the Provider Name list is stored in the property file that is synchronized across the cluster. Changes are reflected when you use the Create TTS Prompt step in the CRS Editor; the new Provider will be available for use by the CRS Editor.
Step 3  Click **Add** to apply changes.  
Your changes appear in the MRCP TTS Providers list web page. You are now ready to provision MRCP TTS Servers.

**Related Topics**

- Configure the Default TTS Provider for the CRS System, page 6-36
- Provisioning MRCP TTS Servers, page 6-37
- Provisioning MRCP TTS Default Genders, page 6-38

**Configure the Default TTS Provider for the CRS System**

Optionally, you can configure a default TTS provider. The Cisco CRS Prompt Manager uses the default TTS provider for rendering TTS prompts if a TTS provider is not configured in the TTS Prompt. This usually happens in the case of VXML applications.

To configure a default TTS provider, follow these steps.

**Step 1**  Select **System > System Parameters**.

**Step 2**  In the Default TTS Provider drop down list, choose the provider you wish to be the system default.

**Note**  If you are deploying an VXML applications and the only TTS functionality you need is to play prerecorded .wav files, select the **Cisco LiteSSMLProcessor** option as the Default TTS Provider. This option allows you to execute SSML that has .wav file references in them.

**Step 3**  Click **Update**.
Provisioning MRCP TTS Servers

On any MRCP TTS Configuration web page, click the **MRCP TTS Server** hyperlink on the navigation bar to configure the TTS server’s name, port location, and available languages.

You need at least one MRCP TTS Server associated with each configured provider.

**Note**

You must have a MRCP TTS Provider defined before you can provision a MRCP TTS Server.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Subsystems > MRCP TTS**.

The MRCP TTS Providers List web page opens.

**Step 2**
Click the **MRCP TTS Servers** hyperlink.

The MRCP TTS Servers Configuration summary web page opens.

**Step 3**
Click the **Add MRCP TTS Server** hyperlink.

The MRCP TTS Server Configuration web page opens.

**Step 4**
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Host name or IP address of the server the MRCP TTS server software is installed on.</td>
</tr>
<tr>
<td>Port</td>
<td>TCP port numbers used to connect to a MRCP server:</td>
</tr>
<tr>
<td></td>
<td>• Nuance SWMS Server - 4900</td>
</tr>
<tr>
<td></td>
<td>• Nuance MRCP Server - 554</td>
</tr>
<tr>
<td></td>
<td>• IBM WVS - 554</td>
</tr>
</tbody>
</table>
Step 5  Click Add to apply changes.

Your changes appear in the MRCP TTS Server List web page. You are now ready to provision MRCP TTS Default Genders.

Note  Whenever a new language is added for a MRCP Server—and if this is the first instance of this language being added for the corresponding MRCP Provider—then the default gender for that locale and for the specified provider is set to Neutral. You should check the MRCP Locales page to review the default genders that are set automatically per locale per provider. Default genders are used when a prompt for a specific locale is used without specifying any gender.

Related Topics
- Provisioning MRCP TTS Providers, page 6-35
- Provisioning MRCP TTS Default Genders, page 6-38

Provisioning MRCP TTS Default Genders

Use the MRCP TTS Default Genders Configuration web page to configure the default gender settings per Locale per Provider. TTS uses default genders when a prompt for a specific locale is used without specifying the gender.

Procedure

Step 1  From the CRS Administration menu bar, choose Subsystems > MRCP TTS.
The MRCP TTS Configuration summary web page opens.

Step 2  Click the **MRCP TTS Default Genders** hyperlink.

The MRCP TTS Default Genders Configuration web page displays the default genders currently configured for each locale for every MRCP TTS Provider that is currently configured.

Step 3  Optionally, change the default gender setting for each locale for each provider.

*Note*  The Locale radio button has the Male, Female, or Neutral options. By default, the “Default Gender” is set to “Neutral” unless configured explicitly.

Step 4  Click **Update** to apply changes.

The system updates the default gender setting for each Locale per Provider.

**Related Topics**
- Provisioning MRCP TTS Providers, page 6-35
- Provisioning MRCP TTS Servers, page 6-37
Provisioning Unified CCX

To provision the Cisco Unified Contact Center Express (Unified CCX) subsystem, you must provision your telephony and media resources (see the “About CRS Telephony and Media” section on page 6-2).

Tip
This section is common to both the Unified CM and Unified CME deployments. Where applicable, a note calls attention if a particular section does not apply to Unified CME.

The following topics introduce the Unified CCX subsystem and explain how to provision it in the Cisco CRS system.

- Configuring the RmCm Provider, page 7-2
- Configuring Resource Groups, page 7-4
- Configuring Skills, page 7-7
- Configuring Agents, page 7-10
- Configuring Contact Service Queues, page 7-17
- Configuring and Using Remote Monitoring, page 7-29
- Configuring Agent-Based Routing, page 7-33
- Configuring Teams, page 7-34
- Unified Gateway Auto-Configuration Details, page 7-40
Configuring the RmCm Provider

The Unified CCX Resource Manager (RM) uses a Unified CM/Unified CME Telephony user (called the RmCm Provider) to monitor agent phones, control agent states, and route and queue calls.

**Note**
For unified CME, the concept of RmCm user does not exist. The AXL Service provider account is used to preform this task.

**Note**
The RmCm user specified through CRS Administration is updated automatically in Unified CM.

After adding the RmCm Provider, you must explicitly associate each agent’s extension in Unified CM/Unified CME to the RmCm Provider.

This section contains the following topics:

- Provisioning the RmCm Provider, page 7-2
- Associating Agent Extensions with the RmCm Provider, page 7-3
- Modifying RmCm Provider Information, page 4-10

**Provisioning the RmCm Provider**

**Note**
This section only applies to Cisco CRS Deployments with Unified CM.

**Caution**
While Unified CM supports Unicode characters in first and last names, those characters become corrupted in Cisco CRS Administration web pages for RmCm configuration, Real Time Reporting, Cisco Agent/Supervisor Desktop, and Historical Reports.

The RmCm Providers area of the RmCm Configuration web page is a read-only page that displays the latest configured information.
To modify the RmCm Provider, click the **Modify Unified CM Telephony Provider Information** hyperlink (see **Modifying RmCm Provider Information**, page 4-10).

The table below describes the read-only fields displayed in the RmCm Provider page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RmCm Provider(s)</td>
<td>The host name or IP address of the Cisco Media Convergence Server (Cisco MCS) running CTI Manager. The RmCm subsystem registers with the CTI manager so that it can observe an agent's device when the agent logs in. When the CTI manager fails, the RmCm subsystem registers with the second CTI manager, if there is one configured.</td>
</tr>
<tr>
<td>User ID</td>
<td>The RmCm user ID.</td>
</tr>
<tr>
<td>Password/Confirm Password</td>
<td>Password for the RmCm user.</td>
</tr>
</tbody>
</table>

**Related Topic**

*Modifying RmCm Provider Information, page 4-10*

**Associating Agent Extensions with the RmCm Provider**

**Note**

This section only applies to Cisco CRS Deployments with Unified CM.

For every agent/resource created in Unified CM make sure that the agent extension is also associated with the RmCm Provider. You do this from the Unified CM User Page for the RmCm Provider. In other words, even though you create the RmCm User in CRS Administration, you still need to use the Unified CM interface to associate the RmCm user with an agent extension. These phones are the same as those associated with each agent (see **Assigning Unified CM Users as Unified CCX Agents, page 4-19**).
Configuring Resource Groups

Resource groups are collections of agents that your CSQ uses to handle incoming calls. To use resource group-based CSQs, you must specify a resource group.

This section describes:

- Creating a Resource Group, page 7-4
- Modifying an Existing Resource Group Name, page 7-5
- Deleting a Resource Group, page 7-6

Creating a Resource Group

To create a resource group, complete the following steps.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>From the CRS Administration menu bar, choose <strong>Subsystems &gt; RmCm</strong>. The RmCm Configuration web page opens, displaying the RmCm Provider area.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>On the RmCm Configuration navigation bar, click the <strong>Resource Groups</strong> hyperlink. The Resource Groups summary web page opens with a list of configured resource groups (if any).</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Click the <strong>Add a New Resource Group</strong> hyperlink. The Resource Group Configuration area opens.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>In the Resource Group Name field, enter a resource group name. Enter a name that identifies the resource group to which you want to assign agents (for example, “Languages”).</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Click <strong>Add</strong>. The Resource Groups summary page opens, displaying the resource group name in the Resource Group Name column.</td>
</tr>
</tbody>
</table>
Modifying an Existing Resource Group Name

To modify a resource group name, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose Subsystems > RmCm.

The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2  On the RmCm Configuration navigation bar, click the Resource Groups hyperlink.

The Resource Groups summary web page opens.

Step 3  In the Resource Group Name column, click the resource group that you want to modify.

The Resource Group Configuration area opens.

Step 4  Type the name of the resource group in the Resource Group Name text field.

Step 5  Click Update to apply the modifications.

The Resource Groups area opens, displaying the modified resource group name in the Resource Group Name column.

Related Topics

- Creating a Resource Group, page 7-4
- Deleting a Resource Group, page 7-6
Deleting a Resource Group

When you delete a resource group, the resource group is removed automatically from any agents and CSQs to which it was assigned. Before deleting a resource group, reassign agents or CSQs to different or new resource groups.

Tip

To delete resource groups, you can use this procedure or use the **Delete** button in the Resource Group Configuration web page.

To delete a resource group, complete the following steps.

**Procedure**

**Step 1** From the CRS Administration menu bar, choose **Subsystems > RmCm**.
The RmCm Configuration web page opens, displaying the RmCm Provider area.

**Step 2** On the RmCm Configuration navigation bar, click the **Resource Groups** hyperlink.
The Resource Groups summary web page opens.

**Step 3** Click the **Delete** icon next to the name of the Resource Group that you want to delete.
A dialog box opens, warning that the resource group is about to be permanently deleted.

**Step 4** Click **Continue**.
The resource group is deleted.

**Related Topics**

- Creating a Resource Group, page 7-4
- Modifying an Existing Resource Group Name, page 7-5
Configuring Skills

Note

The Skills hyperlink is available only if you are using Unified CCX Enhanced or Premium license packages.

Skills are customer-definable labels assigned to agents. The two Unified CCX Enhanced packages can route incoming calls to agents who have the necessary skill or sets of skill to handle the call.

This section describes:

- Creating a Skill, page 7-7
- Modifying an Existing Skill Name, page 7-8
- Deleting a Skill, page 7-9

Creating a Skill

To create a skill, complete the following steps.

Procedure

Step 1
From the CRS Administration menu bar, choose Subsystems > RmCm.
The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2
On the RmCm Configuration navigation bar, click the Skills hyperlink.
The RmCm Configuration Skills summary web page opens to display the Skill Name (customer-definable label assigned to an agent), if configured.

Step 3
Click the Add a New Skill hyperlink.

Note
When the system reaches the maximum number of skills that can be created, the Add a New Skill hyperlink no longer appears.

The Skill Configuration web page opens.
Step 4  In the Skill Name field, enter a description of a relevant skill (for example, French).

Step 5  Click Add.

The RmCm Configuration Skills summary web page opens, showing the skill in the Skill Name column and the total number of skills that exist in the system.

Related Topics
- Modifying an Existing Skill Name, page 7-8
- Deleting a Skill, page 7-9

Modifying an Existing Skill Name

To modify a skill name, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose Subsystems > RmCm.

The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2  On the RmCm Configuration navigation bar, click the Skills hyperlink.

The Skills Configuration summary web page opens.

Step 3  In the Skill Name column, click the skill that you want to modify.

The Skill Configuration web page opens.

Step 4  Modify the name of the skill in the Skill Name text field.

Step 5  Click Update to apply the modifications.

The Skills Configuration summary opens, displaying the modified skill name in the Skill Name column.

Related Topics
- Creating a Skill, page 7-7
Deleting a Skill

When you delete a skill, the skill is removed automatically from any agents and CSQs to which it was assigned. Before deleting a skill, reassign agents or CSQs to different or new skills.

Tip

To delete skills, you can use this procedure or use the Delete button in the Skills Configuration web page.

To delete a skill, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose Subsystems > RmCm.

The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2  On the RmCm Configuration navigation bar, click the Skills hyperlink.

The RmCm Configuration Skills summary web page opens.

Step 3  Click the Delete icon next to the name of the skill that you want to delete.

A dialog box opens, warning that the skill is about to be permanently deleted.

Step 4  Click Continue.

The skill is deleted.

Related Topics

- Creating a Skill, page 7-7
- Modifying an Existing Skill Name, page 7-8
Configuring Agents

Warning

**Do not configure Unified CM users using Administrator/ciscocisco as the user name/password combination when logging into the CRS Administrator. Doing so may restrict the Unified CM when shared across multiple Cisco CRS servers.**

Once Cisco Unified Communications users are defined as agents, the list of agents and their associated Unified CCX Extensions are displayed in the RmCm > Resources page. These agents are also called resources. After you create a resource group, you can assign agents (resources) to that group.

If you have the Unified CCX Enhanced or the Premium package, you can add skills to agents once the skills have been created. You can also select the competence level of the agent(s) in assigned skills. Competence level indicates the agent’s level of expertise in that skill.

You can assign resource groups and skills to agents either individually or in bulk. The bulk option enables you to assign skills and resource groups to multiple agents at the same time.

Once you assign agents to resource groups and skills (if you are using either of the Unified CCX Enhanced versions), you can create a CSQ (see Configuring Contact Service Queues, page 7-17)

This section describes:

- Implications of Deleting Agents in Unified CM, page 7-11
- Assigning Resource Groups and Skills to One Agent, page 7-12
- Assigning Resource Groups and Skills to Multiple Agents, page 7-14
- Removing Skills from Agents, page 7-16

Related Topics

- Modifying an Existing Resource Group Name, page 7-5
- Deleting a Resource Group, page 7-6

---

1. Unified Communications users in a Unified CM deployment refers to a Unified CM user. Unified Communications users in a Unified CME deployment refers to a Cisco CRS user.
Implications of Deleting Agents in Unified CM

Note

This section only applies to Cisco CRS Deployments with Unified CM.

Agent information on the Unified CM is updated in Unified CCX at 10-minute intervals. If you modify an agent’s record in Unified CM (for example, changing the Unified CCX extension or deleting the agent), the agent’s information in the Unified CCX RmCm subsystem is updated at the next interval. You can update the Unified CCX information in the CRS Administration at any time by selecting Subsystems > RmCm and clicking the Resources hyperlink. If you change the Unified CCX extension of an agent who is currently logged in, the agent will continue to use the old extension until the agent logs off. The agent must log off and then log back in to the Cisco Agent Desktop to get the new extension.

When Cisco CRS detects that the agent no longer exists in Unified CM, it does not automatically delete that agent from the Cisco CRS database. Instead, the Cisco CRS Resources page displays a new link called Inactive Agents. When you click this link, Cisco CRS displays a list of agents deleted from Unified CM but still existing in the CRS database. In this case, select the agents to delete from Cisco CRS by checking the check box next to the required agent (or select all agents for deletion by clicking Check All). Then click Delete to remove the selected agents from the Cisco CRS database. Unless you follow this procedure, agents deleted in Unified CM will continue to appear in the agents list in the Cisco CRS Resources page, but they will not be able to log in as the Unified CM authentication will not be successful.

Caution

If Unified CM connection errors have occurred, all agents will not be visible to Cisco CRS. In this case, Cisco CRS interprets these agents as deleted agents. As a result, the Inactive Agents list will not be accurate. When the errors are resolved, click Inactive Agents again to see an accurate list.

Related Topics

- Defining Unified CM Users as Agents, page 4-15
- Assigning Resource Groups and Skills to One Agent, page 7-12
- Assigning Resource Groups and Skills to Multiple Agents, page 7-14
- Removing Skills from Agents, page 7-16
Assigning Resource Groups and Skills to One Agent

To assign a resource group and skills to an individual agent, complete the following steps.

Procedure

Step 1
From the CRS Administration menu bar, choose **Subsystems > RmCm**.
The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2
On the RmCm Configuration navigation bar, click the **Resources** hyperlink.

*Note* Only agents or supervisors who have assigned Unified CCX extensions are displayed in the list of resources in the Resources area.

The Resources summary web page opens.

Step 3
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Name</td>
<td>Name of the agent.</td>
</tr>
<tr>
<td>Resource Group</td>
<td>Resource group to which the agent has been assigned.</td>
</tr>
<tr>
<td>Unified CCX Extension</td>
<td>Unified CCX Extension assigned to the resource group.</td>
</tr>
<tr>
<td>Team</td>
<td>A group of agents who report to the same supervisor.</td>
</tr>
</tbody>
</table>

Step 4
Click the name of the agent in the Resource Name column.
The Resource Configuration web page opens.

Step 5
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Group</td>
<td>(Optional). A resource group with which to associate the agent.</td>
</tr>
<tr>
<td>Resource ID</td>
<td>Unique identifying number of the agent.</td>
</tr>
<tr>
<td>Unified CCX Extension</td>
<td>Unified CCX Extension assigned to the resource group.</td>
</tr>
</tbody>
</table>
Click **Update** to apply the changes.

The Resources area of the RmCm Configuration summary web page opens, and the agent is now assigned to the resource group and skills (if skills were assigned).

### Related Topics

- Implications of Deleting Agents in Unified CM, page 7-11
- Assigning Resource Groups and Skills to Multiple Agents, page 7-14
- Removing Skills from Agents, page 7-16
Assigning Resource Groups and Skills to Multiple Agents

To assign resource groups and skills to agents in bulk, complete the following steps.

**Procedure**

**Step 1**  
From the CRS Administration menu bar, **Subsystems > RmCm**.  
The RmCm Configuration web page opens, displaying the RmCm Provider area.

**Step 2**  
On the RmCm Configuration navigation bar, click the **Assign Skills** hyperlink.

**Note**  
The Assign Skills hyperlink is available only if you are using Unified CCX Enhanced or Premium license packages.

**Tip**  
Only agents or supervisors who have assigned Unified CCX extensions are displayed in the list of resources in the Resources area.

The Assign Skills summary web page opens.

**Step 3**  
Use this web page to specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Name</td>
<td>Contains the agent’s name.</td>
</tr>
<tr>
<td>Resource Group</td>
<td>Contains the resource group assigned to the agent.</td>
</tr>
<tr>
<td>Unified CCX Extension</td>
<td>Contains the Unified CCX extension of the agent.</td>
</tr>
</tbody>
</table>

**Step 4**  
In the Resource Name column, check the check box next to each agent you want to assign to the same resource group and/or skills.

**Note**  
You can check the Select All check box to select all agents.

The Skill summary web page shows the total number of skills created.

**Step 5**  
Click the Add Skill hyperlink.
The Add Skill Configuration web page opens.

**Step 6** Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Group</td>
<td>(Optional). To assign all selected agents to the same resource group, choose a resource group from the Resource Group drop-down menu.</td>
</tr>
<tr>
<td>Skills to Add</td>
<td>Applies to Unified CCX Enhanced packages, only. Selecting one or more skills from the Skills list and clicking ‹ to add the skills to the Skills to Add List.</td>
</tr>
<tr>
<td>Note</td>
<td>The Skills to Add list contains all skills, not just skills that agents already have. Your Unified CCX license package determines the number of skills you can assign to agents.</td>
</tr>
<tr>
<td>Skills</td>
<td>List of the available skills.</td>
</tr>
<tr>
<td>Competence Level</td>
<td>Applies to Unified CCX Enhanced packages, only. Select a skill from the Assigned Skills list and choosing a number from the Competence Level drop-down menu</td>
</tr>
</tbody>
</table>

**Step 7** Click **Update** to apply the changes.

The Assign Skills area of the RmCm Configuration web page opens, and the agents are now assigned to the resource group and skills (if skills were assigned).

**Related Topics**

- Implications of Deleting Agents in Unified CM, page 7-11
- Assigning Resource Groups and Skills to One Agent, page 7-12
- Removing Skills from Agents, page 7-16
Removing Skills from Agents

Note If a resource is not assigned a skill you attempt to remove, the resource is not updated. However, the system will still generate a related message.

To remove skills from agents, complete the following steps.

Procedure

Step 1 From the CRS Administration menu bar, choose Subsystems > RmCm.

The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2 On the RmCm Configuration navigation bar, click the Assign Skills hyperlink.

The Assign Skill summary web page opens.

Step 3 In the Resource Name column, click the check box next to the agent(s) you want to remove skills from.

Note You can click the Select All check box to select all agents.

Step 4 Click Remove Skill.

The Remove Skill Configuration web page opens.

Step 5 Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skills to Remove</td>
<td>List of skills that can be removed from the selected agents.</td>
</tr>
<tr>
<td>Skills</td>
<td>List of the skills not assigned to the agents.</td>
</tr>
<tr>
<td>Update</td>
<td>Click this button to apply changes.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Click this button to cancel changes.</td>
</tr>
</tbody>
</table>

Step 6 Remove skills by choosing one or more skills from the Skills list and clicking > to move the skills to the Skills to Remove list.

Step 7 Click Update to apply the changes.
The Assign Skills area of the RmCm Configuration web page opens, and the agents are no longer assigned to the skills.

Related Topics
- Implications of Deleting Agents in Unified CM, page 7-11
- Assigning Resource Groups and Skills to One Agent, page 7-12
- Assigning Resource Groups and Skills to Multiple Agents, page 7-14

Configuring Contact Service Queues

The Contact Service Queue (CSQ) controls incoming calls by determining where an incoming call should be placed in the queue and to which agent the call is sent. After you assign an agent to a resource group and/or skills, you need to configure the CSQs.

You assign agents to a CSQ by associating a resource group or skills to the CSQ. Agents in the selected resource group or having the selected skills are assigned to the CSQ.

Skills within the CSQ can be ordered. This means that, when resources are selected, a comparison is done based on the competency level (highest for “most skilled” and lowest for “least skilled”) of the first skill in the list. If there is a “tie,” then the next skill within the order is used, and so on.

Skills within the CSQ can also be weighted. The weight value is an integer from 1 to 1000. Each competency level is multiplied by the skill's associated weight, and a final comparison is done on the sum of all the weighted skill competencies (highest value for “most skilled” and lowest for “least skilled”).

Note For an example of using skill order and weight to determine agent competency level, see “Resource Pool Selection Criteria: Skills and Groups” section on page 7-26.
The maximum number of CSQs in the system depends on the type of server on which the engine is running. For example, in Cisco CRS Release 5.0(x), the following numbers apply:

- MCS-7845 (or equivalent platform): 150 CSQs
- All other platforms: 25 CSQs


Each agent can belong to up to 25 CSQs. To ensure that agents are not assigned to more than 25 CSQs, click the Resources hyperlink in the RmCm Configuration web page, and select the Open Resources Summary Report hyperlink. The report opens, listing each agent and the number of CSQs to which the agent belongs. If the agent belongs to more than 25 CSQs, modify the CSQ's resource pool or modify the skills to which the agent is assigned.

**Note**

With the Unified CCX Standard package, each agent can be assigned to only one CSQ.

This section describes the following procedures:

- Creating a CSQ, page 7-18
- Modifying an Existing CSQ, page 7-24
- Deleting a CSQ, page 7-25
- Resource Pool Selection Criteria: Skills and Groups, page 7-26
- Resource Skill Selection Criteria Within a CSQ, page 7-27

**Creating a CSQ**

To create a new CSQ and assign agents, complete the following steps.

**Note**

See About Unified CCX, page 3-2 for the number of CSQs that you can create on your system.
Chapter 7  Provisioning Unified CCX

Configuring Contact Service Queues

Procedure

**Step 1**  From the CRS Administration menu bar, choose **Subsystems > RmCm**. The RmCm Configuration web page opens, displaying the RmCm Provider area.

**Step 2**  On the RmCm Configuration navigation bar, click the **Contact Service Queues** hyperlink.

The Contact Service Queues summary web page opens.

**Step 3**  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the resource or skill group.</td>
</tr>
<tr>
<td>Contact Queuing Criteria</td>
<td>Algorithm used to order the queued calls (contacts).</td>
</tr>
<tr>
<td>Resource Pool Selection Model</td>
<td>The resource selection criteria chosen for this CSQ.</td>
</tr>
<tr>
<td>Resource Pool</td>
<td>The skills or resource group used for this CSQ.</td>
</tr>
</tbody>
</table>

**Step 4**  Click the **Add a new Contact Service Queue** hyperlink.

**Note**  If this link does not appear on the page, it means that the system has reached the maximum number of CSQs that can be created. The CSQ Summary page displays the total number of created CSQs.

The first Contact Service Queue Configuration area page opens.
**Step 5** Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Service Queue Name</td>
<td>Create a meaningful name that is concise, yet easy to recognize (for example, LanguageExperts).</td>
</tr>
</tbody>
</table>
| Automatic Work             | Determines whether agents in this CSQ automatically enter Work state after a call. Options are:  
  - Enabled— Causes the agents to go into Work state automatically when a call ends.  
  - Disabled (default)— Causes agents to enter Ready or Not Ready state when a call ends, depending on the Automatic Available setting for the agent.  
  **Note** For more information, see Assigning Resource Groups and Skills to One Agent, page 7-12. |
| Wrapup Time                | Determines the length of the workstate for this CSQ after a call. Options are:  
  - Enabled button with seconds field— The seconds field specifies the length of the workstate phase (greater than 0 second but less than 7200 seconds).  
  - Disabled— No limit on how long the agent can stay in the workstate. |
| Resource Pool Selection Mode | (Drop-down menu.) Select one of the following options:  
  - **Resource Skills** - To create a skills-based CSQ (available only with Unified CCX Enhanced).  
  - **Resource Group** - To create a resource group-based CSQ.  
  **Note** For information about choosing between skill-based or group-based selection, see “Resource Pool Selection Criteria: Skills and Groups” section on page 7-26. |
| Service Level              | The target maximum number of seconds a call is queued before it is connected to an agent. |
Step 6  Click Next.

The second Contact Service Queue Configuration area opens with the newly-assigned CSQ Name.

Step 7  Select an option from the Resource Selection Criteria drop-down menu:

Note  The Resource Pool Selection Mode setting determines the options available in this drop-down menu.

- **Longest Available**—Selects the agent who has been in the Available state for the longest amount of time.

- **Most Handled Contacts**—Selects the agent who has answered the most handled calls.

- **Shortest Average Handle Time**—Selects the agent who generally spends the least amount of time talking to customers.

- **Most Skilled**—Used for expert agent call distribution. Selects the agent with the highest total competency level. The total competency level is determined by adding the agent’s competency levels for each of their assigned skills that are also assigned to the CSQ.
  
  - *Example 1:* If Agent1 is assigned Skill1(5), Skill2(6), and Skill3(7) and CSQ1 specifies Skill1(min=1) and Skill3(min=1), the total competency level for Agent1 for CSQ1 is **12**.
  
  - *Example 2:* If Agent1 is assigned Skill1(5) and Skill2(6) and Skill3(7) and CSQ1 specifies Skill1(min=1), only, the total competency level for Agent1 for CSQ1 is **5**.

- **Least Skilled**—Used for expert agent call distribution. Selects the agent with the lowest total competency level. The total competency level is determined by adding the agent’s competency level in each assigned skill.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Percentage</td>
<td>The target goal for percentage of contacts that meet the service level.</td>
</tr>
<tr>
<td></td>
<td>For example, a call center that has a service level of 20 and a service level percentage of 80 percent has a goal of answering 80 percent of its calls within 20 seconds.</td>
</tr>
<tr>
<td>Prompt</td>
<td>.wav prompt file to associate with the CSQ.</td>
</tr>
</tbody>
</table>
• **Least Skilled by Weight**—Used for expert agent call distribution. Selects the agent with the lowest total competency level multiplied by the skill’s associated weight.

• **Most Skilled by Weight**—Used for expert agent call distribution. Selects the agent with the highest total competency level multiplied by the skill’s associated weight.

• **Most Skilled by Order**—Used for expert agent call distribution. Selects the agent with the highest total competency level in the ordered list.

• **Least Skilled by Order**—Used for expert agent call distribution. Selects the agent with the lowest total competency level in the ordered list.

---

**Note**  
If two or more agents have equal competency level, then the selection automatically defaults to **Longest Available** selection criteria.

---

**Step 8**  
As necessary, specify the following settings:

---

**Note**  
The Resource Pool Selection Mode setting determines the availability of these options.

---

a. Use the Select Skills list to highlight the skills you want; click the **Add** button next to the list.

b. Specify a Minimum Competence Level for the skills assigned to the CSQ.

c. Depending on the Resource pool criteria you chose, specify a Weight value between 1 and 1000.

d. Optionally, use the arrow icons to order the skills by moving them up or down in the list.

---

**Note**  
Use the Delete icon next to a skill to delete that skill from the Skills Required list.

---

**Step 9**  
Click the **Add** button at the top of the configuration web page to apply changes and update the system.

The Resources list is populated with the list of agents who meet the specified criteria. (This list automatically refreshes every 30 seconds.)
Step 10  Optionally, if you selected one of the Least/Most Skilled options as the Resource Selection Criteria, rearrange the order of agents in the Resources list by highlighting an agent and using the up and down arrows to move the agent in the list.

Note  The order of the agents determines the priority, the agent at the top of the list having the highest priority.

Least/Most Skilled Resource Selection Criteria options consist of:

- Most Skilled
- Least Skilled
- Most Skilled by Order
- Least Skilled by Order
- Most Skilled by Weight
- Least Skilled by Weight

Step 11  If you selected Resource Groups as the Resource Pool Selection Model on the previous page, follow these steps:

a.  Select an option from the Resource Selection Criteria drop-down menu:

   - Longest Available—Selects the agent who has been in the Available state for the longest amount of time.
   - Linear—Selects the next available agent with the highest priority, as determined by the agent order in the Resources list.
   - Circular—Selects the next available agent with the highest priority, based on the last agent selected and the agent order in the Resources list.
   - Most Handled Contacts—Selects the agent who has answered the most handled calls.
   - Shortest Average Handle Time—Selects the agent who generally spends the least amount of time talking to customers.
b. Choose the resource group for this CSQ from the Resource Group drop-down menu.

c. Click **Show Resources** to show all agents who meet the specified criteria.

d. If you selected *Linear* or *Circular* as the Resource Selection Criteria, if necessary, rearrange the order of agents in the Resources list by highlighting an agent and using the up and down arrows to move the agent in the list.

e. Click **Add** to apply changes and update the system.

The new CSQ is now displayed, and all agents who belong to the resource group or skill groups selected are now a part of this CSQ.

**Related Topics**

- Modifying an Existing CSQ, page 7-24
- Deleting a CSQ, page 7-25
- Resource Pool Selection Criteria: Skills and Groups, page 7-26
- Resource Skill Selection Criteria Within a CSQ, page 7-27

---

**Modifying an Existing CSQ**

**Note**

Changes take effect when all agents affected by the changes have left the Ready state.

To modify an existing CSQ, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Subsystems > RmCm**.

The RmCm Configuration web page opens, displaying the RmCm Provider area.

**Step 2**
On the RmCm Configuration navigation bar, click the **Contact Service Queues** hyperlink.

The Contact Service Queues area opens.
Chapter 7  Provisioning Unified CCX

Configuring Contact Service Queues

Step 3  In the Name list, click the CSQ that you want to modify.
The first Contact Service Queue Configuration area page opens.

Step 4  Modify the Contact Service Queue Configuration information as necessary.

Step 5  Click **Update** to apply the modifications.

**Related Topics**
- Creating a CSQ, page 7-18
- Deleting a CSQ, page 7-25
- Resource Pool Selection Criteria: Skills and Groups, page 7-26
- Resource Skill Selection Criteria Within a CSQ, page 7-27

**Deleting a CSQ**

When you delete a CSQ, any skills or resource groups assigned to that CSQ are automatically removed from the CSQ, and any application using that CSQ can no longer access it. Before deleting the CSQ, change the applications to use a different CSQ. If the application is using a CSQ when the CSQ is deleted, new incoming calls will get an error and existing queued calls will not be routed to agents.

To delete a CSQ, complete the following steps.

**Procedure**

Step 1  From the CRS Administration menu bar, choose **Subsystems > RmCm**.
The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2  On the RmCm Configuration navigation bar, click the **Contact Service Queues** hyperlink.
The Contact Service Queues area opens.

Step 3  Click the **Delete** icon next to the name of the CSQ that you want to delete.
Note
You can also delete a CSQ from its configuration page.

Related Topics
- Creating a CSQ, page 7-18
- Modifying an Existing CSQ, page 7-24
- Resource Pool Selection Criteria: Skills and Groups, page 7-26
- Resource Skill Selection Criteria Within a CSQ, page 7-27

Resource Pool Selection Criteria: Skills and Groups

The resource selection criteria available for CSQs with Resource Skills is different from that of CSQs with Resource Groups.

Example—In a banking application with two skills (Banking and CreditCard) and one Resource Group (General Queries), assume that the following agents, skills, and resource groups are defined:

<table>
<thead>
<tr>
<th>Agent ID</th>
<th>Assigned Skills</th>
<th>Resource Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent1</td>
<td>Banking (Competence Level 10) CreditCard (Competence Level 6)</td>
<td>GeneralQueries</td>
</tr>
<tr>
<td>Agent2</td>
<td>Banking (Competence Level 5)  CreditCard (Competence Level 10)</td>
<td>GeneralQueries</td>
</tr>
<tr>
<td>Agent3</td>
<td>None</td>
<td>GeneralQueries</td>
</tr>
</tbody>
</table>

In addition, suppose you had the following Contact Service Queue information defined:
In this scenario, if a caller calls with a question about CreditCard information and there are no CSQs currently available with CreditCard skills (that is, Agent1 and Agent2), there is a possibility for Agent3—who has no CreditCard skill—to get selected as the Longest Available Agent.

To avoid such a situation, you could design the script to always look into CSQ2 for available agents since it has the highest competency of 10 for CreditCard, and agent selection here is based on most skilled.

Note
If two or more agents have equal competency level, then the selection automatically defaults to Longest Available selection criteria.

Related Topics
- Creating a CSQ, page 7-18
- Modifying an Existing CSQ, page 7-24
- Deleting a CSQ, page 7-25
- Resource Skill Selection Criteria Within a CSQ, page 7-27

Resource Skill Selection Criteria Within a CSQ

Resource selection within a CSQ is based on the resource competency levels of the skills associated to the CSQ. You can choose between the most and least skilled.
The CRS system defines a Level 10 competency to be the highest skill level, while a Level 1 denotes the lowest skill level. When more than one skill is involved, each skill is given the same weight, meaning no preference is given to any skill. A comparison is performed on the sum of all the competency levels for the associated skills. (Skills assigned to resources but not associated to the CSQ are ignored.) In the case of a tie when skill competencies are equal, the resource that has been ready for the longest amount of time will be chosen.

The table below provides examples of how Cisco CRS selects resources within a CSQ.

**Table 7-2**

<table>
<thead>
<tr>
<th>Example</th>
<th>CSQ Skills</th>
<th>Agent Competency Levels</th>
<th>Sequence Agents Become Ready</th>
<th>Selection Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most skilled resource selection mode</td>
<td>Technical Support</td>
<td>Agent A = 10&lt;br&gt;Agent B = 10&lt;br&gt;Agent C = 5</td>
<td>A, B C&lt;br&gt;C, A, B&lt;br&gt;A, C, B&lt;br&gt;C, B, A</td>
<td>A, B, C&lt;br&gt;A, B, C&lt;br&gt;A, B, C&lt;br&gt;B, A, C</td>
</tr>
<tr>
<td>Least skilled resource selection model</td>
<td>Technical Support</td>
<td>Agent A = 10&lt;br&gt;Agent B = 10&lt;br&gt;Agent C = 5</td>
<td>A, B, C&lt;br&gt;C, A, B&lt;br&gt;A, C, B&lt;br&gt;C, B, A</td>
<td>C, A, B&lt;br&gt;C, A, B&lt;br&gt;C, A, B&lt;br&gt;C, B, A</td>
</tr>
</tbody>
</table>

**Note** The ordering in the two examples above are not opposite because the selection criteria has changed from most to least skilled—when competency levels are equal, both selection models choose the resources that have been available for the longest time.

<table>
<thead>
<tr>
<th>Example</th>
<th>CSQ Skills</th>
<th>Agent Competency Levels</th>
<th>Sequence Agents Become Ready</th>
<th>Selection Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most skilled resource selection mode</td>
<td>Sales Support</td>
<td>Agent A = Sales (10)&lt;br&gt;Support (5)&lt;br&gt;Agent B = Sales (5)&lt;br&gt;Support (10)&lt;br&gt;Agent C = Sales (5)&lt;br&gt;Support (1)</td>
<td>A, B C&lt;br&gt;C, A, B&lt;br&gt;A, C, B&lt;br&gt;C, B, A</td>
<td>A, B, C&lt;br&gt;A, B, C&lt;br&gt;A, B, C&lt;br&gt;B, A, C</td>
</tr>
</tbody>
</table>
Configuring and Using Remote Monitoring

**Note**
This section only applies to Cisco CRS Deployments with Unified CM.

The Cisco CRS Remote Monitoring feature allows a supervisor to call into any site where the supervisor has a Unified CM user profile and monitor an agent’s conversation.

**Note**
The incoming and outgoing streams to/from the agent phone and the outgoing stream to the supervisor phone must have the same encoding with only G.711 being supported.

When you, as a supervisor, monitor a conversation, you can hear all parties on the call. The parties will have no indication that you are monitoring the call. You cannot join the call or be heard by the parties. This is referred to as silent monitoring.

---

**Table 7-2**

<table>
<thead>
<tr>
<th>Example</th>
<th>CSQ Skills</th>
<th>Agent Competency Levels</th>
<th>Sequence Agents Become Ready</th>
<th>Selection Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Least skilled resource selection model</td>
<td>Sales Support</td>
<td>Agent A = Sales (10) Support (5)</td>
<td>A, B, C</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Agent B = Sales (5), Support (10)</td>
<td>C, A, B</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Agent C = Sales (5) Support (1)</td>
<td>A, C, B</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, B, A</td>
<td>C, B, A</td>
</tr>
</tbody>
</table>

### Related Topics
- Creating a CSQ, page 7-18
- Modifying an Existing CSQ, page 7-24
- Deleting a CSQ, page 7-25
- Resource Pool Selection Criteria: Skills and Groups, page 7-26
With Remote Monitoring, you can choose to monitor a call in either of these ways:

- **By resource (agent)**—In this case, you identify the resource by agent extension. If the agent is on a call, monitoring will begin immediately. If the agent is not on a call, monitoring will begin when the agent is presented with a call (that is, when the agent’s phone rings) or when the agent initiates a call (that is, when the agent’s phone goes off-hook).

- **By CSQ**—In this case, you will monitor the call of an agent who belongs to the CSQ. When you monitor by CSQ, you select the CSQ from a menu. When a call is presented to an agent who belongs to the selected CSQ, monitoring will begin for that agent and call.

For CSQ monitoring, the supervisor cannot start monitoring the call after it connects to the agent; the call must arrive at the agent *after* supervision begins. For agent monitoring, supervision can begin after the call connects to the agent.

This section describes the steps needed to configure Remote Monitoring:

- Creating a Remote Monitoring Supervisor, page 7-30
- Assigning Resources and CSQs to a Supervisor, page 7-31

**Related Topics**

- Configuring the Remote Monitoring Application, page 9-16.
- Viewing CSQ IDs for Remote Monitoring, page 17-8

## Creating a Remote Monitoring Supervisor

**Note**

This section only applies to Cisco CRS Deployments with Unified CM.

Use the User Management web page to assign supervisor privileges to a user.

**Procedure**

**Step 1**

From the CRS Administration menu bar, **Tools > User Management**.
The User Configuration web page opens to display the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Id</td>
<td>Unique identifier of the user for which the spoken name is to be uploaded.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name for each user. You can sort this field alphabetically.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name for each user. You can sort this field alphabetically.</td>
</tr>
<tr>
<td>Capability</td>
<td>The capability assigned for each user. You can sort this field alphabetically.</td>
</tr>
</tbody>
</table>

**Step 2**
In the left pane, click the required view under the **Capability View** title.
The corresponding view displays with two panes. The pane on the right always displays the list of Available Users and the left pane changes to display the users assigned to the selected view.

**Step 3**
Change the users as required for each view using the arrow in either direction.
Your changes are dynamically displayed in this page and are effective immediately.

**Step 4**
Repeat this process as needed to assign the required capability for each user.

**Related Topics**
- Configuring and Using Remote Monitoring, page 7-29
- Assigning Resources and CSQs to a Supervisor, page 7-31
- Configuring the Remote Monitoring Application, page 9-16.
- Viewing CSQ IDs for Remote Monitoring, page 17-8

**Assigning Resources and CSQs to a Supervisor**

**Note**
This section only applies to Cisco CRS Deployments with Unified CM.

Use the Remote Monitor configuration web page to assign a Supervisor a list of Resources and CSQs that he/she is allowed to monitor.
Chapter 7  Provisioning Unified CCX
Configuring and Using Remote Monitoring

Procedure

Step 1  From the CRS Administration menu bar, choose **Subsystems > RmCm**.
The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2  On the RmCm Configuration navigation bar, click the **Remote Monitor** hyperlink.

**Note** The **Remote Monitor** hyperlink is available only if you are using Unified CCX Enhanced or Premium license packages.

The Remote Monitor summary web page opens to display the User ID of Unified CM users who are Cisco CRS supervisors (if configured).

Step 3  Click a User ID value.

**Note** This is a Unified CM user configured as a CRS supervisor. (see Creating a Remote Monitoring Supervisor, page 7-30).

The Remote Monitor Configuration web page opens.

Step 4  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Service Queues Name</td>
<td>(Checkbox.) CSQ Names the supervisor can monitor.</td>
</tr>
<tr>
<td>Resources</td>
<td>(Checkbox.) User IDs of agents the supervisor can monitor.</td>
</tr>
</tbody>
</table>

**Step 5**  Click **Update** to apply the changes.

The Remote Monitor area of the RmCm Configuration web page reappears.

The Supervisor can now access the CRS Supervisor web page and view the allowed CSQs and agents.
Tip When running the Remote Monitoring script, you might need to provide a CSQ ID. This ID is internally generated and is only visible on the CRS Supervisor page (see Viewing CSQ IDs for Remote Monitoring, page 17-8).

Related Topics
- Configuring and Using Remote Monitoring, page 7-29
- Creating a Remote Monitoring Supervisor, page 7-30
- Configuring the Remote Monitoring Application, page 9-16.
- Viewing CSQ IDs for Remote Monitoring, page 17-8

Configuring Agent-Based Routing

Agent-based routing provides the ability to send a call to a specific agent, rather than any agent available in a CSQ.

Use the Agent Based Routing Settings web page to configure system-wide parameters to be used in an agent-based routing application.

**Procedure**

**Step 1** From the CRS Administration menu bar, choose Subsystems > RmCm. The RmCm Configuration web page opens, displaying the RmCm Provider area.

**Step 2** On the RmCm Configuration navigation bar, click the Agent Based Routing Settings hyperlink.

Note The Agent Based Routing Settings hyperlink is available only if you are using Unified CCX Enhanced or Premium license packages.

The Agent-Based Routing Settings area opens.

**Step 3** Use this web page to specify the following fields.
Step 4  Click Update to apply changes.

### Wrap-Up Data Usage

Contact centers use wrap-up data to track the frequency of activities or to identify the account to which a call is charged, and other similar situations. Like reason codes, wrap-up data descriptions are set up by your system administrator to reflect the needs of your contact center. By default this feature is disabled.

If the wrap-up data feature is enabled in Cisco Desktop Administration, the agent will see a pop-up window when he moves to work state in which he can select the appropriate description that sums up the call outcome.

See the Cisco Desktop Administrator User Guide for more information.

### Configuring Teams

A team is a group of agents who report to the same supervisor. A team can have one primary supervisor and optional secondary supervisor(s). A supervisor can also monitor CSQs that are assigned to the team being supervised.
Barge-in is when a supervisor joins an existing call between an agent and a customer.

Intercept is when the supervisor joins a call and drops the agent from the call.

A default team is automatically created by the system and cannot be deleted. If agents are not assigned to any team, they belong to the default team. When an agent is assigned to a team, the team’s supervisor can barge-in and/or intercept any call being handled by the agent.

**Note**

Before creating a team, you must set up supervisors using the User Management page.

This section describes:

- Creating a Team Supervisor, page 7-35
- Creating Teams, page 7-36
- Modifying Agents on Teams, page 7-38
- Deleting a Team, page 7-39

**Creating a Team Supervisor**

You can use the procedure detailed below, or alternately, click on the User View link in the left pane of User Configuration window to view a list of all users. Double-click on the required user and change the capability for that user to Supervisor.

Use the User Management web page to assign supervisor privileges to a user.

**Procedure**

**Step 1**

From the CRS Administration menu bar, choose **Tools > User Management**.

The User Configuration web page opens to display the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Id</td>
<td>Unique identifier of the user for which the spoken name is to be uploaded.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name for each user. You can sort this field alphabetically.</td>
</tr>
</tbody>
</table>
Configuring Teams

Step 2
In the left pane, click the required view under the Capability View title.

Step 3
Click the Supervisor link.
The corresponding view displays with two panes. The pane on the right displays
the list of Available Users and the left pane changes to display the users assigned
to the selected view.

Step 4
Select the required user to be a supervisor by using the arrow in either direction.
Your changes are dynamically displayed in this page and are effective immediately.

Related Topics
- Creating Teams, page 7-36
- Modifying Agents on Teams, page 7-38
- Deleting a Team, page 7-39

Creating Teams

Use the Teams area of the RmCm Configuration web page to create or associate
teams with various agents, CSQs, and supervisors.

Procedure

Step 1
From the CRS Administration menu bar, choose Subsystems > RmCm.
The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2
On the RmCm Configuration navigation bar, click the Teams hyperlink.
Chapter 7  Provisioning Unified CCX

Configuring Teams

Note  The Teams hyperlink is available only if you are using the Unified CCX Enhanced license.

The Teams summary web page opens.

Step 3  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team Name</td>
<td>Name for the team.</td>
</tr>
<tr>
<td>Primary Supervisor</td>
<td>(Drop-down list.) Primary supervisor for the team. The drop-down list contains users designated as supervisors on the User Management web page.</td>
</tr>
<tr>
<td>Delete icon</td>
<td>Click the icon to delete the team information in that specific row.</td>
</tr>
</tbody>
</table>

Step 4  Click the Add a new Team hyperlink.

The Team Configuration page appears.

Step 5  Use this web page to specify the following fields.

Note  Primary and secondary supervisors are users configured as CRS supervisors (see Creating a Team Supervisor, page 7-35).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team Name</td>
<td>Name for the team.</td>
</tr>
<tr>
<td>Primary Supervisor</td>
<td>Primary supervisor for the team.</td>
</tr>
<tr>
<td>Secondary Supervisors / Available Supervisors</td>
<td>Use the arrow buttons to assign secondary supervisors to the team.</td>
</tr>
<tr>
<td>Assigned Resources / Resources Assigned to Other Teams</td>
<td>Use the arrow buttons to assign or remove resources for the team. Note  You cannot remove resources from the default team.</td>
</tr>
<tr>
<td>Assigned CSQs / Available CSQs</td>
<td>Use the arrow buttons to assign or CSQs for the team. Note  You can remove CSQs from the default team.</td>
</tr>
</tbody>
</table>
Step 6 Click **Update** to apply changes.

### Related Topics
- Creating a Team Supervisor, page 7-35
- Modifying Agents on Teams, page 7-38
- Deleting a Team, page 7-39

## Modifying Agents on Teams

Use the Teams area of the RmCm Configuration web page to add agents or change agents on an existing Team.

### Procedure

**Step 1**
From the CRS Administration menu bar, choose **Subsystems > RmCm**.
The RmCm Configuration web page opens, displaying the RmCm Provider area.

**Step 2**
On the RmCm Configuration navigation bar, click the **Teams** hyperlink.
The Teams summary web page opens.

**Step 3**
Click a name in **Team Name** column
The Team Configuration page appears.

**Step 4**
Select an agent name in the **Resources Assigned to other Teams** list and use the arrow icon to move it into the **Assigned Resources** list if you want to add an agent to this team.
To remove an agent from this team, select an agent name in the **Assigned Resources** list and use the arrow icon to move it into the **Resources Assigned to other Teams** list. This agent now belongs to the default team.

**Step 5**
Click **Update** to apply changes.

### Related Topics
- Creating a Team Supervisor, page 7-35
Deleting a Team

Use the Teams area of the RmCm Configuration web page to delete an existing Team.

Procedure

Step 1  From the CRS Administration menu bar, choose Subsystems > RmCm. The RmCm Configuration web page opens, displaying the RmCm Provider area.

Step 2  On the RmCm Configuration navigation bar, click the Teams hyperlink. The Teams summary web page opens.

Step 3  Click the Delete icon next to Team Name you want to delete. The system prompts you to confirm the delete.

Step 4  Click OK.

Related Topics

- Creating a Team Supervisor, page 7-35
- Creating Teams, page 7-36
- Modifying Agents on Teams, page 7-38
Unified Gateway Auto-Configuration Details

Note
Cisco CRS Release 4.x supports ACD integration with the Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) solution by way of the Cisco Unified Gateway. The Unified Gateway is a Peripheral Gateway (PG) which is configured on the Unified ICME software and is co-resident on the CRS server. The CTI protocol, supports integration of Unified Gateway Release 4.x with Unified ICME Release 7.x. The Cisco Unified Gateway Deployment Guide provides an overview of the Unified Gateway feature, lists the supported deployment options, provides comparative information, and includes information on configuring and integrating the Unified Gateway.

Some of the configurations performed on the Unified CCX using the appropriate web page in Cisco CRS Administration will be automatically configured on Unified ICME via the Unified Gateway. The following table provides a list of these configurations, the equivalent term used on Unified ICME for these configurations, and the Configuration Manager tool that can be used on the Unified ICME Admin Workstation to view these configurations.

<table>
<thead>
<tr>
<th>Unified CCX Term</th>
<th>Unified ICME Term</th>
<th>Unified ICME Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Service</td>
<td>Service Explorer</td>
</tr>
<tr>
<td>Route Point (Trigger)</td>
<td>Routing Device</td>
<td>Peripheral Monitor Table</td>
</tr>
<tr>
<td>CSQ</td>
<td>Skill Group</td>
<td>Skill Group Explorer</td>
</tr>
<tr>
<td>Resource</td>
<td>Agent</td>
<td>Agent Explorer</td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td>The agent extension goes to the Peripheral Monitor Table.</td>
</tr>
</tbody>
</table>

Note
These configurations and their attributes cannot be changed on Unified ICME if auto-configuration is enabled on Unified ICME.
Provisioning Additional Subsystems

To provision additional subsystems, you must complete the following tasks:

- Log into the CRS Administration (see Chapter 2, “Introducing the CRS Administration Web Interface”).
- Provision your telephony and media resources (see Chapter 6, “Provisioning Telephony and Media”).
- Provision your Cisco Unified Contact Center Express (Unified CCX) subsystem, if required (see Chapter 7, “Provisioning Unified CCX”)

The following sections introduce the additional Cisco CRS subsystems and explain how to provision them.

- About Additional Subsystems, page 8-2
- Provisioning the Unified ICME Subsystem, page 8-3
- Provisioning the HTTP Subsystem, page 8-8
- Provisioning the Database Subsystem, page 8-12
- Provisioning the eMail Subsystem, page 8-19
About Additional Subsystems

Your CRS system may include some or all of the following additional subsystems:

- The Unified ICME subsystem—The Cisco CRS system uses the Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) subsystem to communicate with Unified ICME to manage call distribution across sites and call-processing environments. (see Provisioning the Unified ICME Subsystem, page 8-3).

  Note: If you are using Unified CCX with the Cisco Unified Gateway solution, please see the Cisco Unified Gateway Deployment Guide. The instructions for configuring Unified CCX with that solution differs from what is described in this guide. The Unified Gateway provides for the integration of the Unified ICME system with Unified CCX by way of the Unified Gateway. The Unified Gateway is a Peripheral Gateway (PG) which you configure on the Unified ICME software.

- The HTTP subsystem—The Cisco CRS system uses the HTTP subsystem to enable CRS applications to respond to requests from a variety of web clients, including computers and IP phones (see Provisioning the HTTP Subsystem, page 8-8).

- The Database subsystem—The Cisco CRS system uses the Database subsystem to enable CRS applications to interact with customer provided enterprise database servers in order to make database information accessible to contacts (see Provisioning the Database Subsystem, page 8-12).

- The eMail subsystem—The Cisco CRS system uses the eMail subsystem to communicate with your e-mail server and enable your applications to create and send e-mail (see Provisioning the eMail Subsystem, page 8-19).

If you plan to run applications that use any of the additional CRS subsystems included in your CRS package, you should now provision those subsystems. The CRS system uses these additional subsystems to communicate with supporting systems such as Unified ICME, web servers, database servers, and e-mail servers.

  Note: You need to provision a particular subsystem only if you are using CRS applications that require it.
The Unified ICME subsystem is available if your system has a license installed for one of the following Cisco product packages: Cisco Unified Queue Manager (Unified QM) or Cisco Unified IP IVR (Unified IP IVR).

The Cisco CRS system uses the Unified ICME subsystem to communicate with Unified ICME to manage call distribution across sites and call-processing environments.

The CRS server is frequently used as part of a Unified ICME solution with Unified ICME. In this type of installation, the Unified ICME uses the CRS server to queue calls and perform other functions such as collecting caller-entered digits, performing database lookups, and playing back prompts.

If you are not using Unified ICME, you do not need to provision the Unified ICME subsystem.

Unified ICME scripts can direct calls based on various criteria such as the time of day or the availability of subsystems. The scripts use four different commands to interact with the CRS system:

- **Connect**—Connects the call. Unified ICME sends the connect message with a label to instruct the CRS system where to direct the call.
- **Release**—Hangs up the call.
- **Run VRU Script**—Runs an Unified ICME Voice Response Unit (VRU) script on the CRS system.
- **Cancel**—Cancels the Unified ICME VRU script that is currently running.

This section includes the following tasks:

- Configuring General Unified ICME Information, page 8-4
- Configuring Unified ICME VRU Scripts, page 8-6

Related Topics

- About Additional Subsystems, page 8-2
- Provisioning the HTTP Subsystem, page 8-8
Provisioning the Database Subsystem, page 8-12
Provisioning the eMail Subsystem, page 8-19
Configuring the Unified ICME Post-Routing Application, page 9-10
Configuring the Unified ICME Translation-Routing Application, page 9-14

Configuring General Unified ICME Information

Configure general Unified ICME information. General Unified ICME information includes the TCP/IP socket number for receiving messages from the Unified ICME system and the expanded call context variables you want to use to pass call-related information. To configure general Unified ICME information, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose Subsystems > ICM.

The Unified ICME Configuration General area automatically opens in the Unified ICME Configuration web page when you first choose the Unified ICME menu option from the Subsystems menu.)

Step 2  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VRU Connection Port</td>
<td>The same number configured in the VRU Peripheral Interface Manager (PIM) on the Unified ICME system. The default value in the Unified ICME setup is 5000. The system uses this TCP/IP socket number to receive messages from the Unified ICME system. You can copy the VRU Connection Port value from the VRU PIM configuration dialog box of the VRU PG machine.</td>
</tr>
<tr>
<td>Service Control</td>
<td>If you click Yes, the Service Control interface allows Unified ICME to provide call-processing instructions to the Cisco CRS system. It also provides Unified ICME software with event reports indicating changes in call state. You must enable the service control interface to use the Unified ICME subsystem.</td>
</tr>
</tbody>
</table>
Provisioning the Unified ICME Subsystem

Note
You can also define your own expanded call variables in the Configure ICME tool in the Unified ICME system. The CRS Engine registers the user-defined expanded call variables with Unified ICME after it loads the VRU scripts that use these variables. The variables remain registered until the Unified ICME session is reopened (either by request from the VRU PG or when the CRS Engine is restarted). The variables remain registered even if you delete the script that uses them.
Tip
Every Call Context Variable and Expanded Call Context Variable must be defined on both sides of the system that receive and send variable data in scripts. In an Unified CCX system, these variables must be defined both in Unified CCX and in Cisco Desktop Administrator (CDA). In an Unified CCX system integrated with Unified ICME through the Unified Gateway, these variable must be defined in Unified CCX, in CDA, and also in Unified ICME.

Step 3
Click Update.

The configuration information is added to the system.

You are now ready to configure the Unified ICME VRU Scripts area of the Unified ICME Configuration web page.

Related Topic
- Configuring Unified ICME VRU Scripts, page 8-6
- About Additional Subsystems, page 8-2

Configuring Unified ICME VRU Scripts

Configure Unified ICME VRU scripts. Unified ICME VRU Script entries allow you to map the VRU script name, used by Unified ICME in the Run VRU Script node, to a CRS script name.

Unified ICME uses VRU scripts to handle interactions with contacts. These scripts are loaded as applications on the CRS Engine.

To configure Unified ICME VRU Scripts, complete the following steps.

Procedure

Step 1
From the CRS Administration menu bar, choose Subsystems > ICM.

The Unified ICME Configuration web page opens, displaying the General area.

Step 2
On the Unified ICME Configuration navigation bar, click the Unified ICME VRU Scripts hyperlink.
The Unified ICME VRU Scripts summary web page opens.

**Step 3** Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VRU Script Name</td>
<td>Displays the VRU script name.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> All scripts under the \default directory are listed in the drop-down list of the Script field in the Cisco Script Application Configuration page.</td>
</tr>
<tr>
<td>Script</td>
<td>Displays the script associated with the VRU script.</td>
</tr>
</tbody>
</table>

**Step 4** Click the **Add a New VRU Script** hyperlink.

The Unified ICME VRU Script area of the Unified ICME Configuration web page opens.

**Step 5** Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VRU Script Name</td>
<td>A name for the VRU script you want to add.</td>
</tr>
<tr>
<td>Script</td>
<td>The CRS script to associate with the VRU script. You can select the script from the drop-down list or click the <strong>Edit</strong> button to specify a new script.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> All scripts under the \default directory are listed in the drop-down list of the Script field in the Cisco Script Application Configuration page.</td>
</tr>
<tr>
<td></td>
<td>To specify a new script, click <strong>Edit</strong>, enter the script name in the dialog box, and click <strong>OK</strong>. The User Prompt dialog box closes, and the name you entered appears in the Script field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you enter the script name as a file URL, enter the value with double backslashes (). For example, file://c:\temp\aa.aef</td>
</tr>
</tbody>
</table>

**Step 6** Click **Add**.

The Unified ICME VRU Script area closes, and the name of the VRU script you added appears in the Unified ICME VRU Scripts summary web page.
You are now ready to provision any additional subsystems your CRS applications require or to begin configuring CRS applications. See Chapter 9, “Configuring Cisco Applications.”

Related Topics

- Configuring General Unified ICME Information, page 8-4
- About Additional Subsystems, page 8-2

Provisioning the HTTP Subsystem

The HTTP subsystem is available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR or Unified CCX Premium.

The Cisco CRS system uses the HTTP subsystem to enable CRS applications to respond to requests from a variety of web clients, including computers and IP phones.

If you are not using HTTP applications, you do not need to provision the HTTP subsystem.

The CRS system uses subdirectories in the Cisco CRS installation directory to store text substitution, eXtensible Style Language (xsl) templates, static and dynamic web pages, and Java Servlet Pages (JSPs).

Use the Document Management page to upload these documents. For more information on the Document Management page, see Chapter 10, “Managing Prompts, Grammars, Documents, and Custom Files.”

To provision the HTTP subsystem, you need to provision HTTP triggers. HTTP applications use triggers to activate the application in response to an incoming HTTP message.
In addition—if necessary—you can change the TCP/IP port used by the HTTP server.

This section describes:

- Configuring HTTP Triggers, page 8-9
- Changing Port Numbers, page 8-11

Related Topics

- About Additional Subsystems, page 8-2
- Provisioning the Unified ICME Subsystem, page 8-3
- Provisioning the Database Subsystem, page 8-12
- Provisioning the eMail Subsystem, page 8-19
- Adding Application Triggers, page 9-18

**Configuring HTTP Triggers**

To configure HTTP triggers for applications, complete the following steps.

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>From the CRS Administration menu bar, choose Subsystems &gt; HTTP. The HTTP Trigger Configuration summary web page opens.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the Add a New HTTP Trigger hyperlink. The HTTP Trigger Configuration web page opens.</td>
</tr>
</tbody>
</table>

**Note** For a complete description of all columns, icons, and buttons on this page, see HTTP Configuration, page 20-23
Step 3  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The relative URL</td>
</tr>
<tr>
<td></td>
<td>For example: <a href="http://www.appserver.acme.com:8080/hello">http://www.appserver.acme.com:8080/hello</a></td>
</tr>
<tr>
<td>Language</td>
<td>Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>• Choose a default language from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• Click Edit, specify a default language in the dialog box that appears,</td>
</tr>
<tr>
<td></td>
<td>and click OK.</td>
</tr>
<tr>
<td>Maximum Number Of</td>
<td>The maximum amount of simultaneous sessions (instances) that the application can handle.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Note  The limit for the maximum number of simultaneous remote monitoring sessions is 16, but the actual number depends on your system's CPU and memory resources. Entering a number that is too high can result in unacceptable system performance.</td>
</tr>
<tr>
<td>Idle Timeout (in ms)</td>
<td>Maximum amount of time (in milliseconds) that the system will wait to invoke the application before rejecting a contact.</td>
</tr>
<tr>
<td>Enabled</td>
<td>(Radio button) Accept Yes (the default).</td>
</tr>
<tr>
<td>Note</td>
<td>If you disable the trigger, the user receives an error message when browsing to the defined trigger URL.</td>
</tr>
</tbody>
</table>

Step 4  Click Add.

The HTTP Trigger Configuration web page closes, and the trigger information appears on the HTTP Trigger Configuration summary web page.

You are now ready to provision any additional subsystems your CRS applications require or to begin configuring CRS applications. See Configuring Cisco Applications, page 9-1.

Related Topics
- Changing Port Numbers, page 8-11
- About Additional Subsystems, page 8-2
Changing Port Numbers

You can set the TCP/IP port number the CRS Engine uses for the internal HTTP server when you install the HTTP subsystem. The default port used during installation is port 8080.

After the HTTP subsystem is installed, you can change the port in the Tomcat server.MIVR.xml file.

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

To change the TCP/IP port number, complete the following steps on all the CRS Engine-enabled nodes in the cluster.

Procedure

Step 1 Create a backup copy of the following configuration file:
installation directory\tomcat\conf\server.MIVR.xml

Step 2 Open the original configuration file using any text editor.

Step 3 Search the file to find the string “Normal HTTP.”

The following example shows the portion of the file that contains the port number:

```xml
<!-- Normal HTTP -->
<Connector
 className="org.apache.tomcat.service.PoolTcpConnector">
 <Parameter name="handler" value="org.apache.tomcat.service.http.HttpConnectionHandler"/>
 <Parameter name="port" value="8080"/>
</Connector>
```

Step 4 Change the value 8080 to the port number you want to use.

The standard port number for HTTP is port 80. The default port number for Secure Socket Layer (SSL) servers (HTTPS) is 443.

Step 5 Save the configuration file.
Provisioning the Database Subsystem

Step 6 Restart the CRS Engine by performing the following steps:

a. Choose **System > Control Center > Server** from the CRS Administration menu bar.

b. Select the CRS Engine radio button and click **Restart** or **Stop** and **Start**.

Tip If you have just completed a Cisco CRS cluster or server setup procedures, be sure to wait at least 10 minutes before you restart the Cisco CRS Engine. This time gap is required for Cisco CRS to synchronize information across the cluster.

Related Topics

- Configuring HTTP Triggers, page 8-9
- About Additional Subsystems, page 8-2
- Adding Application Triggers, page 9-18

Provisioning the Database Subsystem

Note The database subsystem is available if your system has a license installed for either the Unified IP IVR or Unified CCX Premium product packages.

The Cisco CRS system uses the Database subsystem to enable CRS applications to interact with database servers in order to make database information accessible to contacts.

Tip If the enterprise database is an external SQL server, then you must configure this SQL server to run in SQL Mixed Mode Authentication.

Caution Cisco CRS does not support the use of Mixed Mode authentication for internal SQL with MSDE or SQL 2000.
If you are not using CRS applications that require access to databases, you do not need to provision the Database subsystem.

The Database subsystem does not support database views or execute store procedures.

To provision the Database subsystem, perform the following procedures:

- Defining an ODBC Data Source, page 8-13
- Adding a New Data Source, page 8-16

Related Topics
- About Additional Subsystems, page 8-2
- Provisioning the Unified ICME Subsystem, page 8-3
- Provisioning the HTTP Subsystem, page 8-8
- Provisioning the eMail Subsystem, page 8-19

### Defining an ODBC Data Source

For an application script to use information from a database, you must define an ODBC data source name. The ODBC data source name provides information to Microsoft Windows about how to connect the application server to an enterprise database such as Microsoft SQL Server, Sybase, Oracle, or IBM DB2.


To set up a data source name, complete the following steps.
Chapter 8     Provisioning Additional Subsystems

Provisioning the Database Subsystem

Procedure

Step 1  On the script server, choose Start > Programs > Administrative Tools > Data Sources (ODBC).

The ODBC Data Source Administrator window opens.

Step 2  Click the System DSN tab.

The System DSN tab of the ODBC Data Source Administrator window opens.

Step 3  To add a Data Source Name (DSN), click Add.

The Create New Data Source window opens.

Step 4  Select the driver for which you want to set up a data source, and click Finish. As an example, to create a DSN for Microsoft SQL Server, select SQL Server.

The Create a New Data Source to SQL Server window opens.

Step 5  In the Create a New Data Source to SQL Server window, perform the following tasks:

- In the Name field, enter a name.
  The name you enter must match the value entered in the Data Source Name field in the CRS Administration web interface.

- In the Description field, enter a description.
  Enter information that will help the application designer identify the purpose of this data source.

- From the Server drop-down menu, choose the host name or IP address of the computer where the enterprise database resides.

Step 6  Click Next.

The second Create a New Data Source to SQL Server window opens.

Step 7  Select the SQL Server radio button as the authentication mode.

We don't support using CRS and Unified CM database as the Enterprise DB.

Note  The Cisco CRS platform does not support using the Unified CM database as an Enterprise database.
Tip  Select SQL server as the authentication mode for external databases.

Step 8  Click Client Configuration to configure the connection between the CRS server and the computer where the enterprise database resides.

The Client Configuration window opens.

Step 9  Choose TCP/IP network libraries.

Step 10  Enter a username in the Login ID field and a password in the Password field.

Make a note of the username and password you choose. You will use this username and password to complete the enterprise database configuration in the following procedure.

Step 11  Click Next to complete the DSN configuration and to test connectivity to the chosen data source.

You are now ready to add a new data source.

Related Topics
- Adding a New Data Source, page 8-16
- Polling Database Connectivity, page 8-17
- About Additional Subsystems, page 8-2
Adding a New Data Source

After defining the ODBC data source (see Defining an ODBC Data Source, page 8-13), you need to add this data source to the Database subsystem.

To add a new data source, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose **Subsystems > Database**.

The Enterprise Database Subsystem Configuration summary web page opens. The following information is populated for configured data sources.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Data source name configured when an ODBC(^1) data source is defined.</td>
</tr>
<tr>
<td>Username</td>
<td>Username defined for connecting to the enterprise database.</td>
</tr>
<tr>
<td>Password</td>
<td>Password defined for connecting to the enterprise database.</td>
</tr>
<tr>
<td>Maximum Number of</td>
<td>Maximum number of connections allowed to connect to the database.</td>
</tr>
<tr>
<td>Connections</td>
<td>This database is usually an external database to which the customer</td>
</tr>
<tr>
<td></td>
<td>script can connect. While the limit is set by that database and governed</td>
</tr>
<tr>
<td></td>
<td>by your license. If this number in this setting is exceeded, the</td>
</tr>
<tr>
<td></td>
<td>corresponding workflow is aborted and the caller receives an error</td>
</tr>
<tr>
<td></td>
<td>message. However, you can avoid this error by configuring the</td>
</tr>
<tr>
<td></td>
<td>appropriate number of sessions (see Maximum Number Of Sessions, in</td>
</tr>
<tr>
<td></td>
<td>Chapter 9, “Maximum Number Of Sessions”) in the corresponding</td>
</tr>
<tr>
<td></td>
<td>script/application. Also the script writer can provide information about</td>
</tr>
<tr>
<td></td>
<td>how many connections are used per call (or instance of application).</td>
</tr>
<tr>
<td>Delete</td>
<td>Click the icon to delete the data source information in that specific row.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click the icon to refresh the data source information in that specific row.</td>
</tr>
</tbody>
</table>

1. ODBC = Open Database Connectivity

Step 2  Click the **Add a New Data Source** hyperlink.

The Enterprise Database Subsystem Configuration web page opens.
Step 3  Use this web page to specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datasource Name</td>
<td>Data Source Name configured when an ODBC Data Source is defined.</td>
</tr>
<tr>
<td>User Name</td>
<td>Username defined for connecting to the enterprise database in this field.</td>
</tr>
<tr>
<td>Password / Confirm</td>
<td>Password defined for connecting to the enterprise database.</td>
</tr>
<tr>
<td>Password</td>
<td></td>
</tr>
<tr>
<td>Maximum Number of</td>
<td>The maximum amount of simultaneous sessions (instances) that the application can handle.</td>
</tr>
<tr>
<td>Connections</td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>The limit for the maximum number of simultaneous remote monitoring sessions is 16, but the actual number depends on your system’s CPU and memory resources. Entering a number that is too high can result in unacceptable system performance.</td>
</tr>
</tbody>
</table>

Step 4  Click Add to apply changes.

The Enterprise Database Subsystem Configuration summary web page opens, showing the data source you added. You are now ready to provision any additional subsystems your CRS applications require or to begin configuring CRS applications. See Configuring Cisco Applications, page 9-1.

Related Topics
- Defining an ODBC Data Source, page 8-13
- Adding a New Data Source, page 8-16
- About Additional Subsystems, page 8-2

Polling Database Connectivity

To poll connectivity to the database on a periodic basis, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose Subsystems > Database.
The Enterprise Database Subsystem Configuration summary web page opens.

**Step 2** Click the **Parameters** hyperlink.

The Enterprise Database Subsystem Configuration web page opens to display the parameter-related fields.

**Step 3** Use this web page to specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RetryConnectInterval</td>
<td>Specifies the interval between two connection attempts when a data source is initialized. The default is 15,000.</td>
</tr>
<tr>
<td>NumAttempt</td>
<td>Specifies the number of attempts to establish connections to the database when a data source is initialized. The default is 3 attempts.</td>
</tr>
<tr>
<td>LoginTimeout</td>
<td>Sets the maximum time in seconds that a driver will wait while attempting to connect to a database. The default is 0 (disabled).</td>
</tr>
<tr>
<td>SQLState</td>
<td>Error code returned by the database when an invalid, stored procedure is executed. The default state is</td>
</tr>
</tbody>
</table>

**Step 4** Click **Update** to apply changes (or **Reset to Default** if you prefer to retain the default values).

The Enterprise Database Subsystem Configuration summary web page opens, showing the data source you added. You are now ready to provision any additional subsystems your CRS applications require or to begin configuring CRS applications (see Configuring Cisco Applications, page 9-1).

**Related Topics**
- Defining an ODBC Data Source, page 8-13
- About Additional Subsystems, page 8-2
Provisioning the eMail Subsystem

The eMail subsystem is available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR or Unified CCX Premium.

The CRS system uses the eMail subsystem to communicate with your e-mail server and enable your applications to create and send email. You must provision the eMail subsystem if you intend to create scripts that use messaging steps to create and send e-mail.

If your e-mail system is configured to receive acknowledgments, you should process the mailbox you identify in your configuration to determine whether or not an e-mail was successfully sent.

The e-mail configuration process identifies the default e-mail address and server to be used for sending e-mail (including e-pages and faxes) and for receiving acknowledgments.

If you are not using e-mail applications, you do not need to provision the eMail subsystem.

To provision the e-mail subsystem, complete the following steps.

Procedure

Step 1
From the CRS Administration menu bar, choose Subsystems > eMail.

The eMail Configuration web page opens.
Provisioning the eMail Subsystem

Step 2 Use this web page to specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Server</td>
<td>A fully-qualified e-mail server name. Example: server.domain.com</td>
</tr>
<tr>
<td>eMail Address</td>
<td>An existing fully qualified e-mail address for the administrative account. Example: <a href="mailto:administrator@domain.com">administrator@domain.com</a></td>
</tr>
</tbody>
</table>

Step 3 Click Update.

The Cisco CRS system saves your changes and the CRS Administration web page opens.

Note Cisco does not currently support multiple e-mail configurations. To remove the e-mail information, you must erase the fields and click Update.

You are now ready to provision any additional subsystems your CRS applications require, or to begin configuring CRS applications (see Chapter 9, “Configuring Cisco Applications,” and Chapter 10, “Managing Prompts, Grammars, Documents, and Custom Files.”)

Related Topics
- About Additional Subsystems, page 8-2
- Provisioning the Unified ICME Subsystem, page 8-3
- Provisioning the HTTP Subsystem, page 8-8
- Provisioning the Database Subsystem, page 8-12
- Provisioning the eMail Subsystem, page 8-19
Configuring Cisco Applications

The Cisco CRS system uses applications to interact with contacts and perform a wide variety of functions, such as prompting callers for information, transferring calls, and providing information to callers.

To configure CRS applications, you must complete the following tasks:

- Provision telephony and media resources (see Chapter 6, “Provisioning Telephony and Media”)
- Provision your Unified CCX subsystem, if required (see Chapter 7, “Provisioning Unified CCX”)
- Provision additional subsystems, if required (see Chapter 8, “Provisioning Additional Subsystems”)

The following sections describe how to configure applications and make them available to the CRS system.

- About CRS Applications, page 9-2
- Adding Application Triggers, page 9-18
- Managing Scripts, page 9-25
About CRS Applications

The Cisco CRS system uses applications to interact with contacts and perform a wide variety of functions.

Cisco CRS licenses you purchase and install determine the applications available on your system (see The Application Management Menu Option, page 19-2).

Cisco CRS provides the following application types:

- **Script** (see Configuring Cisco Script Applications, page 9-3).
- **Busy** (see Configuring the Busy Application, page 9-7).
- **Ring-No-Answer** (see Configuring the Ring-No-Answer Application, page 9-8).
- **Remote Monitoring** (see Configuring the Remote Monitoring Application, page 9-16).

If Cisco CRS is integrated with Unified ICME, you will also need to configure one or both of the following application types:

- **Unified ICME post-routing** (see Configuring the Unified ICME Post-Routing Application, page 9-10).
- **Unified ICME translation-routing** (see Configuring the Unified ICME Translation-Routing Application, page 9-14).

If you are not using Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) software, you do not need to configure Unified ICME post-routing and Unified ICME translation-routing applications. For information about these Unified ICME software features, see the *Cisco Unified ICME Scripting and Media Routing Guide*.

Related Topic

Application Availability by License Package, page A-2
### Configuring Cisco Script Applications

Cisco CRS script applications are applications based on scripts created in the CRS Editor. These applications come with every CRS system and execute scripts created in the CRS Editor.

Use the CRS Editor to create scripts that direct the CRS system to automatically answer calls and other types of contacts, prompt callers for information, accept caller input, queue calls, distribute calls to available agents, place outbound calls, respond to HTTP requests, and send e-mail messages.

**Note**

The Cisco CRS system includes a number of sample scripts. For a description of these sample scripts, and for more information on creating scripts with the CRS Editor, see the *Cisco CRS Scripting and Development Series: Volume 1, Getting Started with Scripts*. In addition, a script repository is available at [http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_architectures_list.html](http://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_architectures_list.html). This repository provides some examples of scripting techniques that can leverage Cisco CRS abilities.

Cisco script applications can make use of many components, such as scripts, pre-recorded prompts, grammars, languages, locales, and custom Java classes. For more information about these components, see Chapter 10, “Managing Prompts, Grammars, Documents, and Custom Files.”

**Tip**

Upload these components to the Repository before you configure a Cisco script application that uses them.

Depending on your particular CRS implementation, you may need to perform most or all of the following tasks to configure a Cisco script application:

1. Manage scripts. Cisco script applications are based on scripts that you must upload to the repository and make available to the CRS system.

2. Manage prompts. Many applications make use of pre-recorded prompts, stored as .wav files, which are played back to callers in order to provide information and elicit caller response. You must upload these .wav files to the repository and make them available to the CRS system.
3. Install grammars. The CRS system uses specific grammars to recognize and respond to caller response to prompts. You must store these grammars in a directory to make them available to the CRS system.

4. Install customized CRS languages. Language packs, such as American English, Canadian French, and so on, are installed with Cisco CRS. You install language packs in a directory accessible by the CRS system.

5. Install Java files. In addition to the Java files automatically installed as part of the Cisco CRS installation process, you can install your own custom classes and Java Archive (JAR) files in order to customize the performance of your CRS system.

6. Add a Cisco script application. Scripts created in the CRS Editor are used as the basis for Cisco script applications.

7. Add an application trigger. Triggers are specified signals that invoke application scripts in response to incoming contacts. After adding a new Cisco script application, you need to add a trigger so that this application can respond to telephone calls and/or HTTP requests.

To add a new Cisco script application, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Applications > Application Management**.

The Application Configuration summary web page opens.

**Step 2**
Click the **Add a New Application** hyperlink.

The Add a New Application web page opens.

**Step 3**
From the Application Type drop-down menu, choose **Cisco Script Application** and click **Next**.

The Cisco Script Application configuration web page opens.

**Step 4**
Use this web page to specify the following fields.
## Chapter 9  Configuring Cisco Applications

### About CRS Applications

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application.</td>
</tr>
<tr>
<td>ID</td>
<td>Accept the automatically-generated ID, or enter a unique ID.</td>
</tr>
<tr>
<td>Note</td>
<td>The Historical Reporting feature uses this ID to identify this application.</td>
</tr>
<tr>
<td>Maximum Number Of Sessions</td>
<td>The maximum amount of simultaneous sessions (instances) that the application can handle.</td>
</tr>
<tr>
<td>Note</td>
<td>The limit for the maximum number of simultaneous remote monitoring sessions is 16, but the actual number depends on your system’s CPU and memory resources. Entering a number that is too high can result in unacceptable system performance.</td>
</tr>
<tr>
<td>Script</td>
<td>This field is only available for Cisco Script Application type.</td>
</tr>
<tr>
<td>Note</td>
<td>All scripts under the default directory are listed in the drop-down list of the Script field in the Cisco Script Application Configuration page.</td>
</tr>
<tr>
<td>Description</td>
<td>Use the Tab key to automatically populate this field.</td>
</tr>
<tr>
<td>Note</td>
<td>For the Busy and Ring-No-Answer application types, this field is only visible when you click on Show More.</td>
</tr>
</tbody>
</table>
Step 5  Click Add.

The Cisco Script Application page refreshes, the Add New Trigger hyperlink appears on the navigation bar, and a dialog box opens with the following message:

The operation has been executed successfully.

Step 6  Click OK to close the dialog box.

Your next step is to add a trigger for the application (see Adding Application Triggers, page 9-18).

Related Topics

- About CRS Applications, page 9-2
- Configuring the Busy Application, page 9-7
- Configuring the Ring-No-Answer Application, page 9-8
- Configuring the Remote Monitoring Application, page 9-16
- Configuring the Unified ICME Post-Routing Application, page 9-10
- Configuring the Unified ICME Translation-Routing Application, page 9-14
Configuring the Busy Application

This application, which comes with every CRS system, plays a busy signal.

Note: The Cisco Busy application comes with each CRS system.

The Cisco Busy application returns a busy signal when a call reaches a Computer Telephony Interface (CTI) route point and the extension is busy.

To configure the Busy application, you will need to perform the following tasks:

1. Add the Busy application.
2. Add a Unified CM Telephony trigger to the Busy application. The Busy application is activated when it is triggered by a Unified CM Telephony trigger. The Busy application does not support HTTP triggers.

To configure the Cisco CRS server with the Busy application, complete the following steps.

Procedure

Step 1: From the CRS Administration menu bar, choose Applications > Application Management and click the Add a New Application hyperlink.

The Add a New Application web page opens.

Step 2: From the Application Type drop-down menu, choose Busy, and then click Next.

The Busy Application Configuration web pages appears.

Step 3: Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application.</td>
</tr>
<tr>
<td>Description</td>
<td>Use the Tab key to automatically populate this field.</td>
</tr>
<tr>
<td>ID</td>
<td>Accept the automatically-generated ID, or enter a unique ID.</td>
</tr>
<tr>
<td>Note</td>
<td>The Historical Reporting feature uses this ID to identify this application.</td>
</tr>
</tbody>
</table>
Chapter 9  Configuring Cisco Applications

About CRS Applications

Step 4  Click **Add**.

The Busy web page refreshes, the **Add New Trigger** hyperlink appears on the navigation bar, and a dialog box opens with the following message:

**The operation has been executed successfully**

Step 5  Click **OK** to close the dialog box.

Your next step is to add a trigger for the application (see *Adding Application Triggers*, page 9-18).

**Related Topics**

- About CRS Applications, page 9-2
- Configuring Cisco Script Applications, page 9-3
- Configuring the Ring-No-Answer Application, page 9-8
- Configuring the Remote Monitoring Application, page 9-16
- Configuring the Unified ICME Post-Routing Application, page 9-10
- Configuring the Unified ICME Translation-Routing Application, page 9-14

### Configuring the Ring-No-Answer Application

This application, which comes with each CRS system, plays a ring tone.

**Note**  The Cisco Ring-No-Answer application comes with each CRS system.
The Cisco Ring-No-Answer application returns a ring tone signal when a call reaches a CTI route point.

To configure the Ring-No-Answer application, you will need to perform the following tasks:

1. Add the Ring-No-Answer application.
2. Add a Unified CM Telephony trigger to the Ring-No-Answer application. The Ring-No-Answer application is activated when it is triggered by a Unified CM Telephony trigger.

To configure the Cisco CRS server with the Ring-No-Answer application, complete the following steps.

**Procedure**

**Step 1** From the CRS Administration menu bar, choose **Applications > Application Management** and click the **Add a New Application** hyperlink.

The Add a New Application web page opens.

**Step 2** From the Application Type drop-down menu, choose **Ring-No-Answer**, and then click **Next**.

The Ring-No-Answer web page opens.

**Step 3** Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application.</td>
</tr>
<tr>
<td>Description</td>
<td>Use the Tab key to automatically populate this field.</td>
</tr>
<tr>
<td>ID</td>
<td>Accept the automatically-generated ID, or enter a unique ID.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The Historical Reporting feature uses this ID to identify this application.</td>
</tr>
</tbody>
</table>
### Related Topics

- About CRS Applications, page 9-2
- Configuring Cisco Script Applications, page 9-3
- Configuring the Busy Application, page 9-7
- Configuring the Ring-No-Answer Application, page 9-8
- Configuring the Remote Monitoring Application, page 9-16
- Configuring the Unified ICME Translation-Routing Application, page 9-14

### Configuring the Unified ICME Post-Routing Application

These applications are used by the Unified IP IVR system to receive calls directly from Unified CM, which sends the call to the post-routing route point on the Cisco CRS system.
Chapter 9      Configuring Cisco Applications

About CRS Applications

Note

The Unified ICME Post-routing application comes with Unified QM and Unified IP IVR.

Unified ICME post-routing applications use the CRS server as a queue point for Unified ICME. In Unified ICME post-routing, the Unified IP IVR system receives calls directly from Unified CM, which sends the call to the post-routing route point on the CRS system.

If you configure this route point to run an initial application, such as an application to welcome the caller and collect an account number, the CRS system notifies the Unified ICME software about the call, and then waits for further instructions. If you do not configure an initial script, the CRS system informs the Unified ICME software about the call, but takes no other action.

After notification, the Unified ICME system runs a script, which can be composed of many different call-handling steps, including three commands that can be sent to the CRS system:

- **Connect**—This request is automatically sent by Unified ICME whenever an agent is available and the call can be connected to that agent.
- **Release**—This request releases the call.
- **Run VRU Script**—This request runs the VRU script.

Note

Before you can configure a Unified ICME post-routing application, you must first upload any VRU scripts that the application will need (see Provisioning the Unified ICME Subsystem, page 8-3).

To configure a Unified ICME post-routing application, you will need to perform the following tasks:

1. Add a Unified ICME post-routing application. In addition to configuring general information such as name and ID, you must specify the script on which the Unified ICME post-routing application is based.

2. Add a Unified CM Telephony trigger to the Unified ICME post-routing application. The Unified ICME post-routing application is invoked by a Unified CM Telephony trigger. The Unified ICME post-routing application does not support HTTP triggers.
To configure the Cisco CRS server with the post-routing application and to add a Unified CM Telephony trigger, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Applications > Application Management** and click the **Add a New Application** hyperlink.

The Add a New Application web page opens.

**Step 2**
From the **Application Type** drop-down menu, choose **Unified ICME Post-Routing**.

The Unified ICME Post-Routing configuration web page opens.

**Step 3**
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application.</td>
</tr>
<tr>
<td>Description</td>
<td>Use the Tab key to automatically populate this field.</td>
</tr>
<tr>
<td>ID</td>
<td>Accept the automatically-generated ID, or enter a unique ID. This ID is the service identifier that will be reported with the call back to Unified ICME.</td>
</tr>
<tr>
<td>Maximum Number Of Sessions</td>
<td>The maximum amount of simultaneous sessions (instances) that the application can handle.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The limit for the maximum number of simultaneous remote monitoring sessions is 16, but the actual number depends on your system’s CPU and memory resources. Entering a number that is too high can result in unacceptable system performance.</td>
</tr>
<tr>
<td>Enabled</td>
<td>(Radio button) Accept <strong>Yes</strong> (the default).</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>The maximum amount of time (in seconds) that the system will wait to invoke the application before rejecting a contact.</td>
</tr>
</tbody>
</table>
Step 4  Click Add.

The Unified ICME Post-Routing web page refreshes, the **Add New Trigger** hyperlink appears on the navigation bar, and a dialog box opens with the following message:

The operation has been executed successfully

Step 5  Click **OK** to close the dialog box.

Your next step is to add a trigger for the application (see **Adding Application Triggers**, page 9-18).

---

**Related Topics**

- About CRS Applications, page 9-2
- Configuring Cisco Script Applications, page 9-3
- Configuring the Busy Application, page 9-7
- Configuring the Ring-No-Answer Application, page 9-8
- Configuring the Remote Monitoring Application, page 9-16
- Configuring the Unified ICME Post-Routing Application, page 9-10
- Provisioning the Unified ICME Subsystem, page 8-3
Configuring the Unified ICME Translation-Routing Application

These applications use the CRS server as a queue point for Unified CCX, so that Unified ICME can route calls to the CRS server.

**Note**
The Unified ICME Translation-routing application comes with Unified QM and Unified IP IVR.

You must configure Unified ICME translation-routing applications when the CRS server is used as a queue point for a Unified CCX solution (Unified QM) in which calls are expected to be routed by the Unified ICME to the CRS server.

The call attributes will be reported as part of a configured translation-route on the Unified ICME.

**Note**
Before you can configure a Unified ICME translation-routing application, you must first upload any VRU scripts that the application will need (see Provisioning the Unified ICME Subsystem, page 8-3).

To configure the Unified ICME translation-routing application, you will need to perform the following tasks:

1. Add a Unified ICME translation-routing application.
   In addition to configuring general information such as name and ID, you must specify the script on which the Unified ICME translation-routing application is based.

2. Add a Unified CM Telephony trigger to the Unified ICME translation-routing application.
   The Unified ICME translation-routing application is invoked by a Unified CM Telephony trigger, and does not support HTTP triggers.

To configure the Cisco CRS server with a Unified ICME translation-routing application and to add a Unified CM Telephony trigger, complete the following steps.
Chapter 9 Configuring Cisco Applications

About CRS Applications

Procedure

Step 1 From the CRS Administration menu bar, choose Applications > Application Management and click the Add a New Application hyperlink.

The Add a New Application web page opens.

Step 2 From the Application Type drop-down menu, choose Unified ICME Translation-Routing.

The Unified ICME Translation-Routing configuration web page opens.

Step 3 Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application.</td>
</tr>
<tr>
<td>Description</td>
<td>Use the Tab key to automatically populate this field.</td>
</tr>
<tr>
<td>ID</td>
<td>Accept the automatically-generated ID, or enter a unique ID.</td>
</tr>
<tr>
<td></td>
<td>This field corresponds to the service identifier of the call reported to the Unified ICME and configured in the Unified ICME translation route.</td>
</tr>
<tr>
<td>Maximum Number Of</td>
<td>The maximum amount of simultaneous sessions (instances) that the application can handle.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Note  The limit for the maximum number of simultaneous remote monitoring sessions is 16, but the actual number depends on your system’s CPU and memory resources. Entering a number that is too high can result in unacceptable system performance.</td>
</tr>
<tr>
<td>Enabled (Radio button)</td>
<td>Accept Yes (the default).</td>
</tr>
<tr>
<td>Timeout (in seconds)</td>
<td>The maximum amount of time (in seconds) that the system will wait to invoke the application before rejecting a contact.</td>
</tr>
<tr>
<td>Default Script (Drop-down list)</td>
<td>Choose a script to run to route a call to a default treatment in the event of a:</td>
</tr>
<tr>
<td></td>
<td>• System error</td>
</tr>
<tr>
<td></td>
<td>• Request by Unified ICME</td>
</tr>
</tbody>
</table>

Step 4 Click Add.
The Unified ICME Translation Routing web page refreshes, the **Add New Trigger** hyperlink appears on the navigation bar, and a dialog box opens with the following message:

*The operation has been executed successfully*

**Step 5** Click **OK** to close the dialog box.

Your next step is to add a trigger for the application (see *Adding Application Triggers*, page 9-18).

---

**Related Topics**

- About CRS Applications, page 9-2
- Configuring Cisco Script Applications, page 9-3
- Configuring the Busy Application, page 9-7
- Configuring the Remote Monitoring Application, page 9-16
- Configuring the Unified ICME Post-Routing Application, page 9-10
- Configuring the Unified ICME Translation-Routing Application, page 9-14
- Provisioning the Unified ICME Subsystem, page 8-3

---

**Configuring the Remote Monitoring Application**

This application, available when you purchase Unified CCX Premium, allows a supervisor to monitor an agent’s conversation.

**Note** The Remote Monitoring application comes with Unified CCX Premium systems.
You must configure Remote Monitoring applications when you want to use the Remote Monitoring feature to allow a supervisor to monitor an agent’s conversation.

**Procedure**

**Step 1**  
From the CRS Administration menu bar, choose **Applications > Application Management** and click the **Add a New Application** hyperlink.  
The Add a New Application web page opens.

**Step 2**  
Choose **Cisco Script Application** from the Application Type drop-down menu and click **Next**.  
The Cisco Script Application web page appears.

**Step 3**  
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application.</td>
</tr>
<tr>
<td>Description</td>
<td>Use the Tab key to automatically populate this field.</td>
</tr>
<tr>
<td>ID</td>
<td>Accept the automatically-generated ID, or enter a unique ID.</td>
</tr>
<tr>
<td>Note</td>
<td>The Historical Reporting feature uses this ID to identify this application.</td>
</tr>
<tr>
<td>Maximum Number of Sessions</td>
<td>The maximum amount of simultaneous sessions that monitoring sessions allow.</td>
</tr>
<tr>
<td>Note</td>
<td>The limit for the maximum number of simultaneous remote monitoring sessions is 16, but the actual number depends on your system’s CPU and memory resources. Entering a number that is too high can result in unacceptable system performance.</td>
</tr>
<tr>
<td>Enabled</td>
<td>(Radio button) Accept <strong>Yes</strong> (the default).</td>
</tr>
<tr>
<td>Script</td>
<td>Select a customized Remote Monitor script or <strong>rmon.aef</strong> from the drop-down list.</td>
</tr>
<tr>
<td>Note</td>
<td>A new set of fields appears for a remote monitoring script.</td>
</tr>
<tr>
<td>WelcomePrompt</td>
<td>The .wav file of the Welcome prompt.</td>
</tr>
<tr>
<td>MaxRetry</td>
<td>The number of times that the script allows a supervisor to enter an incorrect user ID or password before disconnecting the supervisor.</td>
</tr>
</tbody>
</table>
Adding Application Triggers

After adding a new Cisco application, you need to add one or more triggers so that the application can respond to Unified CM/Unified CME Telephony calls and/or HTTP requests.

Triggers are specified signals that invoke application scripts in response to incoming contacts. The CRS system uses Unified CM/Unified CME Telephony triggers to trigger responses to telephone calls and HTTP triggers to respond to HTTP requests.

### Related Topics

- About CRS Applications, page 9-2
- Configuring Cisco Script Applications, page 9-3
- Configuring the Busy Application, page 9-7
- Configuring the Ring-No-Answer Application, page 9-8
- Configuring the Unified ICME Post-Routing Application, page 9-10
- Configuring the Unified ICME Translation-Routing Application, page 9-14

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator Extension</td>
<td>The extension of the agent being monitored.</td>
</tr>
<tr>
<td>Default Script</td>
<td>Accept <strong>System Default</strong>. The default script is executed if an error occurs with the configured application script.</td>
</tr>
</tbody>
</table>

### Step 4

Click **Add**.

The Remote Monitoring web page refreshes, the **Add New Trigger** hyperlink appears on the navigation bar, and a dialog box opens with the following message:

*The operation has been executed successfully*

### Step 5

Click **OK** to close the dialog box.

Your next step is to add a trigger for the application (see Adding Application Triggers, page 9-18).
You can use either of two methods to add a trigger to an application: Add the
trigger from the Cisco Application web page or add the trigger from the Unified
CM/Unified CME Telephony or HTTP Triggers web pages available from the
Subsystem menu.

This section contains the following procedures:

- Adding a Unified CM/Unified CME Telephony Trigger, page 9-19
- Adding an HTTP Trigger, page 9-21

Related Topics
- About CRS Applications, page 9-2
- Managing Scripts, page 9-25
- Provisioning the Unified CM Telephony Subsystem, page 6-5
- Provisioning the Unified CME Telephony Subsystem, page 5-6
- Provisioning the HTTP Subsystem, page 8-8

Adding a Unified CM/Unified CME Telephony Trigger

You must add Unified CM/Unified CME Telephony triggers to invoke Cisco
applications in response to incoming contacts.

A Unified CM/Unified CME Telephony trigger responds to calls that arrive on a
specific route point by selecting telephony and media resources to serve the call
and invoking an application script to handle the call.

This section contains the following procedures:

- Adding Unified CM/Unified CME Telephony Triggers from an Application
  Web Page, page 9-20
- Adding Unified CM/Unified CME Telephony Triggers from Cisco CRS,
  page 9-21

Related Topics
- Adding a Unified CM/Unified CME Telephony Trigger, page 9-19
- Provisioning the Unified CM Telephony Subsystem, page 6-5
- Provisioning the Unified CME Telephony Subsystem, page 5-6
Adding Unified CM/Unified CME Telephony Triggers from an Application Web Page

To add a Unified CM/Unified CME Telephony trigger directly from the Cisco Application configuration web page, complete the following steps.

Procedure

Step 1  From the configuration web page for the application you want to add a trigger for, click the Add New Trigger hyperlink.

The Add a New Trigger window opens.

Step 2  From the Trigger Type drop-down menu, select Unified CM/Unified CME Telephony and click Click Next.

The Unified CM/Unified CME Telephony Trigger Configuration window opens.

Step 3  Follow the procedure described in Adding a Unified CM Telephony Trigger, page 6-14.

Related Topics

- About CRS Applications, page 9-2
- Adding a Unified CM/Unified CME Telephony Trigger, page 9-19
- Adding an HTTP Trigger, page 9-21
- Provisioning the Unified CM Telephony Subsystem, page 6-5
- Provisioning the Unified CME Telephony Subsystem, page 5-6
- Configuring HTTP Triggers, page 8-9
Adding Unified CM/Unified CME Telephony Triggers from Cisco CRS

To add a Unified CM/Unified CME Telephony trigger to an application from the Unified CM/Unified CME Telephony subsystem, complete the following steps.

Procedure

Step 1
From the CRS Administration menu bar, choose Subsystems > Unified CM/Unified CME Telephony.

The Unified CM/Unified CME Telephony Configuration web page opens.

Step 2
On the navigation bar, click the Unified CM/Unified CME Telephony Triggers hyperlink.

The first Unified CM Telephony Trigger Configuration summary web page opens.

Step 3
Click the Add a New Unified CM/Unified CME Telephony Trigger hyperlink.

Step 4
Follow the procedure described in Adding a Unified CM Telephony Trigger, page 6-14.

Related Topics
- About CRS Applications, page 9-2
- Adding Application Triggers, page 9-18
- Adding a Unified CM/Unified CME Telephony Trigger, page 9-19
- Adding an HTTP Trigger, page 9-21
- Provisioning the Unified CM Telephony Subsystem, page 6-5
- Provisioning the Unified CME Telephony Subsystem, page 5-6
- Configuring HTTP Triggers, page 8-9

Adding an HTTP Trigger

A Cisco application can be used to handle HTTP requests when the CRS system is provisioned with an HTTP trigger.
HTTP triggers are available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR or Unified CCX Premium.

An HTTP trigger is the relative URL a user enters into the client browser to start the application. You can upload either eXtensible Style Language Transformation (XSLT) templates or Java Server Pages (JSP) templates to serve as your HTTP trigger.

The following path is an example of an HTTP-triggered request (using the HTTP trigger name “/hello”):

http://www.appserver.acme.com:8080/hello

In this example, the URL starts the application with the HTTP trigger “/hello” on a web server running on port 8080 with the host name www.appserver.acme.com.

You can add the HTTP trigger from the Cisco Script Application web page or add the trigger from the HTTP subsystem.

This section contains the following procedures:
- Adding HTTP Triggers from an Application Web Page, page 9-22
- Adding HTTP Triggers from the HTTP Subsystem, page 9-24

### Adding HTTP Triggers from an Application Web Page

To add an HTTP trigger directly from a Cisco Application Configuration web page, complete the following steps.

**Procedure**

1. From the configuration web page for the application you want to add a trigger for, click the **Add New Trigger** hyperlink.

   The Add a New Trigger window opens.
Step 2  From the Trigger Type drop-down menu, select **HTTP** and click **Click Next**.

The HTTP Trigger Configuration window opens.

Step 3  Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| URL                    | The relative URL  
For example:  
http://www.appserver.acme.com:8080/hello |
| Language               | Perform one of the following actions:  
• Choose a default language from the drop-down list.  
• Click **Edit**, specify a default language in the dialog box that appears, and click **OK**. |
| Maximum Number Of Sessions | The maximum amount of simultaneous sessions that can be served by the HTTP subsystem for this trigger. |
| Idle Timeout (in ms)   | Maximum amount of time (in milliseconds) that the system will wait to invoke the application before rejecting a contact. |
| Enabled                | (Radio button) Accept **Yes** (the default). |

**Note**  If you disable the trigger, the user receives an error message when browsing to the defined trigger URL.

Step 4  Click **Add**.

The Cisco Application Configuration web page appears, and the URL of the HTTP trigger appears on the navigation bar.

Step 5  Test the trigger by entering the URL you just configured in the address bar of your browser.

For example,  
http://www.appserver.acme.com:8080/hello

The browser should display “hello”.

---
Adding Application Triggers

Related Topics

- About CRS Applications, page 9-2
- Adding a Unified CM/Unified CME Telephony Trigger, page 9-19
- Adding an HTTP Trigger, page 9-21
- Provisioning the Unified CM Telephony Subsystem, page 6-5
- Configuring HTTP Triggers, page 8-9

Adding HTTP Triggers from the HTTP Subsystem

To configure a HTTP trigger from the HTTP subsystem, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Subsystems > HTTP**. The first HTTP Trigger Configuration window opens.

**Step 2**
Click the **Add a New HTTP Triggers** hyperlink. The HTTP Trigger Configuration window opens.

**Step 3**
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The relative URL. For example: <a href="http://www.appserver.acme.com:8080/hello">http://www.appserver.acme.com:8080/hello</a></td>
</tr>
<tr>
<td>Language</td>
<td>Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>• Choose a default language from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Edit</strong>, specify a default language in the dialog box that appears, and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Maximum Number Of Sessions</td>
<td>The maximum amount of simultaneous sessions that can be served by the HTTP subsystem for this trigger.</td>
</tr>
</tbody>
</table>
Managing Scripts

Scripts are created with the CRS Editor, and can perform a wide variety of functions. For example, scripts can prompt callers for extension numbers in order to transfer calls, place callers in a queue and route calls to available agents, and place outbound calls.
The Script Management option of the Applications menu of the Cisco CRS Administration web interface contains options for managing and refreshing CRS scripts that are stored in the repository.

**Note**
Your Cisco CRS system includes sample scripts stored as .aef files. For a description of these scripts, see the “Sample Scripts” section on page 9-35.

This section contains the following procedures:
- Uploading New Scripts, page 9-26
- Viewing or Downloading a Script File, page 9-29
- Refreshing Scripts, page 9-30
- Renaming a Script or Folder, page 9-33
- Deleting a Script or Folder, page 9-34
- Sample Scripts, page 9-35
- The Wizards Menu, page 21-1

**Caution**
If a large number of VRU scripts are configured for your system, the **Upload a New Script** and **Refresh Scripts** operations can take a long time to complete. These tasks can also result in high CPU utilization.

**Related Topics**
- About CRS Applications, page 9-2
- Adding Application Triggers, page 9-18

### Uploading New Scripts

To make a script available for use as a CRS application, you must first upload the script to the repository.

From Cisco CRS Release 4.5, uploaded scripts are stored in the Repository Datastore (RDS) database, along with prompts, grammars, and documents files. Prior to Release 4.5, the RDS database only contained the prompts, grammars,
and documents files. The scripts can also be grouped into folders and subfolders. When user scripts are uploaded into repository, they get synchronized to local disk and are accessed from there.

To upload a script to the repository, complete the following steps.

**Procedure**

**Step 1**  From the CRS Administration menu bar, choose **Applications > Script Management**.

The Script Management page opens.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>A drop-down list defaulting to the root directory as the Script repository. This directory contains one folder called default. You cannot create a new folder at the root directory level nor can you rename the default folder. Within the default folder, you can create, rename, and delete folders. You can upload scripts to the default folder as a zip file so its contents (the *.aef files) can be unzipped and uploaded to the repository.</td>
</tr>
<tr>
<td>Folder path</td>
<td>The level of the directory that is currently selected in the folder drop-down list.</td>
</tr>
</tbody>
</table>
| Name      | The name of the script.  
  Note: Click the icon in front of the script name to download the script file. |
| Size      | The size of the script file prefixed with KB. The file size is converted from bytes to KB.  
  Note: This column is usually blank on the root page as the items on this page are usually folders. |
| Date Modified | The date when the document was last uploaded or changed. |
Managing Scripts

Chapter 9  Configuring Cisco Applications

Step 2  Click on the default folder.
        The Script Management page opens to display the contents of the default folder.

Step 3  Click the Upload New Scripts hyperlink.
        A dialog box opens.

Step 4  In the File Name field, click Browse.
        A Choose File window opens.

Step 5  Navigate to the directory in which scripts are located, select a script, and then click Open.
        The Choose File window closes, and the script path appears in the File Name field.

Step 6  Click Upload to upload the script to the repository.
        A window opens, informing you that the script was successfully uploaded.

Note  When you make changes to a script, you must refresh the script in order to direct all the applications and subsystems that use this script to reload the new version (see Refreshing Scripts, page 9-30).
You are now ready to manage any existing scripts shown in the Script Management page (if necessary) or add prompts that may be useful to your applications.

Related Topics
- About CRS Applications, page 9-2
- Viewing or Downloading a Script File, page 9-29
- Refreshing Scripts, page 9-30
- Renaming a Script or Folder, page 9-33
- Deleting a Script or Folder, page 9-34
- Sample Scripts, page 9-35

Viewing or Downloading a Script File

You can view or download any script file that appears in the list on the Script Management web page.

To view or download a script file, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose Applications > Script Management.

The Script Management page opens.

Step 2  Click on the default folder.

The Script Management page opens to display the contents of the default folder.

Step 3  Click the Download Script icon that appears next to the Name of the script file you want to view or download.

The File Download dialog box opens.

Step 4  Perform one of the following tasks:

- To view the script file, click Open.

  The script file opens in the CRS Editor.
To download the script file, click **Save**, and then follow the prompts to choose a directory and file name for the script file. The file is saved to the specified directory.

**Related Topics**
- About CRS Applications, page 9-2
- Uploading New Scripts, page 9-26
- Refreshing Scripts, page 9-30
- Renaming a Script or Folder, page 9-33
- Deleting a Script or Folder, page 9-34
- Sample Scripts, page 9-35

## Refreshing Scripts

**Caution**

If a large number of VRU scripts are configured for your system, the **Upload a New Script** and **Refresh Scripts** operations can take a long time to complete. These tasks can also result in high CPU utilization.

When you make changes to a script, you must refresh the script in order to direct all the applications and subsystems that use this script to reload the new version. There are two script refresh options:

- Individual script refresh
- Bulk script refresh
Individual Script Refresh

To refresh an individual script on the Cisco CRS server from the repository (RDS), complete the following steps.

Procedure

Step 1
From the CRS Administration menu bar, choose Applications > Script Management.

The Script Management page opens.

Step 2
Click on the default folder.

The Script Management page opens to display the contents of the default folder.

Step 3
Click the Refresh icon in the row that contains the script to refresh.

The script information refreshes and the Script Management page reappears.

Related Topics
- About CRS Applications, page 9-2
- Uploading New Scripts, page 9-26
- Viewing or Downloading a Script File, page 9-29
- Refreshing Scripts, page 9-30
- Renaming a Script or Folder, page 9-33
- Deleting a Script or Folder, page 9-34
- Sample Scripts, page 9-35

Bulk Script Refresh

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.
Bulk scripts refers to multiple .aef script files within one .zip file. This option is only available when you upload .zip files. After the selected file is successfully uploaded, you will see the option to refresh scripts.

To refresh all scripts (within a zip file) with one command, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Applications > Script Management**.
The Script Management page opens.

**Step 2**
Click on the **default** folder.
The Script Management page opens to display the contents of the **default** folder.

**Step 3**
Click the **Upload New Scripts** hyperlink.
A dialog box opens.

**Step 4**
In the File Name field, click **Browse**.
A Choose File window opens.

**Step 5**
Navigate to the directory in which scripts are located, select a file, and then click **Open**.

**Tip**
You can only upload .zip files containing .aef files. The total size of the .zip file cannot exceed 20 MB.

The Choose File window closes, and the selected file appears in the File Name field.

**Step 6**
Click **Upload** to upload the script to the repository.
A window opens, informing you that the script upload succeeded.

**Step 7**
Click the **Refresh the Script** hyperlink.
The Script Management web page opens, giving you the option of refreshing the script and the applications that reference it, or just refreshing the script.

**Step 8**
Specify one of the following options:
If you want all applications and subsystems that reference the script (in the repository) to use the new version, click Yes.

If you only want to refresh the scripts, click No.

If you want to cancel the operation, click Cancel.

The script information refreshes and the Script Management page reappears to display the newly-loaded .zip file.

---

### Related Topics

- About CRS Applications, page 9-2
- Uploading New Scripts, page 9-26
- Viewing or Downloading a Script File, page 9-29
- Refreshing Scripts, page 9-30
- Renaming a Script or Folder, page 9-33
- Deleting a Script or Folder, page 9-34
- Sample Scripts, page 9-35

---

### Renaming a Script or Folder

To rename a script, complete the following steps.

**Procedure**

**Step 1** From the CRS Administration menu bar, choose **Applications > Script Management**.

The Script Management page opens.

**Step 2** Click on the default folder.

The Script Management page opens to display the contents of the default folder.

**Step 3** Perform one of the following actions:

- Click the **Rename Folder** hyperlink. A dialog box opens to display a drop-down list of available scripts and folders. Select the required subfolder from the **Select Folder to Rename** drop-down list.
Managing Scripts

• Click the Rename Folder icon under the Actions column. A dialog box opens to display the selected folder or script in the Select Folder to Rename drop-down list.

Step 4 Enter the new name for this folder in the Rename Folder to field.

Step 5 Click Rename.

The dialog box refreshes to state that the folder was successfully renamed.

Step 6 Click the Return to Script Management hyperlink.

The dialog box closes and the default folder’s updated Script Management page refreshes to display the new script name.

Related Topics
• About CRS Applications, page 9-2
• Uploading New Scripts, page 9-26
• Viewing or Downloading a Script File, page 9-29
• Refreshing Scripts, page 9-30
• Deleting a Script or Folder, page 9-34
• Sample Scripts, page 9-35

Deleting a Script or Folder

When you delete a script or a folder, you remove it permanently from the repository.

To delete a script or folder, complete the following steps.

Procedure

Step 1 From the CRS Administration menu bar, choose Applications > Script Management.

The Script Management page opens.

Step 2 Click on the default folder.

The Script Management page opens to display the contents of the default folder.
Step 3 Perform one of the following actions:

- Click the **Delete Folder** hyperlink.
  
  A dialog box opens to display a drop-down list of available scripts and folders. Select the required subfolder in the **Select Folder to Delete** field. Click **Delete**. The dialog box refreshes to state that the folder or script was successfully deleted. Click the **Return to Script Management** hyperlink.

- Click the Delete icon under the Actions column. A dialog box opens to confirm your action on the selected script or folder. Click **OK**.

The dialog box closes and the default folder’s updated Script Management page refreshes to display the updated list of folders and scripts.

---

Related Topics
- About CRS Applications, page 9-2
- Uploading New Scripts, page 9-26
- Viewing or Downloading a Script File, page 9-29
- Refreshing Scripts, page 9-30
- Renaming a Script or Folder, page 9-33
- Deleting a Script or Folder, page 9-34
- Sample Scripts, page 9-35

---

Sample Scripts

Your Cisco CRS system includes sample scripts stored as .aef files. These scripts have been built using Cisco CRS Editor steps, including prerecorded prompts. You can use these scripts to create applications without performing any script development, or you can use these scripts as models for your own customized scripts.

**Note**

The included scripts are bundled with the CRS system solely as samples, and are not supported by Cisco. For more information on these sample scripts, see the *Cisco CRS Scripting and Development Series: Volume 1, Getting Started with Scripts.*
Managing Prompts, Grammars, Documents, and Custom Files

Cisco CRS applications can make use of many auxiliary files that interact with callers, such as scripts, pre-recorded prompts, grammars, and custom Java classes. To manage these auxiliary files, you must complete the following tasks:

- Provision telephony and media resources (see Chapter 6, “Provisioning Telephony and Media”).
- Provision Cisco Unified Contact Center Express (Unified CCX) subsystem, if required (see Chapter 8, “Provisioning Additional Subsystems”).
- Provision additional subsystems, if required (see Chapter 8, “Provisioning Additional Subsystems”).
- Configure Cisco script applications (see Chapter 9, “Configuring Cisco Applications”)

Depending on your particular CRS implementation, your applications might make use of some or all of the file types described in the following sections:

- Managing Prompt Files, page 10-2
- Managing Grammar Files, page 10-4
- Managing Document Files, page 10-6
- Managing Languages, page 10-8
- Recording and Uploading Prompt Files, page 10-11
- Managing Custom Files, page 10-15
- Managing AAR Files, page 10-19
Managing Prompt Files

Many applications make use of pre-recorded prompts, stored as .wav files, which are played back to callers in order to provide information and elicit caller response.

Several system-level prompt files are loaded during Cisco CRS installation. However, any file you create needs to be made available to the CRS Engine before a CRS application can use them. This is done through the CRS cluster’s Repository datastore, where the prompt, grammar, and document files are created, stored, and updated.

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The CRS Server’s local disk prompt files are synchronized with the central repository during Cisco CRS Engine startup and during run-time when the Repository datastore is modified. For more information about the Repository datastore, see Chapter 12, “Managing the Cisco CRS Datastores.”

To access the Prompt Management page, select Application > Prompt Management. The Prompt Management web page opens to display the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Location of the items listed in the Name column.</td>
</tr>
<tr>
<td>Folder</td>
<td>Path of the item selected in the Name column. Default = default folder</td>
</tr>
<tr>
<td>Codec</td>
<td>(Display only). The CODEC chosen during installation for this CRS server.</td>
</tr>
<tr>
<td>Create Language</td>
<td>Displays a dialog box that lets you create a new language folder.</td>
</tr>
<tr>
<td>Rename Language</td>
<td>Displays a dialog box that lets you rename an existing language folder.</td>
</tr>
<tr>
<td>Delete Language</td>
<td>Displays a dialog box that lets you delete an existing language folder.</td>
</tr>
<tr>
<td>Upload Zip Files</td>
<td>Displays a dialog box that lets you locate and upload a zip file.</td>
</tr>
<tr>
<td>Note</td>
<td>The zip file must contain language folders in the root directory. Be sure to place the prompt files in folders and then zip the folders.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the language.</td>
</tr>
</tbody>
</table>
When you click on a hyperlink (if configured) in the Name folder column, a secondary page appears. From this page, you can create a subfolder or upload a new Prompt, Grammar, or Document.

**Related Topics**
- The Wizards Menu, page 21-1
- Managing Grammar Files, page 10-4
- Managing Document Files, page 10-6
- Managing Languages, page 10-8
- Recording and Uploading Prompt Files, page 10-11
- Managing Custom Files, page 10-15
- Managing AAR Files, page 10-19
- Managing Scripts, page 9-25

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>The size of the prompt file prefixed with KB. The file size is converted from bytes to KB.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> This column is usually blank on the root page as the items on this page are usually folders.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>The date when the document was last uploaded or changed.</td>
</tr>
<tr>
<td>Modified by</td>
<td>The user ID of the person who performed these modifications.</td>
</tr>
<tr>
<td>Actions</td>
<td>The following icons:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Delete</strong> - Click to remove the folder and its contents from the repository.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Rename</strong> - Click to rename the folder in the repository.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Refresh</strong> - Click to rename the folder in the repository.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Upload</strong> - (For files, only.) Click to upload a file to the repository.</td>
</tr>
</tbody>
</table>
Managing Grammar Files

The CRS system uses specific grammars when recognizing and responding to caller response to prompts. A grammar is a specific set of all possible spoken phrases and/or Dual Tone Multi-Frequency (DTMF) digits to be recognized by CRS applications and acted upon during runtime.

Several system-level grammar files are loaded during Cisco CRS installation. However, any file you create needs to be made available to the CRS Engine before a CRS application can use them. This is done through the CRS cluster’s Repository datastore, where the grammar files are created, stored, and updated.

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The CRS Server’s local disk grammar files are synchronized with the central repository during Cisco CRS Engine startup and during run-time when the Repository datastore is modified. For more information about the Repository datastore, see Chapter 12, “Managing the Cisco CRS Datastores.”

To access the Grammar Management page, select Application > Grammar Management. The Grammar Management web page opens to display the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Location of the items listed in the Name column.</td>
</tr>
<tr>
<td>Folder</td>
<td>Path of the item selected in the Name column.</td>
</tr>
<tr>
<td>Codec</td>
<td>(Display only). The CODEC chosen during installation for this CRS server.</td>
</tr>
<tr>
<td>Create Language</td>
<td>Displays a dialog box that lets you create a new language folder.</td>
</tr>
<tr>
<td>Rename Language</td>
<td>Displays a dialog box that lets you rename an existing language folder.</td>
</tr>
<tr>
<td>Delete Language</td>
<td>Displays a dialog box that lets you delete an existing language folder.</td>
</tr>
<tr>
<td>Upload Zip Files</td>
<td>Displays a dialog box that lets you locate and upload a zip file.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The zip file must contain language folders in the root directory. Be sure to place the grammar files in folders and then zip the folders.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the language.</td>
</tr>
</tbody>
</table>
Managing Grammar Files

When you click on a hyperlink (if configured) in the Name folder column, a secondary page appears. From this page, you can create a subfolder or upload a new Prompt, Grammar, or Document.

**Related Topics**

- The Wizards Menu, page 21-1
- Managing Prompt Files, page 10-2
- Managing Document Files, page 10-6
- Managing Languages, page 10-8
- Recording and Uploading Prompt Files, page 10-11
- Managing Custom Files, page 10-15
- Managing AAR Files, page 10-19
- Managing Scripts, page 9-25

**Field** | **Description**
--- | ---
Size | The size of the grammar file prefixed with KB. The file size is converted from bytes to KB.

*Note* This column is usually blank on the root page as the items on this page are usually folders.

Date Modified | The date when the document was last uploaded or changed.

Modified by | The user ID of the person who performed these modifications.

Actions | The following icons:

- **Delete** - Click to remove the folder and its contents from the repository.
- **Rename** - Click to rename the folder in the repository.
- **Refresh** - Click to rename the folder in the repository.
- **Upload** - (For files, only.) Click to upload a file to the repository.
Managing Document Files

Documents might consist of .txt, .doc, .jsp, or .html files. Documents can also include custom classes and Java Archive (JAR) files that allow you to customize the performance of your CRS system.

Several system-level document files are loaded during Cisco CRS installation. However, any file you create needs to be made available to the CRS Engine before a CRS application can use them. This is done through the CRS cluster’s Repository datastore, where the document files are created, stored, and updated.

Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The CRS Server's local disk document files are synchronized with the central repository during Cisco CRS Engine startup and during run-time when the Repository datastore is modified. For more information about the Repository datastore, see Chapter 12, “Managing the Cisco CRS Datastores.”.

To access the Document Management page, select Application > Document Management. The Document Management web page opens to display the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Location of the items listed in the Name column.</td>
</tr>
<tr>
<td>Folder</td>
<td>Path of the item selected in the Name column.</td>
</tr>
<tr>
<td>Codec</td>
<td>(Display only). The CODEC chosen during installation for this CRS server.</td>
</tr>
<tr>
<td>Create Language</td>
<td>Displays a dialog box that lets you create a new language folder.</td>
</tr>
<tr>
<td>Rename Language</td>
<td>Displays a dialog box that lets you rename an existing language folder.</td>
</tr>
<tr>
<td>Delete Language</td>
<td>Displays a dialog box that lets you delete an existing language folder.</td>
</tr>
<tr>
<td>Upload Zip Files</td>
<td>Displays a dialog box that lets you locate and upload a zip file.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the language.</td>
</tr>
</tbody>
</table>

**Note**

The zip file must contain language folders in the root directory. Be sure to place the document files in folders and then zip the folders.
### Managing Document Files

When you click on a hyperlink (if configured) in the Name folder column, a secondary page appears. From this page, you can create a subfolder or upload a new Prompt, Grammar, or Document.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>The size of the document file prefixed with KB. The file size is converted from bytes to KB.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>  This column is usually blank on the root page as the items on this page are usually folders.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>The date when the document was last uploaded or changed.</td>
</tr>
<tr>
<td>Modified by</td>
<td>The user ID of the person who performed these modifications.</td>
</tr>
<tr>
<td>Actions</td>
<td>The following icons:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Delete</strong> - Click to remove the folder and its contents from the repository.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Rename</strong> - Click to rename the folder in the repository.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Refresh</strong> - Click to rename the folder in the repository.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Upload</strong> - (For files, only.) Click to upload a file to the repository.</td>
</tr>
</tbody>
</table>

When you click on a hyperlink (if configured) in the Name folder column, a secondary page appears. From this page, you can create a subfolder or upload a new Prompt, Grammar, or Document.

**Related Topics**

- The Wizards Menu, page 21-1
- Managing Prompt Files, page 10-2
- Managing Grammar Files, page 10-4
- Managing Languages, page 10-8
- Recording and Uploading Prompt Files, page 10-11
- Managing Custom Files, page 10-15
- Managing AAR Files, page 10-19
- Managing Scripts, page 9-25
Managing Languages

The topics in this section describe the procedures for managing languages:

- The Wizards Menu, page 21-1
- Creating a New Language, page 10-8
- Renaming a Language, page 10-9
- Deleting a Language, page 10-9
- Upload Zip files to a Language Folder, page 10-10
- Unzipping a Document File After Uploading, page 10-11

Creating a New Language

Use this procedure to create a new Prompt, Grammar, or Document language folder in the Repository datastore.

Procedure

Step 1 From the CRS Administration menu bar, choose Applications > Prompt Management or Grammar Management or Document Management. The corresponding Management web page opens.

Step 2 Click the Create Language hyperlink. A dialog box opens.

Step 3 Perform one of the following actions:
- Select a value from the Language drop-down list.
- Click Edit, specify a language name, and click OK.

Step 4 Click Create. A new language folder Name appears on the summary web page.
Renaming a Language

Use this procedure to rename a Prompt/Grammar/Document language folder in the Repository datastore.

Procedure

Step 1  From the CRS Administration menu bar, choose Applications > Prompt Management or Grammar Management or Document Management. The corresponding Management web page opens.

Step 2  Perform one of the following actions:

• Select the Rename Language hyperlink, select a folder to rename, specify a folder name, and click Rename.

• Click the Rename icon next to the name of a folder on the summary web page.

Step 3  Click OK to confirm the renaming of the folder.

Deleting a Language

Use this procedure to delete a Prompt/Grammar/Document language folder in the Repository datastore.

Procedure

Step 1  From the CRS Administration menu bar, choose Applications > Prompt Management or Grammar Management or Document Management. The corresponding Management web page opens.

Step 2  Perform one of the following actions:

• Select the Delete Language hyperlink, specify a folder name, and click Delete.

• Click the Delete icon next to the name of a folder on the summary web page.
Managing Languages

Chapter 10    Managing Prompts, Grammars, Documents, and Custom Files

Step 3    Click OK to confirm the deletion.

Upload Zip files to a Language Folder

In addition to adding Prompt or Document files individually, you can upload multiple files from a Zip file.

Note    The maximum upload file size is 20MB, whether it is a single file or a Zip file.

Tip    Be sure to upload (or download) large zip files in Prompt, Grammar and Document Management pages during off-peak hours.

Procedure

Step 1    From the CRS Administration menu bar, choose Applications > Prompt Management or Grammar Management or Document Management.

The corresponding Management web page opens.

Step 2    Click the Upload Zip Files hyperlink.

A dialog box opens.

Step 3    Enter a file name or click Browse to locate a file.

Step 4    Verify if you want to retain the default action of unzipping the file before uploading. If you want to change this option, uncheck the box.

Caution    In the Documents Management summary web page, you have the option to zip or to unzip the file before uploading. By default, this check box is checked to unzip the file before uploading. Ensure to uncheck the check box if you want to upload it as a zipped file.

Step 5    Click OK.
Recording and Uploading Prompt Files

Prompts are messages that the Cisco CRS system plays back to callers. CRS applications often use prompts to elicit caller response so that the CRS system can transfer calls, receive account information, and perform other functions.

To use prompts in your CRS applications, you must first create a folder to store them. You can then record and upload new user prompts, delete prompts, and modify existing prompts.

Unzipping a Document File After Uploading

Use this procedure to automatically unzip a Document file after uploading it in the Repository datastore.

Note

The feature is only available for CRS Document File Management.

Procedure

Step 1

From the CRS Administration menu bar, choose Applications > Document Management.

The Document Management summary web page opens.

Step 2

Click the Upload Zip Files hyperlink.

A dialog box opens.

Step 3

Perform the following steps.

a. Enter a File Name or click Browse to locate a file.

b. Select the Unzip after uploading checkbox.

Step 4

Click OK to confirm the deletion.

The contents of the zip file is uploaded to the folder.
You store pre-recorded prompts as .wav files. The CRS system also allows users to record spoken names, which you can upload to be used in the playback of prompts.

**Note**
Although your MRCP vendor might support multiple .wav file header formats, CRS supports audio playback of RIFF header .wav files, only.

ScanSoft uses RIFF headers. When generating a wav file prompt specifically for Nuance, be sure to consider the server playing the prompt:
- If the prompt is played by the Nuance Speech Server, then the .wav file will require a SPHERE header.
- If the prompt is played by the CRS server, then the .wav file requires a RIFF header.

Nuance provides a tool to convert .wav files from RIFF headers to SPHERE headers.

Managing prompts involves the following tasks:
1. Create a folder to store prompts. You must create a folder to store the .wav files that the CRS system uses as prompts.
2. Record a prompt. You can record your own prompts to be used in applications.
3. Upload a prompt (or prompts). You can replace any of the stored prompts used by Cisco script applications with a different .wav file by uploading the new .wav file.
4. If necessary, add spoken name prompts. Some CRS applications play back the pre-recorded names of the people that callers are trying to reach, in order to allow the caller to confirm the transfer of the call.

This section contains the following topics:
- Recording a Prompt, page 10-13
- Add Spoken Name Prompts, page 10-14

**Note**
For instructions for Adding and Uploading prompts, see “Managing Prompt Files” section on page 10-2.
Recording a Prompt

You can record your own prompts to be used in applications. The example provided in this section uses the Windows Sound Record option. This option is one of many possibilities for recording G711 prompts. G711 is a freely distributed public domain codec and has several recording options. Some of these options are included in Microsoft Windows systems and are available to any sound recording application.

On the other hand, the G729 codec is licensed and is not freely distributed. A white paper that describes the G729 prompt recording options is available on request. You can request a copy of this white paper by sending an e-mail message to apps-support@cisco.com.

To record a prompt, complete the following steps.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>From your Windows Start menu, choose Start &gt; Programs &gt; Accessories &gt; Entertainment &gt; Sound Recorder.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The Sound Recorder dialog box opens.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click the Record button and speak your greeting into the microphone.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click the Stop button when you finish recording.</td>
</tr>
<tr>
<td>Step 4</td>
<td>To check your greeting, click the Rewind button or drag the slider back to the beginning of the recording. Then click the Play button.</td>
</tr>
<tr>
<td>Step 5</td>
<td>When you are satisfied with your greeting, choose File &gt; Save As.</td>
</tr>
<tr>
<td></td>
<td>The Save As window opens.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Click Change to set the recording options.</td>
</tr>
<tr>
<td></td>
<td>You can also set recording properties by choosing Properties from the Sound Recorder File menu.</td>
</tr>
</tbody>
</table>
The Sound Selection dialog box opens.

**Step 7** From the Format drop-down menu, choose one of the following options based on the prompts selected during the Cisco CRS software installation process:
- **CCITT u-Law** if you selected G711 prompts when installing the Cisco CRS software.
- See your G.729 white paper if you selected G729 prompts when installing the Cisco CRS software

**Note** The instructions in this procedure assume that, during CRS installation, you configured CRS to use the G.711 codec for prompts. If this assumption is incorrect, and you specified the G.727 codec instead, you would choose a G.729 option from this menu. (For more information about recording prompts with G.729, see your G.729 documentation.

**Step 8** From the Attributes drop-down menu, choose 8.000 kHz, 8 Bit, Mono 7 kb/sec.

**Step 9** Click **Save As**.

The Save As dialog box opens.

**Step 10** Enter a name for this format, and then click **OK**.

The Save As Dialog Box closes.

**Step 11** In the Sound Selection dialog box, click **OK**.

The Sound Selection dialog box closes.

**Step 12** In the Save As window, navigate to the directory of your choice, preferably a directory that you have set aside for prompts.

**Step 13** Select the file name, and click **Save**.

The Save As dialog box closes.

You are now ready to add this prompt to the CRS system.

---

**Add Spoken Name Prompts**

Some CRS applications play back the prerecorded names of people that callers are trying to reach, to allow callers to confirm the transfer of a call.
To upload .wav files of the spoken names of users, complete the following steps.

**Procedure**

**Step 1** From the CRS Administration menu bar, **Tools > User Management**.

**Step 2** In the navigation bar, click the **Spoken Name Upload** hyperlink.

The Spoken Name Prompt Upload web page opens. The following fields are displayed on the Spoken Name Prompt Upload web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Id</td>
<td>Unique identifier of the user for which the spoken name is to be uploaded.</td>
</tr>
<tr>
<td>Codec</td>
<td>(Display only.) The codec chosen during installation for this CRS server.</td>
</tr>
<tr>
<td>Spoken Name (.wav)</td>
<td>Location of the .wav file.</td>
</tr>
</tbody>
</table>

**Step 3** In the User Id field, enter an ID number that will identify the user.

**Step 4** In the Spoken Name (.wav) field, click **Browse** to navigate to the directory that contains the Spoken Name .wav file.

**Step 5** Click **Upload** to upload the file.

**Step 6** Repeat this process as needed to upload all spoken name .wav files.

---

**Managing Custom Files**

Use the Custom File Configuration web pages to:

- Configure the classpath location of custom classes, steps, and subsystem.
- Define the startup order of custom subsystems.
- Display the order of custom steps.

Making custom subsystems or steps available to applications involves several steps:

1. Creating a class that implements the WFSubsystem interface.
2. Uploading the class/jars to default/classpath folder using the Document Management web page.

3. Use the Custom File Configuration web pages to select the jars/folders which contain the classes, specify a subsystem and start-up order.

4. Restart the Cisco CRS Engine.

**Tip**

If you have just completed a Cisco CRS cluster or server setup procedures, be sure to wait at least 10 minutes before you restart the Cisco CRS Engine. This time gap is required for Cisco CRS to synchronize information across the cluster.

Subsystems will be visible under Subsystem Managers in the Control Center and the custom steps will be visible in CRS Editor.

**Note**

You must upload custom jars and custom class files that are used in custom subsystems and steps to `default [default]/classpath`.

This section includes the following topics:

- The Wizards Menu, page 21-1
- Specify the Custom Steps Startup Order, page 10-18
- Specify the Custom Subsystems Start Up Order, page 10-18

## Specify Custom Classpath Entries

Use these Custom Classes/Steps/Subsystems Configuration web pages to specify the available classpath entries.

**Procedure**

**Step 1**

From the CRS Administration menu bar, select System > Custom File Configuration.

The Custom File Configuration web page opens.

**Step 2**

On the navigation bar, click one of the following options:
Chapter 10  Managing Prompts, Grammars, Documents, and Custom Files

Managing Custom Files

- **Classpath for Custom Classes** hyperlink to access the Custom Classes Configuration area. Select required entries from the Available Classpath Entries list and arrange them in the order you want. Use the arrow icons to move items between the Available Classpath Entries and Selected Classpath Entries lists.

- **Classpath for Custom Steps** hyperlink to access the Custom Steps Configuration area.
  - Enter the fully qualified class name classpath of the BeanInfo class and palette of each custom step, in the correct display order, that they wish to add to the CRS Editor.
  - To create a palette, click the **Enter a new Palette** hyperlink. After creating a Palette.
  - To add a step, click the **Enter a new Step** hyperlink.
  - To arrange the steps within or across palettes, use the arrow icons.
  - To remove a step or whole palette, select the required steps and then click the **Remove** button.

- **Classpath for Custom Subsystems** hyperlink to access the Custom Subsystems Configuration area.

**Step 3**  Use the arrow keys to move items between the Available Classpath Entries and Selected Classpath Entries lists.
  - Enter the fully qualified class name of the subsystem class file of each custom subsystem, in the required startup order.
  - To enter the fully qualified subsystem name, click the **Enter a new Subsystem** hyperlink
  - To arrange items in the Select the Order of Startup, use the arrow icons.
  - To remove a subsystem entry, select the required entry from the list box and then click the **Remove** button.

**Step 4**  Click **Update** when your selections are complete.

**Step 5**  Restart the process as required (see Specify the Custom Steps Startup Order, page 10-18).
Specify the Custom Steps Startup Order

Use these Custom Steps Start Up Order pages to specify the order in which custom steps or palettes will execute.

Procedure

Step 1 From the CRS Administration menu bar, select System > Custom File Configuration.

The Custom File Configuration web page opens.

Step 2 On the navigation bar, click the List of Custom Steps hyperlink to access the Custom Steps Startup Order area.

Step 3 Optionally, click the Enter a New Pallette hyperlink and use the dialog box to specify a palette name.

Step 4 Optionally, click the Enter a New Step hyperlink and use the dialog box to specify a step name. A new step is created under the palette.

Step 5 Use the arrow keys to move items up and down on the Select the Order of startup list. The table below describes the processes that need to be restarted after you make changes to these configuration pages.

<table>
<thead>
<tr>
<th>Custom Step Order</th>
<th>Engine</th>
<th>Editor</th>
<th>CRS Administration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom class classpath</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Custom subsystem classpath</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom step classpath</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Step 6 Click Update when your selections are complete.

Specify the Custom Subsystems Start Up Order

Use these Custom Subsystems Start Up Order pages to define the order in which custom subsystems will be accessed.
Managing AAR Files

Caution

It is the user’s responsibility to ensure that the contents of the AAR file are correct and conform to the specifications detailed in this section. If you upload AAR files that do not conform to these specifications the CRS Engine may not function as designed. Consequently, you need to manually reconfigure some of the applications uploaded through AAR.

AAR files are archives of prompt, grammar, document, scripts, applications, and custom classes that you use as building blocks for applications and extensions.
An AAR file can be simple—for instance, consisting of a single prompt—or complex—for example, containing all the prompts for all languages application uses, the workflow, and the configuration information for an application.

An AAR file is essentially a zip file that contains an optional META-INF directory. The META-INF directory, if it exists, stores configuration data, including security, versioning, extensions, and services (see The META-INF Directory, page 10-23).

You create AAR files using Java tools. Once a file is created, you then need to upload it to Cisco CRS.

The example below shows a sample AAR Application Manifest.

```manifest
Manifest-Version: 1.1
Created-By: 1.4.2_05 (Sun Microsystems Inc.)
Built-By: aaruser
Sealed: false
Crs-Version: 4.5(1)
Class-Path:
Step-Class-Path: CustomStep1.jar CustomStep2.jar com\mycompany\steps
Subsystem-Class-Path: CustomSubsystem1.jar CustomSubsystem2.jar
Application-List: customApp1.mf customApp2.mf
Subsystem-List: sub1.mf sub2.mf
Palette-List: Custom1 Custom2
Custom1-Palette-Name: Category1
Custom2-Palette-Name: Category2
Custom1-Step-List: step1.mf
Custom2-Step-List: step2.mf step3.mf
Implementation-Title: AAR Test File
Implementation-Version: 4.5(1)
Implementation-Vendor: Cisco Systems, Inc.
Implementation-Vendor-Id: 12345
Implementation-URL: http://www.cisco.com
Application-Version: 1.1
Created-By: 1.4.2_05 (Sun Microsystems Inc.)
Built-By: aaruser
Sealed: false
Implementation-Title: AAR Application MF
Implementation-Version: 4.5(1)
Implementation-Vendor: Cisco Systems, Inc.
Implementation-Vendor-Id: 12345
Implementation-URL: http://www.cisco.com
Application-Name: Custom AA
Application-Type: Cisco Script Application
Application-Description: CRS Cisco Custom Application
Application-Id: 100
Max-Sessions: 300
```
Managing AAR Files

Enabled: true
Script: SSCRIPT[aa.aef]
Default-Script: SSCRIPT[aa.aef]
Initial-Script: SSCRIPT[aa.aef]
Step-Version: 1.1
Created-By: 1.4.2_05 (Sun Microsystems Inc.)
Built-By: aaruser
Sealed: false
Implementation-Title: AAR Step MF
Implementation-Version: 4.5(1)
Implementation-Vendor: Cisco Systems, Inc.
Implementation-Vendor-Id: 12345
Implementation-URL: http://www.cisco.com
Step-Bean: com.cisco.step.beanInfo.CustomStepBeanInfo.class
Subsystem-Version: 1.1
Created-By: 1.4.2_05 (Sun Microsystems Inc.)
Built-By: aaruser
Sealed: false
Implementation-Title: AAR Subsystem MF
Implementation-Version: 4.5(1)
Implementation-Vendor: Cisco Systems, Inc.
Implementation-Vendor-Id: 12345
Implementation-URL: http://www.cisco.com
Subsystem-Class: com.cisco.subsystem.CustomSubsystem1.class

The figure below shows a sample AAR file.

To deploy custom applications, steps, and subsystems through an AAR file, you must first create the AAR file using a jar or zip tool and then upload the file through the CRS Administration web page.

The sections that follow describe how to:

- Creating AAR Files, page 10-22
- Uploading AAR Files, page 10-22
- The META-INF Directory, page 10-23
- The Prompts, Grammars, Documents, and Scripts Directories, page 10-23
- AAR Manifest, page 10-24
- Attribute Types, page 10-26
Creating AAR Files

You create an AAR file using a jar or WinZip tool.

An AAR file format is similar to a Zip file format. It includes an optional META-INF directory which is used to store configuration data, including security, versioning, extension and services.

Uploading AAR Files

To upload an AAR file, complete the following steps.

Procedure

**Step 1**
From the CRS Administration menu bar, choose Applications > AAR Management.

The AAR Management web page opens to display the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the AAR file.</td>
</tr>
<tr>
<td>Browse</td>
<td>Click this button to navigate to the directory in which the file is located.</td>
</tr>
<tr>
<td>Upload</td>
<td>Click this button to upload a new AAR file.</td>
</tr>
</tbody>
</table>

**Step 2**
Enter a file name or click the Browse button to upload a file.

**Step 3**
Click OK.

The contents of the AAR file are uploaded to the respective folders.

**Note**
Cisco CRS generates an error if the AAR file is not formatted correctly or is missing some custom files.
Chapter 10      Managing Prompts, Grammars, Documents, and Custom Files

Managing AAR Files

The META-INF Directory
Cisco CRS uses the following files and subdirectories in the META-INF directory to configure applications, extensions and services:

- **MANIFEST.MF.** The file used to define extension and application related data (see AAR Manifest, page 10-24).
- **applications.** This directory stores all application configuration files (see The application Subdirectory Attributes, page 10-31).
- **subsystems.** This directory stores all subsystem configuration files (see The subsystems Subdirectory Attributes, page 10-33).
- **steps.** This directory stores all steps configuration files (see The steps Subdirectory Attributes, page 10-34).

The Prompts, Grammars, Documents, and Scripts Directories
The AAR files features also provides directories to store prompts, grammars, documents, and scripts to be uploaded to the Repository.

The AAR directory structure mirrors the function of the CRS Prompt, Grammar, Documents, and Scripts Management web pages. Each directory corresponds to each language for which to install prompts, grammars, documents and scripts. Languages are defined using the Java Locale standard and the special default directory is used for prompts, grammars, and documents that are common to all languages.

Only CRS supported prompt files and extensions are allowed within each directory. The maximum length of each individual folder name and file name within a directory is 64 characters.

The Prompts Directory
The Prompts directory stores prompts that must be uploaded to the prompt repository (to make it seem like they were uploaded through CRS Prompt Management).
The Grammars Directory

The Grammars directory stores grammars that must be uploaded to the grammar repository (to make it seem like they were uploaded through CRS Grammar Management).

The Documents Directory

The Documents directory stores documents that must be uploaded to the document repository (to make it seem like they were uploaded through CRS Document Management).

The Scripts Directory

The Scripts directory stores scripts that must be uploaded to the script repository (to make it seem like they were uploaded through CRS Script Management).

Note

The Script directory must define a single directory named default under which all script files must be listed.

AAR Manifest

An AAR file manifest consists of a main section followed by a list of sections for individual AAR file entries, each separated by a newline.

Information in a manifest file contains name-value pairs—which are also referred to as headers or attributes. Groups of name-value pairs are known as a section; sections are separated by empty lines.

Table 10-3 describes the expected syntax of the manifest file

<table>
<thead>
<tr>
<th>Table 10-3 Manifest File Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>section:</td>
</tr>
<tr>
<td>nonempty-section:</td>
</tr>
</tbody>
</table>
Managing AAR Files

The main section, which is terminated by an empty line:

- Contains security and configuration information about the AAR file itself, as well as the applications or extensions that this AAR file is defining.

- Defines main attributes that apply to every individual manifest entry. No attribute in this section can have its name equal to “Name”.

The individual sections define various attributes for directories or files contained in this AAR file. Not all files in the AAR file need to be listed in the manifest as entries. The manifest file itself must not be listed. Each section must start with an attribute with the name as “Name”, and the value must be a relative path to the file or directory.

If there are multiple individual sections for the same file entry, the attributes in these sections are merged. If a certain attribute have different values in different sections, the last one is recognized.

Attributes which are not understood are ignored. Such attributes may include implementation specific information used by applications.

### Table 10-3 Manifest File Syntax (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>newline:</td>
<td>CR LF</td>
</tr>
<tr>
<td>header:</td>
<td>name: value</td>
</tr>
<tr>
<td>name:</td>
<td>alphanum *headerchar</td>
</tr>
<tr>
<td>value:</td>
<td>SPACE *otherchar newline *continuation</td>
</tr>
<tr>
<td>continuation:</td>
<td>SPACE *otherchar newline</td>
</tr>
<tr>
<td>alphanum:</td>
<td>{A-Z}</td>
</tr>
<tr>
<td>headerchar:</td>
<td>alphanum 1-1_</td>
</tr>
<tr>
<td>otherchar:</td>
<td>Any UTF-8 character except NUL, CR and LF</td>
</tr>
</tbody>
</table>

**Note** To prevent corruption of files sent through e-mail, do not use “From” to start a header.
Table 10-4 describes the specification for any file that can be archived in the AAR.

Table 10-4 Syntax for AAR Files

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>manifest-file</td>
<td>main-section newline *individual-section</td>
</tr>
<tr>
<td>main-section</td>
<td>version-info newline *main-attribute</td>
</tr>
<tr>
<td>version-info</td>
<td>Manifest-Version: version-number</td>
</tr>
<tr>
<td>version-number</td>
<td>digit+{.digit+}*</td>
</tr>
<tr>
<td>main-attribute</td>
<td>(any legitimate main attribute) newline</td>
</tr>
<tr>
<td>individual-section</td>
<td>Name: value newline *perentry-attribute</td>
</tr>
<tr>
<td>perentry-attribute</td>
<td>(any legitimate perentry attribute) newline</td>
</tr>
<tr>
<td>newline</td>
<td>CR LF</td>
</tr>
<tr>
<td>digit</td>
<td>{0-9}</td>
</tr>
</tbody>
</table>

Attribute Types

Attributes that appear in the main section are called main attributes. Attributes that appear in individual sections are called per-entry attributes. Some attributes appear in both the main and individual sections, in which case the per-entry attribute value overrides the main attribute value for the specified entry.
Main Attributes

Main attributes are the attributes that are present in the main section of the manifest. They fall into three different groups:

- General main attributes: See Table 10-5.

Table 10-5 General Category in the Main Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manifest-Version</td>
<td>The manifest file version. The value is a legitimate version number, as described in the above spec. CRS 4.5 will start with version 1.1.</td>
</tr>
<tr>
<td>Created-By</td>
<td>The version and the vendor of the java implementation on top of which this manifest file is generated. This attribute is generated by the jar tool.</td>
</tr>
<tr>
<td>Crs-Version</td>
<td>The minimum CRS version release compatible with the AAR file. Crs-version is the accumulation of the CRS release, CRS Service Release, and CRS Engineering Special defined in that order. For example, if the AAR file is compatible with CRS release 4.5(1)_Build705, SR1_Build001, ES2_Build002, the Crs-Version would be defined as 4.5(1)SR1ES2_Build002. Only the last build number is taken. So for instance, if the AAR file is compatible with CRS release 4.5(1)_build705, SR1_Build001, then the Crs-Version is 4.5(1)SR1_Build001. As a last example, if AAR file is compatible with CRS release 4.5(1)_Build705 and above, then Crs-Version would be 4.5(1)_Build705.</td>
</tr>
<tr>
<td>Class-Path</td>
<td>The directories or JAR files that need to be installed and accessed by scripts directly. Entries are separated by one or more spaces. The CRS class loader uses the value of this attribute to construct its internal search path where each entry is defined relative to the /Documents/default/classpath directory in this AAR file.</td>
</tr>
</tbody>
</table>
### Table 10-5 General Category in the Main Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step-Class-Path</td>
<td>The directories or JAR files that need to be installed and accessed by customer-defined steps directly. Entries are separated by one or more spaces. The CRS class loader uses the value of this attribute to construct its internal search path where each entry is defined relative to the /Documents/default/classpath directory in this AAR file.</td>
</tr>
<tr>
<td>Subsystem-Class-Path</td>
<td>The directories or JAR files that need to be installed and accessed by customer-defined subsystems directly. Entries are separated by one or more spaces. The CRS class loader uses the value of this attribute to construct its internal search path where each entry is defined relative to the /Documents/default/classpath directory in this AAR file.</td>
</tr>
<tr>
<td>Application-List</td>
<td>The application configuration files from the META-INF/applications/ directory to be installed. Entries are separated by one or more spaces.</td>
</tr>
<tr>
<td>Subsystem-List</td>
<td>The subsystem configuration files from the META-INF/subsystems/ directory to be installed. Entries are separated by one or more spaces.</td>
</tr>
<tr>
<td>Palette-List</td>
<td>The step palettes that need to be installed. Each palette listed in this attribute will have a set of additional attributes that the CRS editor uses to specify the palette name and the palette steps to install. Entries are separated by one or more spaces.</td>
</tr>
<tr>
<td>&lt;palette&gt;-Palette-Name</td>
<td>The unique name of the palette to define in the CRS editor where the specified steps will be grouped and accessible.</td>
</tr>
<tr>
<td>&lt;palette&gt;-Step-List</td>
<td>The step configuration files from the META-INF/steps/ directory to be installed under the palette. Entries are separated by one or more spaces.</td>
</tr>
</tbody>
</table>
• Attribute defined for extension identification: Extension-Name
  This attribute specifies a name for the extension contained in the AAR file. The name should be a unique identifier.

• Attributes defined for extension and directory versioning and sealing information: These attributes define features of the extension which the AAR file is a part of. The values of these attributes apply to all the directories in the AAR file, but can be overridden by per-entry attributes. See Table 10-6.

### Table 10-6 Implementation Category in the Main Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation-Title</td>
<td>The title of the extension implementation.</td>
</tr>
<tr>
<td>Implementation-Version</td>
<td>The version of the extension implementation.</td>
</tr>
<tr>
<td>Implementation-Vendor</td>
<td>The organization that maintains the extension implementation.</td>
</tr>
<tr>
<td>Implementation-Vendor-Id</td>
<td>The ID of the organization that maintains the extension implementation.</td>
</tr>
<tr>
<td>Implementation-URL</td>
<td>The URL from which the extension implementation is downloaded.</td>
</tr>
<tr>
<td>Sealed</td>
<td>Defines if this AAR file is sealed. Sealing a directory means that the files uploaded to the corresponding repository will not be modifiable once installed unless the AAR file is reinstalled. If set to true, then all directories in the AAR file default to be sealed, unless individually defined otherwise. If set to false, then all directories are modifiable.</td>
</tr>
</tbody>
</table>
Per-Entry Attributes

Per-entry attributes apply only to individual AAR file entry with which the manifest entry is associated. If the same attribute also appears in the main section, then the value of the per-entry attribute overwrites the main attribute’s value.

- Example 1: If AAR file a.aar has the following manifest content, then all the files archived in a.aar are sealed, except US English prompts. If the same attributes also appeared in an entry representing a parent directory of another entry then the value of the per-entry attribute overwrites the parent directory per-entry attribute’s value.

```
Manifest-Version: 1.1
Created-By: 1.2 (Sun Microsystems Inc.)
Sealed: true
Name: Prompts/en_US/
Sealed: false
```

- Example 2: If AAR file a.aar has the following manifest content, then all the US English prompts archived in a.aar are sealed, except US English prompts located in the AA/ directory.

```
Manifest-Version: 1.1
Created-By: 1.2 (Sun Microsystems Inc.)
Name: Prompts/en_US/
Sealed: true
Name: Prompts/en_US/AA/
Sealed: false
```

The per-entry attributes fall into the following groups:

- Attributes defined for file contents: Content-Type
  
  This attribute specifies the MIME type and subtype of data for a specific file entry in the AAR file. The value should be a string in the form of type/subtype. For example, image/bmp is an image type with a subtype of bmp (representing bitmap). This indicates the file entry as an image with the data stored as a bitmap. RFC 1521 and 1522 discuss and define the MIME types definition.

- Attributes defined for directory versioning and sealing information:

  These are the same set of attributes defined in Table 10-6 for the main attributes. When used as per-entry attributes, these attributes overwrite the main attributes for the individual file specified by the manifest entry.
The META-INF Directory Attributes

The Cisco CRS platform recognizes the x.MF file in the applications, subsystems, and steps subdirectories in the META-INF directory and interprets each to configure applications, subsystems, and steps respectively. The x is the base file name as listed on the Application-List main attribute of the manifest file. The X.MF file contains one section defining the configuration of a particular application.

The application Subdirectory Attributes

Table 10-7 describes the syntax of the manifest file for the application subdirectory.

**Table 10-7  Application Subdirectory’s Manifest File Syntax**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>application-file</td>
<td>version-info newline *application-attribute</td>
</tr>
<tr>
<td>version-info</td>
<td>Application-Version: version-number</td>
</tr>
<tr>
<td>version-number</td>
<td>digit+{.digit+}*</td>
</tr>
<tr>
<td>application-attribute</td>
<td>(any legitimate application attribute) newline</td>
</tr>
<tr>
<td>newline</td>
<td>CR LF</td>
</tr>
<tr>
<td>digit</td>
<td>{0-9}</td>
</tr>
</tbody>
</table>

The application attributes fall into the following groups:

- General main attributes: See Table 10-8.

**Table 10-8  Application Attributes**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application-Version</td>
<td>The application configurations file version. The value is a legitimate version number. For example Cisco CRS, Release 4.5 starts with version 1.1.</td>
</tr>
<tr>
<td>Application-Name</td>
<td>The unique name of the application (see CRS Application Management).</td>
</tr>
</tbody>
</table>
Table 10-8 Application Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application-Type</td>
<td>The type of the application (Cisco Script Application, Busy, Ring-No-Answer, Unified ICME Translation or Post Routing).</td>
</tr>
<tr>
<td>Application-Description (optional)</td>
<td>The description for the application (see CRS Application Management).</td>
</tr>
<tr>
<td>Application-Id</td>
<td>A unique identifier for the application (see CRS Application Management).</td>
</tr>
<tr>
<td>Max-Sessions</td>
<td>The maximum number of sessions for the application (see CRS Application Management).</td>
</tr>
<tr>
<td>Enabled</td>
<td>The application is enabled if the value is set to true (see CRS Application Management). If the value is set to false, the case is ignored.</td>
</tr>
<tr>
<td>Script</td>
<td>The main script of a Cisco Script Application (see CRS Application Management). The value must be relative to the Scripts directory. CRS 4.5 doesn’t support configuring script parameters.</td>
</tr>
<tr>
<td>Default-Script</td>
<td>The default script of a Cisco Script Application, Unified ICME Translation or Post Routing application (see CRS Application Management). The value must be relative to the Scripts directory. CRS 4.5 doesn’t support configuring script parameters.</td>
</tr>
<tr>
<td>Initial-Script</td>
<td>The initial script of an Unified CCX Post Routing application (see CRS Application Management). The value must be relative to the Scripts directory. CRS 4.5 doesn’t support configuring script parameters.</td>
</tr>
</tbody>
</table>

- Attributes defined for application versioning and sealing information: These attributes define features of the application to which the AAR file belongs. These attributes are the same as those listed in “Implementation Category in the Main Attributes” (see Table 10-6).
The subsystems Subdirectory Attributes

Table 10-9 describes the syntax of the manifest file for the subsystems subdirectory.

Table 10-9  Subsystems Subdirectory’s Manifest File Syntax

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>subsystem-file</td>
<td>version-info newline *subsystem-attribute</td>
</tr>
<tr>
<td>version-info</td>
<td>Subsystem-Version: version-number</td>
</tr>
<tr>
<td>version-number</td>
<td>digit+{.digit+}*</td>
</tr>
<tr>
<td>subsystem-attribute</td>
<td>(any legitimate application attribute) newline</td>
</tr>
<tr>
<td>newline</td>
<td>CR LF</td>
</tr>
<tr>
<td>digit</td>
<td>{0-9}</td>
</tr>
</tbody>
</table>

The subsystems attributes fall into the following groups:

- General main attributes: See Table 10-10.

Table 10-10  Subsystems Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application-Version</td>
<td>The subsystems configuration file version. The value is a legitimate version number. For example Cisco CRS, Release 4.5 starts with version 1.1.</td>
</tr>
<tr>
<td>Subsystem-Class</td>
<td>The class name of the subsystem to be installed. The class must be accessible by the CRS class loader from the Subsystem-Class-Path provided in the manifest file.</td>
</tr>
</tbody>
</table>

- Attributes defined for application versioning and sealing information: These attributes define features of the application to which the AAR file belongs. These attributes are the same as those listed in “Implementation Category in the Main Attributes” (see Table 10-6).
The steps Subdirectory Attributes

Table 10-11 describes the syntax of the manifest file for the steps subdirectory.

Table 10-11 Steps Subdirectory’s Manifest File Syntax

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>step-file</td>
<td>version-info newline *step-attribute</td>
</tr>
<tr>
<td>version-info</td>
<td>Application-Version: version-number</td>
</tr>
<tr>
<td>version-number</td>
<td>digit+{.digit+}*</td>
</tr>
<tr>
<td>step-attribute</td>
<td>(any legitimate application attribute) newline</td>
</tr>
<tr>
<td>newline</td>
<td>CR LF</td>
</tr>
<tr>
<td>digit</td>
<td>{0-9}</td>
</tr>
</tbody>
</table>

The steps attributes fall into the following groups:

- General main attributes: See Table 10-12.

Table 10-12 Steps Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step-Version</td>
<td>The step configurations file version. The value is a legitimate version number. For example Cisco CRS, Release 4.5 starts with version 1.1.</td>
</tr>
<tr>
<td>Step-Bean</td>
<td>The bean information class name of the step to be installed. The class must be accessible by the CRS class loader from the Step-Class-Path provided in the manifest file.</td>
</tr>
</tbody>
</table>

- Attributes defined for application versioning and sealing information: These attributes define features of the application to which the AAR file belongs. These attributes are the same as those listed in “Implementation Category in the Main Attributes” (see Table 10-6).
Cisco CRS administration provides options to configure, control, and monitor CRS component activities and information across a cluster.

See the Cisco CRS Installation Guide for instructions about tasks that significantly change your CRS deployment, such as:

- Changing from a single-server deployment to a multiple-server deployment.
- Removing a Cisco CRS Software component from a server.
- Moving a Cisco CRS Software component to another server.
- Changes to a Cisco CRS cluster (adding, removing, or replacing a server).

The following sections describe the day-to-day management of CRS components:

- Control Center Terminology, page 11-2
- About Control Center Management, page 11-3
- High Availability and Automatic Failover, page 11-7
- Managing the Control Center, page 11-9
- Managing the CRS Engine, page 11-20
- Managing Cisco CRS CDS Information, page 11-22
- Managing System Parameters, page 11-23
- Exiting Cisco CRS Administration, page 11-28
Control Center Terminology

This section provides information about control center terminology.

- **Cluster**: A Cisco CRS cluster (often referred to as cluster in this manual) consists of one or more servers (nodes) that are running Cisco CRS components in your Cisco CRS deployment. If you deploy Cisco CRS components on a single server, the Cisco CRS cluster consists of that server. If you deploy Cisco CRS on multiple servers, the cluster includes the Cisco CRS server and any expansion (additional) servers and standby servers on which you installed Cisco CRS. The CRS cluster supports up to two CRS servers, one designated as the *active CRS server* and the other designated as the *standby CRS server* for high availability purposes.

  **Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

- **Cluster profile**: The Cisco Customer Response Solutions Administration web page (home page) displays information about the cluster profile. A cluster profile includes data relating to the Cisco CRS servers, components, and licenses installed in a cluster.

- **Node (server)**: A computer that belongs to a cluster.

- **Expansion Server**: You can increase the capacity of your Cisco CRS deployment by activating the Database, Monitoring, and Recording components on various additional servers in the Cisco CRS cluster. Such an additional server is called an *expansion server*.

- **Active Server**: The active server provides all system services and resources. You can deploy one active server in each CRS subsystem. If the active server fails, the CRS subsystem automatically fails over to the standby server (see High Availability and Automatic Failover, page 11-7).
Standby Server. You can deploy up to two servers in each CRS system for high availability—one active server (master) and one standby (not active) server. With high availability, if an active server becomes unavailable, the standby server immediately and automatically becomes the active server (see High Availability and Automatic Failover, page 11-7).

Component. The software units in the CRS system. When you install CRS system, you must specify the components that run on a particular server. The main software components of the CRS server are the Engine, datastores, monitoring, recording, and the node manager. When you perform the server setup procedure, you can activate the components that run on the server. See the Cisco Customer Response Solutions Installation Guide for more information on setup and installation procedures.

Service. An executable unit. A service may have other services as its children. (For example, subsystems and managers are children of the engine service).

Feature. A logical representation of the functional unit.

Master service. A specially-elected service. Only one service from the Engine service, desktop services, database services set can be the master within the CRS Engine component (see Reelect Master, page 11-16).

Standby service. An active service that can take over the master functionality in case the master service becomes unavailable within the CRS Engine component. You cannot configure the standby service. The Cluster View Daemon (CVD) dynamically elects one of the standby services to be a master. (see Reelect Master, page 11-16).

Note One service can belong to multiple components. For example, CRS SQL server agent service belongs to all datastore components (Agent, Configuration, Historical, and Repository).

About Control Center Management

Use Control Center web pages to:

- Display all servers belonging to the same cluster.
Note  Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

- Display the server states (running or stopped) with an option to restart one particular server or all servers in the cluster.
- Display the date and time of the last failure for each server.
- Display the server services (running or stopped).
- Configure trace at cluster level.
- View the traces on all machines in the cluster.

The Control Center page contains two tabs:

- **Servers.** This tab provides a physical view of the cluster architecture, that is, the nodes and services that made up its structure.
- **Features.** This tab provides a logical view of the cluster, that is, the components that represent functionality.

Use the tabs to toggle between these two views, illustrated in the figures that follow.
### About Control Center Management

The Servers tab lists the names of all the servers in the cluster. Click a server name to access detailed service information for that server.

The main section of the page gives summary information about each server.

Mouse-over the Status icon to view the server status.

#### Note
For description of the Status icons and the server states they represent, see Monitoring Service Status, page 11-20.

#### Use this link to access the Component Activation page.

<table>
<thead>
<tr>
<th>Server Name</th>
<th>Type</th>
<th>ID</th>
<th>Status</th>
<th>Last Failure</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>CYU0200-PC02</td>
<td>CRS</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CYU0200-PC12</td>
<td>CRS</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Click the Eyeglasses icon to view logs. Click the Pin icon to view details about the server.
The Features tab lists all the features in the cluster. Click a feature name to access detailed service information about that feature.

The main section of the page gives summary information about each feature.

Use this link to access the Component Activation page.
High Availability and Automatic Failover

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

Cisco CRS provides high availability and automatic failover capability through the use of two servers, the active server and the standby server.

Caution
You can deploy over Wide Area Network (WAN) expansion servers on which only the Monitoring component or on which only the Monitoring and Recording components are installed. All other servers in the cluster must be deployed on the same LAN.

The active server provides all system services and resources; no services or resources are available from the standby server. Both servers will be synchronized when administrative changes are made on the active server.

If the active server fails, there is automatic failover to the standby server.

When an active server failover occurs, the following happens:

- Any active calls existing in the system—and those ringing at an agent’s phone—are terminated.

Note
Calls already connected to an agent will not be lost. The agent will be logged out of the system but the call in progress will continue.

- While the system processes the failover, a time window can occur where calls might get rejected or aborted; this time window is five seconds. When the failover to the standby server is complete, call treatment, routing, and queuing will commence on incoming calls.

Note
In cases of network failure, failover processing might take a longer time, so reconvergence can take more than the standard five-second window.
All agents will be automatically re-logged in, and put in the ‘unavailable’ state. Once automatically re-logged in, each agent must manually change their state to what they need it to be.

The standby server becomes the new active server. Until the former active server is recovered or a new Unified CCX server is brought online, the system will be running without any standby capability. When the former active server or a new server is brought online, it will become the new standby server.

Network Partitions

Network malfunction or misconfiguration can create network partitions and split the network into separate islands. If a node enters this state, the node is referred to as being in the island mode. Nodes in the island mode are hard to detect. While these nodes can communicate within a partitioned island, they cannot communicate between partitioned islands. If the islands do not communicate, then each island will select its own active server.

Generally, you can connect to the Cisco CRS administration on any node, and see a consistent cluster view. If a node is in the island mode, you will see different cluster views when you connect to nodes in each island.

Note

Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

If your node enters the island mode, perform one of the following tasks:

• reboot every cluster node, or
• stop all cluster nodes, and restart the CRS node manager.

If the cluster node cannot be restarted, first ensure that all nodes are functioning as desired. Next, from each node, verify the network accessibility to every other node.
Managing the Control Center

Use the Control Center Server Configuration pages to:

- Activate or deactivate components (see Activating a Component, page 11-12)
- Remove a server from the cluster (see Removing a Server, page 11-13)
- Disable a server temporarily or permanently (see Disabling a Server, page 11-14)
- Start, stop, and restart services (see Starting, Stopping, and Restarting CRS Services, page 11-15)
- Reelect master for a particular service (see Reelect Master, page 11-16)
- View server trace files (see Server Traces, page 11-18)
- View server or services details (see Server Details, page 11-19)

To access the Control Center Server Configuration page, select choose System > Control Center from the CRS Administration menu bar and then click the required Server name hyperlink in the main pane.
The Control Center configuration page lists the status of services running on a particular server; the figure above shows the status of services on a server named PC22000.

Table 11-1 below describes the different areas of this page.
Managing the Control Center

See the “Activating a Component” section on page 11-12 for details on tasks you can perform using the Control Center page.

Table 11-1  Areas of the Control Center Web Page

<table>
<thead>
<tr>
<th>Callout</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The server name and CRS Engine status. Button to Start, Stop, Restart, and Reelect individual services.</td>
</tr>
<tr>
<td>2</td>
<td>The services installed on this server. Master services are labeled with a small, blue M icon; standby services with a small, blue S icon. Some Cisco services—CRS Administration, CRS CVD, CRS Editor, and CRS Engine—contain a sub-level manager; these are indicated by a plus sign. Each service with a sub-level manager contains a Manager; the CRS Engine also contains a Subsystem Manager. <strong>Caution</strong> Stopping a service containing a sub-level manager stops all the components controlled by that manager. Stopping one CRS SQL server service stops all other CRS SQL server services, with the exception of Microsoft Distributed Transaction Coordinator.</td>
</tr>
<tr>
<td>3</td>
<td>The Status icons and the server states they represent. For more information, see “Monitoring Service Status” section on page 11-20.</td>
</tr>
<tr>
<td>4</td>
<td>The Last Failure column notes the last time the service was stopped, for each node. The last failure reason is provided in the history information window for each node.</td>
</tr>
</tbody>
</table>
| 5       | Information icons:  
- The Eyeglasses icon accesses server log files.  
- The Pin icon accesses details about the server. |
| 6       | Use these hyperlinks to obtain more information about the server:  
- **Server Traces** accesses the trace logs for the server.  
- **Server Details** access detailed information about the server, such as properties, hardware, services, and reason for last failure. |

See the “Activating a Component” section on page 11-12 for details on tasks you can perform using the Control Center page.
Activating a Component

You do not need to activate components for single node deployments. In a single node deployment, all components are activated by default.

You activate components using the Component Activation Page.

To activate a component, complete the following steps.

A component can be activated even if it is not licensed. However, CRS Node Manager cannot start services related to a component until the license related to the component is uploaded. In other words, in order for a service to run, its component needs to be licensed and activated.

You cannot deactivate publisher datastore components. To deactivate a publisher datastore component, first change the component to be a subscriber and then deactivate the component (see Changing Publisher to Subscriber, page 12-9).

Procedure

Step 1 From the CRS Administration menu bar, choose System > Control Center. The Control Center/Servers summary web page opens.

Step 2 Click the Component Activation hyperlink.

The Component Activation web page opens.

Step 3 Use the check boxes next to Component Names to enable or disable that component feature.

Some feature components, such as the Nuance Vocalizer feature have subfeatures you can also enable or disable. If you disable a feature with subfeatures, the subfeatures are automatically disabled, too.

When a feature component is disabled, it is disabled on that server, only. Every time a server is rebooted, the Node Manager checks for the availability of the license as well as the enable feature flag to enable a particular component.
When the CRS Engine is enabled or disabled, it creates or removes the Unified CM Telephony user in the Unified CM Telephony Provider for that node, provided Unified CM Telephony information exists. If Unified CM Telephony Port groups have already been configured, then CRS will create/remove CTI ports for this node.

See “Viewing License Information” section on page 1-14 for details on viewing license information.

**Step 4**

Click **Update**.

A component activation summary displays.

**Note**

For information about the messages that can appear in this summary, see the *Cisco CRS Servicing and Troubleshooting Guide*.

---

### Removing a Server

**Note**

Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

**Caution**

Once a server is removed, the only way to restore it to the cluster is to reinstall it. Also, after a server is removed, there will be a delay before the change is reflected across all nodes in the cluster.

**Note**

A server cannot be removed if at least one of the datastores has publisher set on this node.
Tip
You can only remove a server from a multiple-node cluster.

To remove a server, complete the following steps:

Procedure

Step 1
From the CRS Administration menu bar, choose **System > Control Center**. The Control Center/Servers summary web page opens.

Step 2
Click the **Component Activation** link on the Right.

Step 3
Select the server name from the navigation bar on the left. The component information for that server appears.

Step 4
Click the **Remove Server** hyperlink to remove the server. The system prompts you to confirm the deletion; click **OK**. The system removes the node from the cluster. Unified CM Telephony and CTI Ports for this node are removed only if the removed node is a CRS Engine-enabled node.

Step 5
Click **Update**.

Disabling a Server

Tip
You can only disable a server in a multiple-node cluster. The Disable Server link is only available when the server you wish to disable is already up and running.

To disable a server, complete the following steps:

Procedure

Step 1
From the CRS Administration menu bar, choose **System > Control Center**. The Control Center/Servers summary web page opens.
**Step 2**  Select the **Component Activation** hyperlink.
The Component Activation web page opens.

**Step 3**  Select the required server name from the navigation bar.
The component information for that server is displayed.

**Step 4**  Click the **Disable Server** hyperlink to disable the server.
The system prompts you to specify a disable method for the server:

- **Temporarily.** Cisco CRS Node Manager is shut down. This server is still part of the cluster. If you reboot the server, the node manager is automatically enabled.

**Note**  Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

- **Permanently.** Cisco CRS Node Manager is shut down and its service type in Windows services is changed to “Manual” (the default set during system installation is “Automatic”). This server is still part of the cluster; but the Node Manager remains in the manual state. If you reboot the server, the Node Manager continues to remain in the manual state and will not be enabled automatically. you must explicitly change the default back to “Automatic.” To re-enable the node manager, start the Cisco CRS Node Manager service by setting service type to Automatic in the Service Control panel, and reboot the node (see Starting, Stopping, and Restarting CRS Services, page 11-15).

If this server happens to be a master for any of the services, then failover happens for that service.

**Step 5**  Click **Update**.

### Starting, Stopping, and Restarting CRS Services

At times, you may need to stop and restart the CRS services. For example, you must stop the Engine before modifying the Historical Reporting configuration, and restart the Engine for the changes to take effect. You may also stop and restart the CRS Engine to view the status of the Engine and subsystems while the Engine stops and starts.
Tip
If you have just completed a Cisco CRS cluster or server setup procedures, be sure to wait at least 10 minutes before you restart the Cisco CRS Engine. This time gap is required for Cisco CRS to synchronize information across the cluster.

Caution
Stopping one CRS SQL server service stops all other CRS SQL server services, with the exception of Microsoft Distributed Transaction Coordinator.

To start, stop or restart CRS services, complete the following steps.

Procedure

Step 1
From the CRS Administration menu bar, choose System > Control Center. The Control Center/Servers summary web page opens.

Step 2
Click a Server Name hyperlink on the navigation bar. The Control Center/Server Configuration web page opens.

Step 3
Select the radio button next to the service whose status you want to change and click one of the following buttons:
- Start
- Stop
- Restart

Reelect Master

The type of service determines how a master is initially elected. For example:
- For the CRS Engine, the first available service becomes the master. That service does not surrender its position as master, even if another service becomes active.
- For datastore services, the best candidate is always elected as master.
You can manually reelect a master service using the Control Center’s **Reelect Master** button. However, if the best candidate for the service is already defined as the master, choosing **Reelect Master** does not cause any changes. (For more information, about master and standby services, see “Control Center Terminology” section on page 11-2.)

**Note**
If the best candidate for the service is already master, **Reelect Master** does not cause any changes.

**Caution**
Use this button carefully, as all active calls on the current master server may be (if failover is available) dropped when you click **Reelect**.

To reelect a master service, complete the following steps:

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **System > Control Center**. The Control Center/Servers summary web page opens.

**Step 2**
Select the server that is currently configured as a standby server, by clicking on the corresponding radio button. (Master services are labeled with a small, blue M icon; Standby services with a small, blue S icon.)

**Step 3**
Click **Reelect Master**.

**Step 4**
Repeat Steps 4 and 5, as necessary.
Server Traces

You can access trace log files for servers from the Control Center pages by completing the following steps.

**Note**
CRS Node Manager needs to be running for the system to access trace log files. If a remote node or CRS Node Manager is not running, then traces cannot be accessed.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **System > Control Center**.
The Control Center/Servers summary web page opens.

**Step 2**
Click a Server Name hyperlink on the servers navigation bar.
The Control Center/Servers Configuration web page open.

**Step 3**
Click the **Server Traces** hyperlink.
The Server Traces web page opens, displaying a folder for each server service.

**Step 4**
Click the folder for the service for which you want to see log files.
A new page opens listing the log files for that folder.

**Step 5**
Click a log file **Name** hyperlink.
The log file opens in a separate window.

**Step 6**
Perform one of the following actions:
- View the contents of the log and select **File > Close** to close the log file window.
- Select **File > Save As**, use the Save Web Page dialog to save the contents of the log to a file, and then select **File > Close** to close the window.

**Related Topics**
- *Tracing Configuration, page 11-28*
- *Configuring Trace Settings, page 12-9*
Chapter 11  Managing the Cisco CRS System

Managing the Control Center

Server Details

You can access detailed information about particular server’s configuration by completing the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose System > Control Center. The Control Center/Servers summary web page opens.
Step 2  Click a Server Name hyperlink on the servers navigation bar. The Control Center/Servers Configuration web page opens.
Step 3  Click a Server Name hyperlink on the servers navigation bar. The Control Center/Servers Configuration web page opens.
Step 4  Click the Server Details hyperlink. The following details display in a separate window:
- Computer name
- Server IP address
- Server host name
- State
- Hardware type
- Install time
- Last restart
- Hardware properties
- Services for enabled components (regardless of state)
- Software version
- Time of upgrade

- Trace File Configuration, page 18-8
- Trace Configuration, page 18-9
- Agent/Historical/Repository Trace Configuration, page 18-9
Managing the CRS Engine

Use the Control Center/Server configuration web page to:

- Remove a server from the cluster (see Removing a Server, page 11-13)
- Disable a server temporarily or permanently (see Disabling a Server, page 11-14)
- Start, stop, and restart services (see Starting, Stopping, and Restarting CRS Services, page 11-15)
- Reelect master for a particular service (see Reelect Master, page 11-16)
- View server trace files (see Server Traces, page 11-18)
- View server or services details (see Server Details, page 11-19)
- Monitor service status (see Monitoring Service Status, page 11-20)
- Configure the Auto Refresh Interval (see Controlling the Auto Refresh Interval, page 11-21)

Monitoring Service Status

Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

To view the status of the CRS system and its subsystems across the cluster, complete the following steps.

**Procedure**

**Step 1** From the CRS Administration menu bar, choose System > Control Center.
Managing the CRS Engine

The Control Center/Servers summary web page opens.

**Step 2**
Click a **Server Name** hyperlink on the navigation bar.

The Control Center/Server Configuration web page opens.

**Step 3**
Move the cursor over the status icon next to the service name you want to monitor. One of messages listed in the following table appears to display the current service status:

<table>
<thead>
<tr>
<th>Status Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initializing</td>
<td>The subsystem is in the process of initializing itself.</td>
</tr>
<tr>
<td>Shutting Down</td>
<td>The subsystem is in the process of shutting down.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Completion of a subsystem shutdown varies from subsystem to subsystem. While the Shutting Down state may be too quick to register for some subsystems, other subsystems may be in the Shutting Down state for a prolonged period of time.</td>
</tr>
<tr>
<td>Shutdown</td>
<td>The subsystem has completed the process of shutting down.</td>
</tr>
<tr>
<td>In Service</td>
<td>The subsystem initialized successfully and is serving with full functionality.</td>
</tr>
<tr>
<td>Partial Service</td>
<td>The subsystem detected at least one error during initialization and is serving with reduced functionality.</td>
</tr>
<tr>
<td>Out of Service</td>
<td>The subsystem failed to initialize or is not ready to serve for some other reason.</td>
</tr>
</tbody>
</table>

**Step 4**
To obtain more information about a server, click the icons in the Info column:

- **Logs icon.** Accesses the Server Traces summary page.
- **Details icon.** Accesses property information about the server.

---

**Controlling the Auto Refresh Interval**

**Note**
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.
When you start or stop a service, the CRS system refreshes the information in the Status area at regular intervals so you can monitor the status of the system or subsystems across the cluster.

To configure the auto-refresh setting perform the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose System > Control Center.  
The Control Center/Servers summary web page opens.

Step 2  Click a Server Name hyperlink on the navigation bar.  
The Control Center/Server Configuration web page opens.

Step 3  Select the Auto-refresh checkbox and, optionally, change the value in the seconds field.  
The Auto-refresh option causes the page to be refreshed until all of the services on the node are in either IN_SERVICE or SHUTDOWN state.  
Also, a page refresh occurs automatically whenever you START/STOP/RESTART a particular service.

Note  When Auto-refresh is in progress, avoid performing another CRS-related actions until the refresh completes.

Step 4  Click the Component Activation hyperlink.  
The system applies the changes.

Managing Cisco CRS CDS Information

The Cisco CRS system stores configuration information in the Cisco Configuration Datastore Server (CDS). The CRS Administration configurations are stored in the CDS.
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The Cisco CRS server can receive directory information from one Cisco Unified Communications directory and application configuration and script logic from a repository on another server.

**Related Topic**

*About the CRS Datastore, page 12-2*

## Managing System Parameters

The parameters in the System Parameters Configuration page are grouped logically into sections with headings. Each parameter has a corresponding suggested or default value on the right side of the page. Where applicable, radio buttons are used to toggle between the parameter options.

In this web page, you can configure the number of historical reporting clients, the recording count, port settings, the default session timeout, and Codec.

### Procedure

1. Choose **System > System Parameters** from the CRS Administration menu bar.

The System Parameters Configuration web page appears displaying the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Internationalization Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Default Language</td>
<td>System default language associated with new contacts for which no language has been defined. This field specifies the last possible fallback language when the system searches for resources such as prompts and grammars. Default: English (United States) [en_US]</td>
</tr>
</tbody>
</table>
### Customizable Locales
- **Use to specify a unique locale.**
- **Default:** (blank)

### Default Currency
- **Default currency, such as American dollars (USD), French Francs (FRF), and so on.**
- **The system uses the default currency for converting currency amounts in a playable format when no currency designator is specified.**
- **Default:** American Dollar [USD]

### Media Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codec</td>
<td>The codec chosen during installation for this CRS server.</td>
</tr>
<tr>
<td></td>
<td>The Codec configuration settings differs based on the Cisco CRS deployment type:</td>
</tr>
<tr>
<td></td>
<td>• In Unified CM deployments, the Codec parameter is configurable.</td>
</tr>
<tr>
<td></td>
<td>• In Unified CME deployments, the Codec parameter is not configurable and is always G711.</td>
</tr>
<tr>
<td>Recording Count</td>
<td>The maximum number of simultaneous sessions that are supported with this system configuration. This value cannot be greater than the number of seats.</td>
</tr>
<tr>
<td></td>
<td><strong>Default:</strong> 0</td>
</tr>
<tr>
<td>Default TTS Provider</td>
<td>Default TTS (Text-to-Speech) provider.</td>
</tr>
<tr>
<td></td>
<td><strong>Default:</strong> By default, no TTS provider is configured. Select a provider from the drop-down list to configure it as the default. The system uses the default TTS provider to determine which provider to use if the TTS request does not explicitly specify the provider to use.</td>
</tr>
</tbody>
</table>

### Application Parameters
### Field | Description
--- | ---
**Supervisor Access** | The Administrator uses this option to allow certain privileges to supervisors (all supervisors have the same privilege). The options are:
- No access to teams—The supervisor logs into the Supervisor page, but will not be able to see any team information (No RmCm info)
- Access to all teams—The supervisor logs into the Supervisor page, and will be able to see all the teams (RmCm information)
- Access to supervisor’s teams only—The supervisor logs into the Supervisor page, and will be able to see the teams they supervise.

**Max Number of Executed Steps** | The maximum number of steps an application can execute before the CRS Engine terminates the script or application.
This limitation is intended to prevent a script from running indefinitely.
Default: 1000
*Note* | Do not change the default value.

**Additional Tasks** | This field allows you to control the creation of additional threads that the CRS server internally initializes based on licensed Unified IP IVR ports.
Default: 0

**Default Session Timeout** | Maximum number of minutes a user-defined mapping ID remains in the session object memory after the session is moved to the idle state. During this duration, the session continues to be accessible even if you have terminated that session. Use this setting to configure the time required to perform your after-call work (for example, writing variables to a database before clearing the session).

The default is 30 minutes (recommended). Reducing this number, also reduces the system memory usage comparatively.
You can add a user-defined mapping ID to a session using the Session Mapping step in the script editor. Once assigned, you can use this mapping ID to get the session object from another application instance. By doing so, other applications obtain access to the session context. See the *Cisco CRS Getting Started with Scripts* guide for more information.

**Enterprise Call Info Parameter Separator** | A character used Get/Set Enterprise Call Info steps in the CRS Editor to act as a delimiter for call data.
Default: | (bar)
### Managing System Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent State after Ring No Answer</td>
<td>Radio button determining how agent state should be set after a “Ring No Answer” event. The choices are:</td>
</tr>
<tr>
<td></td>
<td>• Ready. If an agent does not answer a call, the Agent State is set to Ready.</td>
</tr>
<tr>
<td></td>
<td>• Not Ready (default). If an agent does not answer a call, the Agent State is set to Not Ready.</td>
</tr>
<tr>
<td>Number of HR session licenses</td>
<td>The maximum number of Historical Reporting sessions that can be supported with this system configuration. Historical reporting sessions (seats) refer to the number of historical reporting clients that can be started at the same time on different client machines.</td>
</tr>
<tr>
<td></td>
<td>This value cannot be greater than the number of licensed seats in the case of Unified CCX (see Historical Reporting Configuration, page 13-2).</td>
</tr>
<tr>
<td></td>
<td>Default: 0 for Unified CCX (Standard, Enhanced, and Premium), 5 for Unified QM and Unified IP IVR.</td>
</tr>
</tbody>
</table>

#### System Port Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RMI Port</td>
<td>The port number used by the CRS Engine to serve RMI requests. Default: 1099</td>
</tr>
<tr>
<td>RmCm TCP Port</td>
<td>TCP port number on which the CTI server component of the RmCm subsystem opens the server socket and listens to the clients. All CTI server clients, such as Cisco Agent Desktop, Unified ICME Server, Sync Server, and IP Phone Agent Server, use this port number.</td>
</tr>
<tr>
<td>SQL TCP Port</td>
<td>The TCP port the Cisco CRS SQL Server instance listens on for database connections over TCP/IP network protocol. Default: 4433</td>
</tr>
</tbody>
</table>

**Note**: If you change this value, the system will logged out. (The system generates a warning before proceeding.)

Default: 42027
Managing System Parameters

Step 2 Click **Update**.

The system notifies all nodes in the cluster about the changes.

**Note** If Node Manager is not in Shutdown state during this operation, then the changes just made are synchronized on that node when Node manager is started again.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heartbeat UDP Port ¹</td>
<td>UDP port used to send UDP packets (heartbeats) between all cluster nodes. A undetectable heartbeat indicates that a node is not running. Set this port to a unique value between 1 and 65635. (This setting should do not conflict with other UDP ports on the node.) If you change this value, all CVD on all cluster nodes must be restarted. Default: 996 <strong>Note</strong> Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.</td>
</tr>
<tr>
<td>Master Listener TCP Port ¹</td>
<td>TCP port used for communication between CVD and Cisco Agent/Supervisor Desktop Services. Set one value for every cluster node. Set this port to a unique value between 1 and 65635. (This setting should not conflict with other TCP ports on the node.) If you change this value, all CVD on all cluster nodes must be restarted. Default: 994</td>
</tr>
<tr>
<td>Backup and Restore Port ¹</td>
<td>TCP port for communicating between BARS and BRM. Default: 996</td>
</tr>
</tbody>
</table>

¹ The port changes for this parameter requires restart of CRS Engine on all nodes in the cluster.
Exiting Cisco CRS Administration

You can exit CRS Administration by closing your web browser.

To exit CRS Administration without closing your web browser, choose **System > Logout** from the CRS Administration menu bar. The system logs you out of CRS Administration and displays the Authentication web page.

**Tracing Configuration**

- **Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

You can configure trace options for each CRS component. Tracing enables you to monitor CRS and subsystem activities across the cluster.

- **Note** If you activate tracing, monitor the CPU usage and available disk space on the server. CPU usage near 100% or a full disk can cause your system to shut down unexpectedly.

Access tracing configuration by choosing **System > Tracing** from the CRS Administration menu.

- **Note** For an overview regarding the options available on the Alarm and Trace Configuration pages, see *Configuring Trace Settings, page 12-9*

For complete instructions on configuring tracing, see the *Cisco Customer Response Solutions Servicing and Troubleshooting Guide*. 
CRS Log Collection Tool

The CRS Log Collection Tool provides the ability to collect all log files from the CRS server into one zip file. The tool also provides the ability to write the zip file to a local or network drive.

For complete CRS Log Collection tool information and procedures, refer to the Cisco Customer Response Solutions Servicing and Troubleshooting Guide.

Related Topics
- Server Traces, page 11-18
- Configuring Trace Settings, page 12-9
- Trace File Configuration, page 18-8
- Trace Configuration, page 18-9
- Agent/Historical/Repository Trace Configuration, page 18-9

Cisco CRS Utilities

Cisco CRS has additional tools to help you manage system components:

- **Cisco CRS Admin Utility.** Enables you to change or synchronize passwords for CRS Windows User accounts (see CRS Admin Utility, page 11-29).
- **Cisco CRS Serviceability Utility.** Enables you to synchronize the bootstrap data in a Cisco CRS server, update Cisco CRS IP address information, update Unified CM IP address information, and update Cisco CRS configurable property files that are stored in the Cisco CRS bootstrap repository (see CRS Serviceability Utility, page 11-36).

CRS Admin Utility

**Note** Support for High Availability and remote servers, and expansion servers is only available in multiple-server deployments.
Use the Cisco CRS Admin Utility to change or synchronize passwords of the following CRS Windows User accounts:

- CRS Administrator
- CRSHistRptUsr

CRS Admin Utility applies the password change of any of the above accounts to the Windows services running under these accounts.

The Cisco CRS Admin Utility consists of a window that displays the password status of these accounts on each of the nodes in the CRS Cluster.

**Note**

The displayed accounts depend on the Cisco CRS deployment option.

Each account in the Cisco CRS Admin Utility window has a color-coded icon representing the status of the account’s password:

- A **green** icon indicates that the account matches the cluster-level password.
- A **red** icon indicates that the account does not match the cluster-level password.

This section describes the following topics:

- Guidelines and Requirements for the CRS Admin Utility, page 11-30
- Logging on to the Cisco CRS Admin Utility, page 11-31
- Changing the CRS Administrator Password, page 11-31
- Changing the CRS Administrator Password for Multiple-Node Deployments, page 11-32
- Synchronizing the Cisco Historical Reports User Password, page 11-34

### Guidelines and Requirements for the CRS Admin Utility

Be sure to follow these guidelines when using the CRS Admin Utility:

- Effective Cisco CRS 5.0, the CRS Admin Utility only works on the bootstrap server.
- Only run the CRS Admin Utility on the bootstrap server. Only the bootstrap server has the required bootstrap data storage tool installed. This tool is required to update password for the CRS Admin Utility.
Run the CRS Admin Utility only after the software is properly installed and configured in the server (or cluster as applicable).

Do not run the CRS Admin Utility before, during the installation, or during the cluster configuration.

Logging on to the Cisco CRS Admin Utility

Note: Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

To access and logon to the Cisco CRS Admin Utility, complete the following steps.

Note: Only one instance of this utility should be run within the cluster at any given time to apply password changes across the cluster.

Procedure

Step 1. Select Start > Programs > Cisco CRSAdministrator > Cisco CRS Admin Utility.

The Cisco CRS Admin Utility Logon window opens.

Step 2. Specify your Windows NT Administrator User Name and Password and click OK.

The Cisco CRS Admin Utility window opens, displaying the CRS Cluster information for the CRSAdministrator and CRSHistRptUsr accounts.

Changing the CRS Administrator Password

Note: Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.
To change the CRSAdministrator password across the cluster, complete the following steps.

**Note**

Do not change passwords during peak call traffic times. Doing so may impact the performance of your system.

**Procedure**

**Step 1**
In the CRS Admin Utility, use the checkbox to select the CRSAdministrator account.

**Step 2**
Select **Option > Set New Password**.

The Set Accounts Password dialog box appears.

**Step 3**
Use the dialog box fields to specify and confirm a new password and click **OK**.

A warning dialog box appears.

**Step 4**
Click **OK**.

The password is applied to each node in the cluster and the accounts running under CRSAdministrator account on all nodes; a dialog box reports the status of the changes.

---

**Changing the CRSAdministrator Password for Multiple-Node Deployments**

**Note**
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

If one or more nodes in the cluster has a CRSAdministrator password that is different than the cluster-level password, instead of setting a new password for the cluster, you can change or resynchronize the passwords for the required node.

**Note**
A red CRSAdministrator icon indicates that the password is out of sync.

To change a CRSAdministrator password, complete the following steps.
Procedure

Step 1 Log in to the bootstrap server node that is currently active.
Step 2 Shut down the CRS Administration window for the required node in the cluster.
Step 3 In the CRS Admin Utility, use the checkbox to select the **CRSAdministrator** account.
Step 4 Select **Option > Change Password**.
Step 5 Follow the instructions specified in each window.

**Note** Several message boxes provide the status at each stage, read the update and proceed as required at each stage.

---

**Synchronizing the CRSAdministrator Password for Multiple-Node Deployments**

**Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

If one or more nodes have a CRSAdministrator password that is different from other nodes in the cluster, you can resynchronize the passwords for the required nodes.

To synchronize a CRSAdministrator password in a multiple-node deployment, complete the following steps.

**Procedure**

Step 1 Run the CRS Admin Utility on the bootstrap server node that is currently the active (master) server:

Start > Program > Cisco CRS Administrator > Cisco CRS Admin Utility

Step 2 Shut down the CRS Administration window for all nodes in the cluster.
Step 3 In the CRS Admin Utility, use the checkbox to select the CRSAdminstrator account.

Step 4 Select Option > Synchronize.

Step 5 Follow the instructions specified in each window.

**Note** Several message boxes provide the status at each stage, read the update and proceed as required at each stage.

---

**Synchronizing the Cisco Historical Reports User Password**

During CRS installation, a pre-determined password phrase is set for CiscoHistRrptUsr. If this password is ever changed on any node, you can synchronize it to the pre-determined password.

To synchronize a password, complete the following steps.

**Note** You cannot change a CiscoHistRrptUsr password, only synchronize it.

**Procedure**

Step 1 In the CRS Admin Utility, use the check box to select the CRSHistRrptUsr account.

Step 2 Select Option > Synchronize.

A warning dialog box appears.

Step 3 Click OK.

The password is applied to each node in the cluster where the CRSHistRrptUsr account is out-of-sync; a dialog box reports the status of the changes.
Refreshing Account Sync Status

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The Refresh Menu option refreshes each node’s account sync status with cluster level information, whether they are in-sync or out-of-sync.

Procedure

Step 1
In the CRS Admin Utility, select View > Refresh.
CRS refreshes the node’s account sync status with cluster information.

LogLevel Entry in Registry

The LogLevel entry can be found in registry as the following key:
HKLM\Software\Cisco Systems, Inc.\Cisco CRS Admin Utility\Log\LogLevel.

The value for this entry can be:
- 1 - Errors are logged.
- 2 - Errors and warnings are logged.
- 3 - Errors, warnings, and informational messages are logged.
- 4 - Errors, warnings, informational and debugging messages are logged.
- 5 - Errors, warnings, informational, debugging and verbose messages are logged

Timeout Seconds Entry in Registry

The TimeoutSeconds entry can be found in registry as the following key:
HKLM\Software\Cisco Systems, Inc.\Cisco CRS Admin Utility\Log\TimeoutSeconds.

The default value is 5.
The CRS Admin Utility sleeps for the timeout defined by this register before it polls the status of the node manager or goes to next step. It increases when the node manage start up takes a long time for the bootstrap to be in IN_SERVICE, or if the shut down is slow.

**ExtRetries Entry in Registry**

The ExtRetries entry can be found in registry as the following key:

```
HKLM\Software\Cisco Systems,Inc.\Cisco CRS Admin Utility\Log\ExtRetries
```

Default value is 250.

The retry number defines the Maximums retry to pool the node manager status before failing the function. It increases when the node manage start up takes a long time for the bootstrap to be in IN_SERVICE, or if the shut down is slow.

**CRS Serviceability Utility**

The Cisco CRS Serviceability Utility allows you to:

- Update CRS IP address information.
- Update Unified CM IP address information.
- Update CRS configurable property files that are stored in the Cisco CRS bootstrap repository.

This section describes the following topics:

- Launching the Cisco CRS Serviceability Utility, page 11-37
- Updating Property File information, page 11-37
- Updating CRS IP Address Information, page 11-38
- Updating Unified CM Information, page 11-39
- Examples: Updating CRS IP Address Information, page 11-40
Launching the Cisco CRS Serviceability Utility

**Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

You can launch the Cisco CRS Serviceability Utility from any server in the cluster by selecting **Start > Programs > Cisco CRS Administrator > Cisco CRS Serviceability Utility**.

One of the following happens:

- The Cisco CRS Serviceability Utility connects to the Cisco CRS bootstrap repository and displays bootstrap (and cluster, if applicable) information.
- If the Cisco CRS Serviceability Utility cannot connect to the Cisco CRS bootstrap repository for any reason, the following error message is displayed:
  
  Load/Update failed due to Bootstrap Repository error.

Updating Property File information

Use the Properties tab of the CRS Serviceability Utility to make changes to properties file information.

To update property file information, complete the following steps.

**Procedure**

**Step 1** In the CRS Serviceability Utility, click the Properties tab.

**Step 2** Use the drop-down list on the left side of the dialog and select a Properties File Name.

**Step 3** Specify your changes.

**Step 4** Repeat Steps 1 and 2.

**Step 5** Click **Save**. Each entry in the property file provides an important attribute to the CRS Cluster. Be sure to save each change made to the property file.

  The system saves the information to the configuration datastore server.

**Step 6** Restart the CRS Node Manager for the changes to take effect.
Note: If the changes are to take effect on all nodes in the cluster, restart CRS Node Manager on all nodes.

### Updating CRS IP Address Information

**Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

Use the Node Information tab of the CRS Serviceability Utility to make changes to the IP address of any node in the cluster.

To update node information, complete the following steps.

**Procedure**

**Step 1** In the CRS Serviceability Utility, click the Node Information tab.

**Step 2** Select a Node ID from the drop-down list on the left.

**Step 3** Specify changes to the following fields:
- Existing IP Address
- New IP Address

**Note** The Machine Name is a read only field and cannot be changed.

**Tip** In a multiple-server scenario, the Cisco Agent/Supervisor Desktop client computers and CRA engine should use the same set of active and standby servers to ensure failover protection.

**Step 4** Click **Update**.

The system saves the information in the configuration datastore.
**Step 5** Restart the CRS Node Manager on all nodes for the changes to take effect.

---

### Updating Unified CM Information

If the Unified CM IP address changes, you must update the AXL Provider, the Unified CM Telephony Provider, and the RmCm Unified CM Telephony Provider information. You can update this information using one of two methods:

- Use the CRS Unified CM Configuration web page (see Configuring Unified CM Information, page 4-2). This is the recommended method if you can access the server at any time.
- Use the Cisco CRS Serviceability Utility (the procedure in this section). This is the procedure to use if, for any reason, you are not able to connect to the existing server setup.

To update Unified CM information, complete the following steps.

**Procedure**

**Step 1** In the CRS Serviceability Utility, click the **Unified CM Configuration** tab.

**Step 2** Specify changes to the following fields:
- Existing and New AXL Service Provider information
- Existing and New Unified CM Telephony Provider information
- Existing and New RmCm Unified CM Telephony Provider information

**Step 3** Click **Update**.

The system saves the information in the configuration datastore.

**Step 4** Restart the CRS Node Manager on all nodes for the changes to take effect.
Examples: Updating CRS IP Address Information

**Note** Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

This section provides examples of the steps you need to follow whenever there is a change in IP address for the nodes in a cluster for the following CRS deployments:

- Single-node scenario
- CRS node with third party servers for MRCP ASR and MRCP TTS.

**Note** The deployment options listed above are supported and tested.

**Scenario 1: Single-Node Cluster**

In a deployment consisting of a single-node CRS cluster, do the following to update the IP address:

1. Stop the CRS Node manager from the Services window.
2. Modify the IP address of the machine using the Windows TCP/IP Properties window.
3. Update the DNS server so that new IP address matches the old host name.
4. If you have Unified CCX, run the Cisco Agent Desktop Configuration Setup by double clicking the PostInstall.exe file (located under C:\Program files\Cisco\Desktop\bin) and modify the IP address of the Primary/Secondary CAD Directory Service, click **OK**, and then modify the IP address under the appropriate subsequent screens (such as Unified CM, VoIP Network Device and service IP address).
5. Launch the CRS Serviceability Utility and follow these steps:
   a. When launching the tool, a dialog box appears displaying the old Cisco Unified CM IP address connection details. Enter the new IP address and click **Sync**; the utility updates the information internally and the tabs are populated with the data.
b. Go to the Node Information tab and select the node for which the IP address has to be changed. Select the IP address from the drop-down list, enter the new IP address and click **Update**.

**Note** You need to perform this step on all the nodes in the cluster (if applicable).

c. Go to the Node Manager Information tab, enter the new IP address, and click **Update**.

d. Go to the Unified CM Configuration tab. Update RmCm Unified CM Telephony Provider and Unified CM Telephony Provider with the new IP address and click **Update**.

e. Exit the Serviceability utility.

6. Reboot the Node.

7. If you have Unified CCX and you have configured IP Phone Agent (IPPA) service on Unified CM, access the Unified CM Administration page, update the URL in the IPPA service with new IP address, and click **Update subscriptions**.

**Note** For non-Unified CCX packages ignore Step 5, Running the Cisco Agent Desktop Configuration Setup, and Step 8, Updating IPPA Service.

**Scenario 1: Single-Node Cluster with High Availability**

In a deployment consisting of a single-node CRS cluster with high availability, do the following to update the IP address:

1. Stop the CRS Node manager from the Services window.

2. Modify the IP address of the machine using the Windows TCP/IP Properties window.

3. Update the DNS server so that new IP address matches the old host name.

4. If you have Unified CCX, run the Cisco Agent Desktop Configuration Setup by double clicking the PostInstall.exe file (located under C:\Program files\Cisco\Desktop\bin) and modify the IP address of the Primary/Secondary
CAD Directory Service, click OK, and then modify the IP address under the appropriate subsequent screens (such as Unified CM, VoIP Network Device and service IP address).

5. Launch the CRS Serviceability Utility and follow these steps:

   a. When launching the tool, a dialog box appears displaying the old Cisco Unified CM IP address connection details. Enter the new IP address and click Sync; the utility updates the information internally and the tabs are populated with the data.

   b. Go to the Node Information tab and select the node for which the IP address has to be changed. Select the IP address from the drop-down list, enter the new IP address and click Update.

   c. Go to the Node Manager Information tab, enter the new IP address, and click Update.

   d. Go to the Unified CM Configuration tab. Update RmCm Unified CM Telephony Provider and Unified CM Telephony Provider with the new IP address and click Update.

   e. Exit the Serviceability utility.

6. Repeat Step 2 to Step 5 on the second node in the cluster (or on all nodes in the cluster).

7. Reboot each node in the cluster.

8. If you have Unified CCX and you have configured IP Phone Agent (IPPA) service on Unified CM, access the Unified CM Administration page, update the URL in the IPPA service with new IP address, and click Update subscriptions.
Scenario 3: CRS Node with Third-Party Servers for ASR and TTS

In a deployment consisting of a CRS node with third party servers for MRCP ASR and MRCP TTS, do the following to update the IP address on the nodes in the cluster:

1. If you change the IP address for any of the nodes within the CRS cluster, follow the instructions in the previous scenarios.
2. Changing the IP address of the CRS node does not affect the third party MRCP ASR and MRCP TTS servers. Apart from the instructions in the previous scenarios, no other change is required.
3. If you change the IP address of the third party server(s) that hosts the ASR and/or TTS server software from the MRCP vendors, you will need to update the server configuration data in the App Admin pages for the MRCP ASR and/or MRCP TTS subsystems.
4. Depending on whether this is a MRCP ASR or TTS server that is impacted, select Subsystems > MRCP ASR or Subsystems > MRCP TTS.
5. From the links on the left select the MRCP Servers link. This will list the currently configured servers for the different MRCP Providers in the system.
6. Select the server with the old IP address that was configured earlier and delete it by clicking the Delete icon.
7. Then add a new server by clicking the Add MRCP ASR Server or Add MRCP TTS Server link at the top right of the page.
8. As part of this configuration enter the new IP address of the third-party server and configure additional information as before such as the provider name, port number and the locales. In the case of TTS, configure the gender information as well. Click Add to add the server.
9. Next, click MRCP Providers. This will list all the MRCP Providers configured in the system.
10. The newly added server change will not take effect in the Cisco CRS Engine until the MRCP provider is refreshed. To make this change effective, either click Refresh for the specific MRCP Provider that was affected by this server IP address change, or alternatively if all MRCP providers were affected, you can Refresh All at the bottom of the page.
11. The Cisco CRS Engine will then reload the corresponding MRCP Providers for ASR and/or TTS and the IP address change will take effect.
Note  Host name changes are not supported.

Using the CRS Log Collection Tool

The CRS Log Collection Tool provides a way for you to collect all of the log files you want to view into one zip file. The tool also provides a way for you to run it remotely and to move the zip file off of the CRS server to your own desktop or to a network drive.

Tip  CRS servers do not have JRE installed by default. If you have installed the Real Time Reporting tool, you will have a JRE version on your CRS server. Otherwise, be sure to install JRE on your CRS server.

To use the log collection tool to collect log files into a zip file, complete the following steps:

Step 1  To access the CRS Log Collection Tool, go to Start > Programs > Cisco CRS Administration > Log Collection Tool.

A warning message appears listing several requirements. Be sure to adhere to these requirements.

Step 2  After reading the message, click OK.

Step 3  Enter the path and name of the zip file you want to create and click Save.

This step collects all the log files on the system into the zip file. If you want to limit the number of files by date, time, and component, and if you want to select another location for the zip file, check the Advanced Options check box, and another dialog box appears with more options:

Step 4  Enter the information to limit the collection of log files by date and time. Click the check boxes of the components for which you want to collect log files, and then browse to a location where you want to move the zip file, by clicking the ... box next to the Source Drive field. Select the location for the zip file; it then appears in the Source Drive field. Then click Save.

If you choose a location on the CRS system instead of a network drive, a warning message appears asking if you want to continue.
Step 5  Click Yes to save the file to the CRS system, or click No to go back and select another location on a network drive.

When you click Yes, The tool displays the following dialog box with the estimated disk space to be used by the zip file before actually writing the zip file.

Step 6  Click Yes to continue, or click No if you want to stop the collection of log files into the zip file.

While the tool is collecting the log files, a Progress dialog box appears to indicate the progress of the log collection process.
Managing the Cisco CRS Datastores

Datastores are components that allow you to manage and monitor historical, repository, and configuration data across all servers in the Cisco CRS cluster. Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The following sections provide more information on Cisco CRS datastores.

- About the CRS Datastore, page 12-2
- The CRS Datastore Control Center, page 12-4
- The Publisher Activation Page, page 12-8
- Configuring Trace Settings, page 12-9
- Starting, Stopping, and Restarting Datastores, page 12-15
- Configuring Alarm Settings, page 12-14
About the CRS Datastore

The CRS Cluster uses the publisher/subscriber database model for data replication across the system. Under normal circumstances, the *publisher* acts as the source of data and the *subscriber* acts as the target for the data.

**Note**
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The publisher/subscriber database model enables CRS to provide high-availability and failover support. To support this on the database level, the data must be available on multiple nodes of the cluster. To have such data availability, replication is used for the Agent, Historical, and Repository datastore. (The Configuration datastore does not use replication; instead, it uses atomic transaction to commit data changes to all active Configuration datastore in the cluster.)

The publisher is the main database. All data is written to this database, with the other databases (subscribers) synchronizing with the publisher. If the publisher fails, then data can be written to the subscriber(s). When the publisher is back online, it returns to accepting writes. It also synchronizes with the subscriber(s) by performing the following functions:

- Adding any files or records that are new.
- Deleting any files or records that have been removed.
- Updating any files or records that have a later modification time stamp on the subscriber database.

When the publisher is fully synchronized, then all subscribers return to synchronizing with the publisher.

**Note**
You cannot deactivate publisher datastore components. To deactivate a publisher datastore component, first change the component to be a subscriber and then activate the component (see Changing Publisher to Subscriber, page 12-9).

Internally, CRS datastores use the Microsoft SQL Server merge replication model. This means that a publisher is associated with a *snapshot agent* and a subscriber is associated with a *subscription agent*.
• **Snapshot agent.** Generates a snapshot or image of the current database data. For the CRS datastores, usually a new snapshot is generated only when the publisher is created or a subscriber is added. However, the CRS administrator has the option of manually triggering a snapshot.

• **Subscription agent.** Actively replicates data between the publisher and subscriber. Since CRS uses bidirectional replication, the subscription agent will replicate data from publisher to subscriber as well as from the subscriber to the publisher.

New nodes added to the cluster having datastores will not have any replication role or type. In a multiple node cluster, the first node becomes the publisher only when the second node is activated, and the second node becomes the subscriber.

A datastore with replication can play the following roles:

1. Unknown/Deactivated
2. Subscriber
3. Publisher

A datastore can only move up or down the line of roles one step at a time. For example, a publisher cannot be deactivated, so you first need to change the publisher to a subscriber and then deactivate the subscriber.

Also note that, while CRS administrators can configure a publisher, they cannot configure a subscriber. Subscribers are managed automatically by CRS; the event that triggers a datastore to play the role of a subscriber is the datastore component activation.

You use the CRS Datastore Control Center to manage and monitor these agents.

**Inactive Retention Period**

By default, a subscriber is dropped from the publisher during a merge replication if the subscriber did not synchronize with the publisher within the retention period of two or four days. If a subscriber is dropped under these circumstances, use the CRS Datastore Control Center to prevent data loss.

**Note**

The retention period is two days on a 18GB-30GB hard disk space system, and 4 days on a system with more than 30GB hard disk space.
Publisher Goes Down

For example, in a 2-node cluster, if Node A is currently the publisher and Node B is the subscriber and Node A goes down for more than the 2- or 4-day retention period. In this case, you must change Node B to become the publisher. When you do this, Node A automatically becomes the subscriber and obtains the latest information from Node B.

Subscriber Goes Down

When the subscriber goes down for more than the 2- or 4-day retention period, reinitialize the subscriber in CRS Administration (Datastore Control Center web page) and reinitialize the subscription for all the datastores.

The CRS Datastore Control Center

CRS Cluster configuration is not complete until Agent, Historical, and Repository publishers are configured.

Tip
The Datastore Control Center page is not available in single-node deployments.

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

Note
CRS only supports datastore publishers in a multiple node cluster having high availability.

The Datastore Control Center allows you to configure and manage the following data across all servers in the cluster:

- Agent records
- Historical records
- Repository data, such as prompts, grammars and documents
Configuration data for historical reporting

Access the Datastore Control Center by selecting System > Datastore Control Center from the CRS Administration menu bar.

Use the Datastore Control Center to perform the following functions:

- Obtain an overview of the datastores in the cluster and their relationships.
- Manage the datastore read/write access.
- Monitor and control the replication agents. (Available for Agent, Historical, and Repository datastores, only.)
- Activate the publisher.

The following table describes the datastores available and what they contain.

<table>
<thead>
<tr>
<th>Datastore Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Historical</td>
<td>This datastore contains Historical Report data.</td>
</tr>
<tr>
<td>Repository</td>
<td>This datastore contains user prompts tables, grammar tables, and document tables</td>
</tr>
<tr>
<td>Agent</td>
<td>This datastore contains agent configuration information, agent report data, and metadata for recorded files.</td>
</tr>
<tr>
<td>Configuration</td>
<td>This datastore contains Cisco CRS system configuration information.</td>
</tr>
</tbody>
</table>

Use the navigation hyperlinks in to access the configuration web pages.

\( ^{\text{Note}} \) For more information, see “Datastore Control Center” section on page 12-6.
## Datastore Control Center

The following fields describe the Datastore Control Center contents common to all the CRS datastores.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Server machine name.</td>
</tr>
<tr>
<td>Replication Type</td>
<td>One of the following values:</td>
</tr>
<tr>
<td></td>
<td>• Unknown</td>
</tr>
<tr>
<td></td>
<td>• Publication Snapshot Agent</td>
</tr>
<tr>
<td></td>
<td>• Subscription Agent</td>
</tr>
<tr>
<td></td>
<td>• Atomic Transaction</td>
</tr>
<tr>
<td></td>
<td>• Migration Agent (for HDS3x- upgrade from Cisco CRS 3.x)</td>
</tr>
<tr>
<td>Node ID</td>
<td>Node ID of server/node in CRS cluster.</td>
</tr>
<tr>
<td>Read Access</td>
<td>Indicates whether data can be read from the datastore. Options: Yes, No.</td>
</tr>
<tr>
<td>Write Access</td>
<td>Indicates whether data can be written to the datastore. Options: Yes, No.</td>
</tr>
<tr>
<td>Replication Status</td>
<td>Can be one of the following values:</td>
</tr>
<tr>
<td></td>
<td>UNKNOWN—Status cannot be obtained.</td>
</tr>
<tr>
<td></td>
<td>RUNNING—Replication agent is running</td>
</tr>
<tr>
<td></td>
<td>RETRYING—Replication agent is retrying some failed operation.</td>
</tr>
<tr>
<td></td>
<td>STOPPED—Replication agent is stopped.</td>
</tr>
<tr>
<td></td>
<td>FAILED*—Data migration agent failed</td>
</tr>
<tr>
<td></td>
<td>COMPLETED*—Migration agent successfully completed.</td>
</tr>
<tr>
<td></td>
<td>CANCELLED*—Migration agent last run was cancelled.</td>
</tr>
<tr>
<td></td>
<td>* Specific to HDS3x migration agent (upgrade from CRS3.x), only</td>
</tr>
</tbody>
</table>
Chapter 12  Managing the Cisco CRS Datastores

The CRS Datastore Control Center

In addition, the Datastore Control Center contains the following hyperlinks:

- **Publisher Activation.** Allows for Publisher activation, switch or reset functions. (see The Publisher Activation Page, page 12-8.)
- **Trace Configuration.** Access Trace Configuration, where you can activate detailed debugging for CRS datastore replication (see Configuring Trace Settings, page 12-9).

**Note**  
Debugging should be switched **Off** once the debug session is completed since it impacts the server when left turned **On** under normal operations (for example, disk space used by replication logs will grow without limit.) Debugging reports are written to \wفاوید\log\ReplLogs as well as SQL Server logs and NT Event viewer.

This web page also contains the following buttons:

- **Start**—Click this button to start the replication agent.
- **Stop**—Click this button to stop the replication agent.
- **Restart**—Click this button to restart the replication agent.
- **Reinit Subscriber**—Click this button to reinitialize the subscriber with a copy of data from the Publisher. (This causes the data on the subscriber to be overwritten by the data from the Publisher.)

**Note**  
Only use this button if you have determined that the Subscriber needs this data from the Publisher (if the Subscriber and the Publisher are not synchronized.)
The Datastore Control Center web page contains two fields: the auto-refresh checkbox and seconds field. Use these two fields if you need to modify the refresh interval for this web page.

The Publisher Activation Page

You can activate a new publisher or reset an existing publisher. If you selected datastore components (repository, historical, config, or agent datastores) during initial setup, the Publisher Activation page displays the selected datastores. You cannot deactivate the publisher, only change it to be a subscriber (see Changing Publisher to Subscriber, page 12-9).

Tip
Use the publisher activation and reset functions in the event of a catastrophic situation where the publisher becomes inaccessible.

Warning
Perform the publisher activation and reset functions sparingly. Inappropriate use of these functions may lead to data loss.

Procedure

Step 1  Select Systems > Datastore Control from the CRS Administration menu bar. The Datastore Control Center page appears.

Step 2  Select Publisher Activation. The Publisher Activation page appears.

Step 3  Select the required server and perform one of the following actions
  • Click Activate Publisher to activate the selected server.
  • Click Reset Publisher to reset the existing server.
Changing Publisher to Subscriber

Use the Tracing page to activate and deactivate logging.

Note

For more information on Trace Configuration, see theCisco Customer Response Solutions Servicing and Troubleshooting Guide.

Procedure

Step 1
Access the Datastore Control Center by selecting Systems > Datastore Control from the CRS Administration menu bar.

Step 2
Select each datastore on the left pane and then click Publisher Activation.

Step 3
Select the required server (for the subscriber to be changed) by clicking on the check box next to the server.

Step 4
Click Activate Publisher.

A warning message window appears.

To proceed with the change, click OK.

Repeat Step 3 and Step 4 for each datastore component that requires this change.

When you activate the new publisher, the old publisher automatically becomes the subscriber datastore.

Configuring Trace Settings

You configure Trace settings by component:

- **CRS Administration**—Trace File Configuration and Trace Configuration settings.
- **CRS Engine**—Trace File Configuration and Trace Configuration settings.
Updating Trace File Information

To update trace file information, follow these steps.

Procedure

Step 1  From any Datastore Control Center web page, click the Tracing hyperlink. The Trace Configuration page appears and defaults to display the Trace File Configuration hyperlink. The following fields are displayed on this page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name Prefix</td>
<td>A prefix to be added to each trace file name.</td>
</tr>
<tr>
<td>File Extension</td>
<td>The extension to be added to the trace file name.</td>
</tr>
<tr>
<td>Number of Trace Files</td>
<td>The number of trace files to be retained by the system.</td>
</tr>
<tr>
<td>Trace File Size</td>
<td>The maximum file size for each trace file retained by the system.</td>
</tr>
</tbody>
</table>
Step 2  Click Update.

Related Topics
- Activating/Deactivating Logging, page 12-11
- Trace Settings and Unified CM Telephony Performance, page 12-12
- Agent, Historical, or Repository Trace Configuration, page 12-13
- Configuring Alarm Settings, page 12-14
- Tracing Configuration, page 11-28

Activating/Deactivating Logging

To activate and deactivate logging, follow these steps.

Procedure

Step 1  From any Datastore Control Center web page, click the Tracing hyperlink. The Trace Configuration page appears for that datastore component.

Step 2  Perform one of the following actions:

- To activate logging for a server, select the Logging checkbox next to its node ID.
- To deactivate logging for a server, deselect the Logging checkbox next to its node ID.

Caution  You should activate logging only for the purpose of debugging and remember to deactivate logging once the debugging session is complete. When Logging is activated, debug logs are be written to \wfaxvid\log\ReplLogs, SQL Server logs, and the NT Event viewer.

Note  For detailed information about how to use tracing in your system, see the Cisco Customer Response Solutions Servicing and Troubleshooting Guide.
Step 3  Click Update.

Related Topics
- Updating Trace File Information, page 12-10
- Trace Settings and Unified CM Telephony Performance, page 12-12
- Agent, Historical, or Repository Trace Configuration, page 12-13
- Configuring Alarm Settings, page 12-14
- Tracing Configuration, page 11-28

Trace Settings and Unified CM Telephony Performance

Unified CM performance can degrade under high agent and call load if the default trace setting is used and AntiVirus is enabled, resulting in rejected and aborted calls.

You can improve Unified CM performance under high load by performing the following steps.

Procedure

Step 1  Set Unified CM SDL Trace Directory path to:
F:\Program Files\Cisco\Trace\SDL\n
Step 2  Set the Unified CM SDL Trace output setting to file name:
F:\Program Files\Cisco\Trace\CCM\ccm.txt

Step 3  Exclude the following folders from AntiVirus:
C:\Program Files\Cisco\Trace
F:\Program Files\Cisco\Trace

Related Topics
- Updating Trace File Information, page 12-10
- Activating/Deactivating Logging, page 12-11
- Agent, Historical, or Repository Trace Configuration, page 12-13
Agent, Historical, or Repository Trace Configuration

Note
Agent/Historical/Repository Trace Configuration is available for the SQL Server component, only.

To access a Agent/Historical/Repository Trace Configuration page, select one of the following hyperlinks from the SQL Server list on the Tracing Configuration page navigation bar:

- Agent
- Historical
- Repository

Each one of these options displays a configuration summary page listing all the servers in the cluster. Use the checkbox in the Logging column to enable/disable trace logging for the selected datastore on a particular server and click **Update**.

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

Related Topics
- Updating Trace File Information, page 12-10
- Activating/Deactivating Logging, page 12-11
- Trace Settings and Unified CM Telephony Performance, page 12-12
- Configuring Alarm Settings, page 12-14
- Tracing Configuration, page 11-28
Configuring Alarm Settings

Use the Alarm Configuration page configure system-wide settings to define the Alarm Server.

**Note**

Alarm Server Configuration is available for the following CRS components: CRS Administration, CRS Engine, and CRS Cluster View Daemon.

**Procedure**

**Step 1**

From any Datastore Control Center web page, click the **Alarm Configuration** hyperlink.

The Alarm Configuration page appears for that datastore component. The following fields are displayed on the Alarm Definitions web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>Catalog of alarm message names.</td>
</tr>
<tr>
<td>Alarm Name</td>
<td>Alarm message name for which you want to locate a stored alarm file.</td>
</tr>
</tbody>
</table>

**Step 2**

Perform one of the following actions.

- To activate logging for a server, select the Logging checkbox next to its node ID.
- To deactivate logging for a server, deselect the Logging checkbox next to its node ID.

**Caution**

You should activate logging only for the purpose of debugging and remember to **deactivate** logging once the debugging session is complete. When Logging is activated, debug logs are be written to `\wfvvid\log\ReplLogs`, SQL Server logs, and the NT Event viewer.

**Step 3**

Click **Update**.
Related Topics
Configuring Trace Settings, page 12-9

Starting, Stopping, and Restarting Datastores

Caution
Shutting down one datastore shuts down all datastores on that same node!

All the datastores on a single node share the same SQL Server. When you stop one SQL Server of a datastore on a node, all the other datastores on the same node will stop automatically.

When SQL Services are shutdown, data will not be read, written or replicated because these services are managed by the Node Manager.
Managing Cisco CRS Historical Reporting

The following sections describe how to manage the CRS Historical Datastore to accommodate historical reporting.

- About the CRS Historical Datastore, page 13-2
- Historical Reporting Configuration, page 13-2
- Purging Historical Data, page 13-4
- Database Details for Multichannel Reports, page 13-11
- Truncating db_cra Database Transaction Log Files, page 13-13
- Importing Historical Data from Data Files, page 13-15
About the CRS Historical Datastore

In a CRS Cluster, there can be one or more Historical datastores.

**Note**  Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

The Historical datastore can be:

- Co-located on a CRS Server with the CRS Engine.
- Located on CRS Server without the CRS Engine, (that is, a remote database Server.)

**Note**  For more information about the Historical datastore, see Chapter 12, “Managing the Cisco CRS Datastores.”

### Historical Reporting Configuration

**Note**  Verify that the **Number of HR Session Licenses** field is updated to reflect the licensed value. This value cannot be greater than the number of licensed Unified CCX seats. The default value is **0** for Unified CCX (Standard, Enhanced, and Premium), and **5** for both Unified QM and Unified IP IVR (see Managing System Parameters, page 11-23).

**Caution**  If this value remains at 0 (default), you may encounter a licensing error and you cannot login to the Historical Reporting Client.

The Cisco CRS Historical Reporting subsystem provides you with a way to set up and manage the purging of the Historical Reporting databases.

Setting up CRS for Historical Reporting consists of three tasks:

1.  Configuring Database Server Limits, page 13-3
2. Specifying Users for Historical Reporting, page 13-4
4. Verifying the Migration Status, page 13-10

**Configuring Database Server Limits**

To limit the performance impact of historical reporting on a particular CRS server, you can configure a maximum number of client/scheduler database connections per server.

To do so, complete the following steps:

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Tools > Historical Reporting**.

**Note**
The Historical Reporting configuration web page opens, displaying a list of Historical Datastore components in your cluster. The Database Server Configuration area automatically opens in the Historical Reporting Configuration web page when you first choose the **Historical Reporting** menu option from the Tools menu.

The following fields are displayed in the Database Server Configuration area of the Historical Reporting Configuration web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>The host name or IP Address of the database server.</td>
</tr>
<tr>
<td>Maximum DB Connections for Report</td>
<td>The maximum number of client and scheduler connections that can access the</td>
</tr>
<tr>
<td>Clients Sessions</td>
<td>Historical Reports Database server.</td>
</tr>
<tr>
<td></td>
<td>There is a limit of 5 instances of Historical Reporting Client and Scheduler</td>
</tr>
<tr>
<td></td>
<td>based on the load that can be run on each server. The historical report</td>
</tr>
<tr>
<td></td>
<td>client issues an error if you exceed this limit.</td>
</tr>
</tbody>
</table>

**Step 2**
Enter a value in the Maximum DB Connections for Report Client Sessions field next to a Server Name.
Purging Historical Data

Step 3  
Click Update.
The configuration changes take effect.

Specifying Users for Historical Reporting

Effective Cisco CRS 5.0, you can configure historical reporting users using the Tools > User Management page (see Historical Report User Privileges, page 17-4).

Purging Historical Data

As the Cisco CRS Engine runs, it collects information about the status and performance of the CRS system. Historical information is stored in a database that can then be accessed to provide reports (see the Cisco Customer Response Solutions Historical Reports User Guide for more information about Cisco CRS Historical Reports).

When the database approaches its maximum size, some or all of the data in it must be removed. Removing data from a database is called purging.

When the system purges data, it removes data from the db_cra database. It determines what information to purge based on the number of months you specify and on the current date. For example, if you instruct the system to purge data older than 12 months, a purge on January 15 will purge data older than January 15 of the previous year.

Note  
When you purge data, you permanently delete it. If you want to keep data that will be purged, back up the database.

Cisco CRS Administration provides the following features for purging historical reports from the database:

- Daily comparison of the size of the database to a user-specified maximum size
- User-specified time at which the system purges data
Automatic purging of the database when it exceeds the user-specified maximum sizes

Automatic purging of the database based on user-specified parameters

Manual purging of the database

Automatic e-mail notification of purging activities

Automatic Simple Network Management Protocol (SNMP) traps and Syslog messages describing purging activities

This section describes:

- Configuring Automatic Purging, page 13-5
- Purging Manually, page 13-9

## Configuring Automatic Purging

The CRS Engine performs automatic purging each day at a preset time.

### Note

SQL Agent Job Scheduler manages purge scheduling.

To help keep your system running most efficiently, schedule automatic purging to run when your system is least busy. By default, daily purges are scheduled to run at 4:00 a.m. (0400), but you can change this time.

The system bases its purging activities on a variety of parameters. You can change the default value for any parameter as needed.

A log file, PurgeProcess.log, stores information about the automatic purging activities that the system performs. The PurgeProcess.log file has a maximum size of 2 MB. When this file reaches its maximum size, the system copies it to a backup file named PurgeProcess.bak. The system maintains one such backup file. Each time the PurgeProcess.log file reaches 2 MB in size, the system moves that information to the existing backup file, overwriting the information in the existing backup file. This log file is stored on the CRS server in the `<CRSinstallationDirectory>\wfavvid\log\Purge_Sch` directory. (By default, the system installs in the Program Files directory.) You can view this log file by opening the file in a text editor.

This section contains the following procedures:
Setting the Daily Purge Schedule

You can change the time of day that the system assesses the need to purge data and the age of data to purge.

To set the purge schedule, complete the following steps.

Procedure

Step 1  From the CRS Administration menu bar, choose Tools > Historical Reporting. The Historical Reporting Configuration web page opens, displaying the Database Server Configuration area.

Step 2  Click the Purge Schedule Configuration hyperlink on the Historical Reporting Configuration navigation bar. The Purge Schedule Configuration area opens. The following fields are displayed in the Purge Schedule Configuration area.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily purge at</td>
<td>Time of day for the daily purge.</td>
</tr>
<tr>
<td>Purge data older than $N$ months</td>
<td>Number of months data can persist before being purged.</td>
</tr>
</tbody>
</table>

Step 3  From the drop-down list in the Daily purge at field, choose a time of day at which the system determines if purging is necessary.

Step 4  From the drop-down list in the Purge data older than $N$ months field, choose the required number of months. If the system determines that purging is necessary, it will purge both databases of data that is older than the number of months specified in this field.

Step 5  Click Update. The new purge schedule configuration is added to the CRS system.
Configuring Purge Schedule Configuration Parameters

When data is purged, the CRS system sends one of the following messages, depending on the activity that occurs:

- Database purged—Announces a purge has taken place, and includes an explanation of the purging activity.
- Database approaching maximum size—Sends an alert that the database is approaching its maximum size.

The system can send notifications through the following three methods:

- E-mail
- Syslog (system log)
- SNMP traps

For e-mail notification, the eMail subsystem must be configured on the CRS server. For information about configuring the eMail subsystem, see the “Provisioning the eMail Subsystem” section on page 8-19.

For Syslog and SNMP trap notification, the Cisco CRS Alarm service must be running, and Syslog and SNMP must be properly configured. For more information about Cisco CRS Alarm service, Syslog, and SNMP, see the Cisco Customer Response Solutions Servicing and Troubleshooting Guide.

To set purge schedule configuration parameters, complete the following steps.

Procedure

Step 1 From the CRS Administration menu bar, choose Tools > Historical Reporting. The Historical Reporting Configuration web page opens.

Step 2 Click the Purge Schedule Configuration hyperlink on the Historical Reporting Configuration navigation bar.
Purging Historical Data

The Purge Schedule Configuration area opens. The following fields are displayed in the Purge Schedule Configuration area.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send email notifications to</td>
<td>Email address(es) where notification is sent.</td>
</tr>
<tr>
<td>when database exceeds $N%$ of $&lt;\text{database max size}&gt;$ MB</td>
<td>Percentage of the maximum database size at which notification is sent.</td>
</tr>
<tr>
<td></td>
<td>Where $&lt;\text{database max size}&gt;$ can be one of the following based on your database edition:</td>
</tr>
<tr>
<td></td>
<td>• MSDE = 2048 MB</td>
</tr>
<tr>
<td></td>
<td>• SQL server = 10240 MB</td>
</tr>
<tr>
<td>Initiate automatic purge when database exceeds $N%$ of $&lt;\text{database max size}&gt;$ MB</td>
<td>Percentage of the maximum database size at which an automatic purge is initiated.</td>
</tr>
<tr>
<td></td>
<td>Where $&lt;\text{database max size}&gt;$ can be one of the following based on your database edition:</td>
</tr>
<tr>
<td></td>
<td>• MSDE = 2048 MB</td>
</tr>
<tr>
<td></td>
<td>• SQL server = 10240 MB</td>
</tr>
<tr>
<td>Auto purge data for the oldest $N$ Days</td>
<td>Age of data to be purged.</td>
</tr>
</tbody>
</table>

**Step 3** In the Send email notifications to field, enter the e-mail address for notifications.

**Step 4** From the drop-down list in the Purge data when database size exceeds $N\%$ of $2048$ MB field, accept the default, or choose another number. The default without redundancy is $70$ and the default with redundancy is $55$.

**Step 5** From the drop-down list in the Initiate an automatic purge when database size exceeds $N\%$ of $2048$ MB, accept the default, or choose another number. The default without redundancy is $80$ and the default with redundancy is $65$.

**Step 6** From the drop-down menu in the Auto purge data for the oldest $N$ days field, accept the default of $7$, or choose another number.

**Step 7** Click **Update**.

The Purge Schedule Configuration area refreshes, and the CRS system is configured with the new values.
Purging Manually

You can manually purge the databases at any time. This action will not affect the automatic purging schedule.

A MADM directory stores log files about the manual purge activities that you perform. These log files are stored on the CRS server in the <CRSinstallationDirectory>\wfvvid\log\MADM directory. By default, the system installs in the Program Files directory. You can view this log file by opening the file in a text editor.

In a cluster with more than one database server, when the db_cra database size does not match, the smallest database size will be shown and used for the purging threshold.

Note
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

To manually purge historical data, complete the following steps.

Procedure

Step 1
From the CRS Administration menu bar, choose Tools > Historical Reporting.
The Historical Reporting Configuration web page opens.

Step 2
Click the Purge Now hyperlink on the Historical Reporting Configuration navigation bar.

Note
When you access the Purge Now area, the system displays the percentage of the historical database’s 2048 MB storage space that is currently being used.

The Purge Now web page opens. The Purge data older than field is displayed in the Purge Now area of the Historical Reporting Configuration web page. You can specify this field in months and/or days.

Step 3
From the drop-down list in the Purge data older than N days field, keep the default (15 days) or specify the required number of days.
If the system determines that purging is necessary, it will purge both databases of data that is older than the number of days specified in this field.

**Step 4**
From the drop-down list in the Purge data older than $N$ months field, keep the default (13 months) or specify the required number of months.

If the system determines that purging is necessary, it will purge both databases of data that is older than the number of months specified in this field.

**Step 5**
Click **Purge Now**.
The databases are purged, and the Purge Now area refreshes.

---

### Verifying the Migration Status

Effective Cisco CRS Release 5.0, you can verify the status of a migration from one release to another using the Migration Status option.

**Note**
As this option is only introduced in Cisco CRS Release 5.0, you will only be able to view the status information in this page when you migrate from this release to another.

To verify the migration status from one release to another, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Tools > Historical Reporting**.
The Historical Reporting Configuration web page opens, displaying the Database Server Configuration area.

**Step 2**
Click the **Migration Status** hyperlink on the Historical Reporting Configuration navigation bar.
The Migration Status pane opens to display the columns described in the following table.
Note

If the migration process is not possible (for example from Cisco CRS 5.0 to a non-existent release), then a corresponding message is displayed and the columns remain empty.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Version</td>
<td>The version from which you migrated.</td>
</tr>
<tr>
<td>Target Version</td>
<td>The version to which you migrated.</td>
</tr>
<tr>
<td>Percentage Migrated</td>
<td>The status of the migration at the point when you viewed this page.</td>
</tr>
<tr>
<td>Migration Status</td>
<td>Information on whether the migration completed.</td>
</tr>
<tr>
<td>Date Completed</td>
<td>The date when the migration was performed.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected migration status entry. This option is enabled when the migration process is a 100% complete.</td>
</tr>
</tbody>
</table>

Database Details for Multichannel Reports

Note

The multichannel reports feature requires a Unified CCX Premium license along with a Multichannel license. After loading the Multichannel license in the Cisco CRS Administration application, you must restart the Unified EIM/Unified WIM services as the license is not detected automatically.

Multichannel reports are specific to Cisco Unified E-Mail Interaction Manager (Unified EIM) and Cisco Unified Web Interaction Manager (Unified WIM). These products use the MS SQL 2000 database (installed in a mixed mode authentication). To generate combined historical reports, Cisco CRS requires access details for the Unified EIM/Unified WIM database (host name or IP address of the server, database name, database user, and database password).

Unified EIM increases agent productivity through a powerful, visual workflow designer that helps create the e-mail handling process. Using the required service level agreement (SLA) triggers, you can automate email routing and monitoring.
This e-mail collaboration provides full HTML support for both inbound and outbound communications, the ability to attach larger files from the agent desktop is supported, and powerful content-parsing capabilities in the product enable auto-suggestions from the knowledge base.

Unified WIM ensures that your online customers are connected easily and seamlessly to the right agent every time. It also provides powerful file-sharing capabilities which allows agents to easily share files residing on their desktop. Advanced co-browsing capabilities allow agents and the customers to fill out forms together, field by field, even highlighting specific areas of a form or Web page for additional clarity.

### Multichannel License Requirements

Effective Cisco CRS Release 5.0, multichannel reports are available in the Unified CM version of the Unified CCX product. This addition requires the Multichannel license along with the Unified Premium license.

See Uploading Licenses, page 1-15 for detailed information.

### Configuring the Database Access Details

<table>
<thead>
<tr>
<th>Tip</th>
<th>Be sure to update the database access details if the corresponding configuration on the Unified EIM/Unified WIM database server was changed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The multichannel database configuration is backed-up and restored with each upgrade.</td>
</tr>
<tr>
<td></td>
<td>To configure the database access details for a Unified EIM or a Unified WIM database, complete the following steps.</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** From the CRS Administration menu bar, choose **Tools > Historical Reporting**. The Historical Reporting Configuration web page opens, displaying the Database Server Configuration area.
Chapter 13      Managing Cisco CRS Historical Reporting

Truncating db_cra Database Transaction Log Files

Step 2  Click the Unified WIM/Unified EIM Database Configuration hyperlink located in the left pane.

The Unified WIM/Unified EIM Database Configuration web page opens. The following fields are displayed in the configuration area.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>The IP address or host name of the Unified EIM or Unified WIM database server.</td>
</tr>
<tr>
<td>Database Name</td>
<td>The database name of the Unified EIM or Unified WIM server.</td>
</tr>
<tr>
<td>Database User</td>
<td>The user name of the Unified EIM or Unified WIM database server.</td>
</tr>
<tr>
<td>Database Password</td>
<td>The encrypted form of the Unified EIM or Unified WIM user password.</td>
</tr>
</tbody>
</table>

Caution  If the database for the Unified EIM/Unified WIM product is not functioning as designed, the corresponding multichannel reports may display an SQL error condition. In this case, be sure to verify that the Unified EIM/Unified WIM database is in service and that the Cisco CRS network connection to the database is active.

Step 3  Click Update.

The information is updated in the CRS database using the configuration objects.

Truncating db_cra Database Transaction Log Files

The db_cra_log.ldf database transaction log file can become very large. This log file is stored in the <CRSSQLServerInstallationDirectory>Data directory (for example, c:\Program Files\Microsoft SQL Server\MSSQL$CRSSQL\Data) on any CRS Server with an Historical Datastore component.

The Cisco CRS runTruncateHistDBLogs command line tool can truncate this file to a size that you specify. You can run this command from a Microsoft Windows command window.
The runTruncateHistDBLogs command can spend up to 5 minutes per database log file performing the truncation. If you are substantially truncating a log file, this time limit may not allow the command to truncate the log file to the size that you specified. In this case, rerun the runTruncateHistDBLogs command to truncate the log files to the desired size.

To ensure that the truncated log files are updated with current information, perform a complete backup of the CRS databases and log files after executing the runTruncateHistDBLogs command.

The syntax for the runTruncateHistDBLogs command is:

```
runTruncateHistDBLogs {"db_cra" | "tempdb"} size
```

The table that follows lists the options and parameters for the runTruncateHistDBLogs command.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;db_cra&quot;</td>
<td>Truncates the db_cra_log.ldf database transaction log file.</td>
</tr>
<tr>
<td>&quot;tempdb&quot;</td>
<td>Truncates the tempdb.ldf database transaction log file.</td>
</tr>
<tr>
<td>size</td>
<td>Size in MB to which the file or files will be truncated.</td>
</tr>
</tbody>
</table>

**Note** For the ldb_cra_log.ldf file, specify a size value no less than one-fourth the size of the ldb_cra.mdf database.

For example, the following command truncates the db_cra_log.ldf database transaction log file to 250 MB:

```
runTruncateHistDBLogs "db_cra" 250
```
Importing Historical Data from Data Files

If the database on the CRS server is down, historical records are cached to be written to the database. If the number of records exceeds the cache maximum, the additional records are written to files stored in the wfaavid\SQL\data directory. These data files are also generated if the historical record queue is exceeded when the database on the Expansion server and CRS server are down.

You can import the data from these files into the historical database by running the osql command for all data files in the wfaavid\SQL\data directory.

The syntax for the osql command is:

```
osql -E -S <server>/CRSSQL -i <datafilename>
```

The table that follows lists the options and parameters for the osql command on the CRS server.

<table>
<thead>
<tr>
<th>Option or Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-E</td>
<td>-E – Use entrusted source</td>
</tr>
<tr>
<td>-S server/CRSSQL</td>
<td>-S – Server server/CRSSQL – Name of your server, appended by ID for CRS SQL</td>
</tr>
<tr>
<td>i datafilename</td>
<td>-i – (Small “i”) Input file, with name of the file to be imported to database.</td>
</tr>
</tbody>
</table>

**Note** CRS supports a limited set of databases via ODBC and does not allow connection to a flat file using an ODBC connection.

Example:

If the server name is **CRSDBServer_1** and the file name is **SampleFile.data**, the command is:

```
osql -E -S CRSDBServer_1/CRSSQL -i SampleFile.data
```
Effective Cisco CRS Release 5.0, the Cisco Unified CCX Outbound Preview Dialer (Outbound) feature is available in the Unified CM version of the Unified CCX product. The Outbound feature requires the Outbound license along with the Unified CCX Premium license. With this feature, you can maintain high agent productivity by configuring contact centers for automated Outbound activities and allow agents who are not busy with inbound calls to perform Outbound calls.

Note

The Outbound feature is *not available* in the following products:
- Unified CCX Standard version
- Unified CME version of Unified CCX
- Unified IP IVR
- Unified QM

The following sections describe how to configure the Outbound feature.

- **About the Outbound Feature for Unified CCX**, page 14-2
- **The Outbound Feature License**, page 14-7
- **How Is a Contact’s Local Time Determined?**, page 14-7
- **The Outbound Configuration Checklist**, page 14-9
- **Verifying the RmCm and Outbound Subsystems**, page 14-10
- **Configuring General Outbound Properties**, page 14-11
- **Adding a New Campaign**, page 14-23
About the Outbound Feature for Unified CCX

The Outbound feature provides Outbound dialing functionality in addition to existing Unified CCX inbound capabilities. This feature allows agents who are not busy with inbound calls to handle Outbound calls.

With the Outbound feature, customer calls are placed using the Cisco Unified Communications by way of the Unified CM for call control.

This section contains the following topics:

- Outbound Characteristics, page 14-2
- Unified CCX Requirements, page 14-3
- Outbound Components, page 14-5
- Direct Preview Dialing Mode, page 14-6

Outbound Characteristics

The Outbound feature includes the following characteristics:

- A Outbound subsystem that can be monitored from the control center.
- Direct preview dialing mode
- Inbound/Outbound blending
- CRS Administration web pages to configure the Outbound feature.
- Outbound historical report templates (see the Cisco CRS Historical Reports User Guide).
Chapter 14.Configuring Cisco Unified CCX Outbound Preview Dialer

About the Outbound Feature for Unified CCX

Note

Calls made by the Outbound subsystem will not be displayed in the Contact Summary Real Time Report.

- Real-time reports are part of the CRS Administration GUI real-time reporting applet (see Chapter 16, “Reporting on Real-Time CRS Data”).
- Access to real-time Outbound data from the GetReportingStatistics step.
- Cisco Agent Desktop (CAD) allows agents to handle Outbound calls (see the Cisco Desktop Administrator's User Guide).
- Sequential dialing

Related Topics:

- About the Outbound Feature for Unified CCX, page 14-2
- Unified CCX Requirements, page 14-3
- Outbound Components, page 14-5
- Direct Preview Dialing Mode, page 14-6

Unified CCX Requirements

To use the Outbound feature, you must adhere to the following requirements:

- License requirements:
  - The Unified CCX Enhanced or Premium license package (see Cisco CRS Licensing Packages, page A-1).
  - The Outbound feature license must be uploaded (see Verifying the RmCm and Outbound Subsystems, page 14-10)

- Unified CCX subsystem requirements:
  - The Outbound subsystem must be IN SERVICE (see Verifying the RmCm and Outbound Subsystems, page 14-10).
  - The RmCm subsystem must be IN SERVICE (see Configuring the RmCm Provider, page 7-2).
  - The Unified CM Telephony subsystem must be IN SERVICE (see Provisioning the Unified CM Telephony Subsystem, page 6-5).
The Configuration Datastore Server (CDS) must be IN SERVICE (About the CRS Datastore, page 12-2).

**Caution**  
The Failover/warm feature is not supported for the Outbound subsystem. This feature requires that the Configuration datastore be running on both nodes in a cluster. The Outbound configuration data and the dialing list are synchronized between both nodes in a two-node cluster. In this situation, if one of the nodes stops functioning, the outbound campaigns stop until the failed node is restored or removed from the cluster. When the failed node is restored or removed and the Microsoft Distributed Transaction Coordinator, Microsoft SQL Server, and CRS Datastore services are running on both nodes, the Outbound subsystem becomes in service again and campaigns that can be run at that time start automatically.

- Microsoft Distributed Transaction Coordinator
- Microsoft SQL Server

- **Cisco Security Agent (CSA) usage**: If you plan to use CSA, which Cisco highly recommends, you must always use the default directories when installing any software on a server. You need not choose the default disk drive if an option is available (for example, C: or D:), but you must use default directories (see the *Installing Cisco Security Agent for Cisco CRS 5.0(x)* guide).

- **Geographic region support**:
  - The Outbound feature can be used in any geographic region supported by Unified CCX. The area codes and time zones mapping for North America are automatically pre-populated in the system. The system uses this information to determine the time zone of a customer’s phone number. See Adding Area Codes, page 14-29.
  - For regions outside North America, administrators must enter the mapping of the international area codes and their time zones using the CRS Administration GUI. See How Is a Contact’s Local Time Determined?, page 14-7.
  - The national do_not_call list is not supported in this release. Be sure to abide by the national do_not_call list. See Removing Contacts from the Do Not Call List, page 14-45.
Note: In this guide, the underscore character linking each word differentiates the national do_not_call list from the Outbound subsystem’s Do Not Call list.

Related Topics:
- About the Outbound Feature for Unified CCX, page 14-2
- Outbound Characteristics, page 14-2
- Outbound Components, page 14-5
- Direct Preview Dialing Mode, page 14-6

Outbound Components

This section provides details about the following Outbound feature components:
- CRS Administration: Enables the Outbound subsystem configuration, creates campaigns, and imports contacts to generate the dialing list.
- Outbound subsystem: Is responsible for the following tasks:
  - Manages campaigns
  - Maintains Outbound system configurations
  - Manages the dialing list
  - Reserves agents
  - Makes Outbound calls
  - Updates the call data in the dialing list based on the outcome of the call.
  - Decides which contact records to retrieve from a campaign

The Outbound subsystem views campaigns as logical entities that group a set of contacts together in a dialing list. Campaigns deliver outgoing calls to agents. Agents are assigned to campaigns using CSQs.

The Outbound subsystem Area code and long distance prefix configuration changes made to the Outbound subsystem do not take effect for calls/contacts currently in the Outbound subsystem’s memory. For example, if you change the long distance prefix or local area code, the contacts already in the Outbound subsystem’s memory will continue to use the old long distance prefix and local area code.
Direct Preview Dialing Mode

The Outbound feature supports the direct preview mode in the Unified CCX Release 5.0(1).

The direct preview dialing mode allows agents to preview a customer call on CAD before the call is placed. The advantage of this mode is that an agent is already on the call when the customer answers and can quickly begin talking with the customer immediately.

The Outbound subsystem presents the agent with a popup window displaying the customer information prior to placing the Outbound call. The agent has the choice of accepting the call or ignoring it. The Outbound subsystem dials the customer only if the agent accepts the call.

If the agent accepts the call in this mode, the Outbound call is initiated from the agent’s phone. Since the call is initiated from the agent’s phone, the agent can hear the customer’s phone ring and also hear other tones, such as a busy signal.

Tip

You must explicitly disable the Call Waiting option on the agent’s phone to successfully use this feature. The Call Waiting option must be disabled (default) in Unified CM on each Outbound agent phone to ensure that every customer call successfully transfers to an available agent.

Related Topics:
- About the Outbound Feature for Unified CCX, page 14-2
- Outbound Characteristics, page 14-2
- Unified CCX Requirements, page 14-3
- Outbound Components, page 14-5
The Outbound Feature License

See Uploading Licenses, page 1-15 for detailed information.

---

**Note**

When an Outbound call is transferred or conferenced to another agent, the second/subsequent agents are not counted towards the number of Outbound licenses. For example, if you have five seats licensed for Outbound and Agent1 gets an Outbound call, Agent1 accepts the call and conferences in Agent2 and Agent3. Now, three agents are on one Outbound call but only Agent1 is considered an Outbound agent and you are only using one licensed seat. Consequently, your system allows four more Outbound calls to agents.

---

**Caution**

When Agent A transfers an Outbound call to Agent B, all Outbound option buttons are enabled on Agent B’s desktop. Despite all buttons being enabled, Agent B must only select the Do Not Call or the callback buttons at this time. Likewise, after transferring the call to Agent B, Agent A should not attempt to set or change a callback time for that call.

---

**Related Topics**

- About the Outbound Feature for Unified CCX, page 14-2
- How Is a Contact’s Local Time Determined?, page 14-7
- The Outbound Configuration Checklist, page 14-9

---

How Is a Contact’s Local Time Determined?

The Outbound subsystem use the area code of a contact’s phone number to determine the time zone of the contact’s calling area. The system provides the mapping for North American area codes to their corresponding time zones. The Area Codes web page allows you to add, modify, and delete any area code to time zone mapping (see Adding Area Codes, page 14-29).
How Is a Contact’s Local Time Determined?

Changes to area codes take affect the next time you import contacts (see Importing Contacts for a Campaign, page 14-25). For example, if the time zone of area code 603 is changed from 16 to 17, contacts already present in the system that have an area code of 603 continue to have the GMT Offset of 16. Any contacts with area code 603 that are imported after the area code change have 17 for the GMT Offset.

When Outbound contacts are imported into the database, all contacts are assigned a GMT time zone for the three phone numbers provided. The Outbound subsystem determines this GMT time zone by extracting the area code of each phone number and checking it against the Area Codes table to obtain the corresponding time zone. If the area code cannot be matched, the Outbound subsystem uses the local time zone and Daylight Savings Time (DST) setting of the server. The Outbound subsystem also considers the DST to determine if an Outbound contact can be called at a given time.

The Outbound subsystem ensures that the contacts are dialed at valid times. For Outbound contacts which have been scheduled for callback, the scheduled callback time is converted to the server’s time zone and stored in the callbackDateTime field in the database.

For pending records, the Outbound subsystem ensures that Outbound contacts are called only within the Customer Dialing Time Range (hh:mm) detected by the MinCustomerDialTime and MaxCustomerDialTime, as per federal regulations. You can configure this time in the CRS Administration GUI (see Configuring General Outbound Properties, page 14-11).

Related Topics
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Adding Area Codes, page 14-29
## The Outbound Configuration Checklist

To configure the Outbound subsystem, complete the following tasks after:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>For instructions, see</th>
</tr>
</thead>
</table>
| Step 1 | Configure RmCM. Create CSQs. Assign resources to CSQ. | • Configuring the RmCm Provider, page 7-2  
• Creating a CSQ, page 7-18.  
• Resource Skill Selection Criteria Within a CSQ, page 7-27 |
| Step 2 | Upload the Outbound option license. | • Verifying the RmCm and Outbound Subsystems, page 14-10  
• Viewing License Information, page 1-14 |
| Step 3 | Verify that the RmCm and Outbound subsystems are IN SERVICE. Configure the general properties of the Outbound subsystem. | Verifying the RmCm and Outbound Subsystems, page 14-10  
Configuring General Outbound Properties, page 14-11 |
|      | a | Configure customer dialing time range as determined by the regulations of the required region | How Is a Contact’s Local Time Determined?, page 14-7 |
|      | b | Configure the dialing prefixes for your geographic area. | How the Outbound Option Works with Area Codes, page 14-20 |
| Step 4 | c | Assign the CSQs and the percentage of each CSQ to be used for Outbound. | Allocating CSQ Agent Pool Percentages, page 14-22  
Handling Configuration Updates, page 14-21  
To configure CSQs, see Configuring Contact Service Queues, page 7-17 |
| Step 5 | Create campaigns. | Adding a New Campaign, page 14-23 |
| Step 6 | Import contacts for each campaign. | Importing Contacts for a Campaign, page 14-25 |
| Step 7 | Enable campaigns. | Enabling Campaigns, page 14-27 |
Verifying the RmCm and Outbound Subsystems

The Outbound subsystem’s initial state is OUT OF SERVICE. Next, it goes to INITIALIZING state, at which point it checks the conditions listed below. If all the conditions are met, the state changes to IN SERVICE.

For the Outbound subsystem to be IN SERVICE, the following conditions apply:

- The RmCm subsystem on the same box must also be in service. The RmCm subsystem is considered to be active when you have provisioned the RmCm Provider and associated agent extensions with the RmCm Provider (see Configuring the RmCm Provider, page 7-2).

- The following services (on all boxes) should be up and running:
  - Microsoft Distributed Transaction Coordinator
  - Microsoft SQL Server
  - The CRS Datastore

### Related Topics

- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7

### Step-by-Step Instructions

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>For instructions, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 8</td>
<td>If the dialing list contains contacts outside of North America or if Unified CCX is installed outside of North America, manually add the area codes and their corresponding time zones of the regions.</td>
<td>Adding Area Codes, page 14-29</td>
</tr>
<tr>
<td>Step 9</td>
<td>Enable direct preview in CDA.</td>
<td>See the Cisco Desktop Administrator User's Guide.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Setup communication with the agent’s desktop.</td>
<td>Setting-up Communications with the Agent’s Desktop, page 14-31</td>
</tr>
<tr>
<td>Step 11</td>
<td>Agents log in and get ready to receive Outbound calls (agents must belong to CSQs assigned to Outbound).</td>
<td>Agents Receive Outbound Calls, page 14-31</td>
</tr>
</tbody>
</table>
For example, if you have a dual node (Node A and B) setup, you have two of the above database services on Node A and two on Node B. All four nodes need to be up and running for the Outbound subsystem to be IN SERVICE. On the standby service, if all four nodes are up and running and RmCM is in service, then the Outbound subsystem is IN SERVICE.

**Tip**

During a fail over, it might take a couple of minutes before the Outbound subsystem displays the correct state (IN SERVICE) as the verification cycle needs to complete.

**Related Topics**

- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- The Outbound Configuration Checklist, page 14-9

### Configuring General Outbound Properties

General Outbound properties refer to the settings information that is common for all the campaigns.

**Caution**

Area code and long distance prefix configuration changes made to the Outbound subsystem do not take effect for calls/contacts currently in the Outbound subsystem’s memory. For example, if you change the long distance prefix or local area code, the contacts already in the Outbound subsystem’s memory will continue to use the old long distance prefix and local area code.

To configure general Outbound properties, complete the following steps.

**Procedure**

**Step 1**

From the CRS Administration menu bar, choose **Subsystems > Outbound** and click the **General** hyperlink in the left pane.

The Outbound Configuration web page opens to display the General pane (default view).
### Step 2

Use this web page to specify the following fields in the General Configuration section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Dialing Time Range (hh:mm)</td>
<td>The time range during which a customer can be called. This time range supersedes the time range of individual campaigns and ensures that a customer is never called outside the legally allowed time range for that country. For example, in the USA, the Federal Communications Commission (FCC) specifies the legal time range as 8 AM – 9 PM. This does not apply to callbacks since the customer explicitly requested to be called at a certain time. This time range is always converted to the local time for each contact record. Default = 8:00 AM - 9:00 PM (USA FCC regulations)</td>
</tr>
<tr>
<td>Preview Call Timeout</td>
<td>If an agent does not respond to the Outbound preview call on the Cisco Agent Desktop (CAD) within the timeout duration specified in this field, the system sets the agent to the Not Ready state, similar to the behavior for Ring No Answer (RNA) for inbound calls. Default= 60 seconds, Range = 5 to 3600 seconds.</td>
</tr>
<tr>
<td>Dialing Prefix</td>
<td>The number to pre-pend to the phone number for dialing outgoing calls (also referred to as switch prefix). This number can have any numeric value, including 0 or leading zeros.</td>
</tr>
<tr>
<td>Long Distance Prefix</td>
<td>The number to pre-pend to the phone number for dialing long distance. This number can have any numeric value, including 0 or leading zeros.</td>
</tr>
<tr>
<td>Include Long Distance Prefix</td>
<td>If the Include Long Distance Prefix checkbox is checked, this number is included when dialing.</td>
</tr>
<tr>
<td>International Prefix</td>
<td>The number to pre-pend to international phone numbers. This number can have any numeric value, including 0 or leading zeros.</td>
</tr>
<tr>
<td>Local Area Code</td>
<td>The area code of the Unified CCX server location. This number can have any numeric value, including 0 or leading zeros.</td>
</tr>
<tr>
<td>Do Not Remove Local Area Code When Dialing</td>
<td>If this box is checked, the local area code is included when dialing the phone numbers within this area code. If it is unchecked, then the local area code is stripped from the phone number before dialing the local numbers. It is expected that when contacts are imported into the system, the phone numbers include the area code. For international phone numbers, the country code must be included when importing contacts.</td>
</tr>
</tbody>
</table>
Step 3  Click **Update**.

The System Options components are now updated.

**Related Topics**

- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Customer Dialing Lists, page 14-14
- Handling Callbacks, page 14-19
- How the Outbound Option Works with Area Codes, page 14-20
- Handling Configuration Updates, page 14-21
- Allocating CSQ Agent Pool Percentages, page 14-22
Customer Dialing Lists

Contact centers purchase or maintain customer dialing lists in files, which can be imported using the Cisco CRS Administration GUI. When the file is imported, the Outbound subsystem generates a dialing list that is then used to dial customers.

A dialing list can be in comma-delimited format, with a maximum of 10240 characters per row.

The following table lists all columns in the dialing list table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>recordID</td>
<td>int</td>
<td>Yes</td>
<td>A unique identifier for the record.</td>
</tr>
<tr>
<td>dialingListID</td>
<td>int</td>
<td>Yes</td>
<td>Unique identifier for a contact.</td>
</tr>
<tr>
<td>profileID</td>
<td>int</td>
<td>Yes</td>
<td>Identifier for the Cisco CRS profile that is associated with this record.</td>
</tr>
<tr>
<td>campaignID</td>
<td>int</td>
<td>Yes</td>
<td>A unique identifier for the campaign.</td>
</tr>
<tr>
<td>createDateTime</td>
<td>datetime</td>
<td>Yes</td>
<td>The time when the record is created or updated</td>
</tr>
<tr>
<td>accountNumber</td>
<td>nvarchar(25)</td>
<td>NO</td>
<td>Account number of contact. From imported file. This field is sent to the agent desktop.</td>
</tr>
<tr>
<td>firstName</td>
<td>nvarchar(50)</td>
<td>NO</td>
<td>First Name of contact. From imported file.</td>
</tr>
<tr>
<td>lastName</td>
<td>nvarchar(50)</td>
<td>NO</td>
<td>Last Name of contact. From imported file.</td>
</tr>
<tr>
<td>phone01</td>
<td>varchar(28)</td>
<td>Yes</td>
<td>Primary Phone Number of contact. From imported file.</td>
</tr>
<tr>
<td>phone02</td>
<td>varchar(28)</td>
<td>NO</td>
<td>Additional Number of contact. From imported file. This number is dialed when agent selects Skip--Next for the preview call.</td>
</tr>
<tr>
<td>phone03</td>
<td>varchar(28)</td>
<td>NO</td>
<td>Additional Number of contact. From imported file. This number is dialed if the attempts to dial first two numbers was unsuccessful.</td>
</tr>
<tr>
<td>gmtZonePhone01</td>
<td>smallint</td>
<td>Yes</td>
<td>The time zone for this phone number of this contact. GMT time zones are on a 0-23 scale which begins with 0 at Greenwich, England and increases to the East. For the United States, New York is GMT 19, San Francisco is at GMT 16.</td>
</tr>
</tbody>
</table>
### Configuring General Outbound Properties

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dstPhone01</td>
<td>bit</td>
<td>Yes</td>
<td>1 - DST is observed at this phone. 0 - DST is not observed at this phone.</td>
</tr>
<tr>
<td>gmtZonePhone02</td>
<td>smallint</td>
<td>Yes</td>
<td>The time zone for this phone number of the contact. GMT time zones are on a 0-23 scale which begins with 0 at Greenwich, England and increases to the East. For the United States, New York is GMT 19, San Francisco is at GMT 16.</td>
</tr>
<tr>
<td>dstPhone02</td>
<td>bit</td>
<td>Yes</td>
<td>1 - DST is observed at this phone. 0 - DST is not observed at this phone.</td>
</tr>
<tr>
<td>gmtZonePhone03</td>
<td>smallint</td>
<td>Yes</td>
<td>The time zone for this phone number of the contact. GMT time zones are on a 0-23 scale which begins with 0 at Greenwich, England and increases to the East. For the United States, New York is GMT 19, San Francisco is at GMT 16.</td>
</tr>
<tr>
<td>dstPhone03</td>
<td>bit</td>
<td>Yes</td>
<td>1 - DST is observed at this phone. 0 - DST is not observed at this phone.</td>
</tr>
<tr>
<td>callbackNumber</td>
<td>varchar(28)</td>
<td>NO</td>
<td>Phone number to be used for callback - can be supplied by the agent.</td>
</tr>
<tr>
<td>callbackDateTime</td>
<td>datetime</td>
<td>NO</td>
<td>This column is used, after a call attempt has been made, to store the time in which this contact is called back. For customer requested callbacks, this time is the requested callback time. For retries due to no answers or busy attempts, this is the time when the system retries this contact. Stored in UTC time.</td>
</tr>
</tbody>
</table>
Configuring General Outbound Properties

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>callStatus</td>
<td>smallint</td>
<td>Yes</td>
<td>The status of the contact record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 = Pending: The call is pending.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 = Active: The record is sent (active) to the Outbound subsystem for dialing</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 = Closed: The record is closed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4 = Callback: The record is marked for a callback.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5 = Max Calls: Maximum attempts have been reached for this record (considered closed).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6 = Retry: This record is retried since the previous attempt resulted in busy, ans m/c etc. Retry time is set in CallbackDateTime.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7 = Unknown. If the Outbound subsystem was restarted with records in the Active (2) state, they are moved to this state.</td>
</tr>
</tbody>
</table>

**Note** When contacts are imported, they will have a default value of 1 in the call status column and 0 in the call result column in the Dialing List table. A call status of 3 and a call result is 0 this means that the contact was closed without being dialed. This happens if the phone01 column is empty for the contact.

**Tip** If you import contacts with the same phone01 field as an existing contact, then the existing contact is overwritten by the imported contact in the following fields: accountNumber, firstName, lastName, phone02, phone03 fields. However, other fields like call result, call status are not overwritten. Besides, a new contact will NOT be added to the Dialing List table.
### Chapter 14  Configuring Cisco Unified CCX Outbound Preview Dialer

#### Configuring General Outbound Properties

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>callResult</td>
<td>smallint</td>
<td>NO</td>
<td>The call result from the last call placed for this record</td>
</tr>
<tr>
<td>callResult01</td>
<td>smallint</td>
<td>NO</td>
<td>The call result from the last time phone01 was called.</td>
</tr>
<tr>
<td>callResult02</td>
<td>smallint</td>
<td>NO</td>
<td>The call result from the last time phone02 was called.</td>
</tr>
<tr>
<td>callResult03</td>
<td>smallint</td>
<td>NO</td>
<td>The call result from the last time phone03 was called.</td>
</tr>
<tr>
<td>lastNumberDialed</td>
<td>smallint</td>
<td>NO</td>
<td>The last number dialed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Values same as callResult</td>
</tr>
</tbody>
</table>

**Values for callResult**

1 = (Voice) Customer answered and was connected to agent  
2 = Fax machine detected.  
3 = Answering machine detected  
4 = Number reported as invalid by the network  
5 = Customer does not want to be called again.  
6 = Number successfully contacted but wrong number  
7 = Number successfully contacted but reached the wrong person  
8 = Customer requested regular callback  
9 = Agent has skipped or rejected a preview call  
10 = Agent has skipped or rejected a preview call with the close option  
11 = Busy signal detected  
12 = Timeout (the agent did not respond in the allotted time to the previous call)
## Configuring General Outbound Properties

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>callsMadeToPhone01</td>
<td>smallint</td>
<td>NO</td>
<td>The number of call attempts made to phone01. If there was an error in trying to call this number, the attempt is not counted here.</td>
</tr>
<tr>
<td>callsMadeToPhone02</td>
<td>smallint</td>
<td>NO</td>
<td>The number of call attempts made to phone02. If there was an error in trying to call this number, the attempt is not counted here.</td>
</tr>
<tr>
<td>callsMadeToPhone03</td>
<td>smallint</td>
<td>NO</td>
<td>The number of call attempts made to phone03. If there was an error in trying to call this number, the attempt is not counted here.</td>
</tr>
<tr>
<td>privateData</td>
<td>image(16)</td>
<td>NO</td>
<td>Any fields which is used internally only can be stored in this column in a blob.</td>
</tr>
<tr>
<td>active</td>
<td>bit</td>
<td>YES</td>
<td>Whether the record is active in the system. A record becomes inactive if the campaign is deleted from the system.</td>
</tr>
<tr>
<td>dateInactive</td>
<td>datetime</td>
<td>NO</td>
<td>Date this record was deleted.</td>
</tr>
</tbody>
</table>

### Related Topics
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Handling Callbacks, page 14-19
- How the Outbound Option Works with Area Codes, page 14-20
- Handling Configuration Updates, page 14-21
- Allocating CSQ Agent Pool Percentages, page 14-22
Handling Callbacks

A customer can request a callback at a specific callback phone number and also specify the time/date of the callback. The Outbound subsystem stores this information (the callback phone number, date, time) in the dialing list table.

The Outbound subsystem handles the callback as follows:

- **Different Time Zones:** If the server’s time zone differs from the contact’s time zone, then the customer’s time zone is converted to the server’s time zone and stored in the database.

- **Agent not Available:** When the Outbound subsystem looks up the database for contacts, it first checks the callbacks. The default callback time limit is 15 minutes (can be changed) before and after the customer-specified time. If an agent is available, then the Outbound subsystem places the callback. If an agent is not available, the Outbound subsystem retries agent availability (agent state) after 10 minutes.

- **Missed Callbacks:** If a callback is missed, you have three actions options:
  - Reschedule it to the same time on the next business day
  - Mark it as another retry (the callback phone number is removed and the callback date time is ignored). In this case, it moves out of the call back state and into the retry state.
  - Close the record (never dialed again).

  The selected status is changed at midnight for calls not retrieved (see *Resetting Contact States at Midnight*, page 14-37).

- **Agent reclassifications:** If calls were retrieved and presented to the agent and if the agent reclassified it (for example, changed it to answering machine status), then the call status is updated to answering machine (see *Reclassification Status Behavior*, page 14-40).

- **Invalid number:** If the number is invalid, the callback continues to be retried until the callback time limit expires or the agent reaches the customer.

> **Caution**

If a callback is presented and the callback number is invalid (or busy), the callback continues to be retried irrespective of the number of retries set (for normal busy/invalid). It will be retried until the callback time limit expires.
How the Outbound Option Works with Area Codes

In the Outbound option, the area code determines the geographical location of the phone number you dial, which correspondingly provides the Greenwich Meridian Time (GMT) zone. The db_cra database contains a mapping of the area codes to the time zones.

The U.S. area code mappings are provided along with the product. International customers should provide their own data and add it to the database (see Adding Area Codes, page 14-29).

Related Topics
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Customer Dialing Lists, page 14-14
- How the Outbound Option Works with Area Codes, page 14-20
- Handling Configuration Updates, page 14-21
- Allocating CSQ Agent Pool Percentages, page 14-22
Handling Configuration Updates

Whenever Outbound parameters are modified in the CRS Administration GUI, the changes take effect immediately. If a new CSQ is added using the RmCm -> Contact Service Queue menu option, it is instantly displayed in the list of available CSQs in the General configuration page in the CRS Administration GUI as this list is dynamically updated. If a CSQ is modified and if this impacts the allocation of agents, the Outbound subsystem is aware of this change as it refreshes the list of agents in each relevant CSQ periodically.

- If a configuration change affects the Outbound contacts dialing process (for example, if a campaign is disabled or a CSQ is removed from a campaign), the Outbound subsystem stops processing the Outbound contacts, recalls these contacts to the database, and resets the call status to Pending.

- If a campaign start time is changed, the Outbound subsystem checks if the campaign is enabled. If it is enabled, and if the new start time is after the current time, it performs the following actions:
  - Sends a recallContactsMsg to the Outbound subsystem passing the campaign ID.
  - For all Outbound contacts for this campaign in the Outbound subsystem’s memory, it resets all Outbound contacts to the pending state and clears them from memory.

If the campaign is disabled or if the new start time is before the current time, the Outbound subsystem ignores this change.

- If campaign end time is changed, the Outbound subsystem checks if the campaign is enabled. If it is enabled, and if the new end time is before the current time, it performs the following actions:
  - Sends a recallContactsMsg to the Outbound subsystem passing the campaignID.
  - For all the Outbound contacts for this campaign in Outbound subsystem’s memory, it resets all the Outbound contacts to the Pending state and clears them from memory.

If the campaign is disabled or if the new end time is after the current time, the Outbound subsystem ignores this change.
If a CSQ is deleted from a campaign or if the CSQ itself is deleted, the Outbound subsystem sends a recallContactsMsg with the csqID of the deleted CSQ. It also reallocates any Outbound contacts in its memory that are currently allocated to this CSQ among the other existing CSQs for this campaign.

Related Topics
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Customer Dialing Lists, page 14-14
- Handling Callbacks, page 14-19
- How the Outbound Option Works with Area Codes, page 14-20
- Allocating CSQ Agent Pool Percentages, page 14-22

Allocating CSQ Agent Pool Percentages

You need to specify a percentage of total agents in the assigned CSQs to be allocated for Outbound calls. This pool of agents is shared by all Outbound campaigns.

Tip
The CSQs for Outbound are the same as those CSQs for inbound. If you need more CSQs, you must first configure them in Unified CCX and assign the required CSQs for agents as required by your configuration before allocating them as specified in this procedure.

Related Topics
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- How Is a Contact’s Local Time Determined?, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Configuring General Outbound Properties, page 14-11
Adding a New Campaign

Use the Campaign component to configure the properties for the campaign, including the campaign name and description, CSQ selection, and the time range when a campaign can call contacts.

To configure the system options component, complete the following steps.

Procedure

**Step 1**
From the CRS Administration menu bar, choose **Subsystems > Outbound** and click the **Campaigns** hyperlink.

The Campaigns Configuration web page opens.

**Step 2**
Click the **Campaigns** link in the left pane.

The Campaign web page opens and displays all the campaigns that have been configured.

**Step 3**
Click the **Add New Campaign** hyperlink located in the right side of this page.

The Area Codes Management web page opens and displays all the campaigns that have been configured.

**Step 4**
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign Name</td>
<td>Name of the campaign (must be a unique identifier).</td>
</tr>
<tr>
<td>Enabled</td>
<td>Indicates to the Outbound subsystem whether this campaign is currently active. Default = No.</td>
</tr>
</tbody>
</table>
### Adding a New Campaign

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>Description of the campaign.</td>
</tr>
<tr>
<td><strong>Start Time/End Time</strong></td>
<td>Indicate the time range during which the campaign runs.</td>
</tr>
<tr>
<td>(hh:mm) AM PM</td>
<td>Default = 8:00 AM - 9:00 PM (USA FCC regulations)</td>
</tr>
<tr>
<td><strong>Maximum Attempts to</strong></td>
<td>The maximum number of times the Outbound subsystem attempts to dial a contact.</td>
</tr>
<tr>
<td><strong>Dial Contact</strong></td>
<td>Default = 1, Range = 1 to 3</td>
</tr>
<tr>
<td><strong>Contact Records Cache</strong></td>
<td>The number of contact records the Outbound subsystem retrieves from the database in bulk for dialing. The allowed values are 1-100. For example, if 50 records are retrieved in bulk for campaign 1 and 10 for campaign 2 and they are running at the same time, the Outbound subsystem attempts to place 50 Outbound calls for campaign 1 and 10 Outbound calls for campaign 2. The number of Outbound calls actually placed for each campaign depends upon the number of agents available for the respective campaigns. Once all the records retrieved for a campaign have been dialed, the Outbound subsystem fetches another batch of records for that campaign. Over a period of time, it is likely that more contacts would have been called from campaign 1 than from campaign 2. If two campaigns run simultaneously and share CSQs or agents, the records in both campaigns may not be processed at the same rate—even if their contact cache sizes are identical. It is possible that more records from one of these two campaigns is processed before the other. Default = 20, Range = 1 to 100</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Answering Machine</strong></td>
<td>If you select Yes, then the Outbound subsystem tries to call the phone number again at a later time if an answering machine was reached the first time. This parameter also applies to calls reclassified as FAX. Default = No</td>
</tr>
<tr>
<td><strong>Retry</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Callback Time Limit</strong></td>
<td>The duration past the scheduled callback time until which the Outbound subsystem attempts to place a callback. For example, if a callback was scheduled for 9:30 am and if for some reason, the callback could not be placed at that time (for example, agents not available), then the Outbound subsystem tries until 9:45 am to place the callback if the default time limit expires. Default = 15 minutes, Range = 1 to 60 minutes</td>
</tr>
<tr>
<td><strong>minutes</strong></td>
<td></td>
</tr>
</tbody>
</table>
**Chapter 14  Configuring Cisco Unified CCX Outbound Preview Dialer**

**Importing Contacts for a Campaign**

**Step 5**  
Click **Update**.  
The System Options components are now updated.

**Related Topics**
- About the Outbound Feature for Unified CCX, page 14-2  
- The Outbound Feature License, page 14-7  
- How Is a Contact’s Local Time Determined?, page 14-7  
- The Outbound Configuration Checklist, page 14-9  
- Configuring General Outbound Properties, page 14-11  
- Importing Contacts for a Campaign, page 14-25

**Importing Contacts for a Campaign**

**Note**  
You can only import a total of 10,000 contacts for a campaign at any given time. When some or all of these contacts are processed, you can import additional contacts to add up to a total of 10,000 at any given time.
When contacts are imported, the contacts text file is checked for duplicate entries. If the phone01 value of a contact matches the phone01, phone02, or phone03 values of another contact in the contacts list being imported, then the previous contact is overwritten with the new contact.

**Caution**
You must verify all the contacts against the national do_not_call list before importing them.

**Note**
In this guide, the underscore character linking each word differentiates the national do_not_call list from the Outbound subsystem's Do Not Call list.

**Tip**
Each time contacts are imported, they are appended to the existing list of contacts for the selected campaign. If the new list contains a contact with the same phone01 value as the phone01, phone02, or phone03 value as an existing contact, the existing contact is overwritten with the new contact information. The call history for the contact (if any) is retained.

To import contacts for a selected campaign, complete the following steps.

**Procedure**

**Step 1**
From the CRS Administration menu bar, choose **Subsystems > Outbound** and click the **Campaign** hyperlink.

The Campaign Configuration web page opens.

**Step 2**
Click the **Campaigns** link in the left pane.

The Campaign web page opens and displays all the campaigns that have been configured.

**Step 3**
Click the hyperlink for the required campaign under the Name column.

The Campaign Configuration web page opens for the selected web page.

**Step 4**
Click **Import Contacts**.

A popup window opens.

**Step 5**
Specify a file name to import the contacts from the fields being imported.
A contact list can contain up to 6 fields: AccountNumber, FirstName, LastName, Phone1, Phone2, and Phone 3.

**Step 6** Navigate to the directory that contains the imported fields in the *same order* as they appear in the text file.

---

**Related Topics**
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- How Is a Contact’s Local Time Determined?, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Configuring General Outbound Properties, page 14-11
- Adding a New Campaign, page 14-23
- Enabling Campaigns, page 14-27

---

**Enabling Campaigns**

You must verify that the configured campaigns are active that the start and end times for the enabled campaigns are specified as required.

To verify the state of the required campaign, complete the following steps.

**Procedure**

**Step 1** From the CRS Administration menu bar, choose **Subsystems > Outbound**.
The General Configuration web page opens.

**Step 2** Click the **Campaigns** link in the left pane.
The Campaign web page opens and displays all the campaigns that have been configured.
Enabling Campaigns

Field | Description
--- | ---
Name | Name of the campaign.
Start Time/End Time (hh:mm) AM PM | Start Time and End Time fields indicate the time range during which the campaign runs.
Remaining Contacts | The Remaining Contacts field indicates the number of contacts that are yet to be dialed for each campaign. In addition to the contacts that have not been dialed, this number also includes contacts that have requested a callback and contacts that will be tried again because of unsuccessful prior attempt(s) (for example, contact was busy or unavailable). A detailed breakdown of the pending contacts is provided in the Printable Reports page for each campaign.
Enabled | The Enabled field indicates to the Outbound subsystem whether this campaign is currently active.

**Step 3** Verify that the Enabled field is set to TRUE and that the start and end times are specified as required.

**Related Topics**
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- How Is a Contact’s Local Time Determined?, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Configuring General Outbound Properties, page 14-11
- Adding a New Campaign, page 14-23
- Adding Area Codes, page 14-29
Adding Area Codes

Caution

Area code and long distance prefix configuration changes made to the Outbound subsystem do not take effect for calls/contacts currently in the Outbound subsystem’s memory. For example, if you change the long distance prefix or local area code, the contacts already in the Outbound subsystem’s memory will continue to use the old long distance prefix and local area code.

The Outbound subsystem provides all of the mappings from North American area codes to their corresponding time zones at the time of product release. The Area Codes page allows the administrator to add, modify, and delete any area code to time zone mappings.

Some area codes extend across multiple time zones. For such area codes, only one time zone can be specified, and that time zone is used for all the phone numbers that start with that area code. For all North American area codes that are pre-configured in the system, you can use the default time zone that the system selects for that area code or specify a different time zone for that area code in the Area Code configuration page.

If an area code is in a time zone that observes daylight savings time but the area code does not observe daylight savings time, the system does not take daylight savings time into consideration when computing the local time of contacts that have a phone number starting with this area code. The North American area codes that do not observe daylight savings time are already pre-configured in the system. For other area codes, whether the area code observes daylight savings time must be specified when adding a new area code in the Area Code configuration page.

The Area Codes Management page allows users to find, add, delete, and modify the mapping of area codes and time zones. The Outbound subsystem uses the area code of a contact’s phone number to determine the time zone of the contact’s calling area. This page can also be used for adding international area codes. International area codes must include the country code and the city code.
To add an area code, complete the following steps.

**Procedure**

**Step 1**  
From the CRS Administration menu bar, choose **Subsystems > Outbound** and click the **Area Codes** hyperlink. The Area Code Management web page opens.

**Step 2**  
Click the **Add New Area Code** hyperlink in the right pane. The Area Code Management web page refreshes to display the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area Code</td>
<td>A unique identifier for the area code. This number can have any numeric value, including 0 or leading zeros.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>The time zone contains a drop-down list of valid time zones in the world.</td>
</tr>
<tr>
<td>Daylight Savings</td>
<td>This radio button toggles between Yes (default) and No.</td>
</tr>
<tr>
<td>Observed</td>
<td>• No—If the time zone of this area code observes DST, then the system does not take DST into consideration when calculating the local time of the contact for phone numbers beginning with this area code.</td>
</tr>
<tr>
<td></td>
<td>• Yes (default)—If the time zone observes DST, then the DST is taken into consideration.</td>
</tr>
</tbody>
</table>

**Related Topics**

- **About the Outbound Feature for Unified CCX**, page 14-2
- **The Outbound Feature License**, page 14-7
- **How Is a Contact’s Local Time Determined?**, page 14-7
- **The Outbound Configuration Checklist**, page 14-9
- **Configuring General Outbound Properties**, page 14-11
- **Adding a New Campaign**, page 14-23
- **Importing Contacts for a Campaign**, page 14-25
- **Enabling Campaigns**, page 14-27
Setting-up Communications with the Agent’s Desktop

Effective Unified CCX Release 5.0(x), CAD allows agents to handle Outbound calls. The Cisco Agent Desktop and Cisco Supervisor Desktop does not support any new reports.

To display the additional buttons for the Outbound feature on CAD, the Direct Preview option must be enabled on Cisco Desktop Administrator (CDA). See the Cisco Desktop Administrator’s User Guide and the Cisco Agent User Guide, Release 6.4 for Unified CCX, Release 5.0(x).

Related Topics
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- How Is a Contact’s Local Time Determined?, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Configuring General Outbound Properties, page 14-11
- Adding a New Campaign, page 14-23
- Importing Contacts for a Campaign, page 14-25
- Enabling Campaigns, page 14-27
- Adding Area Codes, page 14-29
- Agents Receive Outbound Calls, page 14-31

Agents Receive Outbound Calls

Agents can now log in and get ready to receive Outbound calls. To do so, agents must belong to CSQs assigned to Outbound (see Allocating CSQ Agent Pool Percentages, page 14-22).

This section contains the following topics:
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
Agent Allocation and Queuing

The Outbound subsystem allocates agents for Outbound calls by pulling a batch of contacts from the db_cra database and assigning a Ready agent to each by reserving the agents for Outbound calls and presenting them with the Outbound calls. Only CAD agents are presented with Outbound calls.

Agents are chosen from the CSQ using the same criteria configured in CRS Administration GUI for inbound calls. If an agent accepts an Outbound call, the Outbound subsystem initiates a call on the agent’s behalf. If the agent rejects the
contact, the agent reservation is cancelled and the agent becomes Ready again and
may be presented with either an Outbound call or an inbound call. The contact that
was rejected is assigned to another agent. If the agent decides to skip the contact,
the agent reservation is not cancelled. Instead, the skipped contact gets assigned
to another (or same) agent.

The agent’s response such as accept, skip, and reject is saved in the database for
each contact presented during a campaign. If the agent does not respond within
the timeout configured on the General page of the Outbound subsystem
configuration in CRS Administration GUI, the Outbound subsystem moves the
agent to Not Ready state (much like an inbound Not Ready state) and assigns the
contact to another agent. The status of the contact (for example, the contact can
be closed or needs to be dialed again) and the call result (for example, the contact
was reached successfully or contact was not home) is recorded in the database and
this data is presented in the real-time and historical reports.

Note

Calls made by the Outbound subsystem will not be displayed in the Contact
Summary Real Time Report.

The goal of the subsystem is to maximize the number of Outbound calls made
without sacrificing the inbound service level of the CSQs involved in the
Outbound campaign. It accomplishes this by only using agents sitting idle in
Ready state, not handling inbound calls. The administrator configures, through
CRS Administration GUI, the percentage of logged in agents (CAD + IPPA in
ready, work, reserved, or talking state) in a CSQ that are allocated for handling
Outbound calls.

Related Topics
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
- Handling Skip-Next Behavior, page 14-42
- Handling Skip/Reject Behavior, page 14-42
- Call Retrieval Priority, page 14-44
Previewing Customer Information

Before placing an Outbound call, an available agent is reserved and presented with a preview record on the desktop. This lets the agent preview the contact before deciding on an action. This dialog contains customer information such as name, account number, and phone number.

The enabled buttons when an agent is in the Reserved state is described in the following table:

<table>
<thead>
<tr>
<th>Status</th>
<th>Result of Selecting this Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept</td>
<td>Accept the current preview record and initiate the Outbound call to the customer from the agent’s phone.</td>
</tr>
<tr>
<td>Reject</td>
<td>Reject the current preview record, cancel the agent reservation, and change the agent state to Ready. The agent can now handle either inbound or Outbound calls.</td>
</tr>
<tr>
<td>Reject-Close</td>
<td>Reject the current preview call and close the record so that contact is not called again for this particular campaign. This cancels the agent reservation and change the agent’s state to Ready so the agent can now handle either inbound or Outbound calls.</td>
</tr>
<tr>
<td>Skip</td>
<td>Skip the current preview record and retain the agent in the reserved state to allow the agent to handle another Outbound contact.</td>
</tr>
<tr>
<td>Skip-Close</td>
<td>Skip the current preview call and close the record so that the contact is not called again for this particular campaign. The agent remains reserved to handle another Outbound contact.</td>
</tr>
<tr>
<td>Cancel Reservation</td>
<td>Cancel the agent reservation and set the agent to the Not Ready state. The record remains open in the database. This state is similar to the Reject state except that the agent is transferred to the Not Ready state instead of the Ready state.</td>
</tr>
</tbody>
</table>

Related Topics

- Agent Allocation and Queuing, page 14-32
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
Exchanging Data with CAD

Unified CCX uses predefined Expanded Call Context (ECC) variables to exchange data with CAD for the Outbound option. Unified CCX uses the same ECC variables that Unified ICME uses for the Outbound option. These ECC variables are present on CDA. To display them on CAD, they must be added to the called OODefault.

The following table lists the pre-defined ECC variables used for the Outbound option:

<table>
<thead>
<tr>
<th>ECC Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACampaign</td>
<td>Optional. The name of the Outbound campaign to which the call belongs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ECC Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BStatus</td>
<td>Required. Contains two characters indicating the mode and direction of the Outbound option initiated call.</td>
</tr>
<tr>
<td></td>
<td>- The first character identifies the call mode:</td>
</tr>
<tr>
<td></td>
<td>- D = Direct Preview reservation for Unified CCX</td>
</tr>
<tr>
<td></td>
<td>- C = Direct Preview call for unified CCX</td>
</tr>
<tr>
<td></td>
<td>- Z = the Outbound call transferred or conferenced</td>
</tr>
<tr>
<td></td>
<td>- The second character identifies the direction (always ‘O’ = Outbound for Unified CCX).</td>
</tr>
</tbody>
</table>

So a BStatus of DO would indicate a Direct Preview Reservation for an Outbound Call, which is always the case for Outbound calls in Unified CCX.

Caution: Do not use these pre-defined ECC variables in any other context as they are reserved for the Outbound feature.
### ECC Variable Description

<table>
<thead>
<tr>
<th>ECC Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAAccountNumber</td>
<td>Optional. Identifies a customer account number and can be used by CAD to perform a database lookup to obtain additional customer data. This ECC variable displays only if the data was available in the customer import file. Note: The maximum character length of this ECC variable is 30 characters.</td>
</tr>
<tr>
<td>BAResponse</td>
<td>Optional. Multi-purpose placeholder that sends data from CAD to the Outbound option. This variable is used when the CAD responds to the server’s agent reservation request (for example, Accept, Reject, Skip, etc.). It is also used to schedule and cancel callbacks and make changes to the callback number.</td>
</tr>
<tr>
<td>BADialedListID</td>
<td>Optional. Unique key identifying a specific customer record.</td>
</tr>
<tr>
<td>BATimeZone</td>
<td>Optional. The GMT offset, in minutes, for the customer’s time zone and local time.</td>
</tr>
<tr>
<td>BABuddyName</td>
<td>Optional. Contains the customer’s first and last name separated by a comma, if provided in the contacts list imported for the campaign.</td>
</tr>
<tr>
<td>BACustomerNumber</td>
<td>Optional. Contains dialed customer phone number.</td>
</tr>
</tbody>
</table>

### Related Topics
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
- Handling Skip-Next Behavior, page 14-42
- Handling Skip/Reject Behavior, page 14-42
- Call Retrieval Priority, page 14-44
- Handling Failover and System Restarts, page 14-44
Call Status Values

For each contact, the call status and their corresponding values are recorded in the database and described in the following table:

<table>
<thead>
<tr>
<th>Call Status</th>
<th>Value (stored in database)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>1</td>
<td>The call is pending. This is the initial state for all records.</td>
</tr>
<tr>
<td>Active</td>
<td>2</td>
<td>The record was retrieved by the Outbound subsystem for dialing.</td>
</tr>
<tr>
<td>Closed</td>
<td>3</td>
<td>The record is closed (not dialed).</td>
</tr>
<tr>
<td>Callback</td>
<td>4</td>
<td>The record is marked for a callback.</td>
</tr>
<tr>
<td>Max Calls</td>
<td>5</td>
<td>Maximum attempts have been reached for this record (considered closed).</td>
</tr>
<tr>
<td>Retry</td>
<td>6</td>
<td>This record is retried since the previous attempt resulted in busy or answering machine status.</td>
</tr>
<tr>
<td>Unknown</td>
<td>7</td>
<td>If the Outbound subsystem was restarted with records in the Active (2) state, they are moved to this state.</td>
</tr>
</tbody>
</table>

Related Topics
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Resetting Contact States at Midnight, page 14-37
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
- Handling Skip-Next Behavior, page 14-42
- Handling Skip/Reject Behavior, page 14-42
- Call Retrieval Priority, page 14-44
- Handling Failover and System Restarts, page 14-44

Resetting Contact States at Midnight

The Outbound subsystem performs the following actions at midnight:
The DialingListConfig records with a call status of Unknown are reset to Pending.

Missed callback records (dialingListConfig records that have call status callback and a callBackDateTime smaller than the current time) are updated depending on the missed callback action configured in the CRS Administration GUI.

- MissedCallbackAction: Reschedule (for the same time on the next business day)
- MissedCallbackAction: Retry (sets the call status to Retry and deletes the callBackNumber from the database).
- MissedCallbackAction: Close (sets the call status to Closed)
- Dialing list records with a call status of Closed or Max_Calls are deleted.
- Dialing list records with a call result of Do Not Call are not deleted as these records are exported to a text file.

When the CRS engine goes from offline to online (for example, the standby server becomes active (online) if the active (first) server fails), the dialing list records with a status of Unknown are reset to Pending.

Related Topics
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
- Handling Skip-Next Behavior, page 14-42
- Handling Skip/Reject Behavior, page 14-42
- Call Retrieval Priority, page 14-44
- Handling Failover and System Restarts, page 14-44
Call Result Values

For each contact, the call result (as marked by the agent on CAD or automatically deleted by the system) and their corresponding values are recorded in the database and described in the following table:

<table>
<thead>
<tr>
<th>Call Result</th>
<th>Value (stored in database)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice</td>
<td>1</td>
<td>Customer answered and was connected to agent.</td>
</tr>
<tr>
<td>Fax</td>
<td>2</td>
<td>Fax machine or modem detected.</td>
</tr>
<tr>
<td>Answering machine</td>
<td>3</td>
<td>Answering machine detected.</td>
</tr>
<tr>
<td>Invalid</td>
<td>4</td>
<td>Number reported as invalid by the network.</td>
</tr>
<tr>
<td>Do Not Call</td>
<td>5</td>
<td>Customer did not want to be called again.</td>
</tr>
<tr>
<td>Wrong Number</td>
<td>6</td>
<td>Number successfully contacted but wrong number.</td>
</tr>
<tr>
<td>Customer Not Home</td>
<td>7</td>
<td>Number successfully contacted but reached the wrong person.</td>
</tr>
<tr>
<td>Callback</td>
<td>8</td>
<td>Customer requested callback.</td>
</tr>
<tr>
<td>Agent Rejected</td>
<td>9</td>
<td>Agent skipped or rejected the preview call.</td>
</tr>
<tr>
<td>Agent Closed</td>
<td>10</td>
<td>Agent skipped or rejected the preview call with the close option (not dialed).</td>
</tr>
<tr>
<td>Busy</td>
<td>11</td>
<td>Busy tone detected.</td>
</tr>
<tr>
<td>Ring No Answer</td>
<td>12</td>
<td>Agent did not respond to the preview call within the time out duration.</td>
</tr>
</tbody>
</table>

Note: You can configure the time out duration using the Preview Call Timeout field detailed in the “Configuring General Outbound Properties” section on page 14-11.

Related Topics
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
Reclassification Status Behavior

When the Outbound contacts are imported into the database from the CRS Administration GUI, the call status column in the Dialing List table is assigned the default value of 1 (Pending) indicating that these Outbound contacts are yet to be dialed. When the Outbound subsystem retrieves a batch of contacts from the database, the call status is set to 2 (Active). After a call is placed to the Outbound contact, the call status is set to 3 (Closed) and the call result is set to 1 (Voice), as all Outbound calls are classified by the agent desktop as voice by default. If the agent clicks the reclassification button on the agent desktop and reclassifies the call as answering machine/fax/busy/invalid or selects the callback button and schedules a callback, the Outbound subsystem updates the call result field accordingly, and based on the call result, it also updates the call status.

The following table describes the relationship between call status and call result values and the resulting behavior of the system. The values in brackets are the actual values stored in the database.

<table>
<thead>
<tr>
<th>Call Result</th>
<th>Call Status</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice (1)</td>
<td>Closed (3)</td>
<td>This contact is not dialed again.</td>
</tr>
<tr>
<td>Fax (2)</td>
<td>Retry (6)</td>
<td>This contact is retried, using a different phone number provided for this contact.</td>
</tr>
<tr>
<td>Answering machine (3)</td>
<td>Retry (6)</td>
<td>This contact is retried, with the same phone number as before.</td>
</tr>
<tr>
<td>Invalid (4)</td>
<td>Retry (6)</td>
<td>This contact is retried, using a different phone number provided for this contact.</td>
</tr>
<tr>
<td>Do Not Call (5)</td>
<td>Closed (3)</td>
<td>This contact is not dialed again.</td>
</tr>
</tbody>
</table>
Chapter 14  Configuring Cisco Unified CCX Outbound Preview Dialer

Agents Receive Outbound Calls

Chapter 14  Configuring Cisco Unified CCX Outbound Preview Dialer

The call status is set to 3 (Closed) when the Outbound contact is no longer dialed for this campaign. This happens when a call was successfully placed (call result is voice) and also when an agent selects Skip-Closed, Reject-Closed, or Do Not Call. This also happens automatically if the system reaches the maximum attempts limit for an Outbound contact which means that the system tried dialing the Outbound contact the maximum number of times configured in the CRS Administration GUI.

### Call Result | Call Status | Behavior
--- | --- | ---
Wrong Number (6) | Retry (6) | This contact is retried, using a different phone number provided for this contact. If alternate phone numbers are not available, the call status is closed.
CustomerNotHome (7) | Retry (6) | This contact is dialed again using the number stored in the callbackNumber column, at the time stored in callbackDateTime column.
Callback (8) | Callback (4) | This contact is dialed again using the number stored in the callbackNumber column, at the time stored in callbackDateTime column.
Reject or Skip (9) | Active (No change) | This contact is presented to another agent.
Reject-Close or Skip-Close | Closed (3) | This contact is not dialed again.
Busy | Retry (6) | This contact is retried, with the same phone number as before.

Wrong Number (6) Retry (6) This contact is retried, using a different phone number provided for this contact. If alternate phone numbers are not available, the call status is closed.
CustomerNotHome (7) Retry (6) This contact is dialed again using the number stored in the callbackNumber column, at the time stored in callbackDateTime column.
Callback (8) Callback (4) This contact is dialed again using the number stored in the callbackNumber column, at the time stored in callbackDateTime column.
Reject or Skip (9) Active (No change) This contact is presented to another agent.
Reject-Close or Skip-Close Closed (3) This contact is not dialed again.
Busy Retry (6) This contact is retried, with the same phone number as before.

The call status is set to 3 (Closed) when the Outbound contact is no longer dialed for this campaign. This happens when a call was successfully placed (call result is voice) and also when an agent selects Skip-Closed, Reject-Closed, or Do Not Call. This also happens automatically if the system reaches the maximum attempts limit for an Outbound contact which means that the system tried dialing the Outbound contact the maximum number of times configured in the CRS Administration GUI.

### Related Topics
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Handling Skip-Next Behavior, page 14-42
- Handling Skip/Reject Behavior, page 14-42
- Call Retrieval Priority, page 14-44
- Handling Failover and System Restarts, page 14-44
Handling Skip-Next Behavior

Tip
To ensure that a skip-next selection is handled as designed, be sure to set at least two, if not all three, phone numbers.

When an agent on an Outbound call with a customer selects the skip-next button on CAD, two options (wrong number or not home) are made available to this agent. The behavior for both options is the same, the agent continues to remain on the call with the customer, while the Outbound subsystem updates the phone number to be dialed to the next available number (with up to three phone number possibilities—phone01, phone02m and phone03). If the record is imported with only one phone number and phone02 and phone03 are empty, this record is closed after the agent drops the call. If phone02 is empty, but phone03 is present, then phone03 is used as the next number to dial.

If the max attempts to dial contact is set to 2 (default), even if the agent selects the skip-next button, the record is closed and the next number is never be dialed.

Related Topics
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
- Handling Skip/Reject Behavior, page 14-42
- Call Retrieval Priority, page 14-44
- Handling Failover and System Restarts, page 14-44

Handling Skip/Reject Behavior

The Outbound subsystem handles an agent’s skip/reject requests as listed below:

- Skip/reject close request: the contact is always set to Closed.
Contact is a callback record: the contact goes back in queue so the callback can be retried.

Contact is not a callback: it is set to Pending and is picked up from the database the next time that the Outbound subsystem reads records.

Contact is recalled (deleted the CSQ to which this contact belonged, or the campaign that this contact belongs to was stopped): then this contact is no longer considered a callback.

Reject: the agent is moved to available or unavailable (depending on configuration) after the reject.

Skip: The Outbound subsystem verified if there is another contact in queue for this agent. If so, the agent remains in the reserved state and receives a new DialingListConfig. Now, the agent has the option again to accept/reject/skip/… for this new record.

No new record for this agent: this agent is moved to available or unavailable, again depending on the configuration.

No record for this agent: With only one active agent for a CSQ, the Outbound subsystem only requests one contact. If the agent skips this contact, there is no other contact available.

Related Topics
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
- Handling Skip-Next Behavior, page 14-42
- Call Retrieval Priority, page 14-44
- Handling Failover and System Restarts, page 14-44
Call Retrieval Priority

While retrieving Outbound contacts from the database, records that have scheduled callbacks have priority as the callback time must be adhered. Outbound contacts are retrieved in the following order of priority:

- Priority 1: Outbound contacts with scheduled callback (call status = 4) and the current time is within the CallbackTimeLimit configured on the Campaigns page in Abdomen (default value is 15 minutes) of the scheduled callback time.
- Priority 2: Outbound contacts in the Pending state (call status = 1).
- Priority 3: Outbound contacts in the Retry state (call status = 6).

Related Topics

- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
- Handling Skip-Next Behavior, page 14-42
- Handling Skip/Reject Behavior, page 14-42
- Handling Failover and System Restarts, page 14-44

Handling Failover and System Restarts

Outbound contacts with an Active call status during a failover indicates that these contacts were retrieved from the database but the system went down either before they could be dialed or after they were dialed but before the call status and call result columns were updated. When the system restarts, the call status for all such Outbound contacts is changed to 7 (Unknown). All Outbound contacts in the Unknown state will be reset to the Pending state (should be retrieved for dialing again) at midnight every night.
If Outbound calls in progress during a failover are not dialed again, when the system comes back up, the call status is set to Closed as soon an Outbound call is placed and these records will not be retrieved for dialing again. However, if the failover happened before the system could update the call status to Closed, these records remain in the Active state and are marked Unknown so they transition to Pending state after midnight. Once they are in the Pending state, they will be dialed again.

Related Topics
- Agent Allocation and Queuing, page 14-32
- Previewing Customer Information, page 14-34
- Exchanging Data with CAD, page 14-35
- Call Status Values, page 14-37
- Call Result Values, page 14-39
- Call Result Values, page 14-39
- Reclassification Status Behavior, page 14-40
- Handling Skip-Next Behavior, page 14-42
- Handling Skip/Reject Behavior, page 14-42
- Call Retrieval Priority, page 14-44

Removing Contacts from the Do Not Call List

Note
In this guide, the underscore character linking each word differentiates the national do_not_call list from the Outbound subsystem’s Do Not Call list.

When an agent reclassifies a call as Do Not Call from CAD, the Outbound subsystem marks it as Do Not Call for the campaign for which this contact was called. To ensure that a contact does not get called again for a subsequent campaign, you must delete the contact from all campaigns to which it belongs. To delete Do Not Call contacts from all campaigns, follow this procedure.
Removing Contacts from the Do Not Call List

Procedure

**Step 1**  
From the CRS Administration menu bar, choose **Subsystems > Outbound** and click the **Campaigns** hyperlink.  
The Campaign web page opens and displays all the campaigns that have been configured.

**Step 2**  
In the Campaign Configuration pane, click on the **Delete All Contacts** button in the right pane.

⚠️ **Caution**  
Do not click the **Delete All Contacts** button (or begin this task) during peak work hours at the call center. This database-intensive operation may cause issues if the system is under high load. Instead, disable the campaign, to stop the processing of contacts for that campaign and then during off-peak hours, click the **Delete All Contacts** button to delete all the records from the database.

>Note> The **Delete All Contacts** button first disables the campaign and then removes all contacts associated with this campaign.

A popup window appears to confirm your action.

**Step 3**  
Click **OK** in the popup window.

⚠️ **Caution**  
If you click **Cancel** at this point, then a contact remains marked as Do Not Call for the campaign that was in progress when the request was made, however, that contact may get called again for a different campaign. A list of all records that have been marked Do Not Call can be obtained manually from the database by running a query on the appropriate table.

If you click **OK**, the following actions are performed by the Outbound subsystem:

- The campaign is disabled if it is currently enabled.
- Any contact with the same phone01, phone02, or phone03 value as the phone01 value of a contact marked Do Not Call is also marked Do Not Call across all campaigns.
Removing Contacts from the Do Not Call List

- All contacts marked do not call are exported to a text file <root dir>:\wfavvid\DoNotCall.txt. If the file already exists, the new contacts being exported are appended to the file along with a timestamp of when the export was done.
- After the Do Not Call contacts are exported to the text file, they are marked inactive in the Dialing List table and are permanently deleted from the database when the database is purged (see Purging Historical Data, page 13-4).

Related Topics
- About the Outbound Feature for Unified CCX, page 14-2
- The Outbound Feature License, page 14-7
- How Is a Contact’s Local Time Determined?, page 14-7
- The Outbound Configuration Checklist, page 14-9
- Verifying the RmCm and Outbound Subsystems, page 14-10
- Configuring General Outbound Properties, page 14-11
- Adding a New Campaign, page 14-23
- Importing Contacts for a Campaign, page 14-25
- Enabling Campaigns, page 14-27
- Adding Area Codes, page 14-29
- Setting-up Communications with the Agent’s Desktop, page 14-31
Removing Contacts from the Do Not Call List
Effective Cisco CRS 5.0, the Backup and Restore application for Cisco CRS is embedded in the Cisco CRS Administrator. You do not need to install it separately in a remote server.

Note
Cisco CRS 5.0 does not support integration with the Disaster Recovery Framework which is based on the Linux platform.

This section contains the following topics:

- About the Backup and Restore Application, page 15-2
- Guidelines and Requirements, page 15-2
- What Is Backed Up?, page 15-9
- Backing-up Data, page 15-3
- Restoring Data, page 15-10
- Tasks to Perform after a Restore, page 15-14
About the Backup and Restore Application

The BARS software which was used in Cisco CRS 4.5 is not supported in Cisco CRS 5.0.

Cisco CRS 5.0 provides a Backup and Restore application that is embedded with the Cisco CRS platform.

The Backup and Restore application performs the following tasks:

- Saves all settings configured through the Backup and Restore Configuration web page in the CRS Administration GUI.
- Authenticates the credentials that you provide during the backup and restore configuration process.
- Creates a trace for each task.
- Backs up the Cisco CRS databases and configurations.
- Restores the data that was backed up.
- Provides a status of the backup and restore operation on the CRS Administration GUI.

Guidelines and Requirements

Be sure to adhere to the following requirements before using the Backup and Restore application:

- Perform the backup and restore operation from the Cisco CRS server. Do not run it from a client desktop.
- Verify that the popup blocker is disabled for the internet browser in the supported operating systems.
- If you have multiple Network Interface Cards (NICs) configured in your Cisco CRS server, verify that the same NIC configuration (created during the CRS installation process) is also maintained during the backup and restore operation. Changes made to the NIC configuration after the CRS installation results in a failed backup and restore process.
• While performing a restore operation, verify that your Cisco CRS server(s) maintain the same IP address, host name, and deployment type (Unified CM or Unified CME) used during the backup phase.

• Do not close or refresh the progress window that appears after you initiate the backup and restore operation. Be sure to respond to the messages/warnings/errors that appear in this window. Failure to do so could time out the backup and restore process.

Note
Refer to the Cisco CRS Software and Hardware Compatibility Guide for details on supported internet browser versions, operating systems, and software releases.

## Backing-up Data

To backup data, complete the following tasks in the specified order:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>For instructions, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Configure the backup storage location.</td>
<td>Specifying the Backup Storage Location, page 15-4</td>
</tr>
</tbody>
</table>
| 2    | You can backup Cisco CRS data in one of two ways:  
|      | Perform a scheduled backup or Manually perform a backup. | Configuring the Backup Scheduler, page 15-5  
|      |                                             | Performing a Backup Now, page 15-8 |

Related Topics

- About the Backup and Restore Application, page 15-2
- Guidelines and Requirements, page 15-2
- What Is Backed Up?, page 15-9
Specifying the Backup Storage Location

You must configure the backup storage location before starting a backup.
To specify the backup storage location, complete the following procedure.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>From the CRS Administration main menu, select Tools &gt; Backup and Restore. The Status pane of the Backup and Restore Configuration web page is displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click the Backup Storage Location link in the left pane. The Destination Options pane of the Backup and Restore Configuration web page is displayed.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Use this web page to specify the following fields:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Directory</td>
<td>Toggle this button if you are specifying a directory path to any server in your network. When you toggle this button, you automatically disable the tape device path (even if specified).</td>
</tr>
</tbody>
</table>
| Path Name              | Specify the network directory location in the following format: \\
|                        | \<server name or IP address>\<required folder>          Verify that the specified folder is a shared folder with write permissions. |
| User Name              | Windows administrator for the server specified in the above path. |
| Password               | Windows administrator password for the server specified in the above path. |
| Tape Device            | Toggle this button if you are specifying a directory a local tape device. When you toggle this button, you automatically disable the network directory path (even if specified). |
| Device Name            | Lists the available tape device names present in the Cisco CRS cluster. |

| Step 4 | Click the Update button at the top of the page. The information provided in the Backup Storage Location web page is validated and in case of any discrepancy, the corresponding error message is displayed. |
Chapter 15  Backing-up and Restoring Data

Backing-up Data

Refer to the Cisco CRS Servicing and Troubleshooting Guide for details on handling error situations.

Related Topics
- About the Backup and Restore Application, page 15-2
- Guidelines and Requirements, page 15-2
- Configuring the Backup Scheduler, page 15-5
- Disabling the Backup Schedule, page 15-6
- Restoring the Default Schedule, page 15-7
- Performing a Backup Now, page 15-8
- What Is Backed Up?, page 15-9

Configuring the Backup Scheduler

In the Cisco CRS Administration GUI, you can configure the Cisco CRS backup Scheduler to automatically trigger on a designated day and time.

Cisco sets a default backup schedule to ensure that the scheduled backup occurs at the designated time. You can change the schedule at any time, restore the default schedule, and enable/disable the configured schedule.

Note

The Scheduler is disabled by default.

You must enable the Scheduler to ensure that the scheduled backup occurs at the designated time.

Procedure

Step 1  From the CRS Administration main menu, select Tools > Backup and Restore.
The Status pane of the Backup and Restore Configuration web page is displayed.

Step 2  Click the Backup Scheduler link in the left pane.
The message “Scheduler Status: Enabled” displays.

Related Topics
- About the Backup and Restore Application, page 15-2
- Guidelines and Requirements, page 15-2
- Specifying the Backup Storage Location, page 15-4
- Disabling the Backup Schedule, page 15-6
- Restoring the Default Schedule, page 15-7
- Performing a Backup Now, page 15-8
- What Is Backed Up?, page 15-9

Disabling the Backup Schedule

When you disable the Scheduler, scheduled backups do not occur.

Procedure

Step 1 From the CRS Administration main menu, select Tools > Backup and Restore. The Status pane of the Backup and Restore Configuration web page is displayed.
Step 2 Click the Backup Scheduler link in the left pane.
Step 3 Click Disable Scheduler.
The message Scheduler Status: Disabled displays.

Related Topics
- About the Backup and Restore Application, page 15-2
- Guidelines and Requirements, page 15-2
- Specifying the Backup Storage Location, page 15-4
- Configuring the Backup Scheduler, page 15-5
- Restoring the Default Schedule, page 15-7
Restoring the Default Schedule

If you want to restore the Backup and Restore application’s default schedule, perform the following procedure:

Procedure

Step 1  From the CRS Administration main menu, select **Tools > Backup and Restore**.
The Status pane of the Backup and Restore Configuration web page is displayed.

Step 2  Click the **Backup Scheduler** link in the left pane.

Step 3  Click **Restore Defaults**.
The default schedule appears in the window.

Step 4  To ensure that backup runs as scheduled, click **Enable Scheduler**.

Step 5  To save the default settings, click **Update Schedule**.

When you restore the default schedule, all default settings including the frequency and the log settings appear in the Configure Scheduler window. Schedule status—*enabled* or *disabled*—does not change.

Related Topics

- About the Backup and Restore Application, page 15-2
- Guidelines and Requirements, page 15-2
- Specifying the Backup Storage Location, page 15-4
- Disabling the Backup Schedule, page 15-6
- Performing a Backup Now, page 15-8
- What Is Backed Up?, page 15-9
Performing a Backup Now

⚠️ **Caution**
The “Backup Now” and “Restore Now” operations cannot be performed from a remote server/client/desktop. You must perform these operations from the server running the CRS software.

💡 **Tip**
If you have a cluster setup (multiple nodes), then perform the backup and restore operation on only one of the nodes in the cluster. You do not need to perform this operation on all the nodes in the cluster.

### Procedure

1. **Step 1**
   From the CRS Administration main menu, select **Tools > Backup and Restore**.
   The Status pane of the Backup and Restore Configuration web page is displayed.

2. **Step 2**
   Click the **Backup Now** link in the left pane.
   The window refreshes to display the backup status and to ensure that you do not close the window until the backup operation is completed.

⚠️ **Caution**
During the backup, heed warnings about the amount of temporary space that is available on the staging directory. The staging directory serves as a temporary directory where Backup and Restore application places all files until it builds the single `Backupmm-dd-yyyyhh-mm.tar` file. If you do not have enough temporary space, the backup will fail. Do not run a backup if you receive these warnings.

Always verify that the backup completed successfully.

---

**Related Topics**
- About the Backup and Restore Application, page 15-2
- Guidelines and Requirements, page 15-2
- Specifying the Backup Storage Location, page 15-4
What Is Backed Up?

Cisco CRS 5.0 restores the data backed in Cisco CRS 4.5.

- Clusters, configurations, and applications profile in the data repository
- Workflow scripts that are already uploaded in the data repository
- The db_cra repository, FCRasSvr database
- Unified CCX configuration data (such as open bootstrap and flat files)
- Unified CCX recording files
- Windows hosts and lmhosts
- Unified CM Telephony configuration (jtapi.ini)
- User prompts, grammars, and documents under these paths:
  - c:\Program Files\wfavvid\Prompts\user
  - c:\Program Files\wfavvid\Grammars\user
  - c:\Program Files\wfavvid\Documents\user

Related Topics

- About the Backup and Restore Application, page 15-2
- Guidelines and Requirements, page 15-2
- Specifying the Backup Storage Location, page 15-4
- Disabling the Backup Schedule, page 15-6
- Restoring the Default Schedule, page 15-7
- Performing a Backup Now, page 15-8
- What Is Backed Up?, page 15-9
Restoring Data

This section describes how to restore data. It includes the following topics:

- Understanding How the Restore Process Works, page 15-10
- Performing a Restore Operation, page 15-11

Understanding How the Restore Process Works

Caution

During the restoration process, services may stop and trigger call-processing interruptions. To minimize the effect of these interruptions on your call processing operations, perform the restore operation during off-peak hours.

The restore process validates if the current system configuration is in sync with the backed up data before it proceeds with restoring the configuration data.

The restore process differs depending on the number of nodes in the cluster:

- Single-node deployment: When you restore a configuration for a single-node deployment, the cluster data folder is saved in the 
  C:\BackupClusterData\ClusterData folder. You will not be prompted for the path where the cluster data folder is to be stored.

- Multiple-node deployment: When you restore a configuration for a multiple-node deployment, you must manually copy the cluster data folder to the required location.

Caution

Before starting the restore, be sure to manually copy the ClusterData folder for both nodes and store it in a folder of your choice.

Tip

If you performed the backup operation on Server A in a multiple node environment, be sure to also perform the restore operation on Server A.
The restore process allows you to recover all data that was compressed into the backup file.

⚠️ Caution

After performing a successful restore operation, if you are prompted to remove the C:\BackupClusterData folder, be sure to delete the folder. This folder only serves as a temporary storage space and is generally deleted by the software after a successful restore operation. If the software does not automatically delete this folder for any reason, then you will need to manually delete it. Failure to delete this folder after each restore operation may affect your next restore process.

Related Topics

- Performing a Restore Operation, page 15-11
- Tasks to Perform after a Restore, page 15-14
- Backing-up Data, page 15-3

Performing a Restore Operation

🔍 Tip

Be sure to perform the restore operation using the latest backup tar file.

⚠️ Caution

Stop and disable the following applications before performing a restore operation:
- all intrusion-detection applications, such as Cisco Security Agent
- virus-protection software
- third party, Cisco-provided/approved applications co-resident on the CRS server

🔍 Tip

For a multiple-node deployment, copy the original cluster data folder for both nodes BEFORE you begin the restore operation. This will ensure a backup situation should your restore operation fail for any reason.
Chapter 15  Backing-up and Restoring Data

Restoring Data

Caution

The “Backup Now” and “Restore Now” operations cannot be performed from a remote server/client/desktop. You must perform these operations from the server running the CRS software.

Note

Before you begin a recovery procedure, be sure to verify that the time on both CRS engine nodes are synchronized:
- When restore is in progress after a system reimage (disaster/recovery), the NTP service will only be available after it is configured through the CRS Administration Setup Wizard. In this case, be sure to manually synchronize each node.
- When restore is in progress on already configured nodes, the servers are automatically synchronized if the NTP service is configured (see Modifying NTP Configuration, page 4-12). If NTP is not configured, then you must manually synchronize each node.

Procedure

Step 1  From the CRS Administration main menu, select Tools > Backup and Restore.
The Status pane of the Backup and Restore Configuration web page is displayed.

Step 2  Click the Restore Now link in the left pane.
The Location Options pane of the Restore Configuration web page is displayed.

Step 3  Use this web page to specify the following fields:
## Restoring Data

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Directory</strong></td>
<td>Toggle this button if you are specifying a directory path to any server in your network. When you toggle this button, you automatically disable the tape device path (even if specified).</td>
</tr>
<tr>
<td><strong>Path Name</strong></td>
<td>Specify the network directory location in the following format: <code>\&lt;server name or IP address&gt;\&lt;shared folder&gt;\&lt;tar_file name&gt;</code> Verify that the specified folder is a shared folder with write permissions. Specify the tar filename. If you do not specify the tar file name, and proceed to click <strong>Restore</strong>, a message prompts you to do so before proceeding.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>If the tar file is greater than 1GB, be sure to manually copy the tar file to <code>c:\temp\backup.tar</code> before running the restore process. Also, use the same path name in this Path Name field (for example, <code>\\&lt;local host&gt;\c$\temp\backup.tar</code>).</td>
</tr>
<tr>
<td><strong>Warning</strong></td>
<td>Do not restore large tar files over the network. Instead, copy it to a local directory and then begin the restore process.</td>
</tr>
<tr>
<td><strong>User Name</strong></td>
<td>Windows administrator for the server specified in the above path.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>Windows administrator password for the server specified in the above path.</td>
</tr>
<tr>
<td><strong>Tape Device</strong></td>
<td>Toggle this button to specify a directory or a local tape device. By toggling this button, you automatically disable the network directory path (even if specified).</td>
</tr>
<tr>
<td><strong>Device Name</strong></td>
<td>Lists the available tape device names present in the Cisco CRS cluster.</td>
</tr>
</tbody>
</table>
Related Topics
- Understanding How the Restore Process Works, page 15-10
- Tasks to Perform after a Restore, page 15-14
- Backing-up Data, page 15-3

Tasks to Perform after a Restore

Whenever you run a restore process, perform the following post-restore tasks:

- Verify that no errors occurred during the restore.
- Go to the CRS Administration Control Center webpage and verify that all configured subsystems are in service.
- After performing a successful restore operation, if you are prompted to remove the C:\BackupClusterData folder, be sure to delete the folder. This folder only serves as a temporary storage space and is generally deleted by the software after a successful restore operation. If the software does not automatically delete this folder for any reason, then you will need to manually delete it. Failure to delete this folder after each restore operation may affect your next restore process.

Related Topics
- Understanding How the Restore Process Works, page 15-10
- Performing a Restore Operation, page 15-11
- Backing-up Data, page 15-3
Reporting on Real-Time CRS Data

When the CRS system is configured and functioning, you can run reports to monitor real-time activity using the CRS Administration web interface.

If you have the Cisco Agent Desktop and Cisco Supervisor Desktop, you also can run real-time reports directly from these applications. Cisco Agent Desktop and Cisco Supervisor Desktop do not use the same calculations or data display methods as those that CRS real-time reporting uses. Therefore, a report run using CRS real-time reporting and a report run using Cisco Supervisor Desktop may not display the same information for a given statistic. To avoid confusion, it might help to make one of these tools your standard reporting tool.

You must be logged into the CRS Administration web interface to run CRS real-time reports.

Caution

While Unified CM supports Unicode characters in first and last names, those characters become corrupted in Cisco CRS Administration web pages for RmCm configuration, Real Time Reporting, Cisco Agent/Supervisor Desktop, and Historical Reports.

The following sections provide more information about real-time CRS data.

- Available CRS Real-time Reports, page 16-2
- Opening Real-time Reporting, page 16-3
- Running Reports, page 16-4
- Viewing Detailed Subreports, page 16-4
- Printing Reports, page 16-5
Available CRS Real-time Reports

CRS real-time reporting provides up to 11 reports that you can use to monitor CRS system activity. The following table briefly describes each of these reports.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Tasks</td>
<td>Provides information about currently active applications.</td>
</tr>
<tr>
<td>Application Tasks Summary</td>
<td>Provides a summary of specific applications’ activity.</td>
</tr>
<tr>
<td>Applications</td>
<td>Provides a list of all applications loaded on the CRS server.</td>
</tr>
<tr>
<td>Contact Summary</td>
<td>Provides information for call contacts, e-mail contacts, and HTTP contacts. Also provides the total number of contacts.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Calls made by the Outbound subsystem will not be displayed in the Contact Summary Real Time Report.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Provides information about currently active contacts.</td>
</tr>
<tr>
<td>CSQ Unified CCX Stats</td>
<td>Provides information about CSQ activity. This report is available only if Unified CCX has been configured.</td>
</tr>
<tr>
<td>Data source Usage</td>
<td>Provides information about configured data source names (DSNs).</td>
</tr>
<tr>
<td>Engine Tasks</td>
<td>Provides information about currently active Engine tasks.</td>
</tr>
<tr>
<td>Overall Unified CCX Stats</td>
<td>Provides information about Unified CCX resources and calls. This report is available only if Unified CCX has been configured.</td>
</tr>
<tr>
<td>Resource Unified CCX Stats</td>
<td>Provides information about Unified CCX resources activity.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Provides information on all active sessions.</td>
</tr>
</tbody>
</table>

**Related Topic**

The Report Menu, page 16-8
Opening Real-time Reporting

Real-time reporting is available from the CRS Administration web interface.

Note

Real-time Reporting requires the Java plug-in. If the Java plug-in is not already installed on the PC on which you are viewing the reports, the CRS system will automatically install it when you choose **Tools > Real Time Reporting**.

The Application Reporting web page is a stand-alone component of the CRS Administration interface. It has its own menu bar, which replaces the CRS Administration menu bar.

To open real-time reporting, complete the following steps.

Procedure

Step 1

If you are running Real-time Reporting for the **first time** on this system, log into CRS Administration as an **Administrator**.

The system prompts you to download the Java plug-in; follow the prompt instructions.

Note

After you perform the initial download of the Real-Time Reporting Java plug-in, non-Administrative users can access Real-Time Reporting on this system.

Step 2

Choose **Tools > Real-time Reporting** from the CRS Administration menu.

The Application Reporting web page opens in a new window. The real-time reporting tool requires a Java plug-in. If the plug-ins is not installed on the machine you are using, the CRS system prompts you to accept the automatic installation of the plug-in. If you do not accept the installation, you cannot use real-time reporting.

Related Topics

- The Application Reporting User Interface, page 16-7.
Running Reports

Open the real-time reporting tool from the CRS Administration web interface to run reports.

To run a real-time report, complete the following steps.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>From the Application Reporting menu bar, choose Reports.</td>
</tr>
<tr>
<td>Step 2</td>
<td>From the Reports menu, choose the report to run. The report opens in the Application Reporting window.</td>
</tr>
</tbody>
</table>

Note

For detailed information about the real-time reports that are available, see “The Report Menu” section on page 16-8.

Viewing Detailed Subreports

You can view more detailed information for selected items in these four reports:

- Application Tasks report
- Contacts report
- Applications report
- Sessions report

To view detailed subreports, complete the following steps.

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Run the Application Task, Contacts, Applications, or Sessions report.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click a line in the report for which you want to view more detailed information. For example, click an e-mail address in the Contacts report.</td>
</tr>
</tbody>
</table>
Step 3  From the Application Reporting menu bar, choose Views and click the subreport that you want to run.

You can also open a subreport by right-clicking on the selected item and choosing a subreport.

The subreport opens.

Note  For detailed information about the subreports that are available, see “The Views Menu” section on page 16-30.

Printing Reports

To facilitate printing, you can open a printable version of a report. To print a report, complete the following steps.

Procedure

Step 1  Run a report.

Step 2  From the Application Reporting menu, select Tools > Open Printable Report. A printable version of the report opens in a separate window.

Step 3  Print the report using your browser’s print functionality.

Resetting Report Statistics

The CRS system automatically resets all statistics each day at midnight. You can reset the accumulated statistics manually at any time. Resetting statistics does not reset active statistics, such as active contacts and active tasks.

To reset report statistics, complete the following steps.
Setting Report Options

You can set the following reporting options:

- Refresh interval
- Number of times that the CRS Administration web interface should attend to reconnect to the CRS server.
- Whether logged off users appear in reports

To set report options, complete the following steps.

Procedure

Step 1 From the Application Reporting menu bar, choose Settings > Options.

Step 2 The Options dialog box opens.

Step 3 From the Polling Interval drop-down menu, choose the refresh rate in seconds.

Step 4 From the Server Connect Retry Count drop-down menu, choose the number of times that the CRS Administration web interface should attempt to reconnect to the CRS server.

Step 5 From the Show Logged Off Resources drop-down menu, choose whether logged off agents appear in reports.

Step 6 Click Apply to apply the settings.
Setting Report Appearance

You can select from three report appearances:

- Windows, which displays reports in colors based on your Windows settings
- Motif, which displays reports in purple and menu items in brown
- Metal, which displays reports in grey and menu items in black

To set the report appearance, choose Settings from the Application Reporting menu bar and click the appearance that you want.

Note: For more information, see “The Settings Menu” section on page 16-32.

The Application Reporting User Interface

Note: Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

When you choose Tools > Real-time Reporting from the CRS Administration menu, the Application Reporting tool opens a web page in a new window.

The Application Reporting tool menu bar contains the following options:

- **Report**—Choose this option to display a list of the available top-level real-time reports (see The Report Menu, page 16-8).
- **Tools**—Choose this option to reset all the statistics and refresh connections (see The Tools Menu, page 16-29).
- **Settings**—Choose this option to set the look and feel of the real-time Reporting client, set the polling (refresh) interval times, and set the amount of times the server will attempt to reconnect (see The Views Menu, page 16-30).
- **Help**—Choose this option to display system information and to access Cisco CRS online help (The Settings Menu, page 16-32).
The Report Menu

Note: All real-time reports display a Last Updated At field, which indicates the time of the snapshot. All summary reports display both a start time (which indicates when the summary statistics started being collected) and the current time. All real-time reports display a Connected or Not Connected status for each node in the cluster.

The Report menu provides access to a variety of top-level reports. It contains the following menu options:

- Contacts Summary Real-Time Report, page 16-8
- Application Tasks Summary Real-Time Report, page 16-10
- Application Tasks, page 16-12
- Engine Tasks, page 16-13
- Contacts, page 16-13
- Applications, page 16-17
- Sessions, page 16-18
- Datasource Usage, page 16-19
- Overall Unified CCX Stats, page 16-20
- CSQ Unified CCX Stats, page 16-23
- Resource Unified CCX Stats, page 16-27
- Outbound Campaign Unified CCX Stats, page 16-24
- Failover Behavior for Unified CCX Stats, page 16-29

Contacts Summary Real-Time Report

Use the Contacts Summary report to view specific contact information for call contacts, e-mail contacts, HTTP contacts, and total number of contacts.

To access the Contacts Summary real-time report, select Reports > Contacts Summary from the Application Reporting menu bar.
Note: You display the data on this report as numbers or percentages by clicking the Display Value/Display % toggle button.

The following fields are displayed on the Contacts Summary report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active contacts that are currently running.</td>
</tr>
<tr>
<td>Inbound</td>
<td>Number of inbound contacts since the statistics were last reset.</td>
</tr>
<tr>
<td>Outbound</td>
<td>Number of outbound contacts since the statistics were last reset.</td>
</tr>
<tr>
<td>Connected</td>
<td>Number of connected contacts since the statistics were last reset. Provides a total for contacts that are connected to resources (for example, a call connected to an ACD agent).</td>
</tr>
<tr>
<td>Terminated</td>
<td>Number of terminated contacts since the statistics were last reset. This row reports contacts that are ended normally by the application (for example, a caller hangs up and the application terminates), indicating whether the contact was terminated:</td>
</tr>
<tr>
<td></td>
<td>• Locally—On the local server.</td>
</tr>
<tr>
<td></td>
<td>• Remotely—On a remote server in the cluster.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Number of rejected contacts since the statistics were last reset. This row reports contacts that are not accepted and/or processed (as a result, for example, of insufficient resources or the rejection of the contact based on some customer-defined logic). Indicates the reason code for the reject:</td>
</tr>
<tr>
<td></td>
<td>• Channels busy</td>
</tr>
<tr>
<td></td>
<td>• No channel license</td>
</tr>
<tr>
<td></td>
<td>• No trigger</td>
</tr>
</tbody>
</table>

Note: Use the + toggle button to access these statistics.
Application Tasks Summary Real-Time Report

Use the Application Tasks Summary report to display statistics that summarize the activity of specific applications.

To access the Application Tasks Summary real-time report, select Reports > Application Tasks Summary from the Application Reporting menu bar.

The following fields are displayed on the Application Tasks Summary report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aborted</td>
<td>Number of aborted contacts since the statistics were last reset. This row reports contacts improperly ended by a task associated with the application (as when, for example, the system generates an exception or cannot invoke the application because of some error in the application) and includes the associated Java exception code.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Java exception codes are dynamic, as they can be generated from a variety of sources.</td>
</tr>
</tbody>
</table>
Chapter 16  Reporting on Real-Time CRS Data

The Application Reporting User Interface

### Field  Description

**DTMF VB and AA**
Application names configured from the Cisco CRS administration.

**Status**
Displays the failover connection status. The possibilities are: Fully connected, Partially connected, and Not connected. See the following tables for detailed status information for Unified IP IVR and Unified CCX reports.

---

IVR real-time reports obtain data from both nodes in the cluster.

**Note**
Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

Failover in a two-node cluster is available for Unified IP IVR reports as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DTMF VB and AA</td>
<td>Application names configured from the Cisco CRS administration.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the failover connection status. The possibilities are: Fully connected, Partially connected, and Not connected. See the following tables for detailed status information for Unified IP IVR and Unified CCX reports.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Failover Scenario</th>
<th>Connection Status</th>
<th>Node 1 Status</th>
<th>Node 2 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both nodes are up</td>
<td>Fully Connected</td>
<td>Node ID current/start-time</td>
<td>Node ID current/start-time</td>
</tr>
<tr>
<td>Node 1 is up</td>
<td>Partially Connected</td>
<td>Node ID current/start-time</td>
<td>Node ID Not Connected</td>
</tr>
<tr>
<td>Node 2 is down</td>
<td>Partially Connected</td>
<td>Node ID Not Connected</td>
<td>Node ID current/start-time</td>
</tr>
<tr>
<td>Both nodes are down</td>
<td>Not Connected</td>
<td>Node ID Not Connected</td>
<td>Node ID Not Connected</td>
</tr>
</tbody>
</table>

Unified CCX real-time reports obtain data only from the current master node—failover in a two-node cluster is available as described in the following table.

<table>
<thead>
<tr>
<th>Failover Scenario</th>
<th>Connection Status</th>
<th>Node 1 Status</th>
<th>Node 2 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both nodes are up</td>
<td>Fully Connected</td>
<td>Node ID current/start-time</td>
<td>Node ID Not Connected</td>
</tr>
<tr>
<td>Node 1 is master</td>
<td>Fully Connected</td>
<td>Node ID current/start-time</td>
<td>Node ID Not Connected</td>
</tr>
</tbody>
</table>
Chapter 16      Reporting on Real-Time CRS Data

The Application Reporting User Interface

16-12

Cisco Customer Response Solutions Administration Guide, Release 5.0(1)

Application Tasks

Use the Application Tasks real-time report to view information about currently active applications.

To access the Application Tasks report, select Reports > Application Tasks from the Application Reporting menu bar. The following fields are displayed on the Application Tasks report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Unique application task ID.</td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique ID for a server in the cluster.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time when the application task started.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time that the application has been active.</td>
</tr>
</tbody>
</table>

Note

If this report indicates that an application is running for an unusually long time, there may be a problem with the application. The application’s script may not include error handling that prevents infinite retries if a call is no longer present. If the application does not receive a disconnect signal after a call, the application repeatedly retries to locate the call, and causes the application to run for an unusually long time. To prevent this problem, include the proper error handling in the application script.

Node 1 is down
Node 2 is master
Both nodes are down

Failover Scenario | Connection Status | Node 1 Status | Node 2 Status |
------------------|------------------|---------------|---------------|
Node 1 is down    | Fully Connected  | Node ID Not Connected | Node ID current/start-time |
Node 2 is master  |                  |               |               |
Both nodes are down | Not Connected    | Node ID Not Connected | Node ID Not Connected |

Note

If this report indicates that an application is running for an unusually long time, there may be a problem with the application. The application’s script may not include error handling that prevents infinite retries if a call is no longer present. If the application does not receive a disconnect signal after a call, the application repeatedly retries to locate the call, and causes the application to run for an unusually long time. To prevent this problem, include the proper error handling in the application script.
Engine Tasks

Use the Engine Tasks real-time report to view information about currently active Engine tasks.

To access the Engine Tasks report, select Reports > Engine Tasks from the Application Reporting menu bar.

The following fields are displayed on the Engine Tasks report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Unique identifier of the engine task. If the engine task is the main task</td>
</tr>
<tr>
<td></td>
<td>running the application and the parent ID is empty, its identifier will</td>
</tr>
<tr>
<td></td>
<td>match the Application Task Identifier.</td>
</tr>
<tr>
<td>Parent ID</td>
<td>Unique identifier for the parent of the engine task (if any).</td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique identifier for a server in the cluster.</td>
</tr>
<tr>
<td>Server IP Address</td>
<td>IP address identifying the server in the cluster.</td>
</tr>
<tr>
<td>Script</td>
<td>Name of the script that is running the task (if the task is running a Cisco</td>
</tr>
<tr>
<td></td>
<td>CRS script).</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time that the task started.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time the task has been active.</td>
</tr>
</tbody>
</table>

Contacts

Use the Contacts real-time report to view information for all the active contacts for all servers across clusters.

*Note* Support for High Availability, remote servers, and expansion servers is only available in multiple-server deployments.

To access the Contacts report, select Reports > Contacts from the Application Reporting menu bar.
The following fields are displayed on the Contacts report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Unique identifier representing a contact.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact: Unified CM Telephony call, Cisco agent call, or Cisco HTTP Contact.</td>
</tr>
<tr>
<td>Impl ID</td>
<td>Unique identifier provided by the particular type of contact. For example, for a call contact, this identifier would represent the Unified CM global call ID.</td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique identifier for a server in the cluster.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time stamp when the contact was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time that the contact is active.</td>
</tr>
<tr>
<td>Handled</td>
<td>If True, the contact is handled; if False, the contact is not handled.</td>
</tr>
<tr>
<td>Aborting</td>
<td>If True, the contact is aborted with a default treatment; if False, the contact is not aborted.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application currently managing the contact.</td>
</tr>
<tr>
<td>Task</td>
<td>Unique identifier of the application task that is currently responsible for the contact.</td>
</tr>
<tr>
<td>Session</td>
<td>Unique identifier of the session currently managing the contact (if any).</td>
</tr>
</tbody>
</table>

You can access detailed information about specific contacts listed on the Contacts web page by performing one of the following procedures:

- Accessing Detailed Call Contact Information, page 16-14
- Accessing Detailed E-mail Contact Information, page 16-15
- Accessing Detailed HTTP Contact Information, page 16-16

**Note**
The information displayed is dependent on the type of contact selected. Depending on the type of call, some fields may not be supported and will appear blank.

**Accessing Detailed Call Contact Information**

Use the Call Contacts Detailed Info real-time report to view all information related to the call contact.
To access the Call Contacts Detailed Info report, right-click a specific call contact record on the Contacts report; information for that specific record displays.

The following fields are displayed on the Call Contacts Detailed Info report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the contact.</td>
</tr>
<tr>
<td>Inbound</td>
<td>If True, this call was received by the CRS server; if False, this call was placed as an outbound call by an application.</td>
</tr>
<tr>
<td>Language</td>
<td>The selected language context of the call.</td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier of the associated application.</td>
</tr>
<tr>
<td>Called Number</td>
<td>Called number for this call leg from the perspective of the called party.</td>
</tr>
<tr>
<td>Dialed Number</td>
<td>Dialed number for this call leg from the perspective of the calling party.</td>
</tr>
<tr>
<td>Calling Number</td>
<td>Calling number of the originator of this call.</td>
</tr>
<tr>
<td>ANI</td>
<td>Automatic number identification.</td>
</tr>
<tr>
<td>DNIS</td>
<td>Dialed number identification service.</td>
</tr>
<tr>
<td>CLID</td>
<td>Caller ID.</td>
</tr>
<tr>
<td>Arrival Type</td>
<td>Information on how the call contact arrived in the system.</td>
</tr>
<tr>
<td>Last Redirected Number</td>
<td>Number from which the last call diversion or transfer was invoked.</td>
</tr>
<tr>
<td>Original Called Number</td>
<td>Originally called number.</td>
</tr>
<tr>
<td>Original Dialed Number</td>
<td>Originally dialed number.</td>
</tr>
<tr>
<td>ANI Digits</td>
<td>Automatic Number Identification information indicator digit codes.</td>
</tr>
<tr>
<td>CED</td>
<td>Entered digits that were gathered by the network before the call was received.</td>
</tr>
</tbody>
</table>

**Note**  Calls running Unified ICME applications are also reported here.

**Accessing Detailed E-mail Contact Information**

Use the Email Detailed Info real-time report to view all information related to the e-mail contact.

To access the Email Detailed Info report, right-click a specific e-mail contact record on the Contacts report; information for that specific record displays.
The following fields are displayed on the Email Detailed Info report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the contact.</td>
</tr>
<tr>
<td>Inbound</td>
<td>If True, this e-mail message was received by the CRS server; if False, this e-mail was created by an application.</td>
</tr>
<tr>
<td>Note</td>
<td>Inbound e-mails are not currently supported.</td>
</tr>
<tr>
<td>Language</td>
<td>Selected language context of the e-mail message.</td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier of the associated application.</td>
</tr>
<tr>
<td>From</td>
<td>Sender of this e-mail message.</td>
</tr>
<tr>
<td>To</td>
<td>All the recipients of this e-mail message.</td>
</tr>
<tr>
<td>Subject</td>
<td>“Subject” field of this e-mail message.</td>
</tr>
<tr>
<td>Attachments</td>
<td>List of all attachments (file names) associated with this e-mail message.</td>
</tr>
</tbody>
</table>

**Accessing Detailed HTTP Contact Information**

Use the HTTP Detailed Info real-time report to view all information related to the HTTP contact.

To access the HTTP Detailed Info report, right-click a specific HTTP contact record in the Contacts report; information for that specific record displays.

The following fields are displayed on the HTTP Detailed Info report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the contact.</td>
</tr>
<tr>
<td>Inbound</td>
<td>If True, this HTTP request was received by the CRS server; if False, this HTTP request was created by an application.</td>
</tr>
<tr>
<td>Note</td>
<td>This information will always be reported as True, because the CRS server does not currently track outbound HTTP requests in this way.</td>
</tr>
<tr>
<td>Language</td>
<td>Language currently associated with the HTTP request.</td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier of the associated application.</td>
</tr>
<tr>
<td>Authentication Type</td>
<td>Name of the authentication scheme used to protect the servlet; for example, “BASIC” or “SSL.”</td>
</tr>
</tbody>
</table>
## Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Character Encoding | Length, in bytes, of the request body, which is made available by the input stream, or -1 if the length is not known.  
  **Note** This length is the same as the value of the CGI variable CONTENT_LENGTH. |
| Content Length   | MIME type of the body of the request, or null if the type is not known.  
  **Note** This is the same as the value of the CGI variable CONTENT_TYPE. |
| Content Type     | Type of HTTP contact request. |
| Request Language | Preferred language for client content (the language that the client accepts for its content), based on the Accept-Language header. |
| Path Info        | Any extra path information associated with the URL the client sent when the HTTP request was made. |
| Protocol         | Name and version of the protocol the request uses in the form:  
  protocol/majorVersion.minorVersion; for example, HTTP/1.1  
  **Note** This value is the same as the value of the CGI variable SERVER_PROTOCOL. |
| Remote Address   | IP address of the client that sent the request  
  **Note** This value is the same as the value of the CGI variable REMOTE_ADDR. |
| Remote Host      | Fully qualified name of the client that sent the request, or the IP address of the client, if the name cannot be determined  
  **Note** This value is the same as the value of the CGI variable REMOTE_HOST. |
| Remote User      | Login of the user making this request, if the user has been authenticated. |
| Requested Session ID | HTTP session ID as specified by the client. |
| Request URL      | Section of the URL of the HTTP request, from the protocol name up to the query string in the first line of the HTTP request. |

1. CGI = Common Gateway Interface

### Applications

Use the Applications real-time report to view all the applications loaded on the server.
To access the Applications report, select **Reports > Applications** from the Application Reporting menu bar.

The following fields are displayed on the Applications report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the currently loaded application.</td>
</tr>
<tr>
<td>ID</td>
<td>Application ID.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of application that is currently running (for example, a Cisco Script Application).</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the application as entered on the CRS Administration web site.</td>
</tr>
<tr>
<td>Enabled</td>
<td>If True, the application is enabled; if False, the application is disabled.</td>
</tr>
<tr>
<td>Max. Sessions</td>
<td>Maximum number of simultaneous task instances that can run simultaneously on the CRS server.</td>
</tr>
<tr>
<td>Valid</td>
<td>If True, the application is valid; if False, the application is invalid.</td>
</tr>
</tbody>
</table>

1. An application is valid if it was successfully loaded and initialized from its configuration. At any time, an application can become invalid if it internally fails to be refreshed.

**Sessions**

Use the Sessions real-time report to view real-time information on all the active sessions.

To access the Sessions report, select **Reports > Sessions** from the Application Reporting menu bar.

The following fields are displayed on the Sessions report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Session ID. This identifier is guaranteed to remain unique for a period of 12 months.</td>
</tr>
<tr>
<td>Mapping ID</td>
<td>User- or system-defined identifier that maps to this session.</td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique identifier for a server in the cluster.</td>
</tr>
<tr>
<td>Parent</td>
<td>Sessions that were created as a result of consult calls propagated in the system.</td>
</tr>
<tr>
<td>Creation Time</td>
<td>Creation time of the session.</td>
</tr>
</tbody>
</table>
Datasource Usage

Datasource Usage

Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Name of the data source, as configured through the CRS Administration web interface.</td>
</tr>
<tr>
<td>Available Connections</td>
<td>Number of connections available.</td>
</tr>
<tr>
<td>Busy Connections</td>
<td>Number of busy connections.</td>
</tr>
<tr>
<td>Note</td>
<td>Busy + available = Maximum number of connections configured.</td>
</tr>
<tr>
<td>Checkouts Granted</td>
<td>Number of times the database connections have been used up since the statistics were last reset.</td>
</tr>
<tr>
<td>Checkouts Denied</td>
<td>Number of times the Database connections have been denied since the statistics were last reset.</td>
</tr>
</tbody>
</table>
Overall Unified CCX Stats

Use the Overall Unified CCX Stats real-time report to view real-time Unified CCX resource and call information.

**Note**

Unified CCX reports contain information for calls that have been queued in one or more CSQs. If a call is not queued (for example, the caller hangs up before being queued), the reports do not display data for that call.

Cisco CRS reports retrieve the following statistics:
- Unified CCX statistics from the current Master node.
- Unified IP IVR statistics from all nodes in the cluster.

To access the Overall Unified CCX Stats report, select **Reports > Overall Unified CCX Stats** from the Application Reporting menu bar.

**Note**

Outbound durations are updated when the outbound call disconnects and all agents (resources) involved in the call move out of the work and/or talking state.

The following fields are displayed on the Overall Unified CCX Stats report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resource Information</strong></td>
<td></td>
</tr>
<tr>
<td>CSQs</td>
<td>Number of CSQs currently configured. If a CSQ is added or removed, this statistic reflects that change.</td>
</tr>
<tr>
<td>Logged-in Resources</td>
<td>Number of resources currently logged in.</td>
</tr>
<tr>
<td>Talking Resources</td>
<td>Number of resources currently talking.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> This number includes resources in Talking, Work, and Reserved states.</td>
</tr>
<tr>
<td>Ready Resources</td>
<td>Number of resources currently ready.</td>
</tr>
<tr>
<td>Not Ready Resources</td>
<td>Number of resources currently not ready.</td>
</tr>
<tr>
<td><strong>Call Information — Inbound</strong></td>
<td></td>
</tr>
</tbody>
</table>
### The Application Reporting User Interface

#### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Total Contacts         | Number of total contacts that have arrived since the statistics were last reset.  
                        | This includes contacts that are waiting, contacts connected to a resource, and  
                        | contacts that have disconnected.                                             |
|                        | If a resource transfers to or conferences with a route point, this value      |
|                        | increases.                                                                  |
| Contacts Waiting       | Number of contacts waiting to be connected to a resource.                    |
|                        | **Note** A contact is shown as waiting until the call is answered by the agent.  
                        | This means that, even if the phone is ringing at the agent, the contact       |
|                        | will still show as waiting in RTR.                                           |
| Contacts Handled       | Number of contacts that have been handled by a resource.                     |
| Oldest Call in Queue   | Displays the wait time for the oldest contact in the queue.                  |
| Contacts Abandoned     | Number of contacts that have arrived and disconnected before being         |
|                        | connected to a resource.                                                    |
| Avg Talk Duration      | Average duration (in seconds) that resources spend talking on Unified CCX    |
|                        | contacts. Talk duration starts when a contact first connects to a resource and |
|                        | ends when the contact disconnects from the last resource to which it was      |
|                        | connected. Talk duration does not include hold time.                         |
| Avg Wait Duration      | Average wait time (in seconds). It begins when the contact enters the system |
|                        | and ends when the contact stops waiting. Wait duration does not include hold  |
|                        | time. The time a contact spends on a CTI port prior to getting queued is     |
|                        | included in this report.                                                    |
| Longest Talk Duration  | Longest talk duration (in seconds) of a contact. Talk duration does not include |
|                        | hold time.                                                                  |
| Longest Wait Duration  | Longest wait (in seconds) for a contact to be connected to a resource. Wait   |
|                        | duration does not include hold time.                                         |

#### Call Information — Outbound

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Total number of outbound calls currently previewed or connected to agents.</td>
</tr>
</tbody>
</table>
| Preview    | Total number of outbound calls currently previewed but have not been accepted,  
                        | rejected. or closed by the agents.                                           |
| Connected  | Total number of Outbound calls currently connected to agents. When an agent   |
|            | conferences in other agents, the call is counted once towards the total number  
|            | of connected calls.                                                         |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offered</td>
<td>Total number of outbound calls offered. A call is considered offered when it is presented to an agent. A contact that is presented to an agent, skipped/rejected by that agent, and then presented to the same agent or to another agent is counted twice towards the number of calls offered. Offered = Accepted + Rejected + Closed + Timed-out.</td>
</tr>
<tr>
<td>Accepted</td>
<td>Total number of outbound calls accepted. A call is considered accepted if an agent has clicked Accept when presented the call. A call that is presented to an agent, skipped/rejected by that agent, presented to another agent, and then accepted by that other agent is counted once towards the number of calls accepted.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The number of outbound calls that were skipped or rejected by an agent. This means that the agent selected Reject, Skip, or Cancel Reservation. These contacts will be dialed again. If a contact is rejected by multiple agents, this field is increments each time the contact is rejected. The number of Rejected is also incremented each time an agent drops the preview call while it is ringing at the customer's contact.</td>
</tr>
<tr>
<td>Closed</td>
<td>The number of outbound contacts that were closed by agents. This means that the agent selected Skip-Close or Reject-close. These contacts will not be dialed again.</td>
</tr>
<tr>
<td>Timed-Out</td>
<td>Total number of outbound calls that timed out. A call is considered timed out when it is presented to an agent and not accepted, rejected, or closed within the allocated time. These contacts will be dialed again. If a contact timed out multiple agents, this field is incremented each time the contact is timed out for each agent.</td>
</tr>
<tr>
<td>Invalid Number</td>
<td>The number of outbound calls that were dialed to an invalid number. This means that the agent accepted the call (by clicking Accept), got connected to the customer, and selected the Invalid Number option from the contact Reclassification drop down. It also includes the number of outbound calls that failed at the network level. <strong>Note</strong>: The agent can manually reclassify the contact as Invalid Number while the customer contact is on the call or when the agent has gone into the Work state after the call.</td>
</tr>
<tr>
<td>Voice</td>
<td>The number of outbound calls that ended in successful customer contact. This means that an agent accepted the call (by clicking Accept) and selected a classification of Voice (default) or Do Not Call for this contact.</td>
</tr>
</tbody>
</table>
Chapter 16  Reporting on Real-Time CRS Data

The Application Reporting User Interface

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answering Machine</td>
<td>The number of outbound calls that connected to an answering machine for this campaign. This means that the agent accepted the call (by clicking Accept), got connected to the answering machine and selected the Answering Machine option from the contact Reclassification drop down.</td>
</tr>
<tr>
<td>Note</td>
<td>The agent can manually reclassify the contact as Answering Machine while the customer contact is on the call or when the agent has gone into the Work state after the call.</td>
</tr>
<tr>
<td>Requested Callback</td>
<td>The number of contacts marked for callback. This means that the agent accepted the call (by clicking Accept), got connected to the contact. The contact requested a callback and the agent selected the CallBack option. A call that is accepted by an agent, marked for callback, later presented to and accepted by another agent (at the callback time), and marked for callback again is counted twice towards the number of callback calls.</td>
</tr>
<tr>
<td>Avg Talk Duration</td>
<td>The average time in HH:MM:SS (hours, minutes, seconds) that agents spend talking on outbound calls. The durations consider all calls that were Agent Accepted and classified as Voice. If an Outbound call is transferred or conferenced to a route point, this average outbound talk duration does not include the talk time of agents who handle the call after it came through the route point. Instead, the talk time is included in the inbound talk duration.</td>
</tr>
<tr>
<td>Longest Talk Duration</td>
<td>The longest talk duration of an outbound call in HH:MM:SS (hours, minutes, seconds). The durations consider all calls that were Agent Accepted and classified as Voice.</td>
</tr>
</tbody>
</table>

### CSQ Unified CCX Stats

Use the CSQ Unified CCX Stats real-time report to view real-time information.

<table>
<thead>
<tr>
<th>Note</th>
<th>Unified CCX reports contain information for calls that have been queued in one or more CSQs. If a call is not queued, the reports do not display data for that call.</th>
</tr>
</thead>
</table>

To access the CSQ Unified CCX Stats report, select Reports > CSQ Unified CCX Stats from the Application Reporting menu bar.
The following fields are displayed on the CSQ Unified CCX Stats report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the CSQ.</td>
</tr>
<tr>
<td>Talking/Ready Resources/Not Ready Resources/Logged-In Resources</td>
<td>Number of resources who are in the talking, ready, and not ready states, and the number of resources logged in for this CSQ. Values for the four items are separated by colons. Values are displayed in the same order that the items appear in the column heading. <strong>Note</strong> This number includes resources in Talking, Work, and Reserved states.</td>
</tr>
<tr>
<td>Total Contacts</td>
<td>Number of total contacts since the statistics were last reset for this CSQ.</td>
</tr>
<tr>
<td>Contacts Waiting</td>
<td>Number of contacts waiting to be connected to a resource in this CSQ. This column also displays how long the oldest contact has been waiting.</td>
</tr>
<tr>
<td>Contacts [oldest contact in queue]</td>
<td>Duration of longest currently waiting contact.</td>
</tr>
<tr>
<td>Contacts Handled</td>
<td>Number of contacts that have been handled by this CSQ.</td>
</tr>
<tr>
<td>Contacts Abandoned</td>
<td>Number of contacts that have been abandoned by this CSQ.</td>
</tr>
<tr>
<td>Contacts Dequeued</td>
<td>Number of contacts that have been dequeued from this CSQ.</td>
</tr>
<tr>
<td>Avg Talk Duration</td>
<td>Average time (in seconds) agents in this CSQ spent talking to contacts.</td>
</tr>
<tr>
<td>Avg Wait Duration</td>
<td>Average wait time (in seconds). It begins when the call was queued (when you execute the “Select Resource” step) and ends when the call reaches the agent. Wait duration does not include hold time. The time a contact spends on a CTI port prior to getting queued is not included in this wait time.</td>
</tr>
<tr>
<td>Longest Talk Duration</td>
<td>Longest time (in seconds) agents in this CSQ spend talking to contacts.</td>
</tr>
<tr>
<td>Longest Wait Duration</td>
<td>Longest wait (in seconds) for a contact to be connected to a resource.</td>
</tr>
</tbody>
</table>

**Outbound Campaign Unified CCX Stats**

Use the Outbound Campaign Unified CCX Stats real-time report to view real-time Unified Contact CCX information for the Outbound preview dialer.

To access the Outbound Campaign Unified CCX Stats report, select **Reports > Outbound Campaign Unified CCX Stats** from the Application Reporting menu bar.
The following fields are displayed on the Outbound Campaign Unified CCX Stats report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign</td>
<td>The name of the campaign.</td>
</tr>
<tr>
<td>Status</td>
<td>The current activation state of the campaign:</td>
</tr>
<tr>
<td></td>
<td>• Running: an active campaign</td>
</tr>
<tr>
<td></td>
<td>• Stopped: an inactive campaign</td>
</tr>
<tr>
<td>Active</td>
<td>Total number of outbound calls currently previewed by or connected to agents for this campaign.</td>
</tr>
<tr>
<td>Preview</td>
<td>Total number of outbound calls currently previewed but have not been accepted, rejected or closed by the agents as part of this campaign.</td>
</tr>
<tr>
<td>Connected</td>
<td>Total number of outbound calls currently connected to agents for this campaign.</td>
</tr>
<tr>
<td></td>
<td>When an agent conferences in other agents, the call is counted once towards the total number of connected calls.</td>
</tr>
<tr>
<td>Offered</td>
<td>Total number of outbound calls offered for this campaign.</td>
</tr>
<tr>
<td></td>
<td>A call is considered offered when it is presented to an agent as part of this campaign.</td>
</tr>
<tr>
<td></td>
<td>A contact that is presented to an agent, skipped/rejected by that agent, and then presented to the same agent or to another agent is counted twice towards the number of calls offered. Offered = Accepted + Rejected + Closed + Timed-out.</td>
</tr>
<tr>
<td>Accepted</td>
<td>Total number of outbound calls accepted for this campaign.</td>
</tr>
<tr>
<td></td>
<td>A call is considered accepted if an agent has clicked Accept when presented the call.</td>
</tr>
<tr>
<td></td>
<td>A call that is presented to an agent, skipped/rejected by that agent, presented to another agent, and then accepted by that other agent is counted once towards the number of calls accepted.</td>
</tr>
<tr>
<td>Rejected</td>
<td>The number of outbound calls that were skipped or rejected by an agent as part of this campaign.</td>
</tr>
<tr>
<td></td>
<td>This means that the agent selected Reject, Skip, or Cancel Reservation.</td>
</tr>
<tr>
<td></td>
<td>These contacts will be dialed again. If a contact is rejected by multiple agents, this field is increments each time the contact is rejected.</td>
</tr>
<tr>
<td></td>
<td>The number of Rejected is also incremented each time an agent drops the preview call while it is ringing at the customer’s contact.</td>
</tr>
<tr>
<td>Closed</td>
<td>The number of outbound contacts that were closed by agents as part of this campaign.</td>
</tr>
<tr>
<td></td>
<td>This means that the agent selected Skip-Close or Reject-close. These contacts will not be dialed again.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Timed-Out</strong></td>
<td>Total number of outbound calls that timed out. A call is considered timed out when it is presented to an agent and not accepted, rejected, or closed within the allocated time. These contacts will be dialed again. If a contact times out for multiple agents, this field is incremented each time the contact is timed out for each agent.</td>
</tr>
<tr>
<td><strong>Invalid Number</strong></td>
<td>The number of outbound calls that were dialed to an invalid number for this campaign. This means that the agent accepted the call (by clicking Accept), got connected to the customer, and selected the “Invalid Number” option from the contact Reclassification drop down. It also includes the number of outbound calls that failed at the network level. <strong>Note</strong> The agent can manually reclassify the contact as Invalid Number while the customer contact is on the call or when the agent has gone into the Work state after the call.</td>
</tr>
<tr>
<td><strong>Voice</strong></td>
<td>The number of outbound calls that ended in successful customer contact. This means that an agent accepted the call (by clicking Accept) and selected a classification of Voice or Do Not Call for this contact.</td>
</tr>
<tr>
<td><strong>Answering Machine</strong></td>
<td>The number of outbound calls that connected to an answering machine for this campaign. This means that the agent accepted the call (by clicking Accept), got connected to the answering machine and selected the Answering Machine option from the contact Reclassification drop down. <strong>Note</strong> The agent can manually reclassify the contact as Answering Machine while the customer contact is on the call or when the agent has gone into the Work state after the call.</td>
</tr>
<tr>
<td><strong>Requested Callback</strong></td>
<td>The number of contacts marked for callback for this campaign. This means that the agent accepted the call (by clicking Accept), got connected to the contact. The contact requested a callback and the agent selected the CallBack option. A call that is accepted by an agent, marked for callback, later presented to and accepted by another agent (at the callback time), and marked for callback again is counted twice towards the number of callback calls.</td>
</tr>
</tbody>
</table>
Chapter 16: Reporting on Real-Time CRS Data

The Application Reporting User Interface

Resource Unified CCX Stats

Use the Resource Unified CCX Stats real-time report to view real-time Unified Contact CCX resource information.

To access the Resource Unified CCX Stats report, select Reports > Resource Unified CCX Stats from the Application Reporting menu bar.

The following fields are displayed on the Resource Unified CCX Stats report:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (ID)</td>
<td>Unique identifier of the resource.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the resource.</td>
</tr>
<tr>
<td>Duration in State</td>
<td>Length of time (in seconds) the resource has remained in the current state.</td>
</tr>
<tr>
<td>Contacts Presented</td>
<td>Number of contacts that have been connected to this resource.</td>
</tr>
<tr>
<td>Contacts Handled</td>
<td>Number of contacts that have been handled by this resource. Adam.</td>
</tr>
<tr>
<td>Avg Talk Duration</td>
<td>Average time (in seconds) that this resource spends talking to contacts.</td>
</tr>
<tr>
<td>Avg Hold Duration</td>
<td>Average time (in seconds) that the resource keeps contacts on hold.</td>
</tr>
<tr>
<td>Longest Talk Duration</td>
<td>Longest time (in seconds) that this resource has spent talking to a contact.</td>
</tr>
<tr>
<td>Longest Hold Duration</td>
<td>Longest time (in seconds) that this resource has placed a call on hold.</td>
</tr>
<tr>
<td>Outbound Offered</td>
<td>Total number of outbound calls offered to this resource. A call is considered offered when it is presented to an agent. A contact that is presented to an agent, skipped/rejected by that agent, and then presented to the same agent or to another agent is counted twice towards the number of calls offered. Offered = Accepted + Rejected + Closed + Timed-out.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outbound Accepted</td>
<td>Total number of outbound calls accepted by this resource. A call is considered accepted if an agent has clicked Accept when presented the call. A call that is presented to an agent, skipped/rejected by that agent, presented to another agent, and then accepted by that other agent is counted once towards the number of calls accepted. For transferred or conferenced outbound calls, the call is considered handled by the resource if it is answered by that resource.</td>
</tr>
<tr>
<td>Outbound Rejected</td>
<td>The number of outbound calls that were skipped or rejected by this agent. This means that the agent selected Reject, Skip, or Cancel Reservation. These contacts will be dialed again. The number of Rejected is also incremented each time an agent drops the preview call while it is ringing at the customer’s contact.</td>
</tr>
<tr>
<td>Outbound Closed</td>
<td>The number of outbound contacts that were closed by this agent. This means that the agent selected Skip-Close or Reject-close. These contacts will not be dialed again.</td>
</tr>
<tr>
<td>Outbound Timed-Out</td>
<td>Total number of outbound calls that timed out. A call is considered timed out when it is presented to an agent and not accepted, rejected, or closed within the allocated time. These contacts will be dialed again. If a contact timed out for multiple agents, this field is incremented each time the contact is timed out for each agent.</td>
</tr>
<tr>
<td>Outbound Voice</td>
<td>The number of outbound calls that ended in successful customer contact for this resource. This means that the agent accepted the call (by clicking Accept) and selected a classification of Voice or Do Not Call for this contact.</td>
</tr>
<tr>
<td>Outbound Avg Talk Duration</td>
<td>The average time in HH:MM:SS (hours, minutes, seconds) that agents spend talking on outbound calls. The durations consider all calls that were Agent Accepted and classified as Voice. This talk duration includes talk time spent by a resource handling an outbound call that was transferred or conferenced to a route point.</td>
</tr>
<tr>
<td>Outbound Avg Hold Duration</td>
<td>The longest time in HH:MM:SS (hours, minutes, seconds) that the Resource has spent holding an outbound call among accepted calls. The durations consider all calls that were Agent Accepted and classified as Voice.</td>
</tr>
</tbody>
</table>
Failover Behavior for Unified CCX Stats

All failovers, regardless of whether the CRS engine is restarted, will cause the Unified CCX stats to reset.

The Unified IP IVR stats do not reset in all cases if the CRS engine is not restarted on a node. However, the node loses its active server status. The Unified IP IVR stats on that node will not be reset.

The Tools Menu

The Tools menu gives you access to the following Application Reporting tools:

- **Reset All Stats**—Choose this option to reset all statistics.
- **Refresh Connections**—Choose this option to refresh connections with the CRS system.

This section contains the following topics:

- The Reset All Statistics Menu Option, page 16-29
- The Refresh Connections Menu Option, page 16-30

The Reset All Statistics Menu Option

Use the Reset All Stats option to reset all statistics accumulated since the last time the statistics were reset. It will not reset active statistics, such as active contacts, tasks, and so on.

Note

The CRS system automatically resets all statistics each day at midnight.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outbound Longest Talk Duration</td>
<td>The longest time in HH:MM:SS (hours, minutes, seconds) that an agent has spent talking on an outbound call. The durations consider all calls that were Agent Accepted and classified as Voice.</td>
</tr>
<tr>
<td>Outbound Longest Hold Duration</td>
<td>The average time in HH:MM:SS (hours, minutes, seconds) that the Resource spend talking the outbound calls among accepted calls. The durations consider all calls that were Agent Accepted and classified as Voice.</td>
</tr>
</tbody>
</table>
To reset all statistics, select **Tools > Reset All Statistics** from the Application Reporting menu bar. The CRS system resets all statistics.

### The Refresh Connections Menu Option

To refresh connections with the CRS system, select **Tools > Refresh Connections** from the Application Reporting menu bar. The CRS system refreshes all connections.

### The Views Menu

The Views menu allows you to access more detailed information for four reports: The Application Tasks report, the Contacts report, the Applications report, and the Sessions report.

**Note**

For some reports, detailed information is also available by right-clicking a record in that report.

The Views menu contains different options, depending on the report you have chosen. Possible options are:

- **Contacts by Application Task ID**—Choose this option to view contacts according to Application Task ID numbers.
- **Engine Tasks by Application Task ID**—Choose this option to view Engine tasks according to Application Task ID numbers.
- **Detailed Info**—Choose this option to view more detailed information on selected reports.
- **Application Tasks by Application Name**—Choose this option to view application tasks by application name.
- **Contacts by Session ID**—Choose this option to view contacts by session ID.

This section contains the following topics:

- Application Tasks, page 16-31
- Contacts, page 16-31
- Applications, page 16-31
Application Tasks

When you use the Views options with the Application Tasks reports, the Views menu contains the following options:

- Contacts by Application Task ID, page 16-31
- Engine Tasks by Application Task ID, page 16-31

Contacts by Application Task ID

This report displays the same report as the Contact report (see the “Contacts” section on page 16-13,) with the exception that the Contacts by Application Task ID report has been filtered using only the contact currently being managed by the selected application task.

Engine Tasks by Application Task ID

This report displays the same report as the Engine Task reports (see the “Engine Tasks” section on page 16-13,) except that the Engine Tasks by Application Task ID report has been filtered to display only the engine tasks that are associated with the application task.

Contacts

When you use the Views options with the Contacts report, the Views menu contains only the Detailed Info option.

The Detailed Info option provides various detailed information, depending on the type of contact selected. For example, if the contact is a call, the Calling Party number, the Called Number, and so on, are displayed for that particular call.

For more information, please see the “Accessing Detailed Call Contact Information” section on page 16-14.

Applications

When you use the Views options with the Application reports, the Views menu contains only the Application Tasks by Application Name option.
The Application Task By Application Name report displays the same report as the Application Task report (see Application Tasks, page 16-31), except that the Application Task By Application Name report is filtered using only the active application tasks associated with this application.

**Sessions**

When you use the Views options with the Session reports, the Views menu contains the following options:

- **Contacts By Session ID**, page 16-32
- **Detailed Info**, page 16-32

**Contacts By Session ID**

This report displays the same report as the Contact report (see the “Contacts” section on page 16-13,) with the exception that the Contacts By Session ID report is filtered using only the contacts associated with the selected session.

**Detailed Info**

Detailed info displays the time the session was created and its current state.

**The Settings Menu**

The Settings menu of the Application Reporting menu bar allows you to adjust various settings of the Real Time Reporting tool.

The Settings menu contains the following menu options:

- **Options**—Choose this option to set the polling (refresh) interval times and to set the amount of times the server will attempt to reconnect.
- **Window**—Choose this option to display reports in colors based on your Windows settings.
- **Motif**—Choose this option to display reports in purple and menu items in brown.
- **Metal**—Choose this option to display reports in grey and menu items in black.
This section contains the following topic:

- The Options Menu Option, page 16-33

**The Options Menu Option**

Choose **Settings > Options** to access the Options dialog box. Use the Options dialog box to set the polling (refresh) interval time, set the number of times the server will attempt to reconnect, and specify whether logged off agents appear in reports.

The following fields are displayed in the Options dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polling Interval</td>
<td>Time between two requests to the server for new statistics by the client.</td>
</tr>
<tr>
<td>Server Connect Retry Count</td>
<td>The number of times that the CRS Administration web interface should attempt to reconnect to the CRS server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If an error occurs, an Error dialog box opens to alert you that the server is not communicating with the web interface.</td>
</tr>
<tr>
<td>Show Logged Off Resources</td>
<td>Specifies whether logged off agents appear in reports.</td>
</tr>
</tbody>
</table>

Click **Apply** to submit configuration changes.
Using the Cisco CRS Supervisor and Cisco CRS User Options Plug-Ins

The following sections provide detailed information on the additional plug-in options provided by the Cisco CRS platform.

- About User Management, page 17-2
- About Cisco CRS User Capabilities, page 17-2
- Using the CRS Supervisor Web Interface, page 17-6
- Using the CRS User Options Web Interface, page 17-9

Related Topics
- Accessing the CRS Administration Web Interface, page 2-2
About User Management

In earlier versions of Cisco CRS, many user parameters like user ID, password, and pin were configured from the Unified CM Administrator. Some Cisco CRS-related user parameters were configured through the CRS Administration.

Effective Cisco CRS, Release 5.0, all Cisco CRS user roles (capabilities) are consolidated into one User Configuration area.

In Cisco CRS versions supporting Unified CME, the user configuration and management is entirely done by Cisco CRS. Therefore, in addition to consolidating all user management under one menu, Cisco CRS users are managed from within the same menu.

The user information for each product is stored in different locations:

- The Unified CM user details are stored in the Unified CM database.
- The Unified CME user details are stored in the Cisco CRS Database.

Related Topics

- About Cisco CRS User Capabilities, page 17-2
- Administrator Privileges, page 17-3
- Supervisor Privileges, page 17-3
- Historical Report User Privileges, page 17-4
- Agent Privileges, page 17-5

About Cisco CRS User Capabilities

The capability for each user refers to the Cisco CRS access level assigned for each user. Cisco CRS users can be assigned to one of four roles (or capabilities): Administrator, Supervisor, Historical Report User, or Agent. Each of these roles are described in this section.

Related Topics

- About User Management, page 17-2
- Administrator Privileges, page 17-3
- Supervisor Privileges, page 17-3
Administrator Privileges

A Cisco CRS Administrator is a user with complete access to the CRS Administration and has the authority to configure the entire system. An Administrator can also be assigned a combination of other roles.

The Administrator can turn on/off the authority of a Supervisor to manage the teams and agents.

Related Topics

- The Administrator Capability View, page 22-14
- About User Management, page 17-2
- About Cisco CRS User Capabilities, page 17-2
- Supervisor Privileges, page 17-3
- Historical Report User Privileges, page 17-4
- Agent Privileges, page 17-5

Supervisor Privileges

Effective Cisco CRS Release 5.0, supervisors can additionally modify and view skills, view the list of all teams for which this user is the supervisor, view the skills, CSQs, and resource groups configured in this system, view and manage resources, and configure the teams managed by the supervisor.

Cisco CRS, provides three types of Supervisors:

- Application Supervisor: A basic supervisor role applicable to a Cisco CRS Application server without a Unified CCX license. An application supervisor can only view reports.
- ACD Supervisor: A supervisor with an agent’s role. This role is applicable to a Cisco CRS Application server with any Unified CCX license. An ACD supervisor can administer teams/agents and also view reports.
• Remote Monitoring Supervisor: An application supervisor role with all numeric characters in the assigned user ID. This role is applicable to a Cisco CRS Application server with only a Unified CCX Premium license. This role is not available for Unified CME users. In addition to viewing reports, this supervisor can also view the list of agents and CSQs being monitored.

Depending on the license allowed, Cisco CRS Supervisors have the following privileges:

• Download and install the Real Time Reporting client and Historical Reporting client to view reports.
• View agents and CSQ being monitored. This is only for a remote Supervisor.
• Download and install the Supervisor Desktop and the Agent Desktop.
• View the list of all Teams for which this user is the Supervisor.
• Configure the Teams managed by the Supervisor.
• View the Skills, CSQs and Resource Groups configured in this system.
• View and manage all the resources.

Related Topics
• About User Management, page 17-2
• About Cisco CRS User Capabilities, page 17-2
• Administrator Privileges, page 17-3
• Historical Report User Privileges, page 17-4
• Agent Privileges, page 17-5
• Using the CRS Supervisor Web Interface, page 17-6
• The Supervisor Capability View, page 22-14

Historical Report User Privileges

A user with a historical report client role can view various historical reports. The number and types of reports allowed to be viewed depends on the licenses available on a given Cisco CRS system.

Generally, a Historical Report User has the following privileges:

• Download and install the Agent Desktop.
• Configure alternate pronunciations for their name.

For Unified CM, Cisco CRS users are also Unified CM end users and are managed by Unified CM entirely.

Unified CME users are configured and management by Cisco CRS. Therefore, in addition to the general privileges, a CRS Application User has the following additional:

• Change password
• Change the pin
• Upload the Spoken Name

Related Topics
• The Reporting Capability View, page 22-15
• About User Management, page 17-2
• About Cisco CRS User Capabilities, page 17-2
• Administrator Privileges, page 17-3
• Supervisor Privileges, page 17-3
• Agent Privileges, page 17-5

Agent Privileges

Note

An agent capability is only available with a Unified CCX license.

Unified CM users in Cisco CRS are assigned an agent’s role when an agent extension is associated to the user in the Unified CM User Configuration page. Consequently, this role can only be assigned or removed for the user using Unified CM Administrator’s End User configuration web page only (see Chapter 4, “Provisioning Unified CM for Unified CCX”). These users can not be assigned or removed in Cisco CRS Administration.
Unified CME users in Cisco CRS are entirely managed by Cisco CRS. This ability to change an agent’s role is only available for Unified CME users. Hence, on selecting the required agents, this page leads you to the Bulk Resource Configuration web page you can configure multiple users and assign skills/resource groups at the same time.

Related Topics
- The Agent Capability View, page 22-15
- About User Management, page 17-2
- About Cisco CRS User Capabilities, page 17-2
- Administrator Privileges, page 17-3
- Supervisor Privileges, page 17-3
- Historical Report User Privileges, page 17-4

Using the CRS Supervisor Web Interface

Use the CRS Supervisor web page to:
- View and monitor permitted agents (see Monitoring Agents, page 17-7).
- View and monitor permitted CSQs (see Monitoring CSQs, page 17-8).
- Install client-side Historical Reporting (see Installing Client-Side Historical Reporting, page 17-9).
- Access real-time reports, tools, and settings (see Chapter 16, “Reporting on Real-Time CRS Data”).

Accessing the Cisco CRS Supervisor Web Page

To access the Cisco CRS Supervisor web page, perform the following steps:

Procedure

Step 1  Verify that the user designated as a supervisor is not assigned to any other capability (see Supervisor Privileges, page 17-3 and The User View Menu Option, page 22-11).
Note
You can access this page only if the supervisor has not been assigned to any other capability views. Be sure to assign only the Supervisor capability to this user.

Step 2
In a new web browser window, enter http://<CRS IP address>/AppAdmin.

Tip
If you have already accessed the CRS Administration application using any capability, other than a supervisor, the web browser remembers the login access and continues to display the regular CRS Administration window. Be sure to open a new web browser window to access the CRS Supervisor page.

Step 3
When prompted, enter the User ID and Password for the supervisor of that server. The CRS Supervisor web page appears.

Monitoring Agents
To monitor agents from the Cisco CRS Supervisor web page, perform the following steps:

Procedure

Step 1
Select Tools > Plug-ins from the CRS Administration menu bar.

Step 2
Click the Unified CCX link.

Step 3
Click the View Agents hyperlink to view allowed Agents and CSQs.

Step 4
When finished, click Return to main page.
Monitoring CSQs

To monitor CSQs from the Cisco CRS Supervisor web page, perform the following steps:

Procedure

- **Step 1** Select **Tools > Plug-ins** from the CRS Administration menu bar.
- **Step 2** Click the Unified CCX link.
- **Step 3** Click the **View CSQ** hyperlink to view allowed Agents and CSQs.
- **Step 4** When finished, click **Return to main page**.

Viewing CSQ IDs for Remote Monitoring

To view CSQ IDs from the Cisco CRS Supervisor web page, perform the following steps:

Procedure

- **Step 1** From the CRS Supervisor web page, log in as the Remote Monitoring supervisor.
- **Step 2** Click the Unified CCX link.
- **Step 3** Select **Tools > Plug-ins** from the CRS Administration menu bar.
- **Step 4** Click the **View CSQ** hyperlink to view the Agents and CSQs being monitored by this supervisor.

The CSQ ID column shows the ID value that you should enter for the CSQ that you selected in the Start Monitor Step. See the Start Monitor Step in the *Cisco CRS Scripting and Development Series: Volume 2, Editor Step Reference* for more information.
Installing Client-Side Historical Reporting

To install client-side Historical Reporting, perform the following steps:

Procedure

Step 1 Select **Tools > Plug-ins** from the CRS Administration menu bar.
Step 2 Click the **Cisco CRS Historical Reports** hyperlink.
Step 3 For more instructions, see the **Cisco CRS Historical Reports User Guide**.

Using the CRS User Options Web Interface

Use the CRS User Options web page to perform:

- Unified CCX downloads
- Alternate pronunciations for call by name
- Access the Unified CM User Page

**Note**
For a Unified CME deployment, you can also change the password/PIN and upload a spoken name prompt.

Accessing the Cisco CRS User Options Web page

To access the Cisco CRS User Options web page, perform the following steps:

Procedure

Step 1 From the CRS Administration enter **http://<CRS IP address>/Appuser**.
Step 2 If prompted to do so, enter your User ID and Password.
The CRS User Option web page appears.
Chapter 17  Using the Cisco CRS Supervisor and Cisco CRS User Options Plug-Ins

Using the CRS User Options Web Interface

Step 3  When finished, click Return to main page.

Downloading the Agent Desktop

To install and configure the Agent Desktop, perform the following steps:

Procedure

Step 1  In the Cisco CRS User Options Welcome web page, click the Unified CCX Downloads hyperlink.
The Download Unified CCX Agent Desktop web page appears.

Step 2  Use the Windows Copy function to copy the following command line from the Download Unified CCX Agent Desktop web page. (Servername is the IP address of your CRS Server.)
\\Servername\DESKTOP_CFG\desktop\InstallManager

Step 3  From the Windows Start menu, choose Run.
The Run dialog box appears.

Step 4  In the Open field in the Run dialog box, use the Windows Paste function to paste the command line that you copied in Step 2, and then click OK.
The Enter Network Password dialog box appears.

Step 5  Enter your user name and password, and then click OK.
The Welcome dialog box appears.

Step 6  Follow the instructions in the Welcome dialog box to install the Unified CCX Agent Desktop on your computer.

Adding Alternative Pronunciations

Alternative Pronunciations for Call by Name is an independent feature located on the Cisco CRS User Options Welcome web page. This feature lets you add one or more alternate pronunciations for your first or last name and is useful if callers
might refer to you by more than one name. For example, if your first name is Bob, you might add the alternate pronunciations “Bob” and “Bobby.” Similarly, if your last name is Xhu, you might add the alternate pronunciation “Xhu.”

To access the Alternative Pronunciations for Call by Name web page, perform the following steps:

**Procedure**

1. **Step 1** In the Cisco CRS User Options Welcome web page, click the **Alternative Pronunciations for Call by Name** hyperlink.
   
The Alternate Pronunciations web page appears.

2. **Step 2** In the First Name field, you can enter an alternate pronunciation of your first name. For example, if your name is “Mary,” you might enter “Maria.”

3. **Step 3** Click **Add>>**.
   
The name moves to a list of alternate first name pronunciations.

4. **Step 4** Repeat Steps 2 and 3 as needed to add other alternate pronunciations.
   
To remove an alternate pronunciation for your first name, click the alternate pronunciation and then click **Remove**.

5. **Step 5** In the Last Name field, you can enter an alternate pronunciation of your last name. For example, if your last name is “Smith,” you might enter “Smitty.”

6. **Step 6** Click **Add>>**.
   
The name moves to a list of alternate last name pronunciations.

7. **Step 7** Repeat Steps 5 and 6 as needed to add other alternate pronunciations.
   
To remove an alternate pronunciation of your last name, click the alternate pronunciation and then click **Remove**.

8. **Step 8** Click **Update** to apply the changes.
   
To return to the Cisco CRS User Options Welcome web page, click the **Back to CRS User home page** hyperlink.
Accessing the Unified CM User Options page

To access the Unified CM User Options web page, perform the following steps:

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>In the Cisco CRS User Options Welcome web page, click the <strong>Unified CM User Page</strong> hyperlink. The Unified CM User Options Log On dialog box appears.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Enter your Unified CM User ID and Password and click <strong>Log On</strong>. The Unified CM User Options web page appears.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click on the option you want.</td>
</tr>
<tr>
<td>Step 4</td>
<td>When finished, click <strong>Logout</strong>.</td>
</tr>
</tbody>
</table>
P A R T  3

Cisco Customer Response Solutions: Reference
The System Menu

The System menu of the CRS Administration system provides options for performing system-related tasks. Depending on the product package you purchased, the System menu contains some or all of the following menu options:

- Installation-based options:
  - Unified CM Configuration (see The Unified CM Configuration Menu Option, page 18-2).
  - Unified CME Configuration (see The Unified CME Configuration Menu Option, page 18-3).

- Control Center (see The Control Center Menu Option, page 18-3).

- Datastore Control Center (see The Datastore Control Center Menu Option, page 18-5).

- System Parameters (see The System Parameters Menu Option, page 18-6).

- Custom File Configuration (see The Custom File Configuration Menu Option, page 18-6).

- Alarm Configuration (see The Alarm Configuration Menu Option, page 18-7).

- Tracing (see The Tracing Menu Option, page 18-8).

- License Information (see The License Information Menu Option, page 18-10).

- Language Information (see The Language Information Menu Option, page 18-11).

- Logout (see The Logout Menu Option, page 18-11).
The Unified CM Configuration Menu Option

Use the Unified CM Configuration web page to update the following information at anytime:

- Unified CM cluster information
- AXL authentication information
- Unified CM Telephony subsystem information
- RmCm Provider configuration information at anytime from within Cisco CRS.

Select **System > Unified CM Configuration** from the CRS Administration menu bar to access the Unified CM Configuration web page.

**Related Topics**

- Modifying Cluster Information from Cisco CRS, page 4-3
- Modifying AXL Information, page 4-5
- Modifying Unified CM Telephony Information, page 4-8
- Modifying RmCm Provider Information, page 4-10
- Configuring the RmCm Provider, page 7-2
- Provisioning the Unified CM Telephony Subsystem, page 6-5
The Unified CME Configuration Menu Option

Use the Unified CME Configuration web page to update the following information at anytime:

- Unified CME cluster information
- Unified CME Telephony subsystem information
- AXL Service Provider configuration information at anytime from within Cisco CRS.

Select System > Unified CME Configuration from the CRS Administration menu bar to access the Unified CME Configuration web page.

Related Topic
Introducing Unified CME for Cisco CRS, page 5-2

The Control Center Menu Option

Use the Control Center web page to:

- Display all servers (CRS Servers as well as Add-On Servers) belonging to the same cluster.
- Display the server states (running or stopped) with an option to restart one particular server or all servers in the cluster.
- Display the feature states (running or stopped).
- Display the server services (running or stopped).
- Configure trace at cluster level.
- View the traces on all machines in the cluster.
Control Center/Servers

Select System > Control Center from the CRS Administration menu bar to access the Control Center/Servers web page.

Related Topics
- About Control Center Management, page 11-3
- Managing the Control Center, page 11-9

Control Center/Servers/Server Traces

Select System > Control Center from the CRS Administration menu bar to access the Control Center/Servers web page. You can access trace log files for servers from the Control Center pages by clicking on the Server Traces hyperlink.

Related Topics
- Server Traces, page 11-18
- Managing the Control Center, page 11-9

Control Center/Features

Select System > Control Center from the CRS Administration menu bar to access the Control Center web page; then click the Features tab.

Related Topic
- About Control Center Management, page 11-3
Control Center/Features/Component Activation

From the Control Center/Features web page, select Component Activation. Use this page to activate licensed components.

Related Topics
- About Control Center Management, page 11-3
- Activating a Component, page 11-12

The Datastore Control Center Menu Option

The Datastore Control Center allows you to manage your datastores and monitor their status.

In addition, the Datastore Control Center contains the following hyperlinks:
- Publisher Activation. Allows for publisher activation, switch or reset functions.
- Trace Configuration. Allows you to activate detailed debugging for CRS datastore replication.

For more information, see Chapter 12, “Managing the Cisco CRS Datastores.”

Note
Debugging should be switched off once the debug session is completed since it impacts the server when left turned on under normal operations (for example, disk space used by replication logs will grow without limit.) Debugging reports are written to \wavvid\log\ReplLogs as well as SQL Server logs and NT Event viewer.

This web page also contains the following buttons:
- Start—Click this button to start the replication agent.
- Stop—Click this button to stop the replication agent.
- Restart—Click this button to restart the replication agent.
- Reinit Subscriber—Click this button to reinitialize the Subscriber with a copy of data from the Publisher. (This causes the data on the Subscriber to be overwritten by the data from the Publisher.)
The System Parameters Menu Option

Use the System Parameters web page to configure system parameters such as port settings, and set the default session timeout.

**Note**

When the System Parameters web page is updated, the system notifies all nodes in the cluster about the changes. If a node or a Node Manager is not in service during this operation, Application Administration will notify it of the changes the next time Node Manager is started.

Choose **System > System Parameters** from the CRS Administration menu bar to access the System Parameters Configuration web page.

**Related Topics**
- Managing System Parameters, page 11-23
- Configure the Default TTS Provider for the CRS System, page 6-36

The Custom File Configuration Menu Option

Use the Custom File Configuration classpath web pages to specify the classpath for custom classes, steps, and subsystems.

Choose **System > Custom File Configuration** from the CRS Administration menu bar to access the Custom File Configuration web page and then:
Click the **Classpath for Custom Classes** hyperlink to access the Custom Classes Configuration area.

Click the **Classpath for Custom Steps** hyperlink to access the Custom Steps Configuration area.

Click the **Classpath for Custom Subsystems** hyperlink to access the Custom Subsystems Configuration area.

CRS determines the available classpath for custom steps and subsystems from the list of jar files and directories under default/classpath of the Document Repository. If the classpath refers to jars or directories that no longer exist in the Repository, CRS generates a warning message box when you open this page.

**Related Topics**

- Specify Custom Classpath Entries, page 10-16
- Specify the Custom Steps Startup Order, page 10-18
- Specify the Custom Subsystems Start Up Order, page 10-18

**List of Custom Start Up Order**

Use the Custom File Configuration Start Up Order pages to specify the order CRS should execute custom steps or subsystems.

Choose **System > Custom File Configuration** from the CRS Administration menu bar to access the Custom File Configuration web page.

To access the Custom Steps Startup Order area, click the **List of Custom Subsystems** hyperlink.

**Related Topic**

Managing Custom Files, page 10-15

**The Alarm Configuration Menu Option**

Use the Alarm Configuration web pages to define system-wide Alarm Server settings and options.
Select **System > Alarm Configuration** from the CRS Administration menu bar to access the Alarm Server Configuration web page.

**Related Topic**
- Configuring Alarm Settings, page 12-14

## The Tracing Menu Option

Use the Tracing web pages to define trace file settings for the following options:
- CRS Administration
- CRS Engine
- CRS Editor
- CRS Cluster View Daemon
- CRS SQL Server

This section describes the following topics:
- Trace File Configuration, page 18-8
- Trace Configuration, page 18-9
- Agent/Historical/Repository Trace Configuration, page 18-9

**Related Topic**
Configuring Trace Settings, page 12-9

### Trace File Configuration

**Note**

Trace File Configuration is available for the following CRS components: CRS Administration, CRS Engine, and CRS Cluster View Daemon.

To access the Trace File Configuration page, select the **Trace File Configuration** hyperlink from any Tracing Configuration page navigation bar.
Related Topics

- Configuring Trace Settings, page 12-9
- Tracing Configuration, page 11-28

## Trace Configuration

Trace Configuration is available for the following CRS components:
CRS Administration, CRS Engine, and CRS Cluster View Daemon.

To access the Trace Configuration page, select **Trace Configuration** from the Tracing page navigation bar.

Use the checkboxes on this page to select the subfacilities you want to trace and debug.

Related Topics

- Updating Trace File Information, page 12-10
- Activating/Deactivating Logging, page 12-11
- Trace Settings and Unified CM Telephony Performance, page 12-12
- Agent, Historical, or Repository Trace Configuration, page 12-13
- Configuring Alarm Settings, page 12-14
- Tracing Configuration, page 11-28

## Agent/Historical/Repository Trace Configuration

Agent/Historical/Repository Trace Configuration is available for the SQL Server component, only.

To access an Agent/Historical/Repository Trace Configuration page, select one of the required hyperlink from the SQL Server list on the Tracing Configuration page navigation bar.
The License Information Menu Option

Use the License Information web pages to display the cluster licensing information and to upload additional licenses.

Select System > License Information from the CRS Administration menu bar to access the License Information web page.

Related Topics
- Display Licenses, page 18-10
- Add License(s), page 18-11
- Viewing License Information, page 1-14
- Cisco CRS Licensing Packages, page A-1

Display Licenses

From the Systems menu, select License Information.

Related Topics
- Add License(s), page 18-11
- Viewing License Information, page 1-14
- Cisco CRS Licensing Packages, page A-1
Add License(s)

From the System menu, select License Information and then click the Add License hyperlink on the navigation bar.

Use this page to specify a license file and upload it to CRS.

Related Topics
- Display Licenses, page 18-10
- Uploading Licenses, page 1-15
- Viewing License Information, page 1-14
- Cisco CRS Licensing Packages, page A-1

The Language Information Menu Option

Customized Cisco CRS languages such as American English, Canadian French, and so on, are installed with Cisco CRS.

Use the Language Information web pages to specify your required language for the Cisco CRS Administration GUI and to load its corresponding online help files.

Select System > Language Information from the CRS Administration menu bar to access the Language Information web page. Select the required language from the drop-down list and specify the required Country and group. Some languages only have one choice. US English (en_US) is the default.

Be sure to click on Update to implement your changes.

The Logout Menu Option

To exit CRS Administration without closing your web browser, choose System > Logout from the CRS Administration menu bar. The system logs you out of CRS Administration and displays the Authentication web page.

Note
You can also exit CRS Administration by closing your web browser.
Chapter 18

The System Menu

The Logout Menu Option
The Applications Menu

The Applications menu contains the following menu options:

- **Application Management**—to add, configure, copy, delete, or refresh a specific application. (see The Application Management Menu Option, page 19-2.)

- **Script Management**—to add a new script and to view, refresh, upload, or delete an existing script. (see Script Management, page 19-3.)

- **Prompt Management/Grammar Management/Document Management**—to display, modify, or delete existing prompts, grammars and documents, and to add new prompts, grammars and documents. (see Prompt Management, page 19-4.)

- **AAR Management**—to upload AAR files to Cisco CRS. (see AAR Management, page 19-7.)
The Application Management Menu Option

The Application Management option of the Applications menu of the Cisco CRS Administration web interface contains options for configuring and managing the applications the Cisco CRS system uses to interact with contacts and perform a wide variety of functions.

To access the Application Management web pages, select Applications > Application Management from the CRS Administration menu bar. The Applications Configuration web page displays a list of the applications that are currently configured on your CRS server.

To add a new application, click the Add a New Application hyperlink to access the Add a New Application web page, where you select the type of application to create.

To refresh all application information across the cluster, click the Refresh Applications hyperlink.

Related Topics
- About CRS Applications, page 9-2
- Configuring Cisco Script Applications, page 9-3
- Configuring the Busy Application, page 9-7
- Configuring the Ring-No-Answer Application, page 9-8
- Configuring the Unified ICME Post-Routing Application, page 9-10
- Configuring the Unified ICME Translation-Routing Application, page 9-14
- Adding Application Triggers, page 9-18
- Application Availability by License Package, page A-2
- Provisioning the Unified ICME Subsystem, page 8-3
Script Management

Use the Script Management web page to add a new script and to rename, refresh, or delete an existing script. Cisco CRS applications are based on scripts created in the Cisco CRS Editor.

To access the Script Management web page, select **Applications > Script Management** from the CRS Administration menu bar. The Script Management web page displays the default directory that contains the scripts uploaded to the repository.

The Script Management web page also contains the following hyperlinks:

- **Create/Rename Language**—Click this hyperlink to create/rename a default folder. If the default folder already exists, you receive a warning message. You can create/rename multiple folders under the default folder.
- **Delete Language**—Click this hyperlink to delete the default folder from the repository.
- **Upload Zip Files**—You cannot upload zip files at this level. Click the default folder hyperlink and then on the Upload New Scripts hyperlink.
- **Create New Folder**—Click this hyperlink to create a new subfolder under the default folder. Enter the name of the new subfolder in the Folder Name field and click Create. When the folder is successfully created, click the Return to Script Management hyperlink to return to the default folder’s updated Script Management page. You can create any number of folders within the default folder.
- **Rename Folder**—Click this hyperlink to rename the required subfolder within the default folder. Alternately, click the Rename icon under the Actions column (see Renaming a Script or Folder, page 9-33).
- **Delete Folder**—Click this hyperlink to delete a specific subfolder within the default folder. Alternately, click the Delete icon under the Actions column (see Deleting a Script or Folder, page 9-34).
- **Upload New Scripts**—Click this hyperlink to upload scripts to the default folder as a zip file so its contents (.aef files) can be automatically unzipped and uploaded to the repository (see Uploading New Scripts, page 9-26).

Click on the default folder (if it already exists) to see the following hyperlinks:

- **Refresh**—Click this hyperlink to refresh the corresponding script (see Individual Script Refresh, page 9-31).
Prompt Management

Several system-level prompt files are loaded during Cisco CRS installation. However, any file you create needs to be made available to the CRS Engine before a CRS application can use them. This is done through the CRS cluster’s Repository datastore, where the prompt, grammar, and document files are created, stored, and updated.

To access the Prompt Management page, select **Application > Prompt Management**.

The Prompt Management web page also contains the following hyperlinks:

- **Create Language**—Click this hyperlink to create a new language folder (see Creating a New Language, page 10-8).
- **Rename Language**—Click this hyperlink to rename an existing language folder (see Renaming a Language, page 10-9).
- **Delete Language**—Click this hyperlink to delete an existing language folder (see Deleting a Language, page 10-9).
- **Upload New Prompts**—Click this hyperlink to upload a new prompt or zip file (see Upload Zip files to a Language Folder, page 10-10).

Click on the required folder (if it already exists) to see the following hyperlinks:

- **Create New Folder**—Click this hyperlink to create a new subfolder under the selected folder.
- **Rename Folder**—Click this hyperlink to rename the required subfolder within the selected folder. Alternately, click the Rename icon under the Actions column.
- **Delete Folder**—Click this hyperlink to delete a specific subfolder within the selected folder. Alternately, click the Delete icon under the Actions column.
• **Upload New Prompts**—Click this hyperlink to upload a new prompt or zip file so its contents (the .wav files) can be unzipped and uploaded to the repository.

**Related Topics**

- Managing Prompt Files, page 10-2
- Managing Languages, page 10-8
- Recording and Uploading Prompt Files, page 10-11
- Managing Custom Files, page 10-15
- Refreshing Scripts, page 9-30

**Grammar Management**

Several system-level grammar files are loaded during Cisco CRS installation. However, any file you create needs to be made available to the CRS Engine before a CRS application can use them. This is done through the CRS cluster’s Repository datastore, where the grammar files are created, stored, and updated.

To access the Grammar Management page, select **Application > Grammar Management**.

The Grammar Management web page also contains the following hyperlinks:

- **Create Language**—Click this hyperlink to create a new language folder (see Creating a New Language, page 10-8).
- **Rename Language**—Click this hyperlink to rename an existing language folder (see Renaming a Language, page 10-9).
- **Delete Language**—Click this hyperlink to delete an existing language folder (see Deleting a Language, page 10-9).
- **Upload New Prompts**—Click this hyperlink to upload a new prompt or zip file (see Upload Zip files to a Language Folder, page 10-10).
Document Management

Click on the required folder (if it already exists) to see the following hyperlinks:

- **Create New Folder**—Click this hyperlink to create a new subfolder under the selected folder.
- **Rename Folder**—Click this hyperlink to rename the required subfolder within the selected folder. Alternately, click the Rename icon under the Actions column.
- **Delete Folder**—Click this hyperlink to delete a specific subfolder within the selected folder. Alternately, click the Delete icon under the Actions column.
- **Upload New Grammars**—Click this hyperlink to upload a new grammar or a zip file so its contents (the .xml files) can be unzipped and uploaded to the repository.

**Related Topics**

- Managing Grammar Files, page 10-4
- Managing Languages, page 10-8
- Recording and Uploading Prompt Files, page 10-11
- Managing Custom Files, page 10-15
- Refreshing Scripts, page 9-30

**Document Management**

Several system-level document files are loaded during Cisco CRS installation. However, any file you create needs to be made available to the CRS Engine before a CRS application can use them. This is done through the CRS cluster’s Repository datastore, where the document files are created, stored, and updated.

To access the Document Management page, select **Application > Document Management**.

The Document Management web page also contains the following hyperlinks:

- **Create Language**—Click this hyperlink to create a new language folder (see Creating a New Language, page 10-8).
- **Rename Language**—Click this hyperlink to rename an existing language folder (see Renaming a Language, page 10-9).
**Delete Language**—Click this hyperlink to delete an existing language folder (see Deleting a Language, page 10-9).

**Upload New Prompts**—Click this hyperlink to upload a new prompt or zip file (see Upload Zip files to a Language Folder, page 10-10).

Click on the required folder (if it already exists) to see the following hyperlinks:

- **Create New Folder**—Click this hyperlink to create a new subfolder under the selected folder.
- **Rename Folder**—Click this hyperlink to rename the required subfolder within the selected folder. Alternately, click the Rename icon under the Actions column.
- **Delete Folder**—Click this hyperlink to delete a specific subfolder within the selected folder. Alternately, click the Delete icon under the Actions column.
- **Upload New Documents**—Click this hyperlink to upload a new document or a zip file so its contents (the .txt, .doc, .jsp, or .html files) can be unzipped and uploaded to the repository.

**Related Topics**
- Managing Document Files, page 10-6
- Managing Languages, page 10-8
- Recording and Uploading Prompt Files, page 10-11
- Managing Custom Files, page 10-15
- Refreshing Scripts, page 9-30

### AAR Management

Use the AAR Management web page to upload an AAR file to CRS.

To access the AAR Management web page, select **Applications > AAR Management** from the CRS Administration menu bar. The AAR Management web page displays.

**Related Topic**
- Managing AAR Files, page 10-19
The Subsystems Menu

The Subsystems menu of the Cisco CRS Administration web interface provides access to the subsystems that are licensed for your CRS system.

The CRS system uses subsystems for communicating with other services. Depending on the CRS package you have installed, the Subsystems menu may contain some or most of the following menu options:

- **Depending on the installation, you can select one of two options:**
  - **Unified CM Telephony**—to enter Unified CM Telephony provider information, Computer Telephony Interface (CTI) port group information, Unified CM Telephony trigger information, and to resynchronize Unified CM Telephony information (see The Unified CM Telephony Menu Option, page 20-2).
  - **Unified CME Telephony**—to enter Unified CME Telephony provider information, Computer Telephony Interface (CTI) port group information, Unified CME Telephony trigger information, and to validate CME and CRS data (see The Unified CME Telephony Menu Option, page 20-5).

- **RmCm**—to set up your Unified CCX resources (The RmCm Menu Option, page 20-7).

- **Outbound**—to configure contact centers for automated outbound activities (The Outbound Menu Option, page 20-15).

- **ICM**—to configure the Unified Intelligent Contact Management Enterprise (Unified ICME) subsystem to interact with Unified ICME software and to add new Voice Response Units (VRU) scripts (see The Unified ICM Menu Option, page 20-19).
• **Database**—to configure the CRS system to communicate with database servers (see *The Database Menu Option, page 20-21*).

• **HTTP**—to configure the CRS Engine to respond to requests from a variety of web clients, including computers and IP phones (see *The HTTP Menu Option, page 20-22*).

• **eMail**—to configure the CRS Engine to communicate with your e-mail server and enable your applications to create and send e-mail (see *The eMail Menu Option, page 20-24*).

• **Cisco Media**—to configure Cisco Media Termination (CMT) dialog groups that can be used to handle simple Dual-Tone Multi-Frequency (DTMF) based dialog interactions with customers (see *The Cisco Media Menu Option, page 20-24*).

• **MRCP ASR**—to configure the MRCP Automated Speech Recognition (ASR) subsystem, which allows users to navigate through a menu of options using spoken responses to prompts (see *The MRCP ASR Menu Option, page 20-25*).

• **MRCP TTS**—to configure the MRCP Text-to-Speech (TTS) subsystem, which converts plain text (UNICODE) into spoken words in order to provide a user with information or to prompt a user to respond to an action (see *The MRCP TTS Menu Option, page 20-27*).

---

### The Unified CM Telephony Menu Option

The Cisco CRS system uses the Unified CM Telephony subsystem of the CRS Engine to send and receive call-related messages from the Unified CM Computer Telephony Interface (CTI) Manager.

To access the Unified CM Telephony Configuration web pages, select **Subsystems > Unified CM Telephony** from the CRS Administration menu bar.
The Unified CM Telephony Configuration navigation bar contains the following hyperlinks:

- **Unified CM Telephony Provider**—Choose this option to enter Unified CM Telephony provider information (see **Unified CM Telephony Provider Configuration**, page 20-3).

- **Unified CM Telephony Call Control Groups**—Choose this option to configure CTI port groups for applications (see **Unified CM Telephony Call Control Group Configuration**, page 20-3).

- **Unified CM Telephony Triggers**—Choose this option to configure Unified CM Telephony triggers for applications (see **Unified CM Telephony Triggers Configuration**, page 20-4).

- **Resynchronize**—Choose this option to resynchronize Cisco CRS with Unified CM (see **Unified CM Telephony > Data Resync**, page 20-4).

### Unified CM Telephony Provider Configuration

To access this configuration area, click the **Unified CM Telephony Provider** hyperlink on the navigation bar of any Unified CM Telephony Configuration web page.

Use the Unified CM Telephony Provider Configuration web page to enter the location of your Unified CM Telephony provider, user ID, and password.

**Related Topics**

- **Provisioning the Unified CM Telephony Subsystem**, page 6-5
- **Additional Unified CM Telephony Information**, page 6-21
- **Resynchronizing Unified CM Telephony Information**, page 6-21
- **Modifying Unified CM Telephony Information**, page 4-8

### Unified CM Telephony Call Control Group Configuration

Use the Unified CM Telephony Call Control Group Configuration web pages to display, add, modify, and delete information about the call control group.

Select **Subsystems > Unified CM Telephony** from the CRS Administration menu bar to access the JTPAI Call Control Group summary web page.
To add a new Unified CM Telephony Call Control Group, click the Add a New Unified CM Telephony Call Control Group hyperlink on the Unified CM Telephony Call Control Group Configuration summary web page.

To modify an existing Unified CM Telephony Call Control Group, click any hyperlink within the group’s summary table entry; the Unified CM Telephony Call Control Group Configuration page opens.

**Related Topics**
- Adding a New Unified CM Telephony Call Control Group, page 6-9
- Additional Unified CM Telephony Information, page 6-21

### Unified CM Telephony Triggers Configuration

To access this configuration area, click the Unified CM Telephony Triggers hyperlink on the navigation bar of any Unified CM Telephony Configuration web page.

Use the Unified CM Telephony Triggers Configuration web pages to display, add, modify, and delete information about the Unified CM Telephony triggers.

To add a Unified CM Telephony trigger, click the Add a New Unified CM Telephony Trigger hyperlink on the Unified CM Telephony Triggers Configuration summary web page; the Unified CM Telephony Triggers Configuration page opens.

**Related Topics**
- Adding a Unified CM Telephony Trigger, page 6-14
- Additional Unified CM Telephony Information, page 6-21
- Adding Application Triggers, page 9-18

### Unified CM Telephony > Data Resync

To access this configuration area, click the Data Resync hyperlink on the navigation bar of any Unified CM Telephony Configuration web page.

To verify the connection, click on Check.

To resynchronize the connection, click on Synchronize.
Unified CM Telephony > Cisco JTAPI Resync

To access this configuration area, click the Cisco JTAPI Resync hyperlink on the navigation bar of any Unified CM Telephony Configuration web page.

If the CRS platform detects a mismatch, the system downloads and installs the compatible/required installer version.

Related Topics
- Resynchronizing the Unified CM Telephony Data, page 6-6
- Resynchronizing the Cisco JTAPI Client, page 6-7
- Unified CM Telephony Provider Configuration, page 20-3

The Unified CME Telephony Menu Option

The Cisco CRS system uses the Unified CME Telephony subsystem of the CRS Engine to send and receive call-related messages from the Unified CME CTI Manager.

To access the Unified CME Telephony Configuration web pages, select Subsystems > Unified CME Telephony from the CRS Administration menu bar.

The Unified CME Telephony Configuration navigation bar contains the following hyperlinks:

- Unified CME Telephony Provider—Choose this option to enter Unified CME Telephony provider information (see Unified CME Telephony Provider Configuration, page 20-6).

- Unified CME Telephony Call Control Groups—Choose this option to configure CTI port groups for applications (see Unified CME Telephony Call Control Group Configuration, page 20-6).
• **Unified CME Telephony Triggers**—Choose this option to configure Unified CME Telephony triggers for applications (see *Unified CME Telephony Triggers Configuration*, page 20-7).

• **Validate Unified CME in CRS Data**—Choose this option to resynchronize Cisco CRS with Unified CM (see *Validate Unified CME in CRS Data*, page 20-7).

**Unified CME Telephony Provider Configuration**

To access this configuration area, click the **Unified CME Telephony Provider** hyperlink on the navigation bar of any Unified CME Telephony Configuration web page.

Use the Unified CME Telephony Provider Configuration web page to enter the location of your Unified CME Telephony provider, user ID, and password.

**Related Topics**

- Configuring a Unified CME Telephony Provider, page 5-9
- Modifying a Unified CME Telephony Trigger, page 5-10

**Unified CME Telephony Call Control Group Configuration**

Use the Unified CME Telephony Call Control Group Configuration web pages to display, add, modify, and delete information about the call control group.

Select **Subsystems > Unified CME Telephony** from the CRS Administration menu bar to access the Unified CME Telephony Call Control Group summary web page.

To access this configuration area, click the **Unified CME Telephony Default Call Control Group** hyperlink on the navigation bar of any Unified CME Telephony Configuration web page.

**Related Topics**

- Verifying Licenses, page 5-5
- Modifying the Unified CME Telephony Call Control Group, page 5-10
Unified CME Telephony Triggers Configuration

To access this configuration area, click the Unified CME Telephony Triggers hyperlink on the navigation bar of any Unified CME Telephony Configuration web page.

Use the Unified CME Telephony Triggers Configuration web pages to display, add, modify, and delete information about the Unified CME Telephony triggers.

To add a Unified CME Telephony trigger, click the Add a New CME Telephony Trigger hyperlink on the Unified CME Telephony Triggers Configuration summary web page; the Unified CME Telephony Triggers Configuration page opens.

Related Topics
- Modifying a Unified CME Telephony Trigger, page 5-10
- Modifying a Unified CME Telephony Trigger, page 5-10

Validate Unified CME in CRS Data

To access this configuration area, click the Validate Unified CME in CRS Data hyperlink on the navigation bar of any Unified CME Telephony Configuration web page.

Related Topics
- Introducing Unified CME for Cisco CRS, page 5-2
- Validating Unified CME and Cisco CRS Data, page 5-8

The RmCm Menu Option

Use the areas of the Unified CCX Configuration web page to configure skills groups, resources, resource groups, Contact Service Queues (CSQs) and RM (Resource Manager) Unified CM Telephony providers.

To access the Unified CCX Configuration web page, select Subsystems > RmCm from the CRS Administration menu bar.
The Unified CCX Configuration navigation bar contains the following hyperlinks:

- **Skills**—Click this hyperlink to create skills. This option is available only with the Unified CCX Enhanced and Unified CCX Premium license packages (see Skills Configuration, page 20-8).
- **Resources**—Click this hyperlink to assign a resource group and/or skills to agents (see Resources Configuration, page 20-9).
- **Resource Groups**—Click this hyperlink to create resource groups (see Resource Group Configuration, page 20-10).
- **Contact Services Queues (CSQs)**—Click this hyperlink to configure CSQs (see Contact Service Queues Configuration, page 20-11).
- **RmCm Provider**—Click this hyperlink to configure the RM (Resource Manager) Unified CM Telephony provider for the RmCm subsystem (see RmCm Provider Configuration, page 20-12).
- **Assign Skills**—Click this hyperlink to assign skills and/or a resource group to agents in bulk (see Assign Skills Configuration, page 20-12).
- **Remote Monitor**—Click this hyperlink to associate agents and CSQs that will be monitored by supervisors (see Remote Monitor Configuration, page 20-13).
- **Agent Based Routing Settings**—Click this hyperlink to send a call to a specific agent, rather than to any agent available in a CSQ (see Agent Based Routing Settings Configuration, page 20-14).
- **Teams**—Click this hyperlink to create or associate teams with various agents, CSQs, and supervisors (see Teams Configuration, page 20-15).

For details on the maximum number of agents, skills, and CSQs that you can configure on your system, see About Unified CCX, page 3-2.

### Skills Configuration

Use the Skills page to add, modify, or delete skill.

Click the **Skills** hyperlink on the navigation bar of the Unified CCX Configuration web page to access the Skills summary web page.

**Related Topic**

Configuring Skills, page 7-7
Adding a New Skill

Use the Skills Configuration area to add a new skill name.
Access the Skills Configuration area by clicking the Add a New Skill hyperlink in the Skills Configuration web page.

Related Topic
Creating a Skill, page 7-7

Modifying Skills

Access the Skills Configuration area by clicking the required skill in the Skill name column on the Skills Configuration web page.
Click the Open Printable Report of this Skill Configuration hyperlink to view a list of the resources associated with that skill.

Related Topics
- Modifying an Existing Skill Name, page 7-8
- Deleting a Skill, page 7-9

Resources Configuration

Use the Resources Configuration area to assign a resource group and skills to a resource.
To access this configuration area, click the Resources hyperlink on the navigation bar of Unified CCX Configuration web page. The main area of the Resources area of the Unified CCX Configuration web page contains a list of resources (if configured).
Click the Open Resources Summary Report hyperlink to open the Resources Summary Report in a new window. For each resource, this report lists the resource groups associated with the resource, the Unified CCX extension of the resource, and the number of CSQs and team to which the resource is assigned.

Related Topic
- Configuring Agents, page 7-10
• Configuring Contact Service Queues, page 7-17

Modifying a Resource

Use the Resource Configuration area to modify resource configuration.

To access the Resource Configuration area, click any of the required resource in the Resource area of the Unified CCX Configuration summary web page.

Click the Open Printable Report of this Resource Configuration hyperlink to open a Resource Report for the agent. The Resource Report lists each agent’s resource ID, resource name, Unified CCX extension, resource group, automatic available status, skills, CSQs, and team.

Related Topic
• Assigning Resource Groups and Skills to One Agent, page 7-12
• Removing Skills from Agents, page 7-16

Resource Group Configuration

Use the Resource Group Configuration web page to display and modify the names of existing resource groups and to add new resource groups.

Click the Resource Group hyperlink on the navigation bar of the Unified CCX Configuration web page to access the Resource Groups summary web page.

Related Topic
Configuring Resource Groups, page 7-4

Adding a New Resource Group

Use the Resource Configuration area to enter the resource group name into the Resource Group Name field.


Related Topic
Creating a Resource Group, page 7-4
Modifying Existing Resource Groups

Use the Resource Modification page to change or update the resource group name into the Resource Group Name field.

Modify an existing Resource Group by clicking the required resource group in the Resource Groups area. In the Resource Group Configuration area, change the Resource Group and update.

Click the Open Printable Report of this Resource Group Configuration hyperlink to view a list of the available resources for this resource group.

Related Topics
- Modifying an Existing Resource Group Name, page 7-5
- Deleting a Resource Group, page 7-6

Contact Service Queues Configuration

Use the Contact Service Queues area of the Unified CCX Configuration web page to display existing CSQs, to delete a CSQ, and to add a new CSQ.

To access the Contact Service Queues area, click the Contact Service Queue hyperlink on the navigation bar of the Unified CCX Configuration web page.

Related Topic
Configuring Contact Service Queues, page 7-17

Adding a CSQ

Use the Contact Service Queue Configuration area to add a new CSQ.

To access the Contact Service Queue Configuration area, click the Add a New Contact Service Queue hyperlink in the Contact Service Queue area of the Unified CCX Configuration web page.
To open the Contact Service Queue Report for the required CSQ, click the **Open Printable Report of this CSQ Configuration** hyperlink from the Contact Service Queue Configuration area.

**Related Topics**
- Creating a CSQ, page 7-18
- Modifying an Existing CSQ, page 7-24
- Deleting a CSQ, page 7-25
- Resource Pool Selection Criteria: Skills and Groups, page 7-26
- Resource Skill Selection Criteria Within a CSQ, page 7-27

**RmCm Provider Configuration**

Use the RmCm Provider area of the Unified CCX Configuration web page to identify the Unified CM Telephony user for the Resource Manager.

To access this configuration area, click the **RmCm Provider** hyperlink on the navigation bar of any Unified CCX Configuration web page.

**Related Topics**
- Configuring the RmCm Provider, page 7-2
- Modifying RmCm Provider Information, page 4-10
- Invoking Unified CM Administration, page 4-14
- Defining Unified CM Users as Agents, page 4-15

**Assign Skills Configuration**

Use the Assign Skills areas of the Unified CCX Configuration web page to modify an existing resource group and skills configuration or to assign new resource groups and skills to the selected agents.

To access this configuration area, click the **Assign Skills** hyperlink on the navigation bar any Unified CCX Configuration web page.
The RmCm Menu Option

This web page also contains the following buttons:

- **Add Skill**—to add new skills or resource groups to selected agent (see Adding Skills, page 20-13).
- **Remove Skill**—to remove skills from selected agent (see Removing Skills, page 20-13).

**Related Topic**
Configuring Skills, page 7-7

**Adding Skills**

When you click the **Add Skill** button in the Assign Skills area of the Unified CCX Configuration web page, the Add Skills area opens. Use the Add Skill area to add a resource group and skills to the selected agents.

**Related Topic**
Assigning Resource Groups and Skills to Multiple Agents, page 7-14

**Removing Skills**

When you click the **Remove Skill** button in the Assign Skills area of the Unified CCX Configuration web page, the Remove Skill area opens. Use the Remove Skill area to remove skills from the selected agents.

**Related Topic**
Removing Skills from Agents, page 7-16

**Remote Monitor Configuration**

Use the Remote Monitor areas of the Unified CCX Configuration web page to specify the monitoring method: by agent or by CSQ.

To access this configuration area, click the **Remote Monitor** hyperlink on the navigation bar of any Unified CCX Configuration web page.
Assigning Resources and CSQs to a Remote Supervisor

Use the Remote Monitor configuration web page to assign a Supervisor a list of Resources and CSQs that he/she is allowed to monitor.

To access the Remote Monitoring Configuration web page, click a User ID value.

Related Topics
- Configuring and Using Remote Monitoring, page 7-29
- Creating a Remote Monitoring Supervisor, page 7-30
- Assigning Resources and CSQs to a Supervisor, page 7-31
- Configuring the Remote Monitoring Application, page 9-16.
- Viewing CSQ IDs for Remote Monitoring, page 17-8

Agent Based Routing Settings Configuration

Use the Agent Based Routing Settings areas of the Unified CCX Configuration web page to configure Automatic Work and Wrapup Time.

To access this configuration area, click the Agent Based Routing Settings hyperlink on the navigation bar of any Unified CCX Configuration web page.

Related Topic
- Configuring Agent-Based Routing, page 7-33
Teams Configuration

Use the Teams area of the Unified CCX Configuration web page to create or associate teams with various agents, CSQs, and supervisors.

To access this configuration area, click the Teams hyperlink on the navigation bar of any Unified CCX Configuration web page.

Related Topics
- Configuring Teams, page 7-34
- Creating a Team Supervisor, page 7-35

Adding a New Team

Click the Add a new Team hyperlink on the Teams summary web page. The Team Configuration page appear.

To open the report in a new window and send it to a printer, click the Open Printable Report of this Team Configuration hyperlink in the Team Configuration area of the Teams web page.

Related Topics
- Creating a Team Supervisor, page 7-35
- Creating Teams, page 7-36
- Modifying Agents on Teams, page 7-38
- Deleting a Team, page 7-39

The Outbound Menu Option

Use the Outbound Configuration web pages to provision the Cisco Unified Preview Outbound Dialer Express (Outbound) feature’s outbound dialing functionality.

Choose Subsystems > Outbound from the CRS Administration menu bar to access the Outbound Configuration General Configuration web page.

This feature requires a separate license along with the Unified CCX Enhanced or Premium packages.
This section contains the following topics:

- General Configuration, page 20-16
- Campaign Configuration, page 20-16
- Area Code Management, page 20-18

Related Topic
Chapter 14, “Configuring Cisco Unified CCX Outbound Preview Dialer”

General Configuration

Use the General area of the General Configuration pane to add or modify Outbound dialing preferences.

To configure the general Outbound preferences, select Subsystems > Outbound from the CRS Administration menu bar.

Related Topics
- Campaign Configuration, page 20-16
- Area Code Management, page 20-18
- Chapter 14, “Configuring Cisco Unified CCX Outbound Preview Dialer”
- Add New Campaigns, page 20-17
- Delete Do Not Call Contacts, page 20-17
- Add New Area Code, page 20-18

Campaign Configuration

From the Campaigns web page in the CRS Administration GUI, a CRS administrator can create and schedule campaign, and import a list of contacts (in bulk from a text file) into the Unified CCX database for each campaign.

Related Topics
- Add New Campaigns, page 20-17
- Import Contacts, page 20-17
Add New Campaigns

To configure the properties for the campaign, including the campaign name and description, personal callback settings, skill group selection, and the time range, click the Add New Campaign hyperlink in the Campaigns web page.

Related Topics
- Adding a New Campaign, page 14-23
- Import Contacts, page 20-17
- Delete Do Not Call Contacts, page 20-17
- Add New Area Code, page 20-18

Import Contacts

To import contacts for a selected campaign, click the hyperlink for the required campaign under the Name column.

The Open Printable Report for this Campaign Configuration hyperlink provides a detailed breakup of the number of callbacks, number of retries, and number of pending contacts.

Related Topics
- Importing Contacts for a Campaign, page 14-25
- Add New Campaigns, page 20-17
- Delete Do Not Call Contacts, page 20-17
- Add New Area Code, page 20-18

Delete Do Not Call Contacts

To ensure that a contact does not get called again for a subsequent campaign, you must delete the contact from all campaigns to which it belongs.

In the Campaign Configuration pane, click on the Delete All Contacts button in the right pane.
Related Topics
- Removing Contacts from the Do Not Call List, page 14-45
- Add New Campaigns, page 20-17
- Import Contacts, page 20-17
- Add New Area Code, page 20-18

Area Code Management

Use this page to manually add new area codes, update existing area codes, and to add international area codes.

Related Topics
- Adding Area Codes, page 14-29
- General Configuration, page 20-16
- Campaign Configuration, page 20-16
- Add New Campaigns, page 20-17
- Delete Do Not Call Contacts, page 20-17
- Add New Area Code, page 20-18

Add New Area Code

The Area Codes Management page allows you to find, add, delete, and modify the mapping of area codes and time zones. The dialer uses the area code of a contact’s phone number to determine the time zone of the contact’s calling area.

Related Topics
- Adding Area Codes, page 14-29
- General Configuration, page 20-16
- Area Code Management, page 20-18
- Chapter 14, “Configuring Cisco Unified CCX Outbound Preview Dialer”
- Add New Campaigns, page 20-17
- Delete Do Not Call Contacts, page 20-17
The Unified ICM Menu Option

Use the Intelligent Contact Manager (ICM) Configuration web pages to add or modify Unified ICME configuration parameters and to modify VRU script information.

Choose Subsystems > ICM from the CRS Administration menu bar to access the Unified ICME Configuration summary web page.

Related Topics
- Provisioning the Unified ICME Subsystem, page 8-3
- Configuring General Unified ICME Information, page 8-4
- Configuring Unified ICME VRU Scripts, page 8-6
- Unified Gateway Auto-Configuration Details, page 7-40
- Configuring the Unified ICME Post-Routing Application, page 9-10
- Configuring the Unified ICME Translation-Routing Application, page 9-14

Unified ICME Configuration

Note
If you are using Unified CCX with the Cisco Unified Gateway solution, see the Cisco Unified Gateway Deployment Guide. The instructions for configuring Unified CCX with that solution differs from what is described in this guide. The Unified Gateway provides for the integration of the Unified ICME system with Unified CCX by way of the Unified Gateway. The Unified Gateway is a Peripheral Gateway (PG) which you configure on the Unified ICME software.

Use the General area of the Unified ICME Configuration page to add or modify Unified ICME configuration parameters.

To configure the Unified ICME subsystem, select Subsystems > ICM from the CRS Administration menu bar to access the Unified ICME Configuration web page.

Related Topics
- Provisioning the Unified ICME Subsystem, page 8-3
Unified ICME VRU Scripts

Unified ICME uses Unified ICME Voice Response Unit (VRU) scripts to handle interactions with contacts. These scripts are loaded as applications on the CRS Engine.

Click the Unified ICME VRU Scripts hyperlink on the navigation bar of the Unified ICME Configuration web page to access the Unified ICME VRU Scripts Configuration web page opens.

Related Topics
- Provisioning the Unified ICME Subsystem, page 8-3
- Configuring General Unified ICME Information, page 8-4
- Configuring Unified ICME VRU Scripts, page 8-6
- Unified Gateway Auto-Configuration Details, page 7-40
- Configuring the Unified ICME Post-Routing Application, page 9-10
- Configuring the Unified ICME Translation-Routing Application, page 9-14

Add a New VRU Script

To add a new VRU Script, click the Add New VRU Script hyperlink on the VRU Script’s summary web page to access the VRU Scripts Configuration web page.

To modify a VRU script, click any hyperlink within the VRU Script’s summary table entry; the VRU Script Configuration page opens.

Related Topics
- Provisioning the Unified ICME Subsystem, page 8-3
- Configuring General Unified ICME Information, page 8-4
The Cisco CRS system uses the Database subsystem of the CRS Engine to communicate with database servers, in order to obtain information to relay to callers or to make application decisions. The Database subsystem enables the CRS applications to obtain information from data sources, which are databases configured to communicate with the CRS system.

This web page contains the following hyperlinks:

- **DataSource Configuration**, page 20-21
- **Adding a New Data Source**, page 20-22
- **Adding a New Database Parameter**, page 20-22

**Related Topics**

- **Defining an ODBC Data Source**, page 8-13
- **About Additional Subsystems**, page 8-2
- **Provisioning the Unified ICME Subsystem**, page 8-3
- **Provisioning the HTTP Subsystem**, page 8-8
- **Provisioning the Database Subsystem**, page 8-12
- **Provisioning the eMail Subsystem**, page 8-19

**DataSource Configuration**

Use the Enterprise Database Subsystem Configuration web pages to display, modify, or delete existing data sources, or to add a new data source.

Choose **Subsystems > Database** from the CRS Administration menu bar to access the Enterprise Database Subsystem Configuration summary web page.
The HTTP Menu Option

The Cisco CRS system uses the HTTP subsystem of the CRS Engine to add components to the CRS Engine that allow applications to be triggered in response to requests from a variety of web clients, including computers and IP phones.

Related Topics
- Adding a New Database Parameter, page 20-22
- Adding a New Database Parameter, page 20-22
- About Additional Subsystems, page 8-2

Adding a New Data Source

To add a new data source, click the Add New Data Source hyperlink on the Enterprise Database Subsystem Configuration summary web page.

Related Topics
- Adding a New Database Parameter, page 20-22
- Defining an ODBC Data Source, page 8-13
- About Additional Subsystems, page 8-2

Adding a New Database Parameter

To add a new data source, click the Parameter hyperlink on the Enterprise Database Subsystem Configuration summary web page.

Related Topics
- Polling Database Connectivity, page 8-17
- Defining an ODBC Data Source, page 8-13
- About Additional Subsystems, page 8-2
- Adding a New Data Source, page 20-22

The HTTP Menu Option

The Cisco CRS system uses the HTTP subsystem of the CRS Engine to add components to the CRS Engine that allow applications to be triggered in response to requests from a variety of web clients, including computers and IP phones.
Related Topics

- Provisioning the HTTP Subsystem, page 8-8
- Adding Application Triggers, page 9-18

HTTP Configuration

Use the HTTP Trigger Configuration web pages to display, add, modify, and delete existing HTTP triggers.

Select Subsystems > HTTP from the CRS Administration menu bar to access the HTTP Trigger Configuration summary web page.

Related Topics

- Provisioning the HTTP Subsystem, page 8-8
- Adding Application Triggers, page 9-18

Add a New HTTP Trigger

To add a new HTTP trigger, click the Add New HTTP Trigger hyperlink on the HTTP Trigger Configuration summary web page to access the HTTP Trigger Configuration web page.

To modify an existing trigger, click any hyperlink within the trigger’s summary table entry; the HTTP Trigger Configuration page opens.

Related Topics

- Provisioning the HTTP Subsystem, page 8-8
- Adding Application Triggers, page 9-18
The eMail Menu Option

The Cisco CRS system uses the eMail subsystem of the CRS Engine to communicate with your e-mail server and enable your applications to create and send e-mail. The e-mail configuration identifies the default e-mail address and server to be used for sending e-mail (including e-pages and faxes) and for receiving acknowledgments.

To access the eMail Configuration web page to configure e-mail functionality so that CRS scripts created with the e-mail steps will function correctly, select **Subsystems > eMail** from the CRS Administration menu bar.

Related Topics

- About Additional Subsystems, page 8-2
- Provisioning the Unified ICME Subsystem, page 8-3
- Provisioning the HTTP Subsystem, page 8-8
- Provisioning the Database Subsystem, page 8-12
- Provisioning the eMail Subsystem, page 8-19

The Cisco Media Menu Option

Select **Subsystems > Cisco Media** from the CRS Administration menu bar to access the Cisco Media Termination Dialog Group Configuration summary web page opens.

The Cisco CRS system uses the Media subsystem of the CRS Engine to configure Cisco Media Termination (CMT) dialog groups that can be used to handle simple Dual-Tone Multi-Frequency (DTMF) based dialog interactions with customers. A dialog group is a pool of dialog channels in which each channel is used to perform dialog interactions with a caller.

To modify an existing CMT dialog group, click any hyperlink within the trigger’s summary table entry; Cisco Media Termination Dialog Group Configuration web page opens.

To add a new CMT dialog group, click the Add a New CMT Dialog Control Group hyperlink.
Related Topics

- Provisioning the Cisco Media Subsystem, page 6-23
- Adding a New Unified CM Telephony Call Control Group, page 6-9

The MRCP ASR Menu Option

The Cisco CRS system uses the MRCP ASR (Automatic Speech Recognition) subsystem to allow navigation through a menu of options by speaking instead of pressing keys on a touch-tone telephone.

Choose Subsystems > MRCP ASR from the CRS Administration menu bar to configure the MRCP ASR subsystem.

Use MRCP ASR Configuration navigation bar hyperlinks to access the following web pages:

- MRCP ASR Provider, page 20-25
- MRCP ASR Servers, page 20-26
- MRCP ASR Dialog Groups, page 20-26

Related Topics

- Before You Provision ASR/TTS, page 6-26
- Provisioning the MRCP ASR Subsystem, page 6-27

MRCP ASR Provider

Click on the MRCP ASR Provider option to configure information about the vendor of your speech server, including the number of licenses and the grammar type.

To modify existing ASR Provider information, click any hyperlink within the provider’s summary table entry; the ASR Provider Configuration web page opens.

To add new ASR Provider information, click the Add MRCP ASR Provider hyperlink.

Related Topic

Provisioning MRCP ASR Providers, page 6-28
MRCP ASR Servers

Click on the MRCP ASR Servers option to configure your speech server’s name, port location, and available languages.

Note
You must have a MRCP ASR Provider defined before you can provision a MRCP ASR Server.

To modify an existing ASR Server, click any hyperlink within the server’s summary table entry; the ASR Server Configuration web page opens.

To add a new ASR Server, click the Add MRCP ASR Sever hyperlink.

Related Topic
Provisioning MRCP ASR Servers, page 6-29

MRCP ASR Dialog Groups

Use the MRCP ASR Dialog Group Configuration web page to display, add, modify, and delete information about MRCP ASR dialog control groups, which enable CRS applications to use speech recognition.

Click on the MRCP ASR Dialog Groups option to configure the MRCP ASR dialog control groups.

Note
You must have a MRCP ASR Provider defined before you can provision a MRCP ASR Group.

To modify an existing MRCP ASR Dialog Group, click any hyperlink within the group’s summary table entry; the MRCP ASR Dialog Control Group Configuration web page opens.

To add a new MRCP ASR Group, click the Add MRCP ASR Dialog Control Group hyperlink.

Related Topic
Provisioning MRCP ASR Dialog Groups, page 6-31
The MRCP TTS Menu Option

The Cisco CRS system uses the MRCP (Text-to-Speech) subsystem to convert plain text (UNICODE) into spoken words in order to provide a user with information or to prompt a user to respond to an action.

Choose Subsystems > MRCP TTS from the CRS Administration menu bar to configure the MRCP TTS subsystem.

Use one or more of the following MRCP TTS Configuration hyperlinks:

Use MRCP ASR Configuration navigation bar hyperlinks to access the following web pages:

- MRCP TTS Providers, page 20-27
- MRCP TTS Servers, page 20-28
- MRCP TTS Default Genders, page 20-28

Related Topics

- Before You Provision ASR/TTS, page 6-26
- Provisioning the MRCP TTS Subsystem, page 6-34

MRCP TTS Providers

Use the MRCP TTS Provider Configuration web pages to display, add, modify, and delete information about your TTS Provider.

On any MRCP TTS Configuration web page, click the MRCP TTS Provider hyperlink on the navigation bar to configure information about the vendor of your TTS system.

To modify an existing MRCP TTS Provider, click any hyperlink within the provider’s summary table entry; the MRCP TTS Provider Configuration web page opens.

Related Topics

- Provisioning MRCP TTS Providers, page 6-35
- Configure the Default TTS Provider for the CRS System, page 6-36
MRCP TTS Servers

Use the MRCP TTS Server Configuration web pages to display, add, modify, and delete the text-to-speech server’s name, port location, and available language.

To modify an existing MRCP TTS Server, click any hyperlink within the server’s summary table entry; the MRCP TTS Server Configuration web page opens.

To add a new MRCP TTS Server, click the Add MRCP TTS Server hyperlink.

Related Topic
Provisioning MRCP TTS Servers, page 6-37

MRCP TTS Default Genders

Use the MRCP TTS Default Genders Configuration web page to display or modify the gender setting for each Locale.

On any MRCP TTS Configuration web page, click the MRCP TTS Default Genders hyperlink on the navigation bar to configure the default gender setting for the Locales specified during TTS Server provisioning.

To modify the default gender, click the MRCP TTS Default Genders hyperlink.

Related Topic
Provisioning MRCP TTS Default Genders, page 6-38
The Wizards Menu

Effective Cisco CRS Release 5.0, the Wizards menu of the Cisco CRS Administration web interface provides access to the wizards available for your CRS system.

In each Wizard web page, you are provided with a list of procedures in the left pane and a description of each procedure in the main pane. At the top of the page, you have the option to exit the wizard at any time or go to the next step as required. You can also jump to any other step by clicking on the required procedure in the left pane.

The CRS system contains the following options in the Wizards menu:

- The Application Wizard (see The Application Wizard, page 21-2).
- The RmCm Wizard (see The RmCm Wizard, page 21-3).
The Application Wizard

Application Configuration is one of the very basic requirements in CRS Administration. You need to complete several steps in the suggested order to successfully complete Application Configuration. The Application Configuration wizard leads you through the suggested steps.

To access the Application Wizard, select **Wizards > Application Wizard** from the CRS Administration menu bar.

The Application Wizard web page contains the following hyperlinks:

- **Description of Steps**—Choose this option to review the order in which to perform the configuration and for a description of each stage in the process. You can jump to any step directly or click **Next** to proceed to the next step (see Configuring Cisco CRS Applications, page 1-16).

- **Scripts**—Choose this option to upload multiple custom scripts. In this step, you are transferred to the Script Management web page which lists the available scripts, provides links to create a folder, and upload scripts (see Managing Scripts, page 9-25).

- **Prompts**—Choose this option to upload multiple prompt files. In this step, you are transferred to the Prompt Management web page which lists the custom available prompts, provides the links to create new folders, and upload prompts (see Managing Prompt Files, page 10-2).

- **Documents**—Choose this option to upload multiple document files. In this step, you are transferred to the Document Management web page which lists the available .txt, .doc, .jsp, or .html, custom classes, and Java Archive (JAR) files that allow you to customize the performance of your CRS system (see Managing Document Files, page 10-6).

- **Grammars**—Choose this option to upload multiple grammar files. In this step, you are transferred to the Grammar Management web page which lists specific grammar files to recognize and respond to caller prompts. (see Managing Grammar Files, page 10-4).

- **Application Configuration**—Choose this option to select the type of application to be configured. In this step, you are transferred to the Application Configuration page (to select the name and maximum number of sessions) after selecting the type of application to be configured. By default, the uploaded script, prompt, document and grammar are selected, if applicable (see About CRS Applications, page 9-2).
• **Trigger**—Choose this option to complete the trigger configuration. In this step, you are transferred to the trigger configuration page. By default, the application configured in the previous step is automatically selected. On providing the Directory Number, device name and language, the trigger configuration is complete (see Adding Application Triggers, page 9-18).

Selecting the type of the trigger concludes the Application Configuration wizard process.

**Related Topics**
- Using Configuration Wizards, page 2-7
- The RmCm Wizard, page 21-3

---

**The RmCm Wizard**

**Note**
The RmCm Wizard option is available with any Unified CCX license (Standard, Enhanced, or Premium).

RmCm Configuration is commonly performed procedure in the contact center environment. You need to complete several steps in the suggested order to successfully complete RmCm Configuration. The RmCm Configuration wizard leads you through the suggested steps.

To access the RmCm Wizard, select **Wizards > RmCm Wizard** from the CRS Administration menu bar.

The RmCm Wizard web page contains the following hyperlinks:

- **Description of Steps**—Choose this option to review the order in which to perform the configuration and for a description of each stage in the process. You can jump to any step directly or click **Next** to proceed to the next step (see Provision the Unified CCX Subsystem, page 1-13).

- **Add a Skill**—Choose this option to configure the skills to be associated with the user. In this step, you are transferred to the RmCm Configuration Skills web page which lists the configured list of skills. Repeat this step to create multiple skills (see Configuring Skills, page 7-7).
• **Add a Resource Group**—Choose this option to upload multiple custom scripts. In this step, you are transferred to the RmCm Configuration Resource Groups web page which lists the agent resources. On either selecting an existing agent as a resource or creating a new resource, you are transferred to the Resource configuration page where you associate this resource to the various skills along with a competency level (see Configuring Resource Groups, page 7-4).

• **Add Resources**—Choose this option to create resource groups that will later be assigned to resources. In this step, you are transferred to RmCm Configuration web page with a hyperlink to **Add resources in Cisco Unified CM**. This link invokes **Unified CM** automatically (see the following related topics:
  – Configuring the RmCm Provider, page 7-2
  – Configuring Unified CM for Unified CCX, page 4-14

• **Add Supervisors**—Choose this option to assign supervisor privileges to a user. In this step, you are transferred to the User Management web page which allows you to search for a specific user (see Creating a Remote Monitoring Supervisor, page 7-30).

• **Configure Resources**—Choose this option to add or remove skills that are associated with resources. In this step, you are transferred to the RmCm Configuration Resources web page which lists the configured resources. Resources can be modified together to obtain the same skills, or they can be modified separately to be assigned different skills.(see Configuring Agents, page 7-10).

• **Contact Service Queues**—In this optional step, you can either create a new CSQ or modify an existing CSQ by adding more skills (see Configuring Contact Service Queues, page 7-17).
  – **Modify Existing Contact Service Queues**—Choose this option to skills that are associated with a contact service queue. In this step, you are transferred to the RmCm Configuration Contact Service Queue web page which lists the configured CSQs (see Modifying an Existing CSQ, page 7-24).
  – **Add a Contact Service Queue**—Choose this option to add contact service queues. Skills or resource groups are associated to these contact service queues in order to filter out the resources. In this step, you are
transferred to the RmCm Configuration Contact Service Queue Configuration web page which allows you to add CSQs (see Creating a CSQ, page 7-18).

- **Teams**—In this optional step, you can either create a new team or modify an existing team. Supervisors, resources, and contact service queues are associated to these teams. (see Configuring Teams, page 7-34).
  - **Modify Existing Teams**—Choose this option to modify agents in existing teams. In this step, you are transferred to the RmCm Configuration Contact Teams web page which lists the configured teams (see Modifying Agents on Teams, page 7-38).
  - **Add a Team**—Choose this option to create new teams and associate those teams with new agents. In this step, you are transferred to the RmCm Configuration Team Configuration web page which allows you to create new teams (see Creating Teams, page 7-36).

- **Create an Application**—On completing the RmCm configuration, you can optionally proceed to the Application Wizard configuration (see The Application Wizard, page 21-2).

**Related Topics**
- Using Configuration Wizards, page 2-7
- The Application Wizard, page 21-2
The Tools Menu

The Tools menu of the Cisco CRS Administration web interface provides access to system tools you can use to perform a variety of administrative tasks and contains the following menu options:

- **Alarm Definition**—to use the alarm catalog to find information about an alarm message name (see Alarm Definition Menu Option, page 22-2).

- **Plug-ins**—to download plug-ins that you can use to enhance the CRS Engine (see The Plug-ins Menu Option, page 22-2).

- **Real-time Reporting**—to generate reports that provide detailed information about the status of your CRS system (see The Real-Time Reporting Menu Option, page 22-3).

- **Real-time Snapshot Config**—to configure the CRS database connection to a wallboard display (see The Real-time Snapshot Config Menu Option, page 22-4).

- **Historical Reporting**—to perform Historical Reporting tasks, including configuring the database server, synchronizing data, configuring users, installing client software, and purging your database (see The Historical Reporting Menu Option, page 22-7).

- **User Management**—to assign access levels to administrators and supervisors (see The User Management Menu Option, page 22-10).

- **Troubleshooting Tips**—to search the troubleshooting database for suggestions on how to solve problems that may arise in the performance of your CRS system (see The Troubleshooting Tips Menu Option, page 22-16).

- **Backup and Restore**—to (see The Backup and Restore Menu Option, page 22-16).
Alarm Definition Menu Option

The Cisco CRS Engine maintains a list of alarm catalogs, each of which contains a list of alarms and alarm definitions. Each alarm definition includes the alarm name, a description, an explanation, suggested actions, and related information.

Use the Alarm Definitions web page to find information about an alarm message name.

To access the Alarm Definitions web page, select Tools > Alarm Definition from the CRS Administration menu bar.

Note
For more information on Alarms and Alarm definitions, please see the Cisco Customer Response Solutions Servicing and Troubleshooting Guide.

Related Topic
Configuring Alarm Settings, page 12-14

The Plug-ins Menu Option

The CRS system includes software components called plug-ins that you can use to enhance the CRS Engine. You can download these plug-ins from the Plug-ins web page.

To access the Plug-ins web page, select Tools > Plug-ins from the CRS Administration menu bar.

The Plug-ins web page contains one or more of the following hyperlinks (depending on the Cisco CRS package you have purchased):

- **Cisco CRS Editor**—Click this hyperlink to install the client-side Cisco CRS Editor. For more information, see the Cisco Customer Response Solutions Developer Guide and the Cisco Customer Response Solutions Editor Step Reference Guide.

Caution
Do not install the CRS editor on the same machine as the Cisco Unity Editor. Both editors cannot coexist on the same machine.
The Real-Time Reporting Menu Option

- **Cisco Desktop Product Suite**—Click this hyperlink to install Cisco Desktop Administrator, Supervisor Desktop, or Agent Desktop. For more information, see *Cisco Customer Response Solutions Supervisor Desktop Plug-in Tasks* and the *Cisco Customer Response Solutions Agent Desktop Plug-in Tasks*.

- **Cisco CRS Historical Reports**—Click this hyperlink to install client-side historical reporting. For more information, see the *Cisco Customer Response Solutions Historical Reports User Guide*.

---

**Note** If you will use Cisco Historical Reporting, the Cisco CRS Historical Reports client system must be same version as the CRS system.

---

The Real-Time Reporting tool is a Java applet that you can use to generate a variety of reports that provide detailed information about the status of your CRS system. You use the Application Reporting web page to access the Real-time Reporting tool.

To access the Application Reporting web page, select **Tools > Real Time Reporting** from the CRS Administration menu bar.

---

**Note** For complete information about using the Application Reporting component, see Chapter 16, “Reporting on Real-Time CRS Data.”
The Real-time Snapshot Config Menu Option

Many call centers use wallboards to display their real-time reporting status. Wallboards can display data such as available agents in CSQs, call volumes, talk times, wait times, and number of handled calls. You can enable the CRS system to write Unified CCX real-time information to a database that can then be displayed on a wallboard.

**Note**

You must purchase the wallboard separately, and configure and control it with its own wallboard software. Wallboard software and hardware are supported by the third-party wallboard vendors, not by Cisco.

You must install the wallboard software on a separate machine or desktop, not on the CRS server. During installation of your wallboard software, you will need to configure your wallboard software to access the CRS database. To do this, you need to assign a DSN, User ID, and password.

Use the Real-time Snapshot Writing Configuration for Wallboard web page to enable the system to write data to the wallboard system.

To access the Real-time Snapshot Writing Configuration for Wallboard web page, select **Tools > Real Time Snapshot Config** from the CRS Administration menu bar.

The following fields are displayed on the Real-time Snapshot Writing Configuration for Wallboard web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Writing Enabled</td>
<td>If checked, the system writes the data to the database. If not checked, the system does not write the data to the database. The default is disabled.</td>
</tr>
<tr>
<td>Data Writing Interval</td>
<td>Sets the refresh interval for the wallboard data. Valid options: 5, 10, 15, 20, and 25.</td>
</tr>
<tr>
<td>Unified CCX CSQs Summary</td>
<td>If checked, writes information about each CSQ to the RtCSQsSummary table in the CRS database.</td>
</tr>
<tr>
<td>Unified CCX System Summary</td>
<td>If checked, writes overall Unified CCX system summary to the RtUnifiedCCXStatistics table in the CRS database.</td>
</tr>
</tbody>
</table>
The Real-time Snapshot Config Menu Option

Chapter 22 The Tools Menu

The wallboard software must be installed on a separate machine or desktop, not on the CRS server. During installation of your wallboard software, you will need to configure your wallboard software to access the CRS database. See the Cisco CRS Software and Hardware Compatibility Guide for compatibility information.

To do this, you need to create a system Data Source Name (DSN) on your Windows server by performing the following procedure.

**Procedure**

**Step 1**
Go to **Start > Programs > Administrative Tools > Data Sources (ODBC)**. The OBDC Data Source Administrator window opens.

**Step 2**
Click the System DSN tab and click **Add**. The Create New Data Source window opens.

**Step 3**
In the Create New Data Source window, choose a SQL Server driver and click **Finish**. The first Create a New Data Source to SQL Server window opens.

**Field** | **Description**
--- | ---
Server Name | Host Name or IP address of the Server running the Wallboard software pointing to the HDS Database Server which contains the Wallboard Real-time Snapshot data.
Administrator User ID | Unique identifier representing an administrator-level user of the Database Server.
Password | The password of the Administrator User of the Database Server.

**Note**
Configuring these Wallboard settings enables the WallboardDataWriter to update the host file on the wallboard software system with the HDS master IP address whenever HDS mastership changes on the CRS.

**Note**
For details about the information written to the RtCSQsSummary and RtUnifiedCCXStatistics database tables, see the *Cisco Customer Response Solutions Database Schema*.

The wallboard software must be installed on a separate machine or desktop, not on the CRS server. During installation of your wallboard software, you will need to configure your wallboard software to access the CRS database.

In the Create New Data Source window, choose a SQL Server driver and click **Finish**. The first Create a New Data Source to SQL Server window opens.

**See the Cisco CRS Software and Hardware Compatibility Guide for compatibility information.**
Step 4 In the first Create a New Data Source to SQL Server window, perform the following tasks:
- In the Name field, specify a name for this DSN (for example, Wallboard.)
- In the Description field, enter a descriptive name.
- In the Which SQL Server field, enter the CRS server IP address or system name.

Step 5 Click Finish.
The second Create a New Data Source to SQL Server window opens.

Step 6 In the second Create a New Data Source to SQL Server window, perform the following tasks:
- Check the Windows NT server authentication button.
- Use wallboardUser as login ID and password.

Step 7 Click Next.
The third Create a New Data Source to SQL Server window opens.

Step 8 In the third Create a New Data Source to SQL Server window, change the default database to db_cra and click Next.
The fourth Create a New Data Source to SQL Server window opens.

Step 9 In the fourth Create a New Data Source to SQL Server window, click Finish.
The ODBC Microsoft SQL Server window opens.

Step 10 In the ODBC Microsoft SQL Server window, click Test Data Source.
If the phrase “Test completed successfully” is returned, then click OK.
If the test is unsuccessful, return to the configuration sequence and fix any errors.
The Historical Reporting Menu Option

**Caution**
While Unified CM supports Unicode characters in first and last names, those characters become corrupted in Cisco CRS Administration web pages for RmCm configuration, Real Time Reporting, Cisco Agent/Supervisor Desktop, and Historical Reports., page 22-3

Use the areas of the Historical Reporting Configuration web page to perform a variety of tasks, including configuring users, installing client software, and purging your database.

To access the Historical Reporting Configuration web page to configure users and set up purging parameters for the Historical Reporting subsystem, select **Tools > Historical Reporting** from the CRS Administration menu bar.

**Note**
For additional information on Historical Reporting, see the *Cisco Customer Response Solutions Historical Reports User Guide*.

The Historical Reporting Configuration navigation bar contains the following hyperlinks:

- **Database Server Configuration**—to specify the maximum number of client and scheduler connections to the database server (see Database Server Configuration Hyperlink, page 22-8).
- **Purge Schedule Configuration**—to choose the user for which you want to configure the Historical Reports (see The Purge Schedule Configuration Hyperlink, page 22-8).
- **Purge Schedule Configuration**—to automatically purge data per the following configurations
  - Timing of the purge (see The Purge Schedule Hyperlink, page 22-9).
  - E-mail addresses notification and database size criteria for the purge (see The Purge Schedule Configuration Hyperlink, page 22-9).
- **Purge Now**—to manually purge data (see The Purge Now Hyperlink, page 22-9).
- **Migration Status**—to view the impact of a migration status from one release to another (see The Migration Status Hyperlink, page 22-10).
• **Unified EIM/WIM Database**—to configure the database access details for a Unified EIM or a Unified WIM database server (see The Unified WIM /Unified EIM Database Hyperlink, page 22-10).

**Database Server Configuration Hyperlink**

Use the Database Server Configuration area to specify the maximum number of client and scheduler connections that can access the database server.

Click the **Database Server Configuration** hyperlink on the navigation bar of the Historical Reporting Configuration web page to access the Database Server Configuration area.

**Related Topics**

Historical Reporting Configuration, page 13-2

**The Purge Schedule Configuration Hyperlink**

Use the Purge Schedule Configuration area to select a user for which you want to choose a reporting package for the CRS Historical Reports system.

Click the **Purge Schedule Configuration** hyperlink on the navigation bar of the Historical Reporting Configuration web page to access the Purge Schedule Configuration web page.

Use the Purge Schedule Configuration for User area to select a reporting package for this user from the list of installed reporting packages.

Use the arrow buttons to toggle highlighted selections between the Installed Report Page and Selected Reporting Package fields.

**Related topic**

Specifying Users for Historical Reporting, page 13-4
The Purge Schedule Hyperlink

Use the Purge Schedule Configuration area of the Historical Reports Configuration web page to control the daily purge schedule and specify how long records should persist before the system purges them.

To access the Purge Schedule Configuration area, click the **Purge Schedule Configuration** hyperlink on the navigation bar of the Historical Reporting Configuration web page.

**Related Topic**
Configuring Automatic Purging, page 13-5

The Purge Schedule Configuration Hyperlink

Use the Purge Schedule Configuration area of the Historical Reports Configuration web page to specify database size criteria for the purge and to whom purge notification should be sent.

To access the Purge Schedule Configuration area, click the **Purge Schedule Configuration** hyperlink on the navigation bar of the Historical Reporting Configuration web page.

**Related Topic**
Configuring Purge Schedule Configuration Parameters, page 13-7

The Purge Now Hyperlink

Use the Purge Now area to manually purge data.

Click the **Purge Now** hyperlink on the navigation bar of the Historical Reporting Configuration web page to access the Purge Now area.

**Related Topic**
Purging Manually, page 13-9
The Migration Status Hyperlink

Use the Migration Status area to view the impact of a migration status from one release to another.

As this option is only introduced in Cisco CRS Release 5.0, you will only be able to view the status information in this page when you migrate from this release to another.

Click the Migration Status hyperlink on the navigation bar of the Historical Reporting Configuration web page to access the Migration Status area.

Related Topic
Verifying the Migration Status, page 13-10

The Unified WIM / Unified EIM Database Hyperlink

Use the WIM/EIM Database area to configure the database access details for a Unified EIM or a Unified WIM database server.

Click the Unified WIM/Unified EIM Database hyperlink on the navigation bar of the Historical Reporting Configuration web page to access the Unified WIM/Unified EIM database web page.

Related Topic
Database Details for Multichannel Reports, page 13-11

The User Management Menu Option

The User Management menu option allows you to assign access levels to CRS system administrators and supervisors.

When you configure a CRS supervisor, you are configuring users who can access the CRS Supervisor web pages. You are not creating a supervisor for Unified CCX.
Only Administrators can update the CRS system. You must select at least one Administrator, so that someone is available to perform updates.

To access the User Management web page to assign administrative privileges to administrators and supervisors, select **Tools > User Management** from the CRS Administration menu bar.

This page contains the following hyperlinks:

- The User View Menu Option, page 22-11
- The Name Grammar Generation Configuration, page 22-12
- The Spoken Name Upload Menu Option, page 22-13
- The Capability View Menu Option, page 22-14

**Related Topics**

- Managing Unified CME Users, page 5-16
- About Cisco CRS User Capabilities, page 17-2
- Configuring and Using Remote Monitoring, page 7-29
- Creating a Remote Monitoring Supervisor, page 7-30
- Assigning Resources and CSQs to a Supervisor, page 7-31
- Viewing CSQ IDs for Remote Monitoring, page 17-8
- Creating a Team Supervisor, page 7-35
- Managing Unified CME Users, page 5-16

**The User View Menu Option**

To access the User Management web page to assign administrative privileges to administrators and supervisors, select **Tools > User Management** from the CRS Administration menu bar. Click the **User View** hyperlink on the left pane of the User Management Configuration web page to access the User Configuration area.

Use the User View web page to view existing users and to create new users. You can provide a search string based on a users ID, first name, or last name. The user ID column is hyperlinked to the user configuration page.
The Name Grammar Generation Configuration

Use the Name Grammar Generation Configuration web page to define scheduling information for the Name Grammar Generator.

Click the Name Grammar Generation Configuration hyperlink on the navigation bar of the User Maintenance Configuration web page to access Name Grammar Generation Configuration area.

Name Grammars need to be generated if you wish to use the Name to User Step with ASR. The Name Grammar Generator scans the User Directory and creates a speech recognition grammar containing every user in the directory. These grammars are saved in the grammar repository.

You may use the Name Grammar Generator Configuration page to run the Name Grammar Generator or schedule it to run at some later time. The page also displays date and time the Name Grammar Generator was last run and the completion status of that run.

The following fields are displayed on the Name Grammar Generation web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>How often Name Grammar Generator is automatically run. Valid options: Never, Daily, Weekly.</td>
</tr>
<tr>
<td>Run task on (hrs of day)</td>
<td>Time of day to run the task.</td>
</tr>
<tr>
<td>Run task on (day of week)</td>
<td>Day of week to run the task.</td>
</tr>
</tbody>
</table>
The User Management Menu Option

The Tools Menu

Chapter 22

The User Management Menu Option

The User Management Menu Option

The Spoken Name Upload Menu Option

When a caller requests to be transferred to a specific extension, CRS applications can play back a recording of the spoken name of the person to whom the caller has called. These spoken name recordings are stored as .wav files and managed by the Spoken Name Upload tool of the CRS Administration web interface.

To access the Spoken Name Prompt Upload web page, select the Spoken Name Upload hyperlink in the navigation bar of the User Maintenance Configuration page.

The Spoken Name Prompt Upload web page also contains the Click Here for More Recording Information hyperlink, which displays a text file in your browser with more information on recording spoken name prompts.

Related Topic

Add Spoken Name Prompts, page 10-14
The Capability View Menu Option

The Capability View web page also contains the following hyperlinks:

- Administrator (see The Administrator Capability View, page 22-14)
- Supervisor (see The Supervisor Capability View, page 22-14)
- Historical User (see The Reporting Capability View, page 22-15)
- Agent (see The Agent Capability View, page 22-15)

Related Topics
- Managing Unified CME Users, page 5-16
- Add Spoken Name Prompts, page 10-14
- About Cisco CRS User Capabilities, page 17-2

The Administrator Capability View

The capability view for the Administrator User Management web page contains a pane for the user(s) identified as the CRS Administrator and another pane with the list of Available Users. Based on your requirements, you can move users back and forth between these two panes by clicking on the arrows in either direction.

Related Topics
- The Capability View Menu Option, page 22-14
- Managing Unified CME Users, page 5-16
- Administrator Privileges, page 17-3

The Supervisor Capability View

The capability view for the Supervisor User Management web page contains a pane for the user(s) identified as the CRS Administrator and another pane with the list of Available Users. Based on your requirements, you can move users back and forth between these two panes by clicking on the arrows in either direction.

Related Topics
- Supervisor Privileges, page 17-3
The Reporting Capability View

The capability view for the Reporting Management web page contains a pane for the user(s) identified as the CRS Administrator and another pane with the list of Available Users. Based on your requirements, you can move users back and forth between these two panes by clicking on the arrows in either direction.

If a user is assigned the Reporting capability, then the Configure Resource hyperlink becomes visible on the top right corner. This link allows the assigned agent to configure resource Configuration.

Related Topics
- The Capability View Menu Option, page 22-14
- Managing Unified CME Users, page 5-16
- Historical Report User Privileges, page 17-4

The Agent Capability View

The capability view for the Agent User Management web page contains a pane for the user(s) identified as the CRS Administrator and another pane with the list of Available Users. Based on your requirements, you can move users back and forth between these two panes by clicking on the arrows in either direction.

If a user is assigned the Agent capability, then the Configure Resource hyperlink becomes visible on the top right corner. This link allows the assigned agent to configure resources.

Note

This role is assigned by default to Unified CME users with an Agent Extension association in Cisco CRS.

Related Topics
- The Capability View Menu Option, page 22-14
The Troubleshooting Tips Menu Option

The CRS system provides the Troubleshooting Tips tool as a way for you to search the troubleshooting database for suggestions on how to solve problems that may arise in the performance of your CRS system.

Note

For more information, see the Cisco Customer Response Solutions Servicing and Troubleshooting Guide.

To access the Troubleshooting Tips web page, select Tools > Troubleshooting Tips from the CRS Administration menu bar.

The Troubleshooting Tips web page also contains a hyperlink to the Cisco Technical Tips Website.

The following fields are displayed on the Troubleshooting Tips web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Components (Drop-down list.)</td>
<td>Restricts the search to a specific CRS component.</td>
</tr>
<tr>
<td></td>
<td>Note Selecting ALL will result in all components being searched for the problem keywords.</td>
</tr>
<tr>
<td>Enter Problem Keyword(s)</td>
<td>Searches the troubleshooting database for specific keywords.</td>
</tr>
</tbody>
</table>

The Backup and Restore Menu Option

Choose this option to migrate the required data when a node is being upgraded.

To access the Backup and Restore Configuration web page, select Tools > Backup and Restore from the CRS Administration menu bar.

For additional information refer to the following documents:

- For compatibility issues, see the Cisco CRS Software and Hardware Compatibility Guide.
• For the latest information on this release, see the *Release Notes for Cisco CRS*.

• For Installation issues, see the *Cisco CRS Installation Guide*.

The Backup and Restore Configuration web page contains the following hyperlinks:

• **Status** (see *Status, page 22-17*)

• **Backup Storage Location** (see *Backup Storage Location, page 22-17*)

• **Backup Scheduler** (see *Backup Scheduler, page 22-18*)

• **Backup Now** (see *Backup Now, page 22-18*)

• **Restore Now** (see *Restore Now, page 22-18*).

### Status

Use this option to view the status of the backup or restore at each stage of your configuration.

**Related Topics**

• **Guidelines and Requirements, page 15-2**

• **Backup Storage Location, page 22-17**

• **Backup Scheduler, page 22-18**

• **Backup Now, page 22-18**

• **Restore Now, page 22-18**

### Backup Storage Location

Use this option to specify the location of the file where the backup must be saved.

**Related Topics**

• **Guidelines and Requirements, page 15-2**

• **Specifying the Backup Storage Location, page 15-4**

• **Backup Scheduler, page 22-18**
The Backup and Restore Menu Option

- Backup Now, page 22-18
- Restore Now, page 22-18

Backup Scheduler

Use this option to ensure that the scheduled backup occurs at the designated time.

Related Topics
- Guidelines and Requirements, page 15-2
- Configuring the Backup Scheduler, page 15-5
- Backup Storage Location, page 22-17
- Backup Now, page 22-18
- Restore Now, page 22-18

Backup Now

Use this option to perform a manual backup at any time.

Related Topics
- Configuring the Backup Scheduler, page 15-5
- Guidelines and Requirements, page 15-2
- Backup Storage Location, page 22-17
- Performing a Backup Now, page 15-8
- Restore Now, page 22-18

Restore Now

Use this option to recover all data that was compressed into the backup file.

Related Topics
- Guidelines and Requirements, page 15-2
- Configuring the Backup Scheduler, page 15-5
- Restoring Data, page 15-10
- Backup Storage Location, page 22-17
- Backup Now, page 22-18
The Backup and Restore Menu Option
The Help Menu

The Help Menu of the Cisco Customer Response Solutions (CRS) Administration web interface provides access to online help for the Cisco CRS system.

Use the Help menu to access configuration procedures and descriptions of CRS components.

The Help menu contains the following menu options:

- **Contents and Index**—Choose this option to view the entire Cisco CRS Administrator Guide online help system and index (see The Contents and Index Option, page 23-2).

- **For this page**—Choose this option to view context-sensitive help (see The For This Page Menu Option, page 23-3).

- **CRS Documentation on Cisco.com**—Choose this option to view the documentation index page (see The For This Page Menu Option, page 23-3).

- **About**—Choose this option to view CRS version information (see The About Menu Option, page 23-3).
The Contents and Index Option

To view the entire Cisco CRS Administrator Guide online help system and index, choose Help > Contents and Index from the CRS Administration menu bar. The Cisco CRS Administrator Guide Online Help window opens.

When you click on any topic in the left pane, the section of the online help that corresponds to that topic appears in the right pane.

The table below describes the menu options in the Cisco CRS Administrator Guide Online Help window.

Table 23-1

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>Returns you to the beginning of the online help document.</td>
</tr>
<tr>
<td>Search</td>
<td>Opens a search window, in which you can search for specific words in the online help files.</td>
</tr>
<tr>
<td>Using Help</td>
<td>Opens a file explaining how to use the online help files.</td>
</tr>
<tr>
<td>Glossary</td>
<td>Opens a glossary of definitions for terms used in the Cisco CRS Administrator Guide.</td>
</tr>
<tr>
<td>View PDF</td>
<td>Opens a PDF¹ version of the Cisco CRS Administrator Guide.</td>
</tr>
<tr>
<td>Contents</td>
<td>Displays the contents of the CRS Administrator Guide online help files in the left pane of the online help window.</td>
</tr>
<tr>
<td>Index</td>
<td>Displays the index of the CRS Administrator Guide online help files in the left pane of the online help window.</td>
</tr>
</tbody>
</table>

1. PDF = Portable Document Format
The For This Page Menu Option

To access context-sensitive help, open the web page for which you want help and choose **Help > For This Page** from the CRS Administration menu bar. The Cisco CRS Administration online help displays information that is specific to the open web page.

The CRS Documentation Link Option

To access the complete CRS documentation set for Cisco Unified CCX, Unified IP IVR, and Unified QM, choose **Help > CRS Documentation on Cisco.com** from the CRS Administration menu bar. A new browser window opens to display the following documentation index page:


The About Menu Option

To access CRS version information, choose **Help > About** from the CRS Administration menu bar. The CRS Administration web page opens, displaying version information and package information.
Cisco CRS Licensing Packages

This appendix describes the features that are available with each Cisco CRS license package. It includes the following sections:

- Application Availability by License Package, page A-2
- Trigger Availability by License Package, page A-2
- Subsystem Availability by License Package, page A-2
- Historical Report Availability by License Package, page A-4
- CRS Services Availability by License Package, page A-4
- CRS Component Availability by License Package, page A-6
### Application Availability by License Package

The following table lists the applications available with each license package.

<table>
<thead>
<tr>
<th>Application</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Script Application</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Busy</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ring No Answer</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified ICME Post Routing</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified ICME Translation</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Trigger Availability by License Package

The following table lists the triggers available with each license package.

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CM Telephony</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified CME Telephony</td>
<td></td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTTP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Subsystem Availability by License Package

The following table lists the subsystems available with each license package.

<table>
<thead>
<tr>
<th>Subsystem</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMT Subsystem</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Core RTR Subsystem</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Subsystem Availability by License Package

<table>
<thead>
<tr>
<th>Subsystem</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Subsystem</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>eMail Subsystem</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Enterprise Server Data Subsystem</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTTP Subsystem</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Unified CM Telephony Subsystem</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CME Telephony Subsystem</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MRCP ASR Subsystem</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MRCP TTS Subsystem</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outbound Subsystem(^1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RmCm Subsystem</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Voice Browser Subsystem</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>VoIP Monitor Subsystem</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

\(^1\) The Outbound feature requires an additional Outbound license along with the Unified CCX Premium or Enhanced license.
Historical Report Availability by License Package

The following table lists the historical reports available with each license package.

<table>
<thead>
<tr>
<th>Historical Report Type</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Interactive Manager (CIM) for Unified EIM and Unified WIM¹</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Unified IP IVR</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Standard</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Unified CCX Enhanced</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Wrap-up code and reports</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

¹ The Unified EIM/WIM feature requires an additional CIM license along with the Unified CCX Premium license.

CRS Services Availability by License Package

The following table lists the CRS Services available with each license package.

<table>
<thead>
<tr>
<th>CRS Services</th>
<th>None¹</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRS Cluster View Daemon</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CRS Administration</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CRS Engine</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

¹ Cisco Desktop Call/Chat Service

<table>
<thead>
<tr>
<th>CRS Services</th>
<th>None¹</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Desktop Call/Chat Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cisco Desktop Enterprise Service</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cisco Desktop IP Phone Agent Service</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### CRS Services Availability by License Package

<table>
<thead>
<tr>
<th>CRS Services</th>
<th>None¹</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Desktop LDAP Monitor Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco Desktop License and Resource Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco Desktop Recording Service (call recording)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco Desktop Recording and Statistic Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco Desktop Sync Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco Desktop VoIP Service</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft DTC²</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft SQL Agent</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRS SQL Server - Agent</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRS SQL Server - Config</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRS SQL Server - Historical</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRS SQL Server - Repository</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Available upon installation, before license package is activated.
2. Distributed Transaction Coordinator (DTC)
CRS Component Availability by License Package

The following table lists the CRS Component available with each license package.

<table>
<thead>
<tr>
<th>CRS Component</th>
<th>None¹</th>
<th>Unified QM</th>
<th>Unified IP IVR</th>
<th>Unified CCX Standard</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRS Node Manager</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CRS Engine</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CRS Repository Datastore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CRS Historical Datastore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CRS Configuration Datastore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>CRS Agent Datastore</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRS Recording</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>CRS Monitoring</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

¹. Available upon installation, before license package is activated.

Support Scalability for Unified CME

See the Release Notes for Cisco Customer Response Solutions, Release 5.0 at.
ACD

Automatic Call Distribution. A feature that automatically routes incoming calls to the next available or longest idle agent or attendant in a line hunt group.

alarm

Signals that declare the run-time status and state of the Cisco CRS system and provide information for troubleshooting. Alarms can be forwarded to a Syslog server, to an SNMP trap subagent, or to a Windows Event Log.

alarm catalog

A file that contains alarms definitions.

alarm definition

A list of alarms and their properties. The definition for each alarm includes the alarm name, a description, an explanation, recommended actions, and related information.

alarm message

An alarm name followed by the reason for the alarm or the module name.
alarm service

A Windows service that receives alarms from the Cisco CRS Engine and its subsystems.

application

In general, an application is a program that helps you accomplish a specific task; for example, a word processing program, a spreadsheet program, or an FTP client. Applications should be distinguished from system programs, which control the computer and run applications, and utilities, which are small assistance programs. In Cisco CRS, an application represents a configured combination of one or more triggers, a script, and the values for any parameter in that script.

Application Engine

A group of Java beans that can be combined in many ways to create applications such as Unified IP IVR. The Application Engine is the execution vehicle for all Cisco CRS based applications including Cisco Unified Contact Center Express, Cisco Unified IP IVR, and Cisco Unified Queue Manager scripts.

ASR

Automatic Speech Recognition. A technology that allows users of IVR systems to speak entries rather than enter numbers on a keypad.

Automatic Call Distribution

See ACD.

Automatic Speech Recognition

See ASR.

C

Call control group

Allows you to control how the Cisco CRS system uses CTI ports.

Call queuing

A method of handling calls until they can be answered by an agent.
**Campaign**

A grouping of contacts for a particular purpose, such as a sales drive or a general announcement to a group of customers. Campaigns are used by Cisco Unified Outbound Preview Dialer to automatically place outgoing calls to a specific list of contacts.

**Campaign manager**

A Campaign Manager is the main control program of the Cisco Unified Outbound Preview Dialer. It maintains campaigns, dialer configuration, and current campaign data.

**CDP**

Cisco Discovery Protocol. Media- and protocol-independent device-discovery protocol that runs on all Cisco-manufactured equipment including routers, access servers, bridges, and switches. Using CDP, a device can advertise its existence to other devices and receive information about other devices on the same LAN or on the remote side of a WAN. CDP runs on all media that support SNAP, including LANs, Frame Relay, and ATM media.

**Cisco CRS Alarm Service**

A Windows service automatically installed as part of Cisco CRS installation that receives alarms about system events from the Cisco CRS Engine and its subsystems. These alarms are defined in XML format in files called *catalogs*, which are set up as part of the Cisco CRS installation process.

**CISCO-CCM-MIB**

Cisco Unified Communications Manager Management Information Base. Exports the data in the Cisco Unified Communications Manager (Unified CM) database and other data sources. Examples of data exports include Unified CM group tables, region tables, time zone group tables, phone detail tables, gateway information tables, and status traps.

**Cisco CRS**

Cisco Customer Response Solutions. A platform that offers integrated application functionality, including Cisco Unified Contact Center Express (Unified CCX) for contact center functionality such as ACD, CTI, IVR, Cisco Unified IP IVR.
(Unified IP IVR) for call treatment and self-help automation, and Cisco Unified Queue Manager (Unified QM), an option for an IP Contact Center that provides call treatment to calls in queue.

**Cisco CRS Editor**

A Windows tool with which application designers create new scripts or modify existing scripts. The visual scripting tool allows designers to drag and drop call-flow steps from a palette into the main design window.

**Cisco CRS Engine**

Execution vehicle for Cisco CRS scripts. The Cisco CRS Engine can run multiple scripts simultaneously. On startup, the Cisco CRS Engine loads all scripts and configuration information from the Cisco CRS configuration datastore server. Individual scripts can be updated in real time and manually pushed to the Cisco CRS Engine without restarting the engine. Scripts that are running when a download occurs will not be affected by updates; they will run to completion with the pre-update logic. One Unified CM can support multiple Cisco CRS engines, but the Cisco CRS engines bind to only one Unified CM.

One Unified CM supports many Cisco CRS Clusters (and not just one engine) and one Cisco CRS cluster, which may contain up to 2 Cisco CRS Engines, binds to one Unified CM.

**Cisco Unified Contact Center Enterprise (Unified CCE)**

Unified CCE can also handle traditional ACD calls and functions as a virtual ACD. Capabilities of Unified CCE include intelligent multichannel contact routing, ACD functionality, network-to-desktop CTI, IVR integration, call queuing, and consolidated reporting.

**Cisco Unified Contact Center Express (Unified CCX)**

Unified CCX is an application that uses the Cisco Customer Response Solutions (Cisco CRS) platform to provide a multimedia (voice, data, and web) IP-enabled customer-care environment to enhance the efficiency of contact center. Unified CCX is available in Unified CCX Standard, Unified CCX Enhanced, and Unified CCX Premium packages.
Cisco Unified Contact Center Express (Unified CCX) Call Monitoring Server

Dedicated server that provides for call monitoring.

Cisco Unified Contact Center Express (Unified CCX) Call Statistics, Recording, and Monitoring Server

Dedicated server that maintains Unified CCX call statistics and that provides for recording and call monitoring for Unified CCX Enhanced.

Cisco Unified Communications Manager (Unified CM)

The Unified CM software extends enterprise telephony features and capabilities to packet telephony network devices such as IP phones, media processing devices, VoIP gateways, and multimedia applications.

Cisco Unified Communications Manager Express (Unified CME)

Unified CME integrates a core set of key system and small PBX functionality with a wide variety of rich IOS voice features inside Cisco multiservice and integrated services routers. By converging voice and data into a single platform, Cisco CallManager Express streamlines operations and lowers network costs, while increasing productivity.

Cisco Unified E-Mail Interaction Manager (Unified EIM)

Unified EIM increases agent productivity through a powerful, visual workflow designer that helps create the e-mail handling process. Using the required service level agreement (SLA) triggers, you can automate email routing and monitoring. This e-mail collaboration provides full HTML support for both inbound and outbound communications, the ability to attach larger files from the agent desktop is supported, and powerful content-parsing capabilities in the product enable auto-suggestions from the knowledge base.

Cisco Unified Intelligent Contact Management Enterprise (Unified ICME)

The Unified CCE component that is responsible for making routing decisions and performing ACD functions. In Cisco CRS with the IPCC Gateway PG, Unified CCX can be integrated as an ACD with Unified ICME software.
Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) subsystem

A subsystem of the Unified IP IVR system that allows that system to interact with Unified ICME. Unified ICME provides a central control system that directs calls to various human and automated systems, such as Voice Response Units (VRUs) and ACDs.

Cisco Unified Outbound Preview Dialer (Outbound)

Allows agents who are not busy with inbound calls to handle outbound calls, thereby maintaining high level of agent productivity. The Outbound provides the ability to create and schedule Outbound campaigns for Unified CCX. The Contacts to Dial are kept in the Cisco CRS Database. A campaign selects agents from CSQs assigned to it.

Cisco Unified Queue Manager (Unified QM)

Unified QM is an IP-based call treatment and solution that provides powerful call-treatment options as part of the Cisco CRS solution.

Cisco Unified Web Interaction Manager (Unified WIM)

Unified WIM ensures that your online customers are connected easily and seamlessly to the right agent every time. It also provides powerful file-sharing capabilities which allows agents to easily share files residing on their desktop. Advanced co-browsing capabilities allow agents and the customers to fill out forms together, field by field, even highlighting specific areas of a form or Web page for additional clarity.

Configuration Datastore Server (CDS)

The Cisco CRS Configuration Datastore Server (CDS) manages and shares configuration, component, and application information within the Cisco CRS cluster and communicates with Unified CM.

Cisco Discovery Protocol

See CDP.

Cisco Media Termination

See CMT.
CISCO-VOICE-APPS-MIB
Cisco Voice Applications Management Information Base. Provides information about supported SNMP traps.

CiscoWorks
CiscoWorks, available as a package separate from Cisco CRS, provides a suite of web-based applications for managing Cisco devices. It is the network management system (NMS) of choice for the Cisco CRS system and for other Cisco Unified Communications family of products.

Cluster
A Cisco CRS cluster consists of a server (node) running Cisco CRS components in your Cisco CRS deployment.

Cluster profile
The Cisco CRS web page (home page) displays information about the cluster profile. A cluster profile includes data relating to the Cisco CRS servers, components, and licenses installed in a cluster.

CMT
Cisco Media Termination. An option to terminate the media on an agent’s personal computer.

CM Telephony
The Unified CM Telephony Application Programming Interface.

CM Telephony call control groups
A pooled series of CTI ports that the Cisco CRS system uses to serve calls as they arrive at the Cisco CRS server.

Codec
Coder/Decoder. A sampling and compression algorithm.
Comma-Separated Value

See CSV.

Component

An installation unit, either hardware or software, that you can install in a Cisco CRS system. Cisco CRS software components include the Cisco CRS Engine, the Database component, the Monitoring component, and the recording component. Hardware components include servers and client computers. You select the components you want when you install the system.

Configuration file

A file containing information for a computer or an application.

Contact

A connection with a remote customer.

Contact Service Queue

See CSQ.

Cisco CRS Datastores

Components that allow you to manage and monitor historical, repository, and configuration data across all servers in the Cisco CRS cluster.

CSQ

Contact Service Queue. In Unified CCX, a CSQ is a call queue associated with one and only one Unified CM CTI Route Point.

CSV

Comma-separated value. A text file format used as a way of recording database fields.
**CTI**

Computer Telephony Integration. The name given to the merger of traditional telecommunications (PBX) equipment with computers and computer applications. The use of caller ID to retrieve customer information automatically from a database is an example of a CTI application.

**CTI Port**

A virtual port, analogous to a trunk line in a traditional ACD or PBX setting. A CTI Port allows access to the post-pouting capabilities of Unified IP IVR.

**CTI Port Group**

A group of access points into the Unified CCX telephone network.

**CTI Route Point**

A virtual device that can receive multiple simultaneous calls for the purpose of application-controlled redirection.

**Customizer**

A window used to configure the properties of a step in the Cisco CRS Editor.

**Datastores**

See Cisco CRS Datastores

**Data type**

In a programming language, a set of data with values having predefined characteristics. Examples include integer, floating point unit number, character, string, and pointer. Usually, a limited number of such data types come built into a language. The language usually specifies the range of values for a given data type, how the values are processed by the computer, and how they are stored.

**Default script**

A script that gracefully terminates a call in the event of an error in the main script.
Deployment scenario

A set of Cisco CRS features and options on a server or servers.

Dialing list

A file containing a list of customer account numbers, names, and phone numbers that can be imported as contacts for a specific outward bound campaign.

Directory profile

The directory profile describes the directory structure. It contains the directory host name or IP address, directory port number, directory user (DN), directory password, base context, server type, and configuration profile name. For each Unified IP IVR system, a directory profile must be created. There are two directories associated with each Unified IP IVR system: the Configuration Directory and the Repository Directory (called “the Repository”).

Direct preview dialing mode

A mode of dialing in the Outbound In this mode, Cisco Agent Desktop (CAD) software enables agents to view outbound call requests automatically placed by the system.

DTMF

Dual Tone Multi-Frequency. The signal to the telephone company that is generated when you press a key on a telephone keypad. With DTMF, each key you press on your phone generates two tones of specific frequencies. So that a voice cannot imitate the tones, one tone is generated from a high-frequency group of tones and the other from a low-frequency group. Unified CCX telephone keypad presses resulting in DTMF is often used to capture customer input to IVR prompts.

Dual Tone Multi-Frequency

See DTMF.
E

Event

An occurrence that is significant to an application and that may call for a response from the application.

Excel (XLS) format

Format of data in the Microsoft Excel spreadsheet application.

Export

To convert a file from the format of one application to the format of another application, or to move data out of one file and import it into another file.

Expression

A formula, evaluated when a Cisco CRS script executes, to determine the value of a variable.

F

Field (also database field)

An item in a database record. For example, Name, City, or Zip Code. A group of fields make up a record.

G

Grammar

A set of spoken phrases or DTMF digits that can be recognized by a script.

I

ICME

See Unified ICME
Interactive Voice Response

See IVR.

IP Phone Agent

A Unified CCX agent without a personal computer. The agent logs in, logs out, and changes states using the Cisco IP Phone screen.

IVR

Interactive Voice Response. A system that provides information as recorded messages over telephone lines in response to user input in the form of spoken words or, more commonly, DTMF signaling.

J

Java Database Connectivity

See JDBC.

JDBC

Java Database Connectivity. A Java API that enables Java programs to execute SQL statements, allowing Java programs to interact with any SQL-compliant database. Because nearly all relational DBMSs support SQL, and because Java itself runs on most platforms, JDBC makes it possible to write a single database application that can run on different platforms and can interact with different database management systems (DBMSs). JDBC is similar to Open Database Connectivity (ODBC) but is designed specifically for Java programs, whereas ODBC is language-independent.

L

Log file

A file that keeps track of the activity of a computer or an application.
Glossary

M

Master service

The service that controls the service-specific function in a Cisco CRS cluster where you can have more than one service of the same type. Only one service of a given type can be the master within the Cisco CRS Engine component. You cannot configure the master service.

MCS

Media Convergence Server. A turnkey server platform for Cisco CRS.

Media Termination

See CMT.

Management Information Base

See MIB.

Media Convergence Server

See MCS.

Media Termination

See CMT.

MIB

Management Information Base. Database of network management information that is used and maintained by a network management protocol, such as SNMP or CMIP. The value of a MIB object can be changed or retrieved using SNMP or CMIP commands, usually through a graphical user interface network management system. MIB objects are organized in a tree structure that includes public (standard) and private (proprietary) branches.

MRCP

Media Resource Control Protocol. An application level protocol that enables client devices requiring audio/video stream processing to control media service resources like Speech Synthesizers (TTS), Speech Recognizers (ASR), Signal
Generators, Signal Detectors, Fax Servers, and so on over a network. This protocol is designed to work with streaming protocols like Real Time Streaming Protocol (RTSP) or Session Initiation Protocol (SIP) which help establish control connections to external media streaming devices, and media delivery mechanisms like Real Time Protocol (RTP).

**N**

**Node**

A computer that is linked to other computers in a network of computers.

**P**

**Palette**

A grouping of steps in the Cisco CRS Editor.

**Pane**

A part of a window that is devoted to a specific function.

**PIM**

Peripheral Interface Manager. The Cisco proprietary interface between a peripheral device and the Peripheral Gateway.

**Ports**

In a communications network, a logical channel identified by its unique port number.

**Post-Routing**

Process of making a routing decision after a call reaches a termination point.

**Pre-Routing**

Process of making a routing decision before a call reaches a termination point.
Prompts

A message from a computer that asks the operator to do something, such as enter a command, enter a password, or enter data, or that indicates that the computer is ready to accept input.

Purge

To delete both a set of data and all references to the data.

R

Real-Time Transport Protocol

See RTP.

Record (also database record)

In a database, a group of fields that make up one complete entry. For example, record about a customer might contain fields for name, address, and telephone number.

Repository

The subdirectory in the configuration datastore where Cisco user scripts are stored. You manage your Cisco scripts with the Repository Manager.

Resource

Agent enabled to handle Unified CCX calls.

Resource group

A set of related resources.

RTP

Real-Time Transport Protocol. One of the IPv6 protocols. RTP is designed to provide end-to-end network transport functions for applications transmitting real-time data, such as audio, video, or simulation data, over multicast or unicast network services. RTP provides services such as payload type identification, sequence numbering, time stamping, and delivery monitoring to real-time applications.
Glossary

S

Scheduler

A program that resides on a Cisco CRS Historical Reports client computer. The Scheduler maintains information about each scheduled report, including when the report should execute and what information the report should contain. The scheduler also executes scheduled reports at their scheduled times, based on the time and date of the Cisco CRS Historical Reports client computer.

Script

A sequence of steps constructed in the Cisco CRS Editor. Scripts are sometimes also called flows, call flows, or work flows since scripts control the flow of a call.

Server

A computer that provides services or resources to other computers (called clients) connected to it through a network.

Service

A program, routine, or process that performs a specific system function to support other programs, particularly at a low (close to the hardware) level. In Cisco CRS, you can have a master service and a standby service.

Serviceability

Enables remote network management support for the Cisco CRS system. Serviceability enables this support through CiscoWorks and through any other third-party network management system (NMS) that uses standard protocols.

Session (historical reporting)

Historical reporting seats are also called historical reporting sessions. Historical reporting sessions (seats) refer to the number of historical reporting clients that can be started at the same time on different client machines.

Session (script)

An object that stores information about a caller as they move through a script...
Simple Network Management Protocol

See SNMP.

Skill

Designated competency of an agent in a given area. Enables agents to handle calls associated with their expertise.

Skill Based Routing

The routing of calls to agents with designated skills.

Snapshot Agent

Generates a snapshot or image of the current database data.

SNMP

Simple Network Management Protocol. The standard protocol for network management software. Using SNMP, programs called SNMP agents monitor devices on the network. Another program collects the data from the agents. The database created by the monitoring operations is called a management information base (MIB).

SNMP agent

Simple Network Management Protocol agent. Hardware or software that monitors devices on a network. Data from an SNMP agent, which is contained in a MIB, helps in network management and troubleshooting.

SNMP service

A Windows service that provides a framework for SNMP and provides the SNMP agent that interfaces with SNMP subagents.

SNMP subagent

Cisco provides SNMP subagents to support each Cisco MIB. The SNMP service loads the Cisco SNMP subagents and it exchanges SNMP messages with the SNMP subagents. The SNMP service formats information as MIBs and sends this information to a Network Management System (NMS). It also sends traps from the SNMP subagents to the appropriate SNMP trap receivers.
**Step**
A single element in the Cisco CRS Editor that accomplishes a specific function.

**Subfacility**
A traceable software component.

**Subsystem**
Extensible modular development environment that performs a particular function.

**Syslog**
A Cisco standard that allows for logging of errors across an enterprise. Provides local logging of network events to files. Also provides remote logging to various systems via standard protocols.

**Table (also database table)**
A presentation of information organized in rows and columns.

**Text-to-Speech**
See TTS.

**Trace (also trace file)**
A TCP/IP utility that allows you to determine the route packets are taking to a particular host. Trace route works by increasing the “time to live” value of packets and seeing how far they get, until they reach the given destination.

**Trap (also SNMP trap)**
A program interrupt, usually caused by some exceptional situation in an application. In most cases, after such an interrupt, the operating system performs some action, then returns control to the application.
Trigger

Signals that respond to incoming contacts at a specified route point by selecting telephony and media resources to serve the contact and invoking application scripts to handle it. The Cisco CRS system uses JTAPI triggers to start responses to telephone calls and HTTP triggers to start responses to HTTP requests. In these cases, telephone numbers and Web addresses (associated with the triggers) act as the triggers.

TTS

Text-to-Speech. A speech synthesis application that creates a spoken sound version of the text in a document or database.

TTS Client

A component of TTS that must reside on the Cisco CRS server.

TTS Server

A dedicated server that converts text into speech and plays it back to the caller.

V

Variable

A placeholder for data.

VXML (also VoiceXML)

Voice Extensible Markup Language. Allows a user to interact with the Internet through voice-recognition technology.

Variable

A placeholder for data.
Wrap-up

Call-related work performed by an agent after the call is over. An agent performing wrap-up is in either the Work Ready or Work Not Ready state. Often includes entering data, filling out forms and making outbound calls necessary to complete the transaction. The agent is unavailable to receive another inbound call while in this mode.

XML

Extensible Markup Language. A programming language developed by the World Wide Web Consortium that allows Web developers to create customized tags that will organize and deliver efficiently. XML is a metalanguage, containing a set of rules for constructing other markup languages.
A

AAR
  files 10-19
  group 6-13
  management 19-7
  uploading files 10-22
active server 1-8, 11-2, 11-7
adding triggers
  Unified CME Telephony 5-10
administrator privileges 17-3
agent
  capabilities 17-2
  configuring 4-20
  configuring teams 7-34
datastore contents 12-5
  handling callbacks 14-19
  user privileges 17-5
alarm settings 12-14
alternative pronunciation 17-10
  Call by Name window 17-11
  Call by Name window, how to add 17-11
application
  by package license A-2
  configuration overview 1-16
management 19-2
report 16-10, 16-12, 16-17
server 1-4
  subsystem 1-10
  triggers 9-18
architecture, cluster 1-7
ASR
  installation guidelines 6-26
  overview 6-26
  provisioning 6-27
  authentication
    mixed mode 13-11
Automated Alternate Routing
  see AAR 6-13
  automatic failover 1-8, 11-2, 11-7
Automatic Speech Recognition
  see ASR 6-26
B
backup
  phase requirement 15-3
  schedule 15-5
  storage location 15-4
Backup and Restore
Index

application 15-1
requirements 15-2
tasks 15-2
busy application
about 9-7
provisioning 9-7

C

cache size
contact records 14-24
call control channel 6-3
calling search space
ignore setting 6-20
restrict users 6-19
Unified CME Telephony trigger setting 5-11
Unified CM Telephony trigger setting 6-15
usage 6-12, 6-19
call processing during failover 11-7
call waiting
disabling in Unified CM 14-6
campaigns
importing contacts 14-25
Outbound subsystem 14-5
time changes 14-21
capabilities
users 17-2
channels
provisioning 6-3

CIM
license A-4
circular resource selection 7-23
Cisco CRS Administration web interface
about 1-3, 2-1
configuration web pages 2-4
menu bar and menus 2-3
using "Add a New . . . Hyperlink" 2-6
using hyperlinks and buttons 2-6
using navigation bars 2-5
Cisco CRS applications
configuration overview 9-2
Cisco CRS components 1-2
Cisco CRS Editor, about 1-3
Cisco CRS Engine
about 1-9
configuring tracing 11-28
starting and stopping 11-16
tracing files 18-8
Cisco CRS Engine subsystems 1-10
Applications 1-10
Cisco Media 1-10
Core Reporting 1-10
Database 1-10
eMail 1-10
Enterprise Server 1-10
HTTP 1-10
MRCP ASR 1-10
RmCm 1-11
TTS 1-11
Unified CME Telephony 1-10
Unified CM Telephony 1-10
Unified ICME 1-10
Cisco CRS platform, about 1-1
Cisco CRS product family
  about 1-4
  Unified CCX 1-5
  Unified IP IVR 1-4, 1-6, 1-10
  Unified QM 1-6
Cisco CRS Server, about 1-2
Cisco Desktop Administration 7-34
Cisco IP Agent and Supervisor desktops
  about 1-3
Cisco Media subsystem
  about 1-10
  provisioning 6-23
Cisco Script Application
  adding 9-3
  adding a trigger 9-18
Cisco Security Agent
  usage 14-4
Cisco TelePresence application 4-17
Cisco Unified Communications components
  about 1-2
  Cisco CRS Administration web interface 1-3
Cisco CRS Editor 1-3
Cisco CRS Server 1-2
Cisco IP Agent and Supervisor desktops 1-3
Cisco Unified Gateway 1-2
  historical reports database server 1-3
  MRCP ASR server 1-3
  MRCP TTS 1-3
  Unified CCX call statistics, recording, and monitoring server, about 1-3
  Unified CM 1-2
  Unified CME 1-2
Cisco Unified Email Interaction Manager
  Multichannel reports 13-11
Cisco Unified IP IVR, about 1-6, 1-10
Cisco Unified Web Interaction Manager
  Multichannel reports 13-11
cluster
  active server 1-8
  architecture 1-7
  cluster manager 1-8
  cluster view daemon 1-9
  restore dependency 15-10
  restore guideline 15-11
  cluster, definition 11-2
  cluster setup
    backup operation 15-8
CMT dialog channels, about 6-23
CMT dialog group
  about 6-23
CMT dialog interactions, about 6-23
CM Telephony
  Call Control group configuration 20-3
  provider configuration 20-3
triggers 20-4
CM Telephony providers
  about 5-9
  configuring 5-9
CM Telephony subsystem
  configuration overview 5-7
  configuring CM Telephony providers 5-9
competence level, about 7-10
component, definition 11-3
components, activating 11-12
Computer Telephony Interface
  see CTI 1-9
configuration
dataset server 1-2
configuration checklist
  Outbound subsystem 14-9
configuration data 15-9
Configuration datastore, contents 12-5
Configuration Datastore Server
  in service 14-4
configuration updates
  Outbound subsystem 14-21
configuring, definition 1-11
Contact Service Queues
  about 7-17
  creating 7-18
  deleting 7-25
  modifying 7-24
contacts report 16-13
contact summary report
  Outbound 14-3
  control center (System menu) 11-3
  control center management
    overview 11-3
Core Reporting subsystem, about 1-10
CPU utilization
  and VRU scripts 9-26
  creating campaigns 14-9
CRS Administration
  connecting 2-2
CRS Administrator
  changing password 11-32
  synchronizing password 11-32, 11-33
CRS Admin utility
  about 11-30
  account sync refresh 11-35
  logging on 11-31
CRS Cluster
  profile G1-7
CRS cluster
  profile 11-2
CRS component availability
  by package license A-6
CRSHistRptUsr
  synchronizing password 11-34
CRS Serviceability utility
  launching 11-37
  node information, updating 11-38
properties files, updating 11-37
Unified CM IP address, updating 11-39
Unified CM LDAP information, updating 11-39
CRS supervisor web interface 17-6
CRS user options web interface 17-9
CSA
  restore requirement 15-11
CSQ
  about 1-5
  creating 20-11
  Outbound percentage 14-22
  Outbound subsystem percentage 14-9
  resource based 7-17
  skill based 7-17
  Subsystems menu 20-11
CSQ Cisco Unified CCX Stats report 16-23
CTI
  managing clusters 1-9
  port device and route point 6-15
CTI Ports
  Unified CME guidelines 5-2
custom
  classpaths for custom classes, steps, subsystems 18-6
  steps 18-7
  subsystems 18-7
custom file configuration 18-6
custom file configuration (System menu) 10-15

D
daily purge schedule
  about 13-6
  configuring 13-6
database
  maximum connections 8-16
  MS SQL 2000 13-11
  parameter 20-22
  password 8-16
  username 8-16
database connectivity
  polling 8-17
database purging, manual 13-9
Database subsystem
  about 1-10, 8-2, 8-12
  adding ODBC datasource 8-16
  configuration overview 8-13
  configuring 8-12
  defining ODBC datasource 8-13
  supported Enterprise Databases 8-13
datasource, adding 20-22
datasource usage report 16-19
Datastore
  Control Center, overview 12-4
datastore
  failover support and high availability 12-2
datastore control center 18-5
datastores
  starting, stopping, and restarting 12-15
Daylight Savings Time
   see DST 14-8
db_cra database
   area code mapping 14-20
db_cra repository 15-9
default schedule
   restore 15-7
default time zone 14-29
devices
   by package license A-4
dialing functionality 14-2
dialing lists
   importing 14-14
dialing mode
   direct preview 14-2, 14-6
dialing prefixes
   geographic area 14-9
Directory Number
   associations 4-19
Directory Number information 5-11, 6-15
disabling a server 11-13, 11-14
disabling the Scheduler 15-6
do_not_call list
   national 14-5
document file
   unzipping after upload 10-11
documents
   about 10-6
Do Not Call list
   Outbound subsystem 14-5
dst
   Outbound subsystem 14-8

E

eMail subsystem
   about 1-10, 8-2, 8-19
   configuring 8-19
   enabling campaigns 14-9, 14-27
   enabling the Scheduler 15-5
   engine tasks report 16-13
   Enterprise Server subsystem, about 1-10
   expansion server, about 11-2

F

failover
   and call processing 11-7
   automatic 1-8
failover support 12-2
feature, definition 11-3
files
   adding zip 10-10
   managing for applications 10-1

G

general properties
Outbound subsystem 14-9, 14-11
geographic region
  Outbound support 14-4
grammars
  about 10-4

H
handling callbacks 14-19
Help menu 23-1
  About 23-3
    Contents and Index 23-2
    For this Page 23-3
high availability 11-7, 12-2
Historical datastore, contents 12-5
historical reporting
  client 1-4
    configuration overview 1-17
    configuring users 13-10, 13-12
historical reporting database
  configuring daily purge schedule 13-6
  configuring database server 13-3
  importing data files 13-15
  purge configuration 13-7
  purge schedule management 13-5
historical reports
  by package license A-4
historical reports database
  purging manually 13-9
historical reports database server
  about 1-3
historical report user capabilities 17-2
historical report user privileges 17-4
HTTP subsystem
  about 1-10, 8-2, 8-8
    configuration overview 8-8
  HTTP triggers, adding 9-24

I
importing campaigns 14-9
importing contacts
  dialing lists 14-16
installation guidelines
  ASR/TTS 6-26
Integrated Service Router
  see ISR 1-9
international area codes
  mapping 14-4
invalid number
  handling callbacks 14-19
IP address, updating (examples) 11-40
ISR
  Cisco Unified CME integration 7-31, 7-35
  Unified CME integration 1-9, 5-17
K

keep alive session management 5-2

L

LDAP server information (System menu) 11-22
least skilled
  by order 7-22
  by weight 7-22
resource selection 7-21
license
  adding components 1-15
  application availability A-2
  CIM (Unified EIM/Unified WIM) A-4
  CRS component availability A-6
database subsystem 8-12
eMail subsystem 8-19
historical report availability A-4
HTTP subsystem 8-8
multichannel reports 13-12
Outbound 14-1, 14-3, A-3
product 6-14
service availability A-4
subsystem availability A-2
trigger availability A-2
triggers 5-10
Unified CME Telephony subsystem 5-6
Unified CM Telephony subsystem 6-5
Unified EIM/Unified WIM 13-11
Unified ICME subsystem 8-3
linear
  resource selection 7-23
log file, automatic purging activities 13-5
logging alarms 12-14
logging traces 12-9
logout 18-11
logout (System menu) 11-28
longest available
  resource selection 7-21, 7-23

M

MADM directory 13-9
manage scripts 19-3
managing users 17-2
master server
  reflecting 11-16
master service, definition 11-3
media channel 6-3
migrating Unified CM Telephony provider information 6-23
missed callback 14-19
mixed mode 13-11
most handled contacts
  resource selection 7-21, 7-23
most skilled
  by order 7-22
  by weight 7-22
resource selection 7-21
MRCP ASR
  groups configuration 6-31
  provider configuration 6-28
  provisioning 6-27
  server configuration 6-29
MRCP ASR server, about 1-3
MRCP ASR subsystem
  about 1-10
  configuration overview 6-27
  provisioning 6-27
MRCP TTS
  locals configuration 6-38
  provider configuration 6-35
  provisioning 6-34
MRCP TTS server, about 1-3
MRCP TTS subsystem
  about 1-11, 6-34
  provisioning 6-34
MS SQL 2000 database 13-11
multichannel license 13-11, 13-12
multiple-node deployment
  restore operation 15-10
multiple time zones 14-29

N
national do_not_call list 14-4, 14-26
navigation bar
  using 2-5

Network Interface Cards
  see NIC 15-2
Network Time Protocol
  See NTP 4-12
NIC
  Backup and Restore guideline 15-2
  nickname 17-11
  node, definition 11-2
  NTP configuration
    modifying 4-12

O
ODBC datasource
  about 8-13
  adding 8-16
  defining 8-13
Outbound
  license 14-1, 14-3
  licensed seat 14-7
Outbound license A-3
Outbound Subsystem
  in service 14-3
Outbound subsystem
  Do Not Call list 14-5
Overall Unified CCX Stats report 16-20
passwords, changing
  CRS Administrator 11-32
passwords, synchronizing
  CRS Administrator 11-32, 11-33
CRSHistRptUsr 11-34
pending records
  Outbound subsystem 14-8
pending state 14-21
plug-ins 22-2
point system for provisioning channels 6-3
product
  licenses 6-14
product license
  database subsystem 8-12
eMail subsystem 8-19
HTTP subsystem 8-8
Unified ICME subsystem 8-3
profile, cluster 11-2, 61-7
prompts
  about 10-2, 10-11
  adding spoken name prompt 5-16, 5-17, 10-15
  recording 10-13
provisioning, definition 1-11
provisioning call control groups 6-9
Provisioning checklist
  Unified CCX subsystem 3-4
provisioning checklist
  telephony and media resources 6-5
publisher
  activation 12-8
  cluster manager 1-9
database 12-2
snapshot agent 12-2
purge configuration
  parameters 13-7
PurgeProcess.log 13-5
purging
  automatic 13-5
  manual 13-7
purging, manually 13-9
queueing calls
  with Unified CCX 6-21
real-time reports
  about 16-1
  application tasks 16-12
  application tasks summary 16-10
  available reports 16-2
  contacts 16-13
  contact summary 16-8
  CSQ Cisco Unified CCX Stats 16-23
datasource usage 16-19
engine tasks 16-13
Overall Unified CCX Stats 16-20
printing reports 16-5
resetting statistics 16-5
Resource Unified CCX Stats 16-24, 16-27
running reports 16-4
sessions 16-18
setting appearance 16-7
setting options 16-6
viewing subreports 16-4
recording files 15-9
recover
  compressed backup file 15-11
Refresh All button 2-6
relect master server 11-16
Remote Monitoring application
  about 9-17
  provisioning 9-16
remote server 15-1
removing a server 11-13, 11-14
Repository datastore, contents 12-5
Resource based CSQ 7-17
resource groups
  creating 7-4, 20-10, 20-11
  deleting 7-6
  modifying name 7-5
Resource Manager, about 1-5
Resource pool selection criteria
  between skills and groups 7-26
  within a CSQ 7-27
resources
  assigning to resource groups and skills in
    bulk 7-14
  assigning to resource groups and skills
    individually 7-12
  modifying 20-10
  removing skills from individual agents 7-16
resource selection
  circular 7-23
  least skilled 7-21
  least skilled by order 7-22
  least skilled by weight 7-22
  linear 7-23
  longest available 7-21, 7-23
  most handled contacts 7-21, 7-23
  most skilled 7-21
  most skilled by order 7-22
  most skilled by weight 7-22
  shortest average handle time 7-21, 7-23
Resource Unified CCX Stats report 16-24, 16-27
restore
  default schedule 15-7
  restore operation 15-3
  off-peak hours 15-10
resynchronizing
  Cisco JTAPI Client 6-7
  Unified CM Telephony data 6-6
  Unified CM Telephony information 6-21
Index

retention period
  merge replication 12-3
Ring-No-Answer application
  about 9-9
  provisioning 9-8
RmCm provider
  about 7-2
  provisioning 7-2
RmCm subsystem
  in service 14-3
RmCm subsystem, about 1-11
RNA application
  about 9-9
  provisioning 9-8

S

scheduling callbacks
  Outbound subsystem 14-8
script application
  about 9-3
  configuration overview 9-3
script management 9-26, 19-3
script repository 9-3
scripts
  about 9-25
  deleting 9-34
  refreshing 9-30
  renaming 9-33
  viewing or downloading 9-29
scripts, uploading 9-26
server
  disabling 11-14
  removing 11-14
  removing and disabling 11-13
servers
  active and standy 11-2, 11-7
  CRS and expansion 11-2
  server services, stopping SQL 11-11
  service, definition 11-3
  Service Control interface 8-4
Session Initiation Protocol
  see SIP 1-9
sessions report 16-18
  shortest average
    handle time 7-21, 7-23
  single-node deployment
    restore operation 15-10
SIP
  router integration 1-9
  SIP-based route point 5-2
Skill based CSQ 7-17
skills
  creating 7-7, 20-13
  deleting 7-9
  modifying name 7-8
  removing 20-13
  removing from individual agents 7-16
snapshot agent
  publisher 12-3
spoken name prompt
  adding 5-16, 5-17, 10-15
SQL server service dependencies 11-11
staging directory 15-8
standby server 11-2, 11-7
standby service, definition 11-3
storage location
  backup 15-4
subscriber
  cluster manager 1-9
database 12-2
subscription agent 12-2
subscription agent
  subscriber 12-3
subsystems
  by package license A-2
Subsystems menu 20-1
  Add a New Dialog Control Group 6-24
  adding HTTP triggers 20-23
adding teams 20-15
agent-based routing 20-14
assigning skills 20-12
Cisco Media 20-24
CM Telephony 20-2, 20-5
CM Telephony Call Control group configuration 20-3
CM Telephony provider configuration 20-3
CM Telephony triggers configuration 20-4
database configuration 20-21
eMail 20-24
general 20-19
HTTP 20-22
MRCP ASR 20-25
MRCP TTS 20-27
remote monitoring 20-13
resource group 20-10
resources 20-9
RmCm provider 20-12
skills configuration 20-8
teams 20-15
Unified CCX 20-7
Unified CME Telephony Call Control group configuration 20-6
Unified CME Telephony provider configuration 20-6
Unified CME Telephony triggers configuration 20-7
Unified ICME 20-19
VRU scripts 20-20
supervisor
  configuring teams 7-34
  supervisor capabilities 17-2
  supervisor privileges 17-3
System menu
  about 18-1
  alarm and trace configuration 18-8
  control center 11-3
  custom file configuration 10-15, 18-6
Index

datastore control  18-5
LDAP Information  11-22
logout  11-28, 18-11
system parameters  11-23
systems parameters (System menu)  11-23

team
  configuring  7-34
  creating a team  7-36
  deleting a team  7-39
  making changes to agents on a team  7-38
temporary space
  backup operation  15-8
Text-to-speech
  see TTS  6-26
time zone
  determining local time  14-7
  handling callbacks  14-19
Tools menu
  alarm definition  22-2
  application tasks  16-12
  application task summary  16-10
  contacts  16-13
  contact summary report  16-8
  CSQ Unified CCX Stats  16-23
  database server configuration  22-8
  datasource usage  16-19
  engine tasks  16-13
  historical reporting  22-7
  migration status  22-10
  Options  16-33
  overall Unified CCX Stats  16-20
  overview  22-1
  plug-ins  22-2
  purge configuration  22-9
  purge now  22-9
  purge schedule  22-9
  real-time reporting  22-3
  real-time snapshot config  22-4
  Refresh Connections  16-30
  report  16-8
  Reset All Stats  16-29
  Resource Unified CCX Stats  16-24, 16-27
  sessions  16-18
  Tools  16-29
  troubleshooting tips  22-16
  Unified WIM/Unified EIM  22-10
  user configuration  22-8
  user management  22-10, 22-11
  user management, Name Grammar Generation  22-12
  user management, Spoken Name Upload  22-13
  Views  16-30
  Tools menu
    Settings  16-32
  trace file configuration  18-8
trace settings 12-9
triggers
  by package license A-2
triggers and applications 9-18
TTS
  default provider 6-36
  installation guidelines 6-26
  overview 6-26
  provisioning 6-34
  VXML applications 6-36

Unified CCX Standard, about 1-6, 3-2
Unified CM
  configure users 4-15, 4-19
  configuring Unified CCX agents 7-11
  connecting to web interface 4-14
  users 17-12
Unified CME
  provisioning 5-1
  users 17-6
Unified CME Telephony
  Call Control group configuration 20-6
  provider configuration 20-6
  trigger information 5-11
  triggers 20-7
Unified CME Telephony call control groups
  about 5-10
  provisioning 5-10
Unified CME Telephony Subsystem
  license A-3
Unified CME Telephony subsystem
  about 1-10, 5-7
  provisioning Unified CME Telephony call
  control groups 5-10
  provisioning Unified CME Telephony
  trigger 5-10
Unified CME Telephony subsystem, license 5-6
Unified CME Telephony trigger
  about 5-10
  adding 9-21
provisioning  5-10
Unified CM Telephony
configuration backup  15-9
trigger information  6-15
Unified CM telephony
configuration  6-5
Unified CM Telephony information, resynchronizing  6-21
Unified CM Telephony provider
migration  6-23
Unified CM Telephony subsystem
about  1-10
configuration overview  6-5
configuring Unified CM Telephony providers  6-8
in service  14-3
provisioning call control groups  6-9
provisioning Unified CM Telephony trigger  6-14
Unified CM Telephony subsystem, license  6-5
Unified CM Telephony trigger
adding  9-21
Unified CM Telephony triggers
using with Unified CCX  6-21
Unified CM User Options page  17-12
Unified ICME
about  1-10
Unified ICME post-routing application
about  9-11
provisioning  9-10
Unified ICME script commands  8-3
Unified ICME subsystem
about  1-10, 8-2, 8-3
configuration overview  8-3
configuring general Unified ICME information  8-4
configuring VRU scripts  8-6
Unified ICME translation-routing application
about  9-14
provisioning  9-14
Unified IP IVR, about  1-4
Unified QM, about  1-6
uploading licenses  1-15
uploading scripts  9-26
user roles  17-2
users
configuring in Unified CM  4-15, 4-19

V
virtual agents  4-17
virtual infrastructure  4-17
voice gateways  1-2
VRU scripts
configuring  8-6, 20-20
uploading time  9-26
VXML applications
default TTS provider  6-36
W

wizards
  using 2-7
Wizards menu 21-1
  Application 21-2
  RmCm 21-3
workflow scripts 15-9
Wrap-up
  license A-4
wrap-up data
  usage 7-34

Z

zip files, uploading 10-10